# Table of Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table of Contents</td>
<td>3</td>
</tr>
<tr>
<td>Quick Reference Guide</td>
<td>15</td>
</tr>
<tr>
<td>1. Welcome to ProShow</td>
<td>23</td>
</tr>
<tr>
<td>Creating Professional Shows with Ease</td>
<td>23</td>
</tr>
<tr>
<td>Making Shows Your Way</td>
<td>23</td>
</tr>
<tr>
<td>2. Getting Started</td>
<td>25</td>
</tr>
<tr>
<td>Making a Simple Show from Start to Finish</td>
<td>25</td>
</tr>
<tr>
<td>Make a Show Right Away</td>
<td>26</td>
</tr>
<tr>
<td>Begin With Basics</td>
<td>28</td>
</tr>
<tr>
<td>Playing a Slideshow</td>
<td>33</td>
</tr>
<tr>
<td>Working Counter-Clockwise</td>
<td>35</td>
</tr>
<tr>
<td>Pick a Transition Effect</td>
<td>36</td>
</tr>
<tr>
<td>Adding Effects to Your Images</td>
<td>37</td>
</tr>
<tr>
<td>Customizing Slides</td>
<td>39</td>
</tr>
<tr>
<td>Share Information with Text</td>
<td>40</td>
</tr>
<tr>
<td>Round Out a Show with Audio</td>
<td>43</td>
</tr>
<tr>
<td>Using Undo and Redo</td>
<td>46</td>
</tr>
<tr>
<td>Save Your Show</td>
<td>47</td>
</tr>
<tr>
<td>Publish and Share Your Show</td>
<td>47</td>
</tr>
<tr>
<td>3. The Three Workspaces</td>
<td>51</td>
</tr>
<tr>
<td>Every Tool at Your Fingertips</td>
<td>51</td>
</tr>
<tr>
<td>Common Workspace Elements</td>
<td>52</td>
</tr>
<tr>
<td>The Build Workspace</td>
<td>59</td>
</tr>
<tr>
<td>The Design Workspace</td>
<td>65</td>
</tr>
</tbody>
</table>
# Table of Contents

The Publish Workspace ................................................................. 67  
Optional Workspace Elements......................................................... 70  
Customizing the Workspaces ............................................................... 71  

## 4. Show Options ................................................................. 75  
The Foundation of a Show ............................................................... 75  
Locating the Show Options ............................................................... 76  
What You Can Do with Show Options ............................................... 77  
Show Settings .................................................................................. 77  
Watermarks ..................................................................................... 85  
Show Background ........................................................................... 87  
The Show Soundtrack ....................................................................... 89  
Additional Show Options ................................................................. 90  
New Show Basics ........................................................................... 92  

## 5. Understanding ProShow ...................................................... 93  
ProShow Explained ........................................................................... 93  
What’s in a Show .............................................................................. 93  
Slide Order and Timing ..................................................................... 95  
Working in the Slide Options Window ............................................... 99  
How ProShow Uses Files .................................................................. 105  

## 6. The Wizard ........................................................................... 111  
Slideshows Made Even Easier ............................................................ 111  
Using the Wizard ............................................................................ 111  
Remixing Slides ............................................................................. 121  
Wizard Themes ............................................................................... 122  

## 7. Effects ............................................................................... 127  
Bringing Slides to Life ................................................................. 127  
Types of Effects ............................................................................. 127
# Table of Contents

- Caption Enhancements ......................................................................................... 226
- The Captions List ............................................................................................... 227
- Caption Setup ..................................................................................................... 228
- Creating a Vertical Caption ................................................................................ 232
- Caption Effects .................................................................................................. 234
- Using Texture on Captions ................................................................................ 239
- Caption Macros .................................................................................................. 242
- Caption Interactivity ......................................................................................... 246

### 11. Text Layers ..................................................................................... 249

- Layers Without Images .................................................................................. 249
- Adding Text Layers ......................................................................................... 249
- Text Layers are Stackable .............................................................................. 251
- Working with Text Layers .............................................................................. 251
- Text Layer Settings ........................................................................................ 254
- Text Layers In Action ..................................................................................... 257
- Text Layers and Slide Styles ......................................................................... 259
- Captions or Text Layers ................................................................................ 260

### 12. Music and Sound Effects .......................................................... 261

- Making a Show for the Senses ....................................................................... 261
- Audio Files Supported ................................................................................... 261
- Adding Music to your Show .......................................................................... 262
- Adding Sound Effects to your Slides ............................................................. 265
- Adding Sounds from a CD .............................................................................. 267
- Syncing Music to a Show .............................................................................. 269
- Syncing Audio to a Beat ............................................................................... 275
- Controlling Soundtrack Volume ................................................................... 277
- Setting Soundtrack Offset Times .................................................................. 281
Working with Slide Sounds .................................................................................. 282
Adding Narration to Slides ................................................................................... 285
Working with Audio in Video Clips .................................................................... 286
Editing Music and Sounds in ProShow ............................................................. 288
Using the Timeline View ....................................................................................... 293
Making Audio Edits Using the Timeline View................................................. 296
Crossfading Audio Tracks ..................................................................................... 301
Using Volume Control Points .............................................................................. 303
Volume Control Point Tips ................................................................................... 305
Additional Volume Control Points ..................................................................... 307

13. Slide Styles .....................................................................................................309
Using Slide Styles ................................................................................................. 309
Understanding the Style Options ................................................................. 312
Applying Styles to Multiple Slides ................................................................. 316
Where to Get More Styles ................................................................................. 317
Making Changes after Applying a Style .......................................................... 317
Creating Your Own Styles ................................................................................... 319
Undoing a Slide Style ......................................................................................... 323
Managing Slide Styles ........................................................................................ 323
Replacing or Updating Styles .......................................................................... 331
Styles as a Training Tool ..................................................................................... 331
Preserving Styles ................................................................................................ 332
Slide Style PXS Files & Structure ................................................................... 333
What Doesn’t Get Applied By a Style ............................................................ 335
Styles and Timing ............................................................................................... 336
Styles and the Show Aspect Ratio ............................................................... 336

14. Transitions ......................................................................................................339
Table of Contents

The Art of Getting from Slide to Slide ............................................................... 339
Using Transitions.............................................................................................. 339
Random Transitions ......................................................................................... 344
Managing Transitions ....................................................................................... 347
Creating Your Own Transitions ....................................................................... 355
Using the Create Transition Window ............................................................... 359

15. Motion ................................................................................................. 365

Bring Slides to Life ............................................................................................ 365
The Fundamentals of Motion ........................................................................... 365
Motion and Time ............................................................................................... 366
Getting to the Motion Effects ........................................................................... 366
The Effects Preview ............................................................................................ 368
Creating Motion Quickly .................................................................................. 374
Using the Preview to Set Motion ....................................................................... 377
Previewing Your Motion .................................................................................... 378
Motion Settings ................................................................................................. 378
Motion and Layers ............................................................................................ 385
Copying Motion ................................................................................................. 389
Matching Motion ............................................................................................... 391
Motion Speed ................................................................................................... 392
Removing Motion .............................................................................................. 393
Randomizing Motion ......................................................................................... 394
Motion and Captions ....................................................................................... 395
Bringing Captions to Life .................................................................................. 395
Other Caption Motion Options ......................................................................... 397
Motion and Soundtrack .................................................................................... 398
Motion and Keyframing ................................................................................... 398
16. Masks & Adjustment Layers .................................................. 399

17. Keyframing ................................................................. 427
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Understanding the Keyframing Interface</td>
<td>430</td>
</tr>
<tr>
<td>The Keyframe Previews</td>
<td>432</td>
</tr>
<tr>
<td>Keyframe Timeline</td>
<td>435</td>
</tr>
<tr>
<td>Keyframe Selector Ribbon</td>
<td>440</td>
</tr>
<tr>
<td>Keyframe Indicators</td>
<td>441</td>
</tr>
<tr>
<td>Effects Values</td>
<td>442</td>
</tr>
<tr>
<td>The Keyframe Toolbar</td>
<td>443</td>
</tr>
<tr>
<td>Additional Keyframing Tools</td>
<td>444</td>
</tr>
<tr>
<td>Creating Keyframes</td>
<td>447</td>
</tr>
<tr>
<td>Selecting Keyframes</td>
<td>450</td>
</tr>
<tr>
<td>Editing and Adjusting Keyframes</td>
<td>451</td>
</tr>
<tr>
<td>Keyframes and Layer Visibility</td>
<td>454</td>
</tr>
<tr>
<td>Keyframes and Caption Visibility</td>
<td>455</td>
</tr>
<tr>
<td>Layer Transitions</td>
<td>456</td>
</tr>
<tr>
<td>Caption Behaviors and Keyframing</td>
<td>458</td>
</tr>
<tr>
<td>Using Transitions &amp; Behaviors with Text Layers</td>
<td>459</td>
</tr>
<tr>
<td>Previewing Keyframe Effects</td>
<td>460</td>
</tr>
<tr>
<td>Auto and Manual Keyframe Settings</td>
<td>461</td>
</tr>
<tr>
<td>Temporary Keyframes</td>
<td>463</td>
</tr>
<tr>
<td>Practical Examples of Keyframing with Motion</td>
<td>465</td>
</tr>
<tr>
<td>Practical Example of Keyframing with Adjustments</td>
<td>472</td>
</tr>
<tr>
<td>A Practical Example of Keyframing with Captions</td>
<td>473</td>
</tr>
<tr>
<td>Controlling Your Soundtrack with Keyframes</td>
<td>479</td>
</tr>
<tr>
<td>18. Modifiers</td>
<td>487</td>
</tr>
<tr>
<td>Working with Modifiers</td>
<td>487</td>
</tr>
<tr>
<td>What is a Modifier?</td>
<td>487</td>
</tr>
<tr>
<td>What Can Be Modified?</td>
<td>489</td>
</tr>
</tbody>
</table>
19. Creating Output for Television ................................. 515
   Making Discs for Television and PC ................................................ 515
   Creating Disc Output ........................................................................... 517
   Making Your Disc ............................................................................... 518
   Making a Menu ..................................................................................... 521
   Choosing What Goes on your Disc ..................................................... 522
   Including an Executable ....................................................................... 525
   Advanced Options .................................................................................. 526
   Burning Options ..................................................................................... 535

20. Creating Video Output .................................................. 541
   Publishing Your Shows as Videos ....................................................... 541
   Creating Video for Web, Devices & Computers ................................... 542

21. Creating Output for the Web......................................... 563
   Getting Your Shows Online ................................................................... 563
   Sharing Shows on Facebook .................................................................. 564
   Announcing Shows on Twitter ............................................................... 566
   Sharing Shows Using YouTube ............................................................... 566
   Sharing Shows with SmugMug ................................................................. 569
<table>
<thead>
<tr>
<th>22. Creating Output for the PC</th>
<th>587</th>
</tr>
</thead>
<tbody>
<tr>
<td>Watching Shows on your Computer</td>
<td>587</td>
</tr>
<tr>
<td>Options for PC Output</td>
<td>587</td>
</tr>
<tr>
<td>Creating an Executable</td>
<td>589</td>
</tr>
<tr>
<td>Menus and Multiple Shows</td>
<td>590</td>
</tr>
<tr>
<td>Branding</td>
<td>594</td>
</tr>
<tr>
<td>Unique Settings for Executable Output</td>
<td>597</td>
</tr>
<tr>
<td>Live Shows</td>
<td>601</td>
</tr>
<tr>
<td>Creating an Autorun Disc</td>
<td>605</td>
</tr>
<tr>
<td>Creating a Screen Saver</td>
<td>605</td>
</tr>
<tr>
<td>Creating an E-mail Show</td>
<td>606</td>
</tr>
<tr>
<td>Capturing Still Frames</td>
<td>607</td>
</tr>
<tr>
<td>Accessing all Publishing Formats</td>
<td>609</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>23. Creating Show Menus</th>
<th>611</th>
</tr>
</thead>
<tbody>
<tr>
<td>First Impressions</td>
<td>611</td>
</tr>
<tr>
<td>Getting Started</td>
<td>611</td>
</tr>
<tr>
<td>Creating a Menu</td>
<td>612</td>
</tr>
<tr>
<td>Menus as Interactive Pages</td>
<td>616</td>
</tr>
<tr>
<td>Creating a Custom Menu</td>
<td>617</td>
</tr>
<tr>
<td>Creating Additional Pages</td>
<td>618</td>
</tr>
<tr>
<td>Adding Shows to a Page</td>
<td>620</td>
</tr>
</tbody>
</table>
Setting Menu Captions ................................................................. 624
Interactivity Makes Menus .......................................................... 625
Saving Custom Menus ................................................................. 627
Saving Themes and Layouts ......................................................... 628

24. Color Profiles .................................................................... 631
Professional Color Quality ....................................................... 631
How Color Profiles are Used ................................................... 632
Using Color Profiles ................................................................. 633

25. Templates and Projects ....................................................... 635
Work Smart, Not Hard .............................................................. 635
Shows are Quick with Templates ............................................ 635
Using Projects ......................................................................... 643

26. Copy, Paste, and Save Time ................................................. 649
Nearly Everything Can Be Copied ............................................ 649
Copying Slides ......................................................................... 649
Copying Slide Styles ............................................................... 650
Copying Layers and Captions .................................................. 650
Copying Settings ...................................................................... 653
Copying Everything ............................................................... 655

27. Configuring ProShow: Preferences .................................. 657
Customizing ProShow ............................................................. 657
Adjusting the Look and Feel of ProShow .............................. 659
Changing the Way ProShow Behaves ..................................... 668
Changing Show Defaults ........................................................ 675

28. The ProShow Remote App ................................................. 677
Going Mobile with ProShow .................................................... 677
The ProShow Remote App ........................................................ 677
## Table of Contents

- Control Playback your PC Using a Device ........................................................ 682
- Additional ProShow Remote App Tools ........................................................... 683
- Tips For Using the ProShow Remote App ......................................................... 684
- Advanced Connection Settings ........................................................................ 685

### 29. Getting Help with ProShow ................................................................. 687
- Call or E-mail Photodex ................................................................................. 687
- Reporting a Problem ..................................................................................... 687
- Checking for Upgrades ................................................................................. 688
- Downloading Extra Content ......................................................................... 689

## Keyboard Shortcuts ...................................................................................... 691

## Predefined Text Macros ............................................................................... 695

## Supported File Types .................................................................................... 697
- Supported Output Formats ............................................................................ 697
- Supported Input Formats ............................................................................. 699
- Video Codecs ............................................................................................... 701
- RAW Files ........................................................................................................ 702

### Appendix 1 ................................................................................................ 703
- ProShow and Windows .................................................................................. 703
- Installing ProShow ........................................................................................ 703

## Notes ............................................................................................................ 709

## End User License Agreement ......................................................................... 713

## Index ............................................................................................................ 723
Quick Reference Guide

This chapter contains quick references to many of the common functions you might perform in ProShow. Use it to quickly reference something you might want to do, such as add a layer, or create a mask.

How to Pick a Transition Effect ................................................................. 36
How to Pick an Effect ............................................................................. 38
Full Screen Playback of a Show ............................................................ 57
Favorites ................................................................................................. 71
Saving a Custom Workspace ................................................................. 73
Loading a Custom Workspace ................................................................. 74
Restoring the Workspace to Defaults .................................................... 74
To Open the Show Options ................................................................. 76
To Change a Show Title and Add Notes ............................................... 78
To Change the Show Thumbnail ............................................................ 81
To Select Random Transition Effects ................................................... 84
To Enable a Watermark ........................................................................ 86
To Set a Show Background .................................................................... 87
To Add a Soundtrack in Show Options .................................................. 89
To Duplicate a Soundtrack in Show Options ......................................... 89
To Open Slide Options ........................................................................ 98
To Lock a Slide Time ........................................................................... 99
To Rename a Slide ............................................................................... 102
To Add Slide Notes ............................................................................. 103
To Add a Flag ..................................................................................... 103
To Add a Flag While Previewing a Show ............................................. 104
To Remove a Flag .............................................................................. 104
To Restore a Show from a Backup File ............................................... 107
Locating Missing Files .......................................................................... 107
To Find Missing Files ........................................................................ 108
Collecting Show Files .......................................................................... 109
To Collect Show Files ........................................................................ 109
To open the Wizard ................................................................. 111
Tune the Energy Level .............................................................. 117
Set the Audio Crossfade Overlap ............................................. 119
To Remix Slides ........................................................................ 121
To Edit a Wizard Theme ............................................................ 122
To Create a New Wizard Theme ............................................... 124
To Remove a Wizard Theme .................................................... 125
To Apply a Transition from the Slide List ............................. 131
To Apply a Transition from the Effects (FX) Window .......... 131
To Apply Slide Styles from the Effects (FX) Window .......... 132
To Apply Slide Styles from Slide Options ............................ 133
To Apply Effects Manually ....................................................... 135
Adding a New Layer in the Build Workspace ..................... 139
To Import Files from Social Media Services ......................... 140
Adding a New Layer to an Existing Slide ............................. 143
Adding More Than One Layer to a Slide at Once .................. 144
Adding a New Layer from Slide Options ............................... 146
To Set a Custom Slide Background ....................................... 156
To Create a Layered Arrangement ......................................... 167
To Enable and Use Chroma Key .............................................. 180
Choose a Color Using the Color Picker ................................. 184
Create a Color to Black & White Adjustment Effect .............. 190
To Create a Solid Color Layer ................................................. 194
To Edit a Solid Color Layer ..................................................... 195
To Create a Gradient Layer ..................................................... 196
To Add Video to a Show ......................................................... 204
To Access the Video Settings ............................................... 205
Customizing Videos with the Video Trimmer ....................... 207
How to Create a Title Slide .................................................... 214
How to Access Caption Styles .............................................. 223
To Apply a Caption Style ....................................................... 223
To Create New Caption Styles .............................................. 224
How to Update Existing Caption Styles ............................... 225
To Delete a Caption Style ...................................................... 226
To Apply an Outline or Shadow to a Caption ......................................... 226
To Create a Vertical Caption .......................................................................... 232
Create a Caption Adjustment Effect.............................................................. 236
Adding an Image Texture to a Caption ..................................................... 240
Adding a Gradient Texture to a Caption .................................................. 240
To Add a Caption Macro ................................................................................. 242
To Insert a Symbol Macro ............................................................................... 243
To Insert a Predefined Macro ........................................................................ 244
To Insert an EXIF Macro: .................................................................................. 245
How to Create Interactive Captions ........................................................... 246
To Convert a Caption to Text Layer ............................................................ 249
To Add a Text Layer from the Layers List ................................................. 250
Smoke Monster Show Intro ........................................................................... 257
To Add Music to a Show ................................................................................. 262
To Automatically Fade Music at the End of a Show ..................................... 264
To Add Slide Sound to a Slide ....................................................................... 266
To Save Music from a CD ................................................................................ 268
To Quick Sync your Music to your Show .................................................. 269
To Access Record Slide Timing ..................................................................... 276
To Adjust the Volume of a Show ................................................................. 277
Changing How a Slide Sound Behaves ....................................................... 283
Removing a Slide Sound ................................................................................. 284
To Record a Voice-Over ................................................................................... 285
Accessing Edit Fades and Timing for Audio ............................................ 288
To Trim Silence from Audio ........................................................................... 289
To Access the Timeline View ......................................................................... 293
To Change Audio Volume Using Timeline View .................................... 296
To Crossfade Audio Tracks Using the Timeline View ........................... 301
To Add a Volume Control Point ................................................................... 303
To Set the Volume Level for a Volume Control Point .......................... 304
To Remove a Volume Control Point ........................................................... 304
How to Access Slide Styles ............................................................................. 309
Creating a Slide with Slide Styles ............................................................... 311
To Include Content in a Style ........................................................................ 322
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>To Manage Slide Styles</td>
<td>323</td>
</tr>
<tr>
<td>To Import a Slide Style</td>
<td>325</td>
</tr>
<tr>
<td>To Create a Slide Style</td>
<td>325</td>
</tr>
<tr>
<td>To Delete a Slide Style</td>
<td>326</td>
</tr>
<tr>
<td>Using Categorize to Change Slide Style Categories</td>
<td>327</td>
</tr>
<tr>
<td>To Create a Slide Style Category</td>
<td>328</td>
</tr>
<tr>
<td>Using Categorize with Multiple Styles</td>
<td>329</td>
</tr>
<tr>
<td>To Export a Slide Style</td>
<td>330</td>
</tr>
<tr>
<td>To Replace or Update an Existing Style</td>
<td>331</td>
</tr>
<tr>
<td>How to Apply a Transition Effect</td>
<td>339</td>
</tr>
<tr>
<td>The Transitions Toolbar</td>
<td>344</td>
</tr>
<tr>
<td>To Apply a Random Transition</td>
<td>345</td>
</tr>
<tr>
<td>To Customize the Random Transition Effects List</td>
<td>346</td>
</tr>
<tr>
<td>To Manage Transitions</td>
<td>347</td>
</tr>
<tr>
<td>To Add a Transition</td>
<td>349</td>
</tr>
<tr>
<td>To Create a Transition</td>
<td>349</td>
</tr>
<tr>
<td>To Delete a Transition</td>
<td>350</td>
</tr>
<tr>
<td>How to Change Transitions Categories</td>
<td>352</td>
</tr>
<tr>
<td>To Create a Transition Category</td>
<td>353</td>
</tr>
<tr>
<td>To Export a Transition</td>
<td>354</td>
</tr>
<tr>
<td>Building a Custom Crossfade Transition</td>
<td>356</td>
</tr>
<tr>
<td>Including Video in your Transitions</td>
<td>361</td>
</tr>
<tr>
<td>To Access the Effects Options</td>
<td>367</td>
</tr>
<tr>
<td>To Create a Traditional Panning Layer</td>
<td>375</td>
</tr>
<tr>
<td>To Enable the Motion Path</td>
<td>384</td>
</tr>
<tr>
<td>To Create an Exploding Collage</td>
<td>385</td>
</tr>
<tr>
<td>To Randomize Motion</td>
<td>394</td>
</tr>
<tr>
<td>Panning and Zooming a Caption</td>
<td>396</td>
</tr>
<tr>
<td>To Access the Masking Options</td>
<td>401</td>
</tr>
<tr>
<td>To Move a Layer Into or Out of a Mask</td>
<td>406</td>
</tr>
<tr>
<td>To Change an Existing Layer into a Mask</td>
<td>407</td>
</tr>
<tr>
<td>Add a Layer and Make it a Mask</td>
<td>408</td>
</tr>
<tr>
<td>To Blend Images with Grayscale Masking</td>
<td>410</td>
</tr>
<tr>
<td>To Create a Transparency Mask Blend</td>
<td>414</td>
</tr>
</tbody>
</table>
Creating a Grayscale Mask using a Text Layer................................. 417
Using a Grayscale Adjustment ........................................................... 422
Using a Transparency Adjustment ...................................................... 425
To Open the Effects Options ............................................................... 430
To Open the Keyframe Editor ............................................................ 445
To Create One New Keyframe .......................................................... 447
To Create One New Keyframe at a Specific Time ......................... 448
To Add Multiple Keyframes Simultaneously ................................ 448
To Delete a Keyframe ........................................................................ 449
To Select a Keyframe ......................................................................... 450
To Move to Another Keyframe ........................................................ 450
To Change the Time of a Keyframe .................................................. 451
To Add or Remove Time to a Keyframe ......................................... 452
How to Set a Layer Transition .......................................................... 457
To Set The Timing for Layer Transition ............................................ 457
How to Set a Caption Behavior ......................................................... 458
To Set The Timing for Caption Behavior ....................................... 459
To Create Zoom, Freeze then Move ................................................. 467
Using Pause Motion Until Here ....................................................... 469
Using Pause Motion ......................................................................... 471
To Control the Soundtrack Using Keyframes ................................. 480
Adding Soundtrack Keyframes to an Existing Effect .................... 483
To Apply a Modifier .......................................................................... 489
To Remove a Modifier ....................................................................... 489
To Edit a Modifier ............................................................................ 490
To Create “Layer Tag” ................................................................. 506
To Create the “Dog Shake” .............................................................. 507
To Copy a Modifier .......................................................................... 511
To Create DVD or Blu-ray Disc ......................................................... 517
To Add a Show to a Disc ................................................................. 523
To Turn Off an Intro Show ............................................................... 524
To Use a Custom Intro Show ........................................................... 525
To Access the Create Video Window .............................................. 542
To Create a Custom Video File ......................................................... 551
To Check for ProShow Upgrades ................................................................. 688
To Download More Content ................................................................. 689
1. Welcome to ProShow

Creating Professional Shows with Ease

Thank you for picking up a copy of ProShow Producer. You now have access to the best slideshow creation software on the market. Unlike other packages which make shows for you, taking away control, or drown you in arcane options, Producer is designed to help you make a professional quality show without overwhelming you or taking away your creative freedom.

This manual is designed to get you started with the program. It explains the functions of the program, as well as practical uses for features. You'll find examples, how-to tips, and technical descriptions for every feature offered.

Making Shows Your Way

You’re going to learn how to use the various features in ProShow to create a show that is entirely yours. You have tools to control how your slides appear, create custom motion, make your own special effects, add and edit music, and move your whole production into just about any final format you can imagine.

We’ll get started by taking a look at the program from a practical standpoint. You’ll learn how it works, why, as well as some great shortcuts to create and work with your slides easily. Once you learn the basics, we’ll move into the individual aspects of the program in more detail.
1. Welcome to ProShow
2. Getting Started

Making a Simple Show from Start to Finish

To help you become familiar with ProShow, we’re going jump right in and walk you through the process of making a very simple show. By the end of this chapter, you'll learn the basics of working within ProShow and you'll have your very first show ready to share with friends, family or customers.

In this chapter, we’ll cover the basics of:

- Adding images to your shows
- Changing slide and transition times
- Previewing your shows
- Choosing your transition effects
- Adding effects to your images
- Adding simple captions
- Adding a soundtrack to your show

Naturally, each of these topics will be covered in much greater detail later on in this User Guide.
2. Getting Started

Make a Show Right Away

1. When you first open ProShow, you’ll be asked how you’d like to begin your new Slide Show. Select the Blank Show icon.

2. In the Show Title box, give your new show a name.

3. Select the Aspect Ratio. By default, it will be set to 16:9 (Widescreen) as this is the most common for playback on most PCs, Televisions and Devices.

4. Once you press Create, you’ll be in the Build Workspace. This is where you’ll start out each time you are ready to make new show.

5. Use the Folder List to browse for any folder on your PC that contains images. Try to find a folder with 100 images or less in order to make your first show more quickly.

6. When you select the desired folder in the Folder List, right-click on any one of the thumbnails that appears in the File List below.

7. Select Add All Files to Show from the sub-menu that appears.
Depending on the number of images in the selected folder, it may take a few moments to import everything into ProShow. A task monitor indicator will appear just below the **File List** that will show you how far along you are in the import process.

Once all of the images have been added as slides in your **Slide List** at the bottom of the screen, continue creating your first show by following the "1, 2, 3" method.

The "1, 2, 3" method uses some of the many keyboard shortcuts found in ProShow to randomly re-arrange the order of your images, add random motion effects to your images and randomly select transition effects to go in between each of your slides.

1. Select every slide in your show by clicking on any slide and pressing CTRL + A.
2. Randomize the order of your slides by pressing CTRL + Shift + 1.
3. Add some random motion by pressing CTRL + Shift + 2.
4. Finally, randomize the transition effects between slides by pressing CTRL + Shift + 3.

With just a few simple steps, you now have a brand new slide show, complete with motion and transition effects. To see what you've created, click the **Play** button that appears beneath the preview window.

So there it is, your very first show! Now that you see how easy it is to get started, let's dig a little deeper and get you on your way to doing even more with ProShow.
Begin With Basics

In the quick introduction, you learned how to begin with a blank canvas and create a simple show by adding the entire contents of a folder. Now let's take a more detailed look at the Build Workspace and learn how to use the interface to make shows using only certain images.

Using the Proper Workspace

ProShow features three different Workspaces that you will use for creating and sharing shows. The Workspaces are Build, Design, and Publish. Each will be covered in more detail in the next chapter, but as they all have slightly different options, it's important to know what each does and how to tell which one is selected.

- The Build Workspace is where you'll begin making a show. This is where you'll have access to the Folder List and File List.

- Once you have all of your content added, the Design Workspace gives you more room to preview your show and see details about each slide you are working on.

- Once you're ready to share your show, use the Publish Workspace to choose from your output options.

The Workspace selector is located in the top right-hand corner and will always highlight the selected Workspace.

For creating new shows, you'll want to use the Build Workspace. This is also where we'll spend the rest of this chapter.
Locating Your Images

The **Folder List**, which appears in the upper left corner of the main workspace, is almost exactly like any folder browser you use in Windows. While looking at it, you’ll notice that it shows you your hard drives, My Pictures folder, and more. You can think of this just like browsing around the contents of your system – it works the exact same way.

Double-click on a folder to open it, and in that folder you can see any sub-folders that are there. Here’s a quick example:

If your images are stored in your “My Pictures” folder, you can access that by finding the “Pictures” entry in the **Folder List**, double-clicking on it, and choosing the sub-folder with your images from the list that shows up beneath the “Pictures” entry.

On that same note, if you keep your images in a general folder on your hard drive, like C:\PhotoShoots\Wedding2014, you can access those just as you would in Windows. Double-click on the C: entry, locate the “PhotoShoots” folder, and then click on the “Wedding2014” folder that appears beneath it.
Note: various versions of Windows place virtual folders like “My Pictures” in different locations. Consult your Windows documentation if you’re not familiar with this.

When you have found a folder that contains images, the File List will show thumbnails of the images there. This gives you the ability to visually figure out which images you want to put in your show.

Build Workspace Tips:

- If you need more room to see folders, or files, you can adjust the size of the Folder List and File List. Simply hover your mouse in between the two panes to activate the size arrows. Click and drag up or down to achieve the desired size.

- In the Files List, right-click to access the Files List sub-menu. From the sub-menu you can change the size of your thumbnails, see details for your files, change the sorting order and more.
Creating New Slides

Go ahead and pick an image that you want to use to start your show. Once you’ve chosen that image, click on it. This will highlight it in the **File List**. Now click on it again, but hold your mouse button down.

As you hold down the mouse button, move the mouse cursor over the **Slide List**, which is the blank bar at the bottom of the main workspace. The slide list looks like it contains a series of placeholder squares.

When your mouse cursor is over the slide list, release the mouse button. Notice that ProShow creates a new slide using the image you chose. This process is called **drag and drop**. Just drag an image, or images, from the **File List** and drop them into the slide list. ProShow will do the rest. Double-clicking on an image in the **Files List** will also add it your **Slide List**, but you’ll most likely find drag and drop may be the better way to go.
Changing Slide and Transition Times

Once you have an image in place, take a look at the slide. You'll notice that it displays a thumbnail of the image, the slide number, and two values. These, by default, should say 3.0.

These time values are referring to seconds. The number at the bottom of your slide is your **Slide Time** or the length of time the slide is going to be displayed. Again, by default, this is 3 seconds. The number to the right of the slide is the **Transition Time**, or the amount of time it will take for this slide to transition into the next slide.

Each slide will always have two time values. In this example, it means that the total time for your first slide is 6 seconds - the slide time, plus the transition time. If you want your slide to be longer or shorter, you can adjust either time by clicking on the value and typing in any number you want. Remember that the time is calculated in seconds.

**Note:** the 6 second total time is a default because it works well when used with a wide variety of effects and soundtracks. It's generally just enough time to see a slide and appreciate the contents of a slide before moving on to another one.
Playing a Slideshow

Now that you know how to locate your images, add them to a show and perform some basic timing adjustments. Go ahead and add some more images to your new show. Once you have a good number images, let’s take a look at how the slideshow actually plays.

Playing a Preview

The Preview window is featured in each of the Workspaces and is where you’ll most often go to see how your show looks.

Go ahead and press the Play icon just below the window. You’ll notice that the slide list displays slides, in order, from left to right. The first slide in your show is number 1, on the far left. The last slide in your show will be on the far right. Playing a show is just a process of going through those slides in order, from start to finish.

Build Workspace Tip:
- The Preview window is also perfect for browsing images in your File List before you add them to your Slide List.
As your show plays, you should see a playback indicator begin to move along the bar just above your **Slide List**.

This indicator shows you what part of your show you are currently looking at. As you preview your show, the indicator moves along the **Slide List** and shows you which slide in your show is currently being displayed in the **Preview**.

Let's click on the **Stop** button to stop the **Preview** playback. Now click on any slide in your show. Notice that the playback indicator appears at the beginning of the slide you’ve chosen. The indicator is telling you that the **Preview** window is currently showing you what is seen at the very beginning of that selected slide.

You can also click and drag this indicator to see any part of your show in the **Preview**. This is a great way to examine parts of your show in slow motion, and to make sure your shows look the way you want them to. Simply drag the playback indicator slowly through a slide to see how your images will appear in your show.

You should use the **Preview** playback frequently as it will give you the chance to see how each show looks in real-time as you build it and make changes.
Working Counter-Clockwise

You may have noticed that creating a slideshow is a counter-clockwise process as you move through the Build Workspace. You start in the upper left corner with your Folder List, locate the images you want to use in the File List, drag and drop files down on to the Slide List, then up to check your show in the Preview, and back to the left to add more images.

This is a constant cycle that you will use to build your shows, a few images at a time, until you have all of your desired content ready and loaded into ProShow. If you remember this counter-clockwise working pattern, it will help you begin to become comfortable with the Build Workspace, as well as working within other Workspaces and windows that you'll come across in the program.
2. Getting Started

Pick a Transition Effect

Every slide comes complete with a **Transition**. It doesn’t matter whether it’s the first slide in your show or the last – they all have a **Transition** that appears at the end of the slide.

As you’ve already seen, the **Transition Time** is the amount of time it takes for your one slide to change to the next. The **Transition Effect** on the other hand, is the visual change that takes place as you go from one slide to the next. Adjusting both the **Transition** time and effect can make for some amazing results, so let’s see how easy it is to select those effects.

How to Pick a Transition Effect

1. Click on the **Transition Icon** on the right side of the **Slide Thumbnail**, which is in the **Slide List**.
2. From the **Choose Transition** window, browse through the categories and select a **Transition**.
3. Double-click to apply the Transition, or press the **Apply** button.

There are over 500 built-in **Transition Effects** to choose from. If you single-click on any effect, at the top of the **Choose Transition** window, you will see a preview of what each **Transition Effect** will look like when applied to your slide. If you like what you see, simply press the **Apply** button at the bottom or double-click on the desired effect.

**Note:** you can change the **Transition Effect** for multiple slides at once by selecting all of the slides you wish to change and clicking on the **Transition Icon**. Once you choose the new **Transition Effect**, all selected slides will change to have the same effect. You can select multiple slides by holding **CTRL** on the keyboard and clicking on each one you want to select, or a range of them by clicking on the first slide you want to select and holding **Shift** as you click on the last slide. All slides between the two will be selected. You can also select every slide in your show by clicking on a slide in the **Slide List** and pressing **CTRL + A** on your keyboard.
Adding Effects to Your Images

Even if you are brand new to creating slideshows, chances are you are familiar with the "Ken Burns effect". This refers to the visual effect made popular by documentary filmmaker, Ken Burns that features still images panning and zooming as they appear on the screen.

Earlier in this chapter you learned how to create your own "Ken Burns style" slideshow by using a keyboard shortcut to randomize the Pan, Zoom and Rotation of each of your selected images. If you forgot the shortcut, don't worry, you can also right-click on any selected slide in your Slide List and choose the same randomize options from the sub-menu.

Random motion effects are fine and can make for a very nice show, but what makes ProShow really fun is when you start using Slide Styles. First of all, Slide Styles are effects that you can apply to any slide in your show. Secondly, they are not random. Slide Styles are effects that always look and behave the same way each time you use them. They can be very simple (such as a pan from left to right), or extremely complex (using multiple layers, color filters, advanced motion, etc)

Slide Styles are covered in much more detail in Chapter 13, but for now, let's see just how easy it is to apply these effects to your slides.
2. Getting Started

How to Pick an Effect

1. In the Build Workspace, take a look at the Toolbar just above the Folder List. Click on the Effects (FX) icon. This will open the Effects (FX) window.

2. With the Slide Styles tab at the top selected, browse the categories and choose your desired effect.

3. Press the Apply to Slide button. You'll see a message letting you know that any other effects that exist for the selected slide will be replaced by the Slide Style you have chosen. Press OK to apply the new Slide Style.

4. Once you are finished applying your effects, press the Done button.

Much like you saw earlier when choosing a Transition, the Effects (FX) window allows to browse effects by category and will show you a thumbnail preview of what the effect will look like when once applied to your slide.

As you click on each effect, more information about the effect will appear on the right side of the window, including: the name of the style, the number of layers you'll need for the effect, the preferred image orientation and the optimal slide and transition times.

Effects (FX) Tip:

- If you have more than one slide selected in your Slide List, the same effect will be applied to each selected slide.
Customizing Slides

Now that you’re adding images, changing timing and beginning to add effects, let’s take a very quick look at customizing the slides in your show.

Customization is where the real power of ProShow comes into play. You can adjust almost every aspect of the images and video clips that appear in your slides - including how they look in your show and how they move around the screen.

Opening the Slide Options

You’re going to do all of your customization in the Slide Options window. There are several ways to open the various slide options, but let’s use the fastest method available:

Double-click on the any slide in your show.

This will open the Slide Options. From this window, you can control how a slide appears in your show, including applying effects, adding captions, adding slide sounds, changing backgrounds and controlling motion.

All of the Slide Options will be covered in detail in later chapters, but for now, just note that the easiest way to access this window is by double-clicking, and this is where you'll go to customize each slide.
Share Information with Text

Using text isn't mandatory in a show, but it is a great way to add a little extra information and expand your storytelling.

To add text in ProShow, you'll use Captions By creating and working with captions you'll be able to do things like make title slides, add interesting information or comments during your show or create movie-style credits at the end of a slideshow.

Captions are covered in more detail in Chapter 10, but for now, let's wrap up the simple show you have been building as we go.

To get a sense of how captions work, let's add a title slide to the beginning of your show. The goal of a title slide is act as an introduction. Something that gives the audience a little information about the show they are about to watch. Typically this will be something like "The Smith Wedding" or "Eric's Birthday".

Making a Title Slide

1. Double-click on the very first slide in your show. This will open the Slide Options window.

2. Locate the Captions pane on the left and press the Add (+) icon. You will now see the words "Blank Caption" appear.

   This doesn't mean the words "Blank Caption" will be in your show.

   This is simply a placeholder in the Captions List showing you that you need to type something.
3. To the right of the **Preview** you'll find the **Selected Caption Text** pane. This is where you will type the text that you want to have in your title slide.

   Go ahead and type the words "My First ProShow".

4. Just below that text area, you'll see the **Caption Format** pane. Use these options to select the font, size, case and color of your caption.

5. Below the **Preview** you'll find the **Caption Placement** pane. This is where you'll justify your text (left, center, etc) and adjust the position of your text.

As you can see, using **Captions** in ProShow is similar adding text to any word processing program. You begin with a blank field, you type in your text, and then you choose the font, size, and position of your caption.

**Creating Captions Tip:**

- You can adjust the position of your caption simply by clicking and dragging the caption within the **Preview**.

- **Caption** size can be changed by using the scroll wheel on your mouse. Simply click on the caption in the **Preview** and scroll up or down until your caption reaches your desired size.

If you're following along in ProShow and want to make sure your title slide looks similar to the sample images; from the **Font** dropdown list, select Georgia. It's a font that comes standard in Windows and makes a great title.

Once you have the font chosen, click on the size dropdown list and change the font size to something big enough for a title, try 24 or more. If your preferred size isn't listed, you can also type in a number to get the perfect size for your show.
Now that you have the caption created and adjusted, go ahead and use the mouse to drag the caption in the preview window until you have it roughly centered at the top of the slide frame. You don’t need to be overly specific here – just eyeball it.

Adding Effects to Captions

The title caption you've created will certainly look good and work just fine as it is. However, you can make it look even better by adding some effects.

In ProShow, each caption has three **Caption Behaviors**. These behaviors control what your captions do when the slide starts and ends, as well as what happens to the caption while the slide is playing. You can think of **Caption Behaviors** as animated effects that you add to your text.

Let's start by selecting the **Effects** tab just above the **Preview** in **Slide Options**. On the right, beneath the **Preview**, you'll find the **Caption Behaviors** options.

Click on the **Fly In** dropdown list to choose how your caption first appears in your slide. You'll see that there are plenty of options, and we'll cover them all later, but for now, just choose **Fade In** from the list.

Once you’ve picked an effect for the start of the slide, click on the **Fly Out** dropdown list. In this list, find the **Fade Out** option. Click on that to select it.
With these effects chosen, your caption will now fade into view at the beginning of the slide and fade out of view at the end. Without those effects in place, the caption would pop into view and abruptly disappear. These kinds of effects can give your captions a more natural and professional feel.

To see how your slide will look with the newly added text effects, click the Play icon located at the bottom of the Slide Options window. If you’re happy with the results, press the OK button to close Slide Options.

Round Out a Show with Audio

A good show isn’t quite complete until you’ve added some music. Ideally, you’ll want to choose a song that compliments the visuals. For example, a good high energy song works well with a fast-paced show. You can also try using songs that are clearly themed like Holiday music, or songs that feature lyrics that match the photos in your show. For now, pick any song you want so you can see how the process works and get this simple show all wrapped up.
ProShow supports almost all major digital audio formats, like MP3, WMA, M4A, OGG, and more. As long as your song doesn’t have DRM software on it, it’s probably going to work.

**Adding Music to Your Show**

Adding audio to your show works almost the same way as adding images. Simply use the **Folder List** in the upper left corner of the **Build Workspace** and locate a folder where you store music.

Once you have opened a folder that contains music, you will see those icons appear in the **File List**. Pick the song you want to use in your show.

Once you’ve highlighted that music, drag and drop it into the **Soundtrack Bar** at the bottom of the workspace. The **Soundtrack Bar** is located just beneath the **Slide List**, and is labeled “**Soundtrack**”.

ProShow will begin importing the audio once you drag and drop it into place. This can take a few seconds or longer based on the length of the audio file.

---

1 Digital Rights Management software is found on songs purchased from iTunes and other online music vendors. ProShow cannot use audio files that have DRM security installed in them.
Once it’s done, you’ll see a green waveform underneath your slides.

Try playing your show right now and you’ll hear music playing. Getting audio into your shows is that simple.

**Synchronizing Your Music**

In almost all cases, your slideshow and music are going to be two different lengths. In order to make your show and song end at the same time, we’ll have to make some adjustments.

Using what you’ve already learned so far, you could change the times for each slide and transition. That would work, but it’s not very efficient and can be time consuming. Instead, let ProShow do the work for you by performing a **Quick Sync**.

At the very top of the workspace, click on the **Audio** entry in the **Menu Bar**. In the menu that appears, choose the option that says **Quick Sync – Entire Show**.
ProShow will now adjust the times of your slides so that your music and your slides end at the same time.

Use the scrollbar beneath the **Slide List** to scroll all the way to the end of the show. You will see the green waveform and the slides end at the same time.

**Quick Sync Tip:**

- Don't want to navigate? Use the keyboard shortcut CTRL + Q to do your next **Quick Sync**.

**Using Undo and Redo**

While making your show, you’ll probably make a few mistakes along the way. Thankfully ProShow has tools which are designed to help you get back on track quickly.

The **Undo** option can be used at any time in ProShow by pressing CTRL + Z on the keyboard. You can also select **Edit > Undo** from the **Menu Bar**. This option will reverse the last thing you did.

**Undo** can be used multiple times in a row to undo a series of steps you may have changed. Just press CTRL + Z as many times as you want to undo changes.

The **Redo** option, done by pressing CTRL + Y, will undo your **Undo** operation. If you accidentally undo something you didn't mean to, use **Redo** to bring it back.
Save Your Show

You've covered all of the basics of making a slideshow, now don't forget to save your work!

To save a show, click on the Save icon in the Toolbar and choose a location on your hard drive to save the show file. You can also use CTRL + S, or the File > Save options from the Menu Bar.

Try to remember where you save your shows for future access. We recommend you pick a consistent location for your shows, like “C:\My Documents\My ProShows”.

Publish and Share Your Show

If you have been following along, you should now have a complete show that features all of the elements of a fully produced slideshow: images, effects, captions, and music. The next step...publish your show into a format that you can share with others. You can’t invite everyone to come and sit around your PC, after all.

Publish Options

Publishing is the process that takes the shows you create in ProShow and outputs them into a sharable format such as DVD or as a YouTube video, etc.

To wrap up this introductory chapter, let’s create a DVD of the show you just created. Just about everyone has a DVD player so it makes an ideal choice for a show that almost anyone can watch.
Creating a DVD

Once the show is saved, the next step is to change over to the Publish Workspace. This is where you'll find all of your output formats as well as more tools that come in handy when publishing shows.

In the Toolbar at the top of the Workspace, click on the DVD icon. This will open the Create DVD window.

The Create DVD window offers quite a few options that we'll cover in more detail later on in the book. For now, let’s just cover the basics to get your new show on a disc.
Under the **Menus** tab, you have a range of choices available that you'll use to customize the menu that appears when you put the disc in the drive. First, pick a background for your menu. There are several built-in options that appear in the **Menu Themes** list on the right side of the window. Choose any background that you like. Next, down toward the bottom left you'll find the **Menu Settings** pane. Locate the **Title** field and give your disc a name. “My First DVD” is always a good choice.

Now grab a blank DVD and insert that disc into your DVD burner. Once it's done reading the blank disc, click on the **Create** button in the lower right corner of the options window.

**Rendering and Viewing**

Congratulations, you've covered all of the basics! Once you press **Create**, ProShow takes care of the rest. First ProShow will go through a rendering process. This involves converting your show into a video file that will appear on your DVD.

Once the rendering is finished, ProShow will then burn the disc and let you know when it’s complete. Once the disc is done, pop it into your DVD player and enjoy your first show!

In the next chapter, you're going to learn about the three Workspaces and in more detail. As you move beyond that, you will find in-depth information and tips about all aspects of the program.

For now, go ahead and close your show by using the keyboard shortcut **CTRL + W**, or by using the **File** option in the **Menu Bar** and selecting **Close**.
2. Getting Started
3. The Three Workspaces

Every Tool at Your Fingertips

ProShow is designed to give you quick access to every option that can be used in the program. Whether you use the options found in the **Menu Bar**, the icons in the **Toolbar**, or keyboard shortcuts, everything you need is just a few clicks away.

Before introducing the Workspaces, consider the three things you need to do in order to create a slideshow:

- First, you have to build a show by adding images, videos and music into ProShow.
- Next, you design your show by choosing effects, customizing slides and fine-tuning your music.
- Finally, you publish your show in whatever format is best for your audience.

To make the whole process as simple as possible, ProShow's three different Workspaces are each optimized to give you access to the tools you need during the three phases of show creation.

These Workspaces are named **Build**, **Design**, and **Publish**.

- The **Build Workspace** is where you'll begin making a show. This is where you'll have access to the **Folder List** and **File List**, allowing you to locate and add content to your show.
- Once you have all of your content added, the **Design Workspace** gives you more room to preview your show and view additional details as you customize each slide.
- Once you're ready to share your show, use the **Publish Workspace** to choose from your output options.
3. The Three Workspaces

The **Workspace Selector** is located in the top right-hand corner and will always highlight the currently selected Workspace.

---

**Common Workspace Elements**

The three Workspaces share several common elements that will always be there for you, regardless of the Workspace you have chosen.

**The Menu Bar**

In the upper-left corner of the workspace, you will find the **Menu Bar**. The **Menu Bar** is a standard feature found in almost all Windows applications. Here you can access almost every feature within ProShow using the categories shown. We’ll discuss what all these features do later in this manual, but for now, let’s take a look at the types of things you’ll find in the main menu. Each category contains a certain set of options:

- **File** contains all of the options related to your show files and their management. Here is where you will find options to create new shows, save shows, create and save Projects, import content from Social Media Services, the ProShow Remote App or import shows from ProShow Web.

- **Edit** contains options for changing aspects of your show. You will find tools like copy & paste, undo & redo, combining slides, copy settings as well as the Preferences for ProShow.
**Show** gives you quick access to the tools which impact your whole show. From here you can open the **Show Options** window and set a show title, show background, manage your soundtrack and quickly add content to placeholders used by templates and Slide Styles. You’ll also find Play/Pause/Stop and Full Screen options for playing shows in the **Preview** window.

**Slide** is much like the show menu, as it gives you quick access to your **Slide Options** window. Additionally you can add/remove slides, flag slides, navigate between slides and apply effects to slides from here.

**Audio** contains all of your sound tools. Here you can open your soundtrack options for your show, add new music to your show from CD, match beats to slide timing with the **Record Slide Timing** feature, and perform a **Quick Sync** of your show and music.

**Tools** is where you’ll go to manage your effects, manage Media Sources, manage your Show Templates, access the ProShow Remote options, create new effects, revert to backups, collect show files or find any files that may be missing when you open a show.

**Publish** features all of the output options available once you are ready to publish and share your shows. From here you can go directly to the options to Upload to YouTube or Facebook, Create a DVD or Blu-ray, or export a show to a device using the ProShow Remote app.

**Window** is where all of your options to view/hide menus, toolbars, and window arrangements are found. This is also where you can save and restore window layouts.

**Help** is where you can open the built-in help guide, enter your registration information, contact support and check for upgrades.

As you can see, there’s quite a bit to be found in the **Menu Bar**. In fact, we have summed up quite a few of the features of ProShow in just that overview. Just remember that while there’s a lot of information there, you only need to use the menu bar as it helps you.
The Toolbar

Beneath the menu bar is a bar that contains a series of icons. This is your **Toolbar**. The **Toolbar** is designed to give you quick access to the features that you’re likely to use over and over again.

While the **Toolbar** does appear in each Workspace, most of the options that appear in the **Toolbar** are different for each Workspace. The **Toolbar** changes as you select a new Workspace and is optimized to give you access to the tools you’ll most likely need for that specific part of the show creation process.

A little later in this chapter we’ll cover all of the **Toolbar** options for each Workspace.

The Workspace Selector

In the top right corner you’ll find the **Workspace Selector**. Simply click the text to change to a different Workspace. The current Workspace will always be highlighted.

You can also switch between Workspaces using the keyboard. With the CTRL key held down, press the TAB key to cycle through the Workspaces.
The Information Bar

Just beneath the toolbar is a small, but important, section called the **Information Bar**. Here you can see the name of the show you’re working on, as well as how many slides are currently in the show, and how many audio tracks are in the show. You'll also see the length of those elements to get a quick, at-a-glance summary of exactly what makes up your show.

When you are working with multiple shows in a project, this area will contain tabs which allow you to switch between shows with ease.

By default, you'll notice that the title in the **Information Bar** for a new show is always "ProShow Slideshow". You can change that quickly by double-clicking on the title and making changes to your **Show Settings**.

The Slide List

The **Slide List** is the bar at the bottom of each Workspace where your slide thumbnails are displayed. From here you can change the order of slides, adjust timing or even change your transition effects.

The **Slide List** is numbered from left to right, just like you would read. When you create new slides, they appear at number 1, on the far left, and increase in number as you add more slides. Playing the show starts at the beginning of the **Slide List** and plays your slides in order from left to right. Creating a show is just a process of sequentially creating the slides you want to see in the **Slide List**. For now, don’t worry about actually creating slides. We’ll cover that in another chapter.
3. The Three Workspaces

The Soundtrack Bar

The **Soundtrack Bar** appears just beneath the slide list, and is labeled “**Soundtrack**”. This is where you can drag and drop audio files to add them into your show soundtrack. It’s also where those audio files will appear to indicate that you have music in your show’s soundtrack. Double-click any track in the **Soundtrack Bar** to adjust its options.

Music that appears in the soundtrack list is shown as a waveform. It’s a histogram of the audio, making it easy to see where the music ebbs and swells as it plays during your show. To get a better look at the waveform, press the Tab key or click on the **Slide List** and **Timeline** tabs that appear at the top of the **Slide List**.

As you add multiple tracks, the waveforms will alternate in color: green, blue, green, blue etc. If any of your slides feature a slide sound (such as a voice-over or sound effect), those sounds alternate in color as red, yellow, red, yellow, etc.
The Preview Window

The Preview is where you can see enlarged versions of your images and slides as you select them in the Build Workspace. Additionally, this is where your show is displayed when you play back and watch your show as you build it. During playback, what you see in the workspace Preview is what your audience will see once you publish and share your show.

Just beneath the main display area of the Preview window, you will see playback controls for your show. The Play button starts playing the preview of your show. During playback this will change to a Pause button, allowing you to temporarily stop the playback. Stop will end the preview playback. The Advance Left and Right arrow buttons allow you to go the next or previous slide while previewing your show, or jump to the beginning or end of your show.

The final icon you'll see is the Full Screen Playback icon. Notice that the arrows will point outward if Full Screen Playback is not selected (outward, meaning you can make it bigger). When the arrows point inward, that indicates that Full Screen Playback is active (inward, meaning you can make the preview smaller).

Full Screen Playback of a Show

1. Make sure you have at least one slide in your show.
2. Click the Full Screen Playback icon beneath the Preview window or...
   1. Right-click on the Preview window.
   2. Click on Full Screen Playback to toggle it on.
To exit **Full Screen Playback**, just press **ESC** on your keyboard. If you want to turn off full screen playback, simply repeat the steps above.

Next to the playback control buttons, you’ll also see two numbers. The number to the left of the "/" is the spot in your show that is currently visible in the **Preview**. It’s accurate down to 1/100th of a second. To the right of the "/" is the total length of your show.

On the bottom right-hand side of the **Preview** you’ll see even more information about your slides as they become visible in the **Preview** including:

- Number of the slide currently visible in the **Preview**
- Total number of slides in your show
- Slide Style used by slide currently in the **Preview** (when applied)
- Number of layers in the slide currently visible in the **Preview**
- Number of slides selected in the **Slide List**
- Total length of the selected slide(s).
- Transition effect for the slide currently visible in the **Preview**

![Slide Preview](image)

Above the controls, you'll also see a slider bar. In addition to being a visual representation of where you are in your show, it can also be used to control playback. Simply click and drag the slider to scrub backwards and forwards through your show.
The Build Workspace

The *Build Workspace*, is where you'll begin each new show. Within the *Build Workspace*, you'll find all of the tools you'll need to add content to your show.

The Folder List

The *Folder List* is found beneath the information bar on the upper left side of the *Build Workspace*. This is part of two sections that are used to locate your images, audio, and video files to use in your show.

The *Folder List* works just like Explorer in Windows. That is, you can see all of the folders on your hard drive and other connected storage. You double-click on those folders to open and browse through them. Once you have found a folder that contains media you want to use, click on it in the *Folder List*. From there, those files that ProShow can use will appear just beneath it, in the *File List*.

You can right-click in the *Folder List* to add and remove folders, fine-tune the way the *Folder List* looks, add commonly used folders to your *Favorites*, or Open an Explorer window.
There are also some special entries in the **Folder List**. One is **Media Sources**. This entry is for any content that comes with ProShow, or that you may have purchased or downloaded from Photodex, you will find those listed there.

By right-clicking on the **Media Source** folder, you can open the **Manage Media Sources** window. From here you can see which titles you have, where they are located on your machine and add or remove your **Media Source** titles.

Another special entry you may see **Imported Content** or **ProShow Imported Content**. These entries will appear when you import content from **Social Media Services**, like Facebook or Instagram.

**Note:** These folders are actually the same! Any changes made to one, will affect the other. To learn more about importing content from **Social Media Services**, see Chapter 8.

**The File List**

Once you’ve located a folder that contains the images or video clips you want to use in your show, you’ll see those files appear in the **File List**. This is located just beneath the **Folders List**

By default, the **File List** shows your images as thumbnails. These smaller versions of your images are used to help you identify your content more quickly, and without having to memorize file names. You will also see
digital audio files like MP3 and WAV files using their standard icons. Video files will also appear as icons.

ProShow will only display file types that it recognizes in the File List. For example, if you have some unrecognized file types in the same folder with your images, those files will not appear in the File List, so you can’t accidentally try to add them to your show. Don’t let this concern you, though, ProShow supports almost any media file you can throw at it.

You can also control how your files are shown and organized in the file list. This is done by right-clicking anywhere inside the File List.

Once you do this, you will see a sub-menu with a series of options. At the bottom of the sub-menu, you will the following options:

**Sort** will let you change the order of the files that appear in your file list. This is set to Name (numeric) by default, which means that numbered files show in order, followed by named files in alphabetical order. You can change to almost any sorting order, including sorting by the date the file was created. This can help keep your images in chronological order.

**View** allows you to check whether you want to see small versions of your images, or thumbnails, or a list of file names and other information, without thumbnails. Select the one that is most useful to you.

Also found under the View option is the ability to change the Thumbnail Size for images that appear in the File List.

Choose the size value that captures the best blend of size and space for your file list. ProShow saves these sorting and other File List preferences for you automatically, so next time you open the program they will remain this way.
3. The Three Workspaces

In the Preferences, you'll find even more options for customizing how your thumbnails appear. These options include custom thumbnail sizes as well as options for what information appears below each file. That includes things like filename, date, size, and more. For more information on changing your preferences, see Chapter 27.

There are also several other options available by right-clicking in the File List including, Adding Files to a Show and Adding Files to Placeholders (used with Slide Styles and show Templates).

Selecting File also gives you the options to view more details about each file, delete a file from the folder, open an Explorer window, or edit your files in an external editing program.

Using the File List to Identify Files Added to a Show

Any and all images, audio, or video that you’re using in your show will appear with a green check mark and a number on the lower right corner of the image. This is a great way to tell, at-a-glance, whether you’ve added that file to your show or not.

If you use any content more than once, the number of times that image, video clip or audio track appears in the show will be shown next to the green check mark.
Build Workspace Tip:

- If you need more room to see folders, or files, you can adjust the size of the Folder List and File List. Simply hover your mouse in between the two panes to activate the size arrows. Click and drag up or down, or left and right to achieve the desired size.

- When in doubt, Right-Click! You can right-click on just about everything in ProShow, and in almost all cases, this will help you find what you are looking for in any pane. Plus, you'll often find additional options.

The Task Monitor

The Task Monitor is a simple, but still very useful, part of the Build Workspace. The Task Monitor appears just beneath the file list and above the Slide List and acts and an indicator when ProShow is loading something.

Refer to the Task Monitor to see how far along your show loading is going, how long a video clip is going to take to import, etc.

It’s also used as a progress indicator for downloads or uploads within ProShow.

The Build Workspace Toolbar

As mentioned previously, each Workspace has slightly different options in the Toolbar. Options that are best suited for what you'll be doing within the selected Workspace. In the Build Workspace, these options are focused on adding content, quickly adding effects and performing some simple soundtrack adjustments.

Let’s take a look at each of the buttons:
3. The Three Workspaces

- **New** opens the **New Slide Show** window. From here you can choose to use the **Wizard**, start a new, blank show, create a show from a template or open a previously saved show.

- **Open** allows you to browse your system for a saved show file, to open a show you were working on previously.

- **Save** will save a show you’re currently working on, or have just created. If you click this with a brand new show, it will ask you where you want to save that file, and what you want to call it. Clicking it with a show that has already been saved will update that existing save file.

- **Wizard** opens the ProShow **Wizard**. Use the **Wizard** to create a complete show, or use it as a starting point for show creation. If you click this icon with a show open, ProShow will close the open show and start a new show using the **Wizard**.

- **Add Blank** will add a **Blank Slide** to the show you are currently working on.

- **Add Title** will add a **Title Slide** to the show you are currently working on. This is very similar to adding a **Blank Slide**. However, in addition to inserting a new slide in your show, the **Slide Options** window will open and you’ll be ready to begin typing your text right away.

- **Import** will take you to the **Import from Service or App** window. From here you can connect to your online social media accounts and download files directly into your shows.

- **Remix** is a great tool that will use the **Wizard** to create, or redo effects on any slides you have selected in your show. You can remix one slide or a range of slides.

- **Edit Slide** opens the **Slide Options** window, which is where you go to create and customize the effects for each slide.

- **Effects (FX)** opens the **Effects (FX)** window. From here you can apply slide styles and/or transitions to any slides you have selected in the **Slide List**. If you have a range of slides selected, whatever effect you choose will be applied to all of the selected slides.
• **Show Opt** will open the **Show Options** window, which is where you configure settings that impact your whole show at once. This includes your show title, aspect ratio, background, watermark and more.

• **Music** opens the **Show Options** window and takes you directly to the **Soundtrack** area. From here you can add or remove songs, change the order in which they appear in your show, or edit your soundtrack settings.

• **Sync Music** opens the **Synchronize Show to Soundtrack** window. From here you can adjust exactly how you'd like your show and soundtrack to line up with each other.

---

**The Design Workspace**

Once you have all of your content loaded into your show, head on over to the **Design Workspace**. Here you'll notice right away that the **Folder List** and **File List** do not appear. This is to give you more room to preview your show as you customize and add effects. Naturally, if you need more content, you can always toggle back and forth between the Workspaces by using the **Workspace Selector**.

---

**The Design Workspace Toolbar**

The **Design Workspace Toolbar** is nearly identical to the **Build Workspace Toolbar**, with the exception of two additional options:

- **Reset** will reset any and all effects applied to the currently selected slide(s). This is a very handy tool for those times when you simply want to erase all effects and start over from scratch.

- **Combine** will take a range of selected slides and combine them all into one. This can be a very useful tool when you plan to use effects that feature multiple layers.
3. The Three Workspaces

The Slide Inspector

The **Slide Inspector** provides detailed information about each slide as you design your show.

Beginning with the slide name and the position of the slide in the show.

Next you'll see the **Slide Summary**. Here you'll find details that include:

- The name of any **Slide Style** applied to the slide
- The **Style Timing** recommended for the optimal use of the effect
- The **Duration** of the slide (including the transition times both in and out of the slide)
- The **Timing** of the slide relative to its position in the show
- The type and length of the **Transition In**
- The type and length of the **Transition Out**
- **Special Notes** for the slide. Typically you'll see this if there is a slide sound or custom background

Below the summary, you'll find the **Layers and Captions** information for the slide. This tells you how many layers and captions can be found in each slide.

At the bottom of the **Slide Inspector** you'll see any **Notes** that have been added to the slide. If no **Notes** have been added, the **Notes** pane will not be visible.
The Publish Workspace

With your show complete, it's time to Publish your work and share it friends, family, customers, pets or random strangers on YouTube and Facebook.

The Publish Workspace Toolbar

The Publish Workspace Toolbar features the same New, Open and Save options found in other Toolbars, but the rest of the options are all optimized for this Workspace and are there to help you finalize and output your shows quickly.

Let's take a look at the options:

- **Menu** takes you to the Menu Theme And Layout options. From here you can customize the look and feel for your DVD and Blu-ray disc menus.

- **Watermark** takes you directly to the Watermark area in Show Options. From here you select and adjust any image that you wish to appear across every slide in your show. A very nice finishing touch if you are selling slideshows.

- **Collect** opens the Collect Show Files window. Perfect for creating archived back-ups of your shows.

- **Capture** allows you to take snapshots of whatever is in the Preview and save the results as either a JPG or PNG image file.

- **All Formats** opens the Publish Your Show window. From here, choose the output that works best for you and your audience.

- **DVD** takes you directly to the Create a DVD menu.
3. The Three Workspaces

- **Blu-ray** takes you directly to the **Create a Blu-ray** menu.

- **Executable** opens up the options window for **Create an Executable**.

- **Video** opens the **Video for Web, Devices and Computers** window. From here, simply select the format that best matches how you plan to share the slideshow.

- The **YouTube** and **Facebook** icons will create a video clip of your show and upload it directly to your online account. Simply add a little information about the slideshow and press **Upload**.

---

**The Size Meter**

Just above the **Slide List**, is the **Size Meter**. You can think of this bar as being a guide for the actual file size of your show. Notice that it shows an output format on the left side of it, with a series of guidelines and number markings. This is showing you the total allowed size for a particular format.

The **Size Meter** updates as you work on your show, letting you know if your show will fit in a particular format. For example, the DVD indicator lists values from 0 to 4.1 gigabytes, which is the max that you can fit on a DVD. If your show gets bigger than that, it won’t fit on the disc.

To change the format type shown by the **Size Meter**, just click on it. You can cycle through the various options to find the one that is relevant for you.
Publishing Formats

To the right of the Preview you’ll find the Publishing Formats pane. This is an even faster way to select the output option that’s best for you. Simply scroll down the list to select your preferred method and press Create when you’re ready to publish your show.

Publish Workspace Tip:

- As you select different publishing formats, the Size Meter will automatically change to match your selection.

The Project Pane

If you plan to add multiple shows to a DVD, Blu-ray, Executable or Flash show, you’ll use the Project Pane to help manage the shows within your project. From here you can add or remove shows, change the order of the shows and see the total combined length of all of the shows in your project.
Optional Workspace Elements

In addition to the areas of the three Workspaces that you’ve just seen, there are two additional areas that you can optionally display. These areas are not visible by default, but can be turned on by selecting **Window > Show** from the **Menu Bar**.

The Lightbox

The **Lightbox** is a different way of looking at your slides. Unlike the **Slide List**, which shows all your slides in one long horizontal list, the **Lightbox** shows your slides in multiple rows, allowing you to see more at a time.

The **Lightbox** provides all the same functionality as the standard **Slide List**. You can have both open at the same time, and can switch back and forth anytime.

*Note:* The **Lightbox** can be especially useful if you have multiple monitors. To make the best use of your screens, try tearing out the **Lightbox** (see **Tearing Out Workspace Panes**, below) and placing it on your second monitor.
Favorites

The Favorites list is a list of bookmarks for frequently used folders.

If you always access the same folders to get content for your show, try enabling Favorites. You can right-click on any folder in the Folder List to add it to your favorites.

Within Favorites, you can right-click to add folders, which allow you to categorize your favorites by dragging them into folders.

By default, the Favorites list will automatically populate with folders that you’ve frequently used. This is an option you can turn on or off from the Preferences. See Chapter 27 for information on changing preferences.

Customizing the Workspaces

Now that you have a sense of what each pane in the main workspace does, feel free to customize and adjust the panes to suit your own personal preferences.

Most of the sections in a Workspace can be “torn out”. This means that they can be taken out of their normal spot, placed elsewhere, and used as individual windows. This gives you the chance to completely re-arrange the windows layout and come up within a workspace that makes the most sense to you.
Tearing Out Workspace Panes

Tearing out a pane in the main workspace is as simple as click and drag.

Try it with the slide list. If you look on the upper left edge of the Slide List, you will see a border there that says “Slide List” on it. Click on this and drag. You will see an outline of the Slide List appear as you move your mouse around.

Move your mouse far enough and release the button, and your Slide List will appear in an independent window. The Slide List has now been torn out of the Workspace and you can place this wherever you want, even on another monitor if you have more than one hooked up.
Using Workspace Layouts

The ability to reposition and hide/show the assorted panes in the Workspaces means that you can customize the window layout to best fit your needs. But what happens if your needs change based on the type of show you are making? Don’t worry, ProShow has a solution for this.

You can save your custom Workspace at any time, and load that layout whenever you need it.

Saving a Custom Workspace

Once you have arranged your Workspace in a way that you like, you can save that Window Layout for future use:

1. Click on Window in the Menu Bar.
2. Choose Save Window Layout from the menu that appears.
3. Enter a name for your layout and click on Save.

Your layout has now been saved.

The next time you open ProShow that custom Workspace and Window Layout will appear.

If you tinker with your layout one day and want to restore your Workspace to your custom layout, simply choose Load Window Layout from the same menu.
3. The Three Workspaces

**Loading a Custom Workspace**

You can load any saved *Window Layout* at any time.

1. Click on **Window** in the **Menu Bar**.
2. Click on **Load Window Layout**
3. Select the layout you’d like to use.
4. Click **Apply** to apply the custom Workspace.

Normally you will not need to access these files directly, but in the event you need to, window layouts are saved in your computer’s common application data folder. This folder is the standard location for saving program settings that are shared between users. Saved layouts are stored as .DPR files in the Window Layouts folder.

**Restoring the Workspace to Defaults**

If you experiment with different Workspace layouts and decide that you prefer the standard look, you can always restore your window layout to the defaults settings:

1. Click on **Window** in the **Menu Bar**.
2. Click on **Default Window Layout**.

Your workspace will now be reverted back to the standard ProShow window layout.
4. Show Options

The Foundation of a Show

You can think of ProShow as working on three levels. You have ProShow which encases all of the options and tools you use to create shows. Within ProShow you have the show you are working on. **Show Options** are used to control all of the broad settings and features about a show you are creating. Within your show are slides, and **Slide Options** are used to control individual slides as part of your show.

The relationship looks like this:

![Diagram showing the relationship between ProShow, Show, and Slides]

This means that the **Show Options** are responsible for controlling and adjusting settings that apply to your whole show at once rather than individual slides.

These tools give you a variety of broad settings to adjust. For example, you can change the aspect ratio of your show all at once by adjusting that setting in the **Show Options**. The basic rule of thumb is that any setting which applies to your whole show will be found in the **Show Options** window.
Locating the Show Options

You can open the **Show Options** window in a variety of different ways.

**To Open the Show Options**

Choose from any of the following methods

- In the **Build** or **Design Workspace**, Click on the **Show Opt** icon in the **Toolbar**.

- Double-click on the **Information Bar**. This is a shortcut designed to open the **Show Options** window with the **Title** text selected in the **Show Setup** pane.

- Use the Keyboard Shortcut and press CTRL + H.

- In the **Menu Bar**, under the **Show** entry, select **Show Settings**, **Show Background**, **Watermark**, **Soundtrack**, **Set Show Thumbnail** or **Set Show Title**.

Any of the above will get you into the **Show Options** window.
What You Can Do with Show Options

There are four basic show elements that you can configure from the Show Options window.

- **Show Settings** - Name a show, select the thumbnail image for a show, choose the aspect ratio, adjust the TV Safe Zone, and add any general notes for the show.

- **Watermark** - From this tab you can select, position and adjust the watermark for your show. Once configured, this watermark will appear on every slide in your show.

- **Background** - By default, the show background is black. Using this tab, you can select another color or choose an image or gradient to appear as the background for each slide in your show.

- **Soundtrack** - From here you can Add (+) or Remove (-) songs, change the order of songs, and control the volume and fades of the songs that appear in your show's soundtrack.

Show Settings

When you build a new show from scratch, it's typically a good idea to open the Show Options and take a look at the Show Settings before you dive in to show creation.

Let's take a look at the key ingredients you should visit before building your show.

The Show Title and Notes

You read earlier in the manual that when creating a new blank show, ProShow will prompt you for a show title and aspect ratio. Unfortunately, most people tend to skip this part, click Ok and move on to making the show.
4. Show Options

Try not to overlook this. Setting the **Title** and adding **Notes** are great ways to keep your shows organized. Especially if you choose a useful name that helps identify what the show is all about. "Timmy's 5th Birthday" for example.

**Notes** are also quite useful, especially if you make and re-use shows commercially, or find yourself needing to edit shows later on. You can use **Notes** to remind you of pacing, music or effects that work best in the show. For example, “A great show for Weddings. Slides optimized for Portrait images.” etc.

**To Change a Show Title and Add Notes**

1. In the **Build** or **Design Workspace**, Click on the **Show Opt** icon in the **Toolbar**.

2. Click on the **Show Settings** tab in the upper left corner.

3. In the **Show Setup** pane, chose a **Title** for your show.

4. Enter any notes about your show in the **Notes** field.

Next you’re going to set the **Aspect Ratio** for your show.

---

2 Show Notes are never visible to someone watching the show. They only appear for you when editing the actual show file.
Setting or Changing the Aspect Ratio

The Aspect Ratio refers to the physical dimensions of your show in width and height as it will appear on a display. When possible, it's always best to set the Aspect Ratio to match the display your show will be viewed on.

There are three options to choose from in ProShow.

- **16:9 (Widescreen):** This is the aspect ratio of modern televisions, many handheld devices and many computer monitors (it is also the default for new shows). It's far wider than it is tall and gives your shows a more cinematic look. Modern televisions and pretty much anything "HD" will feature a widescreen aspect ratio.

- **4:3 (TV):** This is the standard aspect ratio for older televisions and older computer monitors. The shape is almost a square and is what most people think of when they think of a tube television.
4. Show Options

- **Custom**: selecting a custom Aspect Ratio allows you to set your show for use with any dimensions you might need. For example, if you plan to show off your work on a 19" monitor that has a pixel resolution of 1440 x 900, you would want to choose an aspect ratio of 16:10.

Remember, when possible you should always try to match the Aspect Ratio of the show to the display the show will be viewed on. When you mix aspect ratios, your shows can end up looking a little odd.

For example, if you create a show using 4:3 and play it on a widescreen television, based on how the television is configured, the show will either be stretched out to fill the screen, or will appear as a smaller box in the middle of the TV.

Alternatively, playing a 16:9 show on a standard 4:3 TV will make the picture look squashed – too thin compared to how it should look since the wide picture is getting compressed into a smaller width.

On some more modern TVs it might also cause the display to be “letterboxed”, which is when black bars appear above and below the widescreen picture. You get the whole picture but it doesn’t take up the full screen.

**Note**: you can change the aspect ratio of your show at any time during show creation, however this does change the size of your slides.

If you change the aspect ratio, some adjustments and tweaking might be needed in order to make sure everything looks the way you expect. You can easily make a show in both widescreen and regular TV formats by making two versions of the show – one in each aspect ratio. Choice is never a bad thing to give your audience.
The Show Thumbnail

Your Show Thumbnail is pretty simple. It’s the image that will be used to represent your show on the menu you create for your show -assuming you select an option that supports menus and choose to include one.

By default, the Show Thumbnail will be an image from the first slide in your show. You can change it to anything you want, whether that’s another slide in the show or a completely different image.

To Change the Show Thumbnail

1. In Show Thumbnail pane, click the Set Thumbnail button.

2. In the Set Show Thumbnail window, choose either Image from File or Slide from Show (this option requires a show to be open first).
   
   a. If you chose Image from File click on the Browse button and locate the image you want to use for your thumbnail.
   
   b. If you chose Slide from Show, use the slider to find a slide in the show that you have open and click on it.

3. When you’re done, click Ok at the bottom of the Show Options window.
The Safe Zone

The **Show TV Safe Zone in Previews** option is designed to help you make sure that all of the important parts of your show are going to be seen regardless of the type of display being used.

A little Safe Zone history lesson - Older model televisions used big picture tubes. These tubes were held in place by plastic bezels that wrapped around the front edges of the glass picture tubes. In most cases, these plastic edges would actually cover up some of the display area of the picture tube. This meant that you wouldn’t see a full scene if that scene took up the entire picture tube area.

The **Safe Zone** is a border that you can use as a visual guide to help you estimate what parts of the slide frame might be cut off by an older television like this. When you enable this option in ProShow, in the **Preview** you will see a pattern of diagonal lines around the outside edge. This is the area defined as the **Safe Zone**. If you’re concerned that parts of your show may be cut off when viewed, simple enable this option and keep your the best parts of your show confined to this area.

The **Show TV Safe Zone in Previews** pane gives you the horizontal and vertical sizes of the **Safe Zone** in percentages of the total slide frame. You can change these if you feel that the **Safe Zone** doesn't quite meet the look you want.
**Note:** the **Safe Zone** defaults were created after some extensive research into what areas older TVs cut off. You’re welcome to change the value but it’s set at what is considered to be the best universal size for most TVs out there.

You can use the visual indicator for the **Safe Zone** to plan how you want your layers to appear or you can choose to scale your layers directly to the **Safe Zone** using the **Scaling** option found in the **Slide Options** window. For more information on **Scaling** see Chapter 8.

What if you want your photos to perfectly fill the TV screen? Unfortunately, there’s no perfect solution to this. If you choose to fit your images to the **Safe Zone**, it may look correct on some TVs and wrong on others since every TV is different. Fitting to the **Safe Zone** may result in some TVs still clipping the edges of your photos, while other TVs show a border where your photos don’t fill the screen.

Since newer flat-panel TVs don’t suffer from many **Safe Zone** issues and PC playback (video clips, EXEs, etc.) don’t have any Safe Zone issues at all, you may be better off fitting your images to the entire frame. Some old TVs may clip the edges of your photos, but newer TVs and everyone viewing your show on a computer will see perfectly fitted images.

Remember that the **Safe Zone** is only a guide. The display area which might be cut off changes with every different model of TV.
Randomizing Transition Effects

ProShow will normally choose from over 500 built-in transitions when you randomize any transitions in your show. That’s not always the desired option.

You can limit which transitions ProShow will randomly select by using the Set Random Transitions option. This will let you filter which transitions ProShow will be allowed to use if you decide to randomize the transitions in that show.

To Select Random Transition Effects

1. In the Show Setup pane, click the Set Random Transitions button.

2. Check any transitions that you would like to use, and uncheck those that you don’t.

3. Click on Apply to save the changes for that show.
If you find that you want to check or uncheck a large number of effects, try starting with All or None icons at the bottom and then selecting your preferred transition effects.

**Note:** random transition effects are only used if you decide to randomize the transitions that are being used for your slide(s). The options you set here don’t apply otherwise. It’s also important to remember that these random transitions settings are saved per show. If you want to use that same set of transitions for multiple shows you must click on **Save as Default** to make your selections the normal transition effects options for all future shows. You can also set the default random transitions for all shows using the Preferences. See Chapter 27.

**Show Information**

On right side of the window you'll find the **Show Information** pane. Here you can see a number of details about your show, including:

- The show name
- The number of slides in the show
- The total duration of the show
- The average number of slides per minute
- The number of flagged slides
- The number of placeholder slides
- The file name and file path where your show is saved
- The date and time the show was last saved
- The version of ProShow used when the show was last saved

**Watermarks**

A **Watermark** is simply an image that will appear on every slide in your show. Typically a **Watermark** will be a logo or some other form of identifying mark - perfect for advertising or branding your shows.

When viewing a slideshow, you can think of a **Watermark** as being like one of those network logos that appears in the lower left or right corner of almost every TV channel.
In ProShow, **Watermarks** by default will be semi-transparent. This is to make sure they are seen without causing too much of a distraction as your shows are viewed.

### To Enable a Watermark

1. Click on the **Watermark** tab in the **Slide Options** window.

2. To the right of the **Preview**, you'll see the **Watermark With Image** pane. This will provide you with more information about your chosen **Watermark**.

   If you don't have an image selected, simply press the **Browse** button to search your computer.

3. Once you find your desired image, click the Windows **Open** button.
A **Watermark** is basically a show-wide layer. It will appear on every slide you have in the show in the same position, and with the same settings, that you specify for it.

Once you’ve chosen a **Watermark** you can configure the appearance of it by dragging or using your mouse wheel in the **Preview** pane, or by changing the options found in the **Position and Size, Adjustments** and **Editing Tools** panes. For more information on how to use these options see Chapter 8.

**Show Background**

The background that appears behind all of the layers on your slide is set here in the **Show Options**. Normally the background is just a solid black color but you can change it to be anything you want. Images, other solid colors, and gradients will all work as backgrounds.

Choosing the background you want to use is as simple as picking which of the three you want.

**To Set a Show Background**

1. Click on the **Background** tab in the **Show Options** window.

![Show Options Window](image.png)

2. In the **Background Source** pane, select the radio button for the type of background you want: **Solid Color, Gradient** or **Image**.

   a. If you choose **Solid Color** click on **Set** to choose the color you want to use and click on **Set Color** to lock it in.
b. If you choose **Gradient** you can configure the gradient by clicking on the **Edit Gradient** button.\(^3\)

c. If you choose **Image** you can browse your system for the image you want to use by clicking on **Browse**, locating the image, and clicking on **Open**.

3. Once you have chosen your background it will appear behind the layers in all slides of your show.

If you select **Image** as your background type, you’ll notice that the **Adjustments** and **Editing Tools** options become available. These settings can be used to change the appearance of the image you’ve chosen for your background. To learn more about how to use these tools see Chapter 8.

The background you specify in **Show Options** will be applied to all slides. If you want a different background on just a few slides, you can override the background for individual slides from within **Slide Options**.

For example, you could set a default background for your entire show using **Show Options**, and then use the individual **Slide Options** to set different background for just your title slides.

---

\(^3\) You can learn all about customizing gradients in Chapter 8.
The Show Soundtrack

The Soundtrack area is where you'll go to configure all of the options for the soundtrack that will play during your show.

The Soundtrack options are varied and powerful enough that there is an entire chapter dedicated to the subject. Please take a look at Chapter 11 for more information.

To Add a Soundtrack in Show Options

1. Click on the Add (+) icon at the top of the Soundtrack List.

2. Select Add Sound File from the sub-menu to browse your computer.

3. Once you find your desired sound files, click the Windows Open button. You can add one sound at a time or multiple tracks at once.

4. Use the Add (+), Remove (-) or Up and Down icons to change your selections or rearrange the order of your songs.

To Duplicate a Soundtrack in Show Options

- Right-click on the sound in the Soundtrack List and select Duplicate Sound.
Additional Show Options

To borrow from a famous movie, "if you right-click, features will come". Just like in other parts of ProShow, there are a few extras hidden in the Slide Options window.

To access these features, you must first click on either the Watermark or Background tabs in order to display the Preview pane.

Composition Lines

You have the option to enable a series of visual lines which can help you arrange your slides more precisely. This feature is called Composition Lines and can be enabled in the Preview window for both the Show and Slide Options.

To turn on Composition Lines, just right click in the Preview pane and choose Show Composition Lines from the menu you see. This will cause the blue lines to appear. Notice that they divide your slide into thirds both horizontally and vertically. This is specifically to help you follow the Rule of Thirds by balancing the elements on your slide.
Grid Lines

If you want a more customizable series of guides in the Preview pane, you can use the Grid. If you right-click in the Preview pane, you’ll see 3 Grid-related options: Define Grid, Show Grid, and Snap to Grid.

Selecting Show Grid is a good starting place. This will turn the grid on so you can actually see it. Once the grid is turned on you can customize how it looks by selecting Define Grid.

The Define Grid options are broken into the Left and Right Grid Size options.

The left number refers to the number of lines that will be drawn vertically, while the right value determines how many lines will be drawn horizontally. You can choose any number of lines you want to use.

You can also choose the color of your grid lines by clicking on Set in the Grid Color option.

Finally, if you want to use your grid as an actual guide rather than a visual aid, you can select Snap to Grid from the Preview menu. This will make layers and captions snap to grid lines so that you can be more exact in your placement.

Just like the Composition Lines, the Grid works in the Slide Options as well as the Show Options.
New Show Basics

As you read in previous chapters, Show Options doesn't have to be your first step when making a new show. However, as these settings form the foundation of your show, you should definitely address these settings before getting too far into the show creation process.

As a recap, here are the key items you should really focus on:

- Choose a Title for your show. Something that helps you organize your work and can serve as a quick reminder about the subject or content of the show.

- Select the Aspect Ratio for your show. Doing this in advance goes a long way towards making you show look it's best during playback.

- Choose a Show Thumbnail for your show based on how you want it to appear in DVD or Blu-ray menus.

- Double-check the Safe Zone to make sure nothing important will be cut off during playback.

- Leave yourself Notes and keep track of the images or effects that work best for each show you create.
5. Understanding ProShow

ProShow Explained

It’s important to understand how ProShow works if you’re going to really grasp the assembling of shows and timing effects. First, we’ll take a look at how slide times are tied together with other elements in the slide. Later, we’ll move on to some advanced concepts that deal with your slides and with your shows as a whole. Next, we’ll cover how ProShow stores your shows and uses all of files that you include in the shows you build.

What’s in a Show

Before you get too far into creating and customizing slides, let’s take a moment to look at exactly what makes up a show. It may seem obvious, but understanding the elements of a show and how they relate is an essential first step.

A show is made up of slides. There’s no limit on the number of slides.

- Each slide has its own time that controls how long the slide is visible.
- Between slides are transitions, which control how slides blend together. Each transition has its own time and effect.
- Slides are made up of layers, captions, a background and optionally, a slide sound.
Each slide can have any number of **layers**

- A layer can be any type of visual. It can be a photo, a video, text, a solid color, or a gradient. ProShow treats them all basically the same.

- Each layer can be fully customized. Motion, adjustments, timing, etc. can all be set for each layer.

**Captions** are basically layers of text that you add to a slide. Each slide can have any number of captions.

- Captions can have effects applied that control how they appear and move.

- Captions always appear above all of the layers in your slide.

A single background can be set for each slide, or the background for the show can be used.

A single sound effect can be added to each slide for voiceovers or effects.

Layers and captions can use keyframes, which allow precise control over their timing and effects. Layers and captions can also use modifiers, which let you ‘program’ effects using advanced techniques.

**Styles** can be applied to Slides. **Styles** are effects that control the settings for all of the elements within a slide. These effects can be motion effects, color adjustments, etc.
Slide Order and Timing

You’ve already learned that your slides play in order from left to right, just like you read across a page. The first slide in your show will always be Slide 1 and your show will always play slides in consecutive order.

Changing Slide Order

The fact that slides play in order doesn’t mean that you can’t change the order as you see fit. There are few different ways to move slides around as you build your show.

The first is to select a slide in the Slide List, right-click, and choose Shift Slides then choose Shift Slide(s) Left or Shift Slide(s) Right. This will move the slide one position over to the left or right, based on what you chose. Notice that there’s a hotkey to do this as well.

You can also click on that same slide and press the "<," or ">." keys on your keyboard to move the slide left or right, respectively.

Keep in mind that you can also move groups of slides. Simply select more than one slide and choose the keyboard keys to move the slides. With each keystroke, the group will all move over one position in the direction you chose.

How Transitions Integrate with Timing

Every slide you create is made up of two time components: the slide time and the transition time. These times flow seamlessly from one into the other to make your show work.

The first slide in your show is going to start with nothing but slide time. That’s what gets your show started. From there, the slide will move into transition time at the end of the slide. This specific transition period is known as Transition Out. It’s the time during which your slide is changing from one to another.
Once the Transition Out is complete you will move into the slide time for your next slide. That time will play and come to the Transition Out at the end once again.

There’s a bit of a catch, though. Consider the second slide in your show. This slide technically has 3 sections you need to factor into its total time:

- The transition time from the previous slide, which is considered Transition In for your second slide
- The slide time for your second slide
- The Transition Out for this slide.

The contents of your second slide are going to be visible during all 3 of those sections. That’s why it’s relevant. The first slide in your show doesn’t have a transition before it, so there’s no Transition In. The end of slide 1 acts as a Transition Out for slide 1 and as a Transition In for slide 2.

Calculating Slide Time

You read this earlier but it’s important to repeat here. The total time of a slide, including transition, is determined by what is assigned to that specific slide in the Slide List.

Every slide you create has a slide time and a transition time. That means that every slide’s total time is the addition of the slide time and the transition time. A slide time of 3 seconds with a Transition In time of 3 seconds and a Transition Out time of 3 seconds results in a total slide time of 9 seconds.
Why ‘Transition In’ is Important

Transition In is important because, unless you specify otherwise, your layers and any effects are going to begin to be seen on the screen as soon as the slide becomes visible -and the slide becomes visible during the transition period as one slide ends and the next one begins.

Let’s say you’ve added some motion to slide 2. As soon as slide 1 begins to Transition Out, it’s also starting the Transition In to slide 2. When the Transition In starts, the motion starts on slide 2. The transition from a previous slide will kick off the motion on the slide after it. Remember that unless you specifically set motion to start only after the Transition In is over, that motion will begin even before the full slide time on slide 1 has been reached.

Changing All Times at Once

There are several ways to see the length of a slide. In all three Workspaces, simply single-click on any slide. Just below the Preview on the right, you’ll see information about the selected slide including the slide name, the number of layers of the slide, and the total length of the slide.

In the Design Workspace, you’ll also see the total slide length displayed as part of the Slide Summary in the Slide Inspector pane.

Regardless of the Workspace you are in, you can see all three time values, and change them easily by opening up the Slide Options window.
5. Understanding ProShow

To Open Slide Options

1. In the Build or Design Workspace, click on the Edit Slide icon in the Toolbar

   Or...

2. In any Workspace, simply double-click on a slide.

In the top right corner, under the words "Slide Options", click on the first tab -this is the Slide Settings tab. Once selected, you'll have access to the basic settings for the slide. Just below the Preview, you'll see the Slide Timing pane. From here, you can set the Transition In, Slide Time, and Transition Out values all in the same place. It's a great way to change exactly how the slide's total time will be set.

![Slide Timing](image)

Locking Slide Time

Slide time has a direct impact on the speed of any effects you have in a slide. For example, a slide with a shorter slide time will display a motion effect more quickly. Chose a longer slide time, and that same motion effect will move more slowly.

On occasion, you may find that a slide works best with very specific timing, and you want to preserve that timing in order to make sure the effect always looks perfect. In those cases, ProShow has a feature which lets you lock the time of a slide so that it doesn't change under any circumstances. This will ensure that your time sensitive effects always remain intact.
A prime example of when locking a slide time comes in handy is when you plan to sync your show and audio together.

To Lock a Slide Time

1. Open the Slide Options window and click on the Slide Settings tab.

2. In the Slide Timing pane, Check the Lock option to Lock the slide time to prevent changes.

Remember that this setting locks all times associated with this slide, so the Transition In, Slide Time, and Transition Out settings will all be locked to prevent changes.

Working in the Slide Options Window

As you create custom shows, you'll probably spend the majority of your time using the Design Workspace and accessing all of the various Slide Options. In later chapters we'll cover all of the options in more detail, but for now let's get a feel for what the options are and where you'll find them.

As you have learned, you can double-click on any slide to open the Slide Options window for that slide. On the left, you'll find the options tabs.

Depending on which tab you select, you'll have access to different options that are specific to each category. In some cases, such as Layers, you will also see additional tabs that appear above the preview.
Starting from the top, the **Slide Options** tabs include:

- **Slide Settings** - Here you’ll see some basic information about your slide. You can also go here to adjust timing, add notes, set actions and reset the slide.

- **Slide Styles** - From this tab you can preview and apply ready-made effects to your slide.

- **Captions** - Use this tab to add and apply effects to any captions you add to your slide.

- **Layers** - This area will list all of the layers on a slide. You can add or remove layers and change their order from this pane.

  Select a layer to apply effects or make edits.

- **Background + Sound** - Here you can edit the background for a slide, add sound effects or record a voice over.
Using the Slide Options Toolbar

Rather than repeatedly opening and closing the Slide Options window for each slide you wish to work on, try using the Slide Options Toolbar. This is one of the best time saving features in ProShow as it allows you to perform a variety of functions without the open/close/repeat routine.

From the Slide Options Toolbar, you can:

- **Move between slides** - Use the left and right arrow icons to move one slide backward or forward in your show.
- **Play/Stop playback** - Preview any changes you make to your slide.
- **Set Slide Times** - Change the times for your Transition In, Slide Time and Transition Out.
- **Open the Keyframe Editor** - A great tool for precisely lining up keyframes when you have multiple layers on a slide.
- **Change the Slide Options window size** - The 'gear' icon accesses the same preview options you'll find by right-clicking in the Preview. Additionally, you can change the size of the Slide Options window to give you more room to work on your slides. You can set it to a minimum size or have it completely fill your screen.
- **Open the Copy Settings tools** - Tool for copying layers, layer settings or captions between slides and keyframes.
- **Adjust the Preview canvas size** - Zoom out when you need to view or control objects as they fly off the screen.
Naming and Annotating Slides

To help keep your shows organized, ProShow allows you to rename and add notes to each of your slides. Neither will be visible to your audience once you publish a show, so feel free to add whatever notes you need. Both will be visible in Slide Settings and in the Slide Inspector. The slide name will also be visible in the Slide List.

To Rename a Slide

1. In any Workspace, double-click on a slide to open the Slide Options window and select the Slide Settings tab.

2. To the right of the Preview, you'll find the Current Slide pane. The default slide name will be "Slide" and a number.

3. Click Rename located just below the slide name.

4. In the Rename Slide Window, type in your preferred name and press Ok.
To Add Slide Notes

1. In any Workspace, double-click on a slide to open the Slide Options window and select the Slide Settings tab.

2. Below the Preview, you'll find the Notes pane. Type whatever notes you'd like and press Ok when you're done.

For any slides that you add notes to, you'll also see a green info icon appear on the slide in the Slide List.

Flagging Slides

Another great organizational tool is the ability to add a Flag to any slide in your show. Flags don't alter your show in any way, they simply provide you with a visual reference to remind you that there is something about a slide that has earned special attention. Perhaps there's an effect you really like, maybe it's a great place in your show for a soundtrack change, or it could simply mark the place in your show where you paused to take a break.

To Add a Flag

1. In the Slide List, right-click on the slide(s) you would like to flag.

2. From the menu that appears, select Flag Slide, then choose Flag Selected Slides. In the Slide List, you'll see the flag appear just to the right of the slide.

Or...

3. Use the keyboard shortcut CTRL + F to flag a selected slide.
A flag will also appear in the Slide Settings tab when you open the Show Options for the flagged slide.

Flags can also be added while previewing a show - even when using the Full Screen Playback option. This is very handy when you want to mark a slide as being noteworthy or in need of further attention, without having to stop and start the show constantly.

**To Add a Flag While Previewing a Show**

1. As you’re watching your show, simply use the keyboard shortcut CTRL + ALT + F

**To Remove a Flag**

1. In the Slide List, right-click on the flagged slide(s) and select Flag Slide > Remove Flag from Selected Slides.

**Toggle Flags**

When you add a flag, you'll also see the option to Toggle Flag on Selected Slides. While this option will add a flag to a slide, it does behave a little differently - which is worth noting for times when you are working with a range of selected slides.

When you select Flag Slide or Remove Flag, these options forcibly set or remove flags, regardless of the current flag state of a slide (on or off). The toggle option swaps the current state with the opposite state and does so on a per-slide basis.
As an example, select a range of slides with some flagged and some not. If you choose **Toggle Flag on Selected Slides**, the slides that have flags will be toggled to off, the slides that originally did not have flags will now have flags turned on. If you had selected **Flag Selected Slides** instead, all of the slides would be flagged.

**How ProShow Uses Files**

ProShow has a unique approach to creating shows which helps keep your show files small and your image collection organized. Let’s talk about what files are used when you make a show, and how those files work.

**The Show File**

The core file that makes up your slide show is a PSH file. You’ll find that this file has the name you’ve given to your show with the PSH extension. So, your show file might be ‘MyShow.PSH’.

The PSH file does not contain the materials you put into the show. What it does contain are pointers, like those you would find in a database. These pointers tell ProShow where the files you’ve added to the show are located on your system. When you open a show, the PSH file says “This image is in that folder and this audio file is in this other folder over here”. ProShow is told where those files are and opens them when you open your show.

Once ProShow is told where to find your content, the next thing the PSH file does is tell ProShow how to interpret those images, videos or audio clips. For example, if slide 4 features an image that is cropped, rather than crop the original image on your computer, the PSH file tells ProShow to display the crop effect that’s been added.

Essentially, the PSH file is your show. If you delete this file, or lose it, you’ve lost your show.
The PXC File

ProShow may not store all your show materials in the PSH file, but it does need a file it can use to hold data about your images, audio, and video. That’s where the PXC file comes in.

You can think of the PXC file as a cache that contains data that ProShow uses while you’re constructing your show. It’s a support file for the show.

PXC files can get pretty big based on how large your show becomes. It’s important to note that you can delete the PXC file at any time. ProShow will rebuild the PXC file any time it needs it to, so you can get rid of it once you’re done with a show.

You’ll find the PXC file stored in the same place as your PSH file.

Note: The name of the PXC file will be identical to the name of your show’s PSH file. Be very careful which file you are selecting should you need to delete the cashed data of a PXC file.

The BAK File

ProShow automatically creates backups of your show as you make it. When you click on the Save button, ProShow creates a new PSH file for you and renames the previous PSH file to a BAK file.

This means that you’ll have a file next to your PSH file which might be called ‘MyShow.BAK’.

Each time you save your show you’ll get a new backup. The previous backup will get a new name, too. ProShow saves up to 10 backup versions of your shows in this way. They’ll appear as ‘MyShow.BAK’ and ‘MyShow.B01’ through ‘MyShow.B09’. In this example, ‘MyShow.BAK’ will be the most recent backup, ‘MyShow.B01’ is the next most recent and ‘MyShow.B09’ will be the oldest backed up version of your show.
These backup files are there just in case you need to revert back to an older version of your show. You’re welcome to delete any of these files once you finish the show, or if you don’t care to have all of those backup files present.

You can adjust the settings for how these BAK files are created in the Preferences, will be covered in more detail in Chapter 27.

To Restore a Show from a Backup File

If you want to revert to a backup that ProShow has created, you can do so at any time.

1. Load the show you want to revert to backup.
2. In the Menu Bar, click on Tools > Revert to Backup.
3. Select the version you want to revert to based on date, time, and size.
4. Click on Open.

ProShow will open that version of the file so that you can save it and continue working.

Locating Missing Files

As you've learned, PSH show files only point to your content, they do not directly import and edit your content. If files that you use in a show are moved or deleted, ProShow may tell you that it’s unable to find all of the files that are in a show.

If you’re prompted by the Missing Files dialog, you can choose to locate the files by clicking Yes, ignore the missing files by clicking No, or stop loading the show by clicking on Cancel.

If you select Yes you will be shown the Find Missing Files window. This window will display a list of the images, audio, and video that ProShow can’t locate. It will also tell you how many files are missing in total.
To begin locating missing files, select the first file you want to find and click on **Find Selected**. This will bring up an Explorer window which you can use to locate the file on your hard drive. Once you’ve found the file, select it and click on **Open**.

The **Find Missing Files** window will update to indicate the image you have found. ProShow will automatically search in the location you choose for the rest of the images. If they’re also in the same folder, it will update the location for those, too.

Deleted show material can be replaced with other images, audio, or video, just by selecting a new file rather than the one you deleted.

After all of the files have been located, click on **Ok**. The show will open. To avoid having to locate files again the next time you open the show, be sure to save the show so that the PSH file properly records the new locations.

**To Find Missing Files**

If you skipped the prompt when first opening a show, you’ll see a "**Missing File**" placeholder appear in your show for each file ProShow wasn’t able to locate. To open the **Find Missing Files** window and locate your content:

- In the **Menu Bar**, click on **Tools > Find Missing Files**.
Collecting Show Files

A common question asked after publishing a show is “Now what do I do with it?” The short answer is you’re ready to store it.

In most cases, you want to store the show in a way that allows you to make changes to it later. That means gathering up all of the files that were used to make the show, as well as the show file itself.

The Collect Show Files option does just that. It collects all of the files used in the show, including all images, audio, and video clips and copies them into a single location along with the show file. This gives you one folder which has everything you need for the show, even if all the files were in different places previously. It’s a great way to organize your shows for storage, or future editing.

To Collect Show Files

1. With the show you want to archive open, in the Menu Bar, select Tools > Collect Show Files.

2. Choose whether you want to show content to Copy to Folder on your hard drive or Burn to DVD/CD.
   a. If you select Copy to Folder, click on Browse to locate the folder you want to use for the collection, or create a new one.

3. Click on Collect to begin gathering the files into one place.

There’s quite a bit of information in the Collect Show Files window. The Files Used in Show list displays every file that is in your show, no matter the file type.

To the right of that list you’ll see the Space Necessary for Collection pane. This tells you how many files by type are in your show, and how much storage space you'll need to collect and save everything.
Whether you choose to copy the collection to a folder or burn it to disc, you’re going to get the same folder structure once the collection process is complete. The folder you select to will contain the following:

- Your show’s PSH file
- An ‘image’ folder - The images used in your show
- An ‘audio’ folder - All audio used in your show
- A ‘video’ folder - All video clips used in your show

The PSH file for your show will also be changed to reflect the location of your files. The great thing is that this location stays intact as long as you move the whole collection from one place to another.

Finally, the **Save List** option which appears at the bottom left corner window is great for getting a quick inventory of what you’re using in your show. This option saves the **Files Used in Show** list into a text format so you can have a full account of the content into your show.
6. The Wizard

Slideshows Made Even Easier

The **Wizard** is a way of automatically creating a show with very little effort. The Wizard takes the selected photos, videos, text and music and builds a show using the selected theme and energy level. The theme and energy level work together to define the types of effects used in your show. The length of your show will vary with the amount of content selected and the energy level you’ve chosen.

A show made using the Wizard can be published right away, or it can become a starting point for a show that you customize further using the powerful creative tools found in **Slide Options**.

Using the Wizard

ProShow will use your photos, videos and music to create a unique slide show in four easy steps.

- Add your photos, videos and captions.
- Add your music.
- Choose a theme for your show.
- Name your show and set the **Energy Level**.

To open the Wizard

The easiest way to access the **Wizard** is by clicking on the icon in the **Build Workspace Toolbar**. This will open the **Wizard** window.
You can also access the **Wizard** by clicking the **New** icon in any Workspace **Toolbar**, or by choosing **File > New Show From Wizard** from the **Menu Bar**.

**Step 1: Photos, Videos and Text**

The first step is to add your photos and videos or add text slides that will be used by the **Wizard** to create your new show. You can use any image or video file that is supported by ProShow. As you add content, a thumbnail for each item will be added to the content box.

**To Add Photos and Videos**

1. Click the **Add** icon.
2. Locate the file(s) on your computer that you wish to add.
3. Select the file(s) and click Open.

To add multiple files to the **Wizard** at the same time, use the **Shift** or **CTRL** keys as you select your content. With all desired files highlighted, click Open to add them to the **Wizard**.

New additions to your show will appear after the currently selected item. This allows you to insert new content anywhere in your show.

Simply select where you wish to add the new content and click the **Add (+)** icon. The new content will be added just to the right of the selected content.
The Wizard also gives you the option to import files that you have uploaded to online services such as Facebook or Instagram.

**To Import Files from a Service**

1. Click the **Import** icon

2. Choose the service you wish to download content from, and log in to your account.

3. Select the file(s) you wish to import. If your images have captions or descriptions that you'd like to include with your show, check the **Download Captions** button at the bottom of the window. This will combine an image and a caption onto the same slide.

4. Click the **Add to Show** button

For more information on importing files from a service, see Chapter 8
Additionally, you can use the import option to add photos and videos directly from your iPhone or iPad using the ProShow Remote App.

**Note:** This option requires that you install the app separately on a compatible device, and works best when your device is connected to a WiFi network.

For more details on using the ProShow Remote App, see Chapter 28.

**To Import Files Using the ProShow Remote App**

1. Click the **Import** icon
2. Connect to a device running the ProShow Remote app.
3. Select the file(s) you wish to import and click the **Add to Show** button

**To Add a Text Slide**

1. Click the **Text** icon.
2. Type the text into the blank window
3. Click the **Ok** button at the bottom of the window

If you have already added photos or videos, the text may not appear at the beginning of your show. To move the text, simply click and drag it to the preferred position.

To change your text, highlight the title and click the **Edit** icon.
Photo and Video Content Options

The **Wizard** offers you some basic options for sorting and editing your content.

If you wish to remove an image, video or title from the **Wizard**, simply highlight the item and click the **Remove** icon.

To change the order of your images, videos or titles, either click and drag each manually, or click the **Randomize** icon. You can randomize all of the content in your show, or selected content.

To rotate an image or a video, select the thumbnail and click the **Rotate** icon. Each click will apply 90 degrees of rotation to the selected item.

Whereas **Text** slides are separate from your visual content, using the **Caption** option allows you to blend text and visual content together on the same slide. Simply select a slide, press the **Caption** icon and insert your text.

If you've added video clips to the **Wizard**, highlight the video and click the **Edit** icon. This will open the **Trim Video Clip** window where you can trim your clips to the desired length.

**Note:** You can only add captions, change text or edit videos one slide at a time.

At the bottom of the **Wizard** window, you will see a summary of contents you have added. Once you have sorted and edited your content, click the **Next** button to proceed to Step 2.
Step 2: Music

The next step is to add your music. You can add any audio file that is supported by ProShow to the Wizard. As you add music, each track will appear in the content box. For each track added, you will see the name and duration of the track.

If you add multiple tracks, the Wizard will crossfade your tracks to give your show a smooth, continuous soundtrack.

To Add Music

1. Click the Add (+) icon
2. Locate the audio file(s) you wish to add.
3. Select the file(s) and click Open.

Music Content Options

If you wish to remove a track from the Wizard, simply highlight the track and click the Remove (-) icon.

To change the order of your tracks, click and drag each track to the desired position.

If you've added tracks to the Wizard that you would like to trim, highlight the track and click the Edit icon. This will open the Edit Timing window. Here you can edit your tracks to the desired length by changing the starting and ending times. Once edited, you'll see the Trim times that show when the track begins and ends along with the name and Length of the track in the content box.

Once you have sorted and edited your music tracks, click the Next button to proceed to Step 3.
Step 3: Theme

In step three you choose a theme for your show.

The theme you select will determine which slide styles and transition effects the Wizard will use when creating your show.

There are over 950 built-in effects to choose from.

Any slide style or transition can be used in a theme, including any effects you install or create. Choose from any of the 30+ built-in themes, or create one of your own.

To choose a theme, simply select one from the list and click Next.

Step 4: Final Details

The last steps when using the Wizard are naming your show, setting the energy level, selecting the aspect ratio and setting the audio crossfade.

Tune the Energy Level

The Energy Level determines the speed and intensity of the show. Lower settings will create a slower paced show, while higher levels will create a show with a faster pace. Because some effects work better than others at certain levels, the energy level you select also helps the Wizard determine which effects from your selected theme will be used.

There are two Energy Level options:

- Auto
- Custom
If you choose **Auto**, ProShow will pick an energy level that syncs the length of your show to your music. Any songs that you add will play completely from start to end, and your show will end at the same time as your music.

Here are some examples of how **Auto** may work in your show:

- If you have a five minute long song with only 20 slides, the energy level will be extremely low. Slides will stay visible for a long time and effects will move very slowly.

- If your song is only one minute long, and there are 300 slides, the energy level will be extremely high. Slides will only appear for a blink of an eye and effects will move very quickly.

Choosing **Custom** gives you more control over the pacing of your show. To change the energy level, drag the slider to the desired position.

When setting a **Custom Energy Level**, from time to time, the **Wizard** may create shows that don't match up with the length of your music. For example, it may create a show that is much shorter than you may have expected. If this happens, try adjusting your **Energy Level** to a lower setting. Changing your theme or adding more content may also give you better results.
Choose an Aspect Ratio

This allows you to choose whether you want the show to be created for Widescreen or Standard playback. In most cases, you will want to create a Widescreen show to be compatible with newer monitors and televisions.

![Choose an Aspect Ratio](image)

Set the Audio Crossfade Overlap

As mentioned in Step 2, when you add more than one audio track, the **Wizard** will crossfade your tracks automatically in order to give your show a smooth, continuous soundtrack.

By default, the crossfade is set to 2 seconds, however you can change that by simply moving the slider under the **Audio Crossfade Overlap** setting. You can set tracks to have no overlap, or blend them together by as much as 10 seconds.

![Audio Crossfade Overlap](image)

**Note:** This option will only appear if you have added more than one audio track.

With the final settings taken care of, click the **Create** button and the **Wizard** will build your show for you.
Ready to Preview

The Wizard prepares your show, adds all of your content to the Slide List and Soundtrack Bar and will begin playing the preview automatically.

Use the Stop/Play icons to control playback of the Wizard Preview.

If you don’t like the results, you can select Try Again and the Wizard will recreate the show for you.

You can use the Try Again option as often as you like. If you still aren’t satisfied with the results, use the Back button and try adjusting your energy level or changing your theme. Once you are happy with the results, click Next to continue.

Finished

Once the Wizard has created your show, all that's left is to do is save, publish or fine tune the results.

- **Save your Show** – Your new show isn't saved until you save it. From the navigation window, choose a location on your computer and save your show.

- **Publish your Show** – This option opens the Publish Your Show window. Choose from over 40 different output options offered in ProShow. Note: Some options like DVD and Blu-ray will require you to save your show first.

- **Learn How to Customize or Fine-Tune** – This option will introduce you to the basics of customizing your show with ProShow.

If you're ready to do some fine-tuning, press the Done button. The show the Wizard just build for you will be loaded into your Slide List and ready to go!
Remixing Slides

After using the **Wizard** to create your show, from time to time you may find that certain effects used just don't work well for your images, or perhaps you want to add more content, but don't want to rebuild the entire show. You can do all of that manually, or you can use the **Remix** option. This will run the **Wizard** again, but only on the slide, or range of slides that you'd like to redo.

**To Remix Slides**

1. In the **Slide List**, select any slide or any range of slides.
2. Click the **Remix** icon located in **Build Workspace Toolbar** or the **Design Workspace Toolbar**.
3. In Step 1, verify the slides you want to **Remix**. You can also change or add more content here if you'd like.
4. In Step 2, choose a theme for the content you are about to remix.
5. In Step 3, choose your **Energy Level** and press **Create**.

Just as before, the **Wizard** will add effects and playback a preview of the changes. **Try Again**, go **Back** to make adjustments or press **Done** as needed.

**Note:** **Remix** does not offer you the ability to add more music or chose an **Auto Energy Level**. It's more of a "do that slide over" tool, not a "build a new show" tool. If you feel that you need to make significant changes, you'll probably want start over and have the **Wizard** build a new show for you.

Also, keep in mind that you do not have to use the **Wizard** prior to using the **Remix** option. You can use **Remix** at any time for any slide(s) on any show you create. This is an excellent tool that really comes in handy when you want to spice up a show, but you're not sure which styles or effects you'd like to use.
Wizard Themes

If you have favorite effects that you would like the **Wizard** to use, try customizing an existing theme or creating your own. This is especially useful if you use the **Wizard** frequently to make specific kinds of shows. For example, if you use the **Wizard** to make shows with wedding images, make a custom theme that only uses the effects that you feel will work best for wedding images.

To Edit a Wizard Theme

1. When using the **Wizard**, select any Theme in the **Wizard** and click the **Edit** icon.
2. Enter a new name for the theme.
3. Check the effects you’d like to have be a part of this theme.
4. Click **Apply**.

or when not using the **Wizard**....

1. Click the **Effects (FX)** icon located in the **Build Workspace Toolbar** or the **Design Workspace Toolbar**.
2. Select the **Themes** tab in the top right corner of the **Effects** window.
3. Select the theme you would like to edit.

4. At the bottom of the Effects (FX) window, locate the effects tools and press the **Edit** button.

5. Give the theme a new name.

6. Check the effects you'd like to have be a part of this theme.

7. Click **Apply**.

In the **Edit Theme** window, the list on the left shows all the different categories of **Slide Styles** and **Transitions** you have installed. Styles will be listed first. To see the transitions that can be used in the theme, scroll down to the transition categories.

To add an effect to your theme, simply check the box next to the name of the effect. To remove an effect from a theme, uncheck the box. After you have finished, click **Apply**.

**Note:** If you create a theme that has the same name as an existing theme, the older theme will be replaced by the newly created theme. To keep yourself organized, it's always best to choose a new name.
To Create a New Wizard Theme

1. Click the Effects (FX) icon located in the Build Workspace Toolbar or the Design Workspace Toolbar.

2. Select the Themes tab in the top right corner of the Effects (FX) window.

3. At the bottom of the Effects (FX) window, locate the effects tools and press the + Create button.

4. Enter a name for the new theme.

5. Choose a Start With option to get your theme up and running by adding some effects.

Selecting the Use default set of effects option will create a new theme that features all effects installed on your system.

Choosing Use the effects selected in the selected theme will create a new theme that has the same effects as whatever theme you currently have selected in the Effects (FX) window. This is a great way to create a new version of an existing theme.

Or you can also create a new theme with the Use the effects in the current show option.

6. Click Ok.
In the **Edit Theme** window, simply check the box next to the name of the effect. To remove an effect from a theme, uncheck the box. After you have finished, click **Apply**.

For best results, be sure that your new themes include a good selection of styles and effects. Having a good selection will make your theme perform better across a variety of energy levels and show durations. Themes with lots of effects enabled will generally produce better shows than themes with just a few effects.

**To Remove a Wizard Theme**

Any custom theme you create as well as any modified built-in theme can be removed.

1. Click the **Effects (FX)** icon located in the **Build Workspace Toolbar** or the **Design Workspace Toolbar**.

2. Select the **Themes** tab and Click on the theme you'd like to remove.

3. From the effects tools, chose **x Remove**

**Note:** Custom themes you choose to remove will be permanently deleted from your system. However, removing a built-in theme will not permanently delete the theme. Instead, any changes you have made will be undone and the built-in theme will be restored to its default state.
6. The Wizard
7. Effects

Bringing Slides to Life

Still images work fine for some presentations, but if you really want to wow your audience, you need to do more than just show static images. So how do you make your best photos look even better? Add motion. How do you make a lower quality image look better? Do a little creative image editing. When you add motion or make creative adjustments, your shows can instantly become more interesting, dynamic and enjoyable.

As an example of how much effects matter, consider the documentaries made by film maker by Ken Burns. The vast majority of those are made up of still images that pan and zoom as narration tells the story. Now imagine watching those films without those motion effects. Think you'd make it through 6 hours of watching still photos? It's those simple motion effects that really bring the images to life and make the storytelling so compelling.

In this chapter, we'll introduce you to the different types of effects that you'll find in ProShow, and show you how easy it is to use effects in your shows. In later chapters, we'll dive a little deeper into managing your effects and show you how to make your own.

Types of Effects

At the most basic level, effects are simply "things you do to your slides". An effect can be as generic as zooming in on a photo, or something more advanced like combining several effects to create a complex montage of motion and creative image editing.

In ProShow, there are four types of effects that you can apply to your slides:

- Transitions
- Motion
- Adjustments
- Slide Styles
Transition Effects

Transitions are the visual effects that occur as one slide ends and the next slide begins. Every slide in ProShow has one. It doesn’t matter whether it’s the first slide in the show or the last – at the end of each slide, there is always a transition effect.

Transitions help define the pacing, as well as the visual appearance of your slideshow. For a slower paced show, you’ll use longer transition times and simple blending effects. For a faster paced show, you’ll use shorter transition times with more energetic effects.

Motion Effects

Motion effects of course are the assorted ways that you can move any individual layer within a slide around the screen. You can Pan a layer from one side to the other. You can Zoom in or out, or you can Rotate a layer.

These basic effects work for any layer, including images, videos and captions. With images and videos, you can also choose to Tilt a layer and add motion that creates a 3D/perspective feel.

Motion effects always begin and end within each slide. As a result, they are also affected by your Slide Time. When you have a less time, the motion will happen more quickly. With longer Slide Times, the motion will be slower.
Adjustment Effects

When you add an image, video or caption to a slide, you have the ability to make adjustments and change how that layer looks. This could be adding blur, changing the opacity, or even colorizing the layer. This kind of adjustment changes how the image will always look within that slide.

Adjustment effects are those same kinds of adjustments only rather than always being applied to a layer in your slide, they happen over the duration of a slide.

For example, let's say you have a 10 second slide with one color photograph. If your Adjustment effect is to colorize the image so that it looks black and white, when the slide starts, you'll see the normal color picture. As the slide continues to play, the colors will fade until the image finally becomes black and white as the slide ends.

Image/video layers and captions have slightly different Adjustment effect options, but they perform the same way. Additionally, just like Motion effects, Adjustment effects are affected by time - short slide times = faster adjustment, longer slide times = slower adjustment.
Slide Styles

Slide Styles are pre-built, ready-made effects that you can apply to any slide. They can be very simple, but often they will combine Motion effects and Adjustment effects together to create effects that really add life to your images.

When you apply a Slide Style, the style acts as a blueprint. Within that blueprint are all of the instructions ProShow needs in order to create the desired effect. The number of layers, the layers' appearance, motion effects, adjustment effects, captions and even slide sounds—all of that information is stored within the Slide Style.

Slide Styles are incredibly beneficial to both novice and advanced users. They are easy to use, they are a great time saver, they can be customized and you can even create your own.

For more advanced users, Slide Styles also make a great learning tool. Once you've applied a style to your slide, you can see every option was configured to make that effect work. From there, you can make changes and adjust settings to figure out exactly what makes the style tick.

Applying Effects

When it comes to applying effects, you basically have two categories, "automatic" and manual.

The "automatic" effects are Transitions and Slide Styles. These effects are pre-built and ready to go. All you have to do is select your desired effect and press Ok. Whatever motion, timing or adjustments are needed for the effect will be created for you. All you have to do is add your content.

The manual effects are Motion effects and Adjustment effects. You'll use these when starting with a blank canvas and creating your own, new effects. You'll also use these manual options to customize existing effects.

Let's start with the "automatic" effects...
Applying Transition Effects

There are two ways you can apply a Transition effect. The first is to use the Transition icon in the Slide List.

To Apply a Transition from the Slide List

1. Click on the Transition Icon on the right side of the Slide Thumbnail in the Slide List.

2. From the Choose Transition window, browse through the categories and select a Transition effect.

3. Double-click to apply the effect, or press the Apply button.

As mentioned in Chapter 2, there are over 500 built-in Transition effects to choose from. As you single-click on any effect, you will see a preview of what each Transition Effect will look like when applied to your slide.

The second way to apply Transition effects to your slides is to use the Effects (FX) window. From this window you can also apply and manage other effects as well, but for now, just note that you can apply Transition effects using this window. Regardless of which method you use, the available effects that you can apply to your slides will be the same.

To Apply a Transition from the Effects (FX) Window

1. Click the Effects (FX) icon located in the Build Workspace Toolbar or the Design Workspace Toolbar.

2. Select the Transitions tab in the top right corner of the Effects (FX) window.

3. Browse for your desired effect and press the Apply to Slide button in the bottom right corner.
**Transition Effects Tip:** To change the Transition effect for multiple slides at once, simply select all of the slides you wish to change before clicking on either the Transition or Effects (FX) icons. When you apply your desired effect, all of your selected slides will feature the new transition.

**Applying Slide Styles**

Much like Transitions, there are also two ways to apply Slide Styles: from the Effects (FX) window and by using the Slide Options window.

**To Apply Slide Styles from the Effects (FX) Window**

1. Click the Effects (FX) icon located in the Build Workspace Toolbar or the Design Workspace Toolbar.
2. Select the Slide styles tab in the top right corner of the Effects (FX) window.
3. Browse for your desired effect and press the Apply to Slide button in the bottom right corner.

As you browse for effects, you'll notice that information about each Slide Style will appear on the far right side of the Effects (FX) window.

In this information area, you'll see:

- A thumbnail preview of the Style
- The name of the Style
- Publisher information
- Notes about what the effect does
- Any categories the Style belongs to
- The number of Layers the Style uses
- Aspect Ratio information
- Optimal slide time and transition time
- A link that will take you to the saved location of the effect
The details listed in the information area are often overlooked, but they can be a great resource when looking for the best effect for your slide(s).

When using the Effects (FX) window to apply Slide Styles, you can also apply the Styles to multiple slides at once. In the Slide List, simply select all of the slides you wish to change before pressing the Effects (FX) icon. When you apply your desired effect, all of your selected slides will feature the new Slide Style.

The second way to apply Slide Styles is by using the Slide Options window.

To Apply Slide Styles from Slide Options

1. In any Workspace, double-click on the slide you wish to add an effect to.

   OR

   Click the Edit Slide icon located in the Build or Design Workspace Toolbar.

2. Select the Slide Styles tab in the top left corner of the Slide Options window.

3. Below the Preview, browse for your desired effect. Press Apply to Slide to add the effect to your slide.

4. If you’re happy with the effect, press the Ok button to close the Slide Options window.
Much like using the Effects (FX) window, you'll see an information area on the right that provides details about the Slide Style. Right away you'll also notice one of the key advantages to using this method...the preview. When you click on a Style, you'll see a real-time preview of exactly what the effect will look like once applied to your slide.

Just like Transitions, the exact same effects are available to you regardless of the method you choose to apply them.

**Manual Effects: Motion and Adjustments**

Manual effects are exactly what the name implies, they are effects that you control on your own. You'll use the manual control options when customizing Slide Styles or when creating brand new effects for your shows.

We'll cover how to use these options is greater detail in later chapters, but for now, let's take a look at where these manual controls can be found.

All of the Manual Effect controls will be found in Slide Options.
To Apply Effects Manually

1. In any workspace, double-click on the slide you wish to add an effect to.

OR

Click the Edit Slide icon located in the Build Workspace Toolbar or the Design Workspace Toolbar.

2. Select either a layer from the Layers List, or a caption from the Captions List on the left side of the Slide Options window.

3. Above the Preview, select the Effects tab.

4. Below the Preview, Set your Motion or make your Adjustments

5. Press Ok to apply the changes to your slide and close the Slide Options window.

The most important thing to note is that manual controls work on an individual basis. Each layer or caption on a slide has its own settings that you will configure separately when creating effects.
Managing and Creating Effects

Later in this manual you'll find chapters dedicated to **Transitions** and **Slide Styles** that will cover creating and managing these effects in more detail. For now, let's get familiar with where to look for these options.

The Effects (FX) Window

Located at the bottom of the **Effects (FX)** window you'll find all of your **Effects** management tools. These tools and options are the same for both **Transitions** and **Slide Styles**.

From the **Effects (FX)** tools you can:

- Add
- Create
- Remove
- Edit
- Categorize
- Select Favorites
- Export

To access the **Effects (FX)** window, simply click the **Effects (FX)** icon in the **Build Workspace Toolbar** or the **Design Workspace Toolbar**. You can also use the keyboard shortcut CTRL + E.
8. Layers

How ProShow Works with Images

The best way to understand how ProShow works on a fundamental level, is to begin with the concept of layers. In ProShow, when you add any image or video to a slide, that content becomes a layer as soon as it’s added.

Every Image or Video is a Layer

It’s easiest to think of a layer as a “container” for your images or video. When you add a picture to your slide, ProShow puts it inside a container that fits the image and makes that part of the slide.

This “container” that makes up the layer is what gives you the ability to make all kinds of changes to the image. Because it’s a layer, you can move it around, change the size, edit the appearance and more. This “container” is just hypothetical. You can’t actually see something that acts as a holder for the image; you just see the image on the slide. Thinking of a layer in this way can help understand what it does, though.

Layers Stack

ProShow gives you the ability to include an unlimited number of layers on a single slide. Each of these layers stacks one on top of the other. You can think of this just as you would a cake or a deck of cards.

Consider the card analogy. Each card has an image on the front of it. If you have the cards perfectly stacked on top of one another, you can only see the topmost card.
Spread the cards out a bit, though, and now you can begin to see the rest beneath it. Place them all out individually and you can see them all, assuming you have enough table space for them.

This is exactly what layers do. Each image or video you add to a slide goes into the stack of layers.

Using ProShow, you control where each layer shows up in the stack, and how it will be seen by your audience.

**Layers are Interchangeable**

One of the reasons it’s important to think of a layer as a container of sorts is because it opens up new ways of creating shows that you may not have considered in the past. Because layers are interchangeable, they allow you to change the image or video you have in a layer at any time.

For example, you add image A to a slide. You set up a custom effect, but later decide image B would make for a better slide. Because a layer is a "container", all you have to do is swap the images. The settings of your custom effect will be left intact.

Now that you have a better idea of what layers are and how they work in ProShow, let’s learn how to actually add and work with layers within a slide.
Adding Layers to a Slide

In this section you’ll learn a variety of ways to add layers to your slides. Regardless of the method you choose, there are two key things to remember about adding layers:

- **Layers are independent.** Each layer has its own settings. If you have multiple layers in a slide and want to manually add effects, you’ll need to adjust the settings for each layer separately.

- **Layers are adjusted using Slide Options.** All of the things that you can do to an image, video or caption can be found in Slide Options. The rest of this chapter will be spent walking you through the Slide Options window and showing you what all of the options are and where you can find them.

As you learned in the previous chapter, the two easiest ways to access Slide Options are to double-click on the slide you wish to edit, or to click the Edit Slide icon located in the Build Workspace Toolbar or the Design Workspace Toolbar.

Adding Layers

There are multiple ways to do just about everything in ProShow, and adding layers to a slide is no different. Here are the various ways you can add layers to a slide.

Adding a New Layer in the Build Workspace

1. In the File List, click on the image you want to add as a layer to a slide.

2. Drag and drop the image onto the Slide List. This will create a new slide with one layer.
Importing Content from Social Media Services

If you frequently upload images to places like Facebook or Instagram, ProShow can quickly access your social media services and directly add content that you have already uploaded.

This is very helpful if you don't want to dig around on your computer to find files. Plus it's a great way to make a beautiful slideshow out your favorite, uploaded images.

To Import Files from Social Media Services

1. In the **Menu Bar**, click on **File**, and select **Import Content from Service or App**.

   Or

   Click the **Import Icon** in the **Build or Design Workspace**.

2. Choose your desired service You can choose from: Facebook, Instagram, flickr, Picassa, SmugMug or Zenfolio. You can only access one service at a time, but you can repeat this process as often as you'd like and add content to a show from all over the web.
3. Log-in to your account and choose a folder full of images.

4. Once you've selected a folder, choose the images you'd like to add to your show. You can browse and select images from multiple folders.

At the bottom of the window, you'll see several importing options.

Let's take a look at each of these:

- **All or None**: Checking the option will select either all or none of the images available in the folder you have selected.

- **Download Captions**: If you added any kind of text or description when you originally uploaded the content, when you check this box, you will also download that text. The text and image will be combined on the same slide as a layer and a caption.

- **Download Only**: This will download all of the content you have selected, but it will not add it to your show. This can be a helpful tool if you wish to create an archive of your uploaded content.

- **Add to Show**: With your content selected, choose this option to import files into your show.
Notes: Using this feature you can only import one layer to a slide at a time. If you select 5 images, you will create 5 new slides with one visual layer each.

If you’ve chosen the Download Captions option, for every item selected, you’ll create one slide with one visual layer and one caption. Note that captions added this way, may not look very pleasing at first. You’ll very likely need to adjust their settings, which you’ll learn more about in chapter 10.

Importing Layers from a Device

Additionally, you can use the import option to add photos and videos directly from your iPhone or iPad using the ProShow Remote App.

Note: This option requires you to install the app separately on a compatible device, and works best when your device is connected to a WiFi network.

For more details on using the ProShow Remote App, see Chapter 28.

To Import Files Using the ProShow Remote App

1. Run the app on your device and connect ProShow to your device.

2. Click the Import Icon in the Build or Design Workspace.

3. Choose the ProShow Remote App option.

4. Select the file(s) you wish to import and choose from the same add or download options.
Locating Imported Files

Any content that you download or import directly into a show will be saved on your computer.

You can access these files just like any other content by using the Folder List and File List.

Imported content will always be listed as Imported Content under the Media Sources entry in the Folder List. As you import from different Social Media services, ProShow will add new entries to help you keep these downloads organized.

Adding a New Layer to and Existing Slide

1. In the File List, click on the image you want to add as a new layer on an existing slide.

2. Drag & drop the image onto the slide you have chosen to add the layer to. But before you "drop" the image, press the CTRL key on the keyboard.

This method will drop the image right on top of the slide as a new layer. ProShow lets you know you are adding the image as a new layer by changing the mouse cursor.
When working correctly, your mouse cursor will have an icon that looks like a page with a “+” in it as you hover over the **Slide List**. You can even do this with multiple images at once.

![Slideshow with layers]

### Adding More Than One Layer to a Slide at Once

1. Hold **CTRL** on the keyboard and click on each layer you want to add from the **File List**.

2. Continue to hold **CTRL** while you drag & drop the selected images onto your slide.

   When multiple images are selected in the file list, this method will add all of them to the slide as layers.

**Note:** Using the drag & drop method to add layers can be visually confusing at first. When you drop a new layer onto an existing slide, ProShow makes it the topmost layer. If that new layer fills the entire slide frame, in the **Slide List**, it may appear as though you only have one layer as the others are hidden behind the top layer.

To make sure all of your layers were added successfully, simply open the **Slide Options** for the slide and check the **Layers List**.
In the Slide List, you'll also see a multi-layer icon appear on the slide.

Right-Click to Add Layers

There are quite a few ways to add layers or images to your show using the right-click context menu of your File List. You can right-click anywhere in the File List to see the menu. There are a few options here that you may find helpful:

- **Add to Show**: adds the currently selected file, or files, to the show as new slides. Each image selected will become a new slide.

- **Add All Files to Show**: adds every image and any other valid files in the current folder to your show. Each file will be added as a new slide.

- **Add to Selected Slides**: another way to add images as layers to a slide. Select the images you want to add in the File List, click on the slide you want to add them to in the Slide List, and choose Add to Selected Slides. All of the files you’ve picked will be added as new layers.

- **Add as One New Slide**: use this option to create a single new slide with many layers. Click on each of the files you want to use in the new slide and choose Add as One New Slide from the menu. They will all be added to the new slide together.
Adding a New Layer from Slide Options

1. Double-click on any slide you have created to open the Slide Options window.

2. In Layers List located on the left, Click the Add (+) icon and select Add Image or Video from the sub-menu.

   or

   Right-click anywhere in the list, or click the 'gear' icon in the Layers List, and select Add Layer > Add Image or Video from the sub-menu.

Browse your system for the image you want to use, select it in the file browser window and click Open.

Using the Layers List to add new layers via the Slide Options window is a straight-forward way to add new layers, but it’s not the fastest or easiest.
Using the Layers List

The Layers List is one of the primary tools for working with layers on your slide.

You will use the Layers List to access editing options for each layer, control the order of your layers, add new layers, and work with advanced layer techniques like Masking.

Understanding how the Layers List works is a very important first step in using layers as part of your slide composition.

Reading the Layers List

The Layers List has a central area where it displays a thumbnail and name for each layer on your slide as well as a toolbar on the left. Start by taking a look at the actual layer display in the center of the list.

You're going to see at least one layer present in the list even if your slide only contains one image. Remember that every image becomes a layer. Each layer displays the number of that layer in the overall order on the slide. If you only have 1 layer, you'll see that layer labeled as number 1.

As you hover over a layer, you'll also see a tool tip window that tells you size of the image in the layer as well as the file path where that file is located on your computer.

To the right of the assigned number is a checkbox. This Layer Toggle toggles whether the layer is active or not. Unchecking the box turns the layer off and causes it to be hidden from the slide. This can often be useful when you are working on an effect that uses multiple layers and you want to avoid seeing every layer at once. Turn off the layers you aren't working on for easier editing.
Reading Masking and Adjustment Layers

The **Layers List** also displays changes that are made to your slide using masks or adjustment layers. The function of the **Layers List** doesn’t change when these options are active but it does adjust the look of the list as a whole.

You’re going to see a line of text and an additional icon indicating if a layer is a mask or adjustment layer. The icon for each type appears on the left side of the layer and a line will be drawn from the icon down the left side of the **Layers List**.

![Layers List Example](image)

Each layer that is being affected by the mask or adjustment layer will be indented. Masks, by default, will work on the layer just beneath them. Adjustment layers will change every layer underneath it. You can also see which layer is affected thanks to a line that will be drawn from the mask or adjustment layer to any other layers which are included.

The lines for a mask layer will appear to the left of each layer it is working with, ending with a pointer at the final layer. Because adjustment layers work with every layer beneath them, the line simply draws straight to the bottom of the list.

For more information on working with masks and adjustment layers, please see Chapter 16.
Reading Text Layers

When working with **Text Layers**, instead of a thumbnail and file name, the **Layers List** will show you the actual text used with the layer. Keep in mind that font and color choices may make it hard to read the text in the thumbnail -this is normal and often results in seeing little more than a checkerboard pattern.

Text Layers share attributes of both visual layers and captions. You can learn more about them later in this chapter and find greater details in Chapter 11.

Adding or Changing Photos or Videos with the Layers List

The **Layers List** isn't limited to working with the images you've added to the slide. As you've learned, you can also add more content by using the **Add (+)** button. Or, if you’re more comfortable with using your mouse, you can even change the contents of your slide by dragging and dropping images directly into the **Layers List**

Let's cover a few ways you can add new layers to the list:

- **Dragging and Dropping from the File List**: you can drag and drop files from the **File List** directly into your **Layers List**. This is something that is easy to overlook because the **Slide Options** window tends to cover the **File List** while you’re working. Just move the **Slide Options** window to the side and try dragging a file into the **Layers List** directly from the **File List**.
• **Dragging and Dropping from Windows Explorer:** any time you’re moving or working with files in Windows, you’re using the Explorer. You can drag files into the **Layers List** straight from one of the folders on your hard drive. Try opening a folder with some images and dragging a few straight into the **Layers List**.

As you may recall, at the beginning of this chapter we mentioned that layers are interchangeable and that you can replace “image A with image B” within a layer. Here’s how you can swap the content of a layer by dragging and dropping:

• **Drag and Drop to Replace Layer Content:** when you drag a file into the **Layers List**, no matter where you’re dragging it from, try dropping it onto the thumbnail for one of your existing layers. When you drop a file onto an existing layer’s thumbnail, it will replace the layer’s content with the new file. Any settings for that layer will be applied to the new, replacement image.

**Adding Text Layers with the Layers List**

To add a Text Layer from the **Layers List**, simply click on the **Add (+)** button to access the **Layer List** menu. Once selected, the **Add Text Layer** window will open.

![Image of Layer List Menu]

After you have created the new **Text Layer**, you’ll notice that the Text Settings and Text Effects options will appear as tabs above the Preview. If you need to edit what you typed, click the Text Settings tab, and make your changes.
Layers List Tools

At the top of the Layers List, you'll find the Layer List Tools. Using these tools you can add, remove, and organize your layers.

The Add (+) icon, is your first option. When you click on this button to add a new layer, a sub-menu will appear. From here you choose the type of new layer you would like to add. You have the following options:

- **Add Image or Video**: This option will allow you to browse your hard drive or other system drives for images or video content to use to make a new layer. This is the most commonly used option.

- **Add Solid Color**: Selecting this option will allow you to create a new layer of one complete color. This option is most often used with masking. You will learn more about creating solid color layers later in this chapter.

- **Add Gradient**: You can create your own gradient layers using this option. This is another feature that is often used in combination with masking. You will learn more about creating gradients later in the chapter.

- **Add Text Layer**: Unlike Captions (which always appear above your visual content), Text Layers can be added to your layer stack and mixed together with your images and video clips. In addition to being able to be placed behind your images, Text Layers also feature movement and adjustment options available to both Captions and layers—which can be used to create some very compelling effects. You'll learn more about working with Text Layers in Chapter 11.

- **Add Placeholder**: Selecting this option inserts a placeholder layer, which is a blank layer with no image or video attached. Placeholder layers are best used to create a particular effect that doesn’t call for a particular image. You'll find these useful when designing templates or creating your own transition effects. Of course you can add an image later.
8. Layers

- **Add From Media Source**: If you have any ProShow Media Source packages installed you can quickly add that content using this option. Once selected, you will be able to select which Media Source, of those you have installed, that you want to add content from. By default you will always have ‘ProShow Producer Built-In Content’.

- **Add Adjustment Layer**: This option creates an Adjustment Layer that works somewhat like a mask. For more information on Adjustment Layers, see Chapter 16.

- **Add Masking Layer**: Selecting this option expands to a sub-set of your normal layer options. The difference is that the layer you add using this method will automatically be converted to a mask once it has been created. You can read more about masking in Chapter 16.

- **Duplicate Layer**: This option makes an exact copy of the layer you currently have selected in the Layers List. This copy will appear directly above the original and contains all of the layer information including image, motion, effects, etc. Duplicating a layer is a great shortcut if you plan to have many similar layers on your slide.

You can create every kind of layer using the Add (+) button. It’s something that you will frequently be working with as you become more comfortable with the process of creating shows. You can also access these options by right-clicking anywhere in the Layers List and opening the Add Layer submenu.

The Remove (-) button is quite simple by contrast. Just click on the layer that you want to delete from the slide and click on the Remove (-) button. It will be deleted from the slide completely.

The arrow icons you see are used to control layer positioning within the slide. Remember that layers stack on top of one another. The Up and Down arrow icons will move the selected layer up or down in the list. This is how you set how and where you want your layers to be ordered on the slide. To change the layer order, you can use the arrows, or just click and drag your layers.
The last item in the toolbar is the **Layer List Menu** icon. This menu contains alternative ways to access many of the features for layers. With the **Layer List Menu**, you can add/remove layers, edit layers, rename layers, hide or show layers, convert a layer into a mask, copy the layer, and quite a bit more.

**The Layers List Menu**

There are two ways to access the **Layer List Menu**. You can select the layer you want to work on in the list and then click on the **Layer List Menu** icon, or you can right-click on the layer in the list.

As you just read, you can add or remove layers using this menu, but there are also several other very useful features found here.

- **Select File**: Using this option allows you to swap the content of a layer with a new image or video. Simply browse your hard drive and select the replacement file. As layers are placeholders, any adjustments or effects you have applied to the layer will be instantly applied to the replacement file.

- **Rename Layer**: Another way to rename your layers and help keep your slides and shows organized.

- **Edit Layer**: Selecting this option expands to a sub-set of editing options. You can open an external editor or jump to different editing menus within ProShow.

- **Visibility**: From here you can hide or show the layers in your slide. This often comes in handy when working with slides that feature many layers or that use complex effects. Hiding layers does not delete the layers, it simply toggles them into a "off" state, so that you can focus on editing visible layers.
8. Layers

- **Move**: Gives you the ability to move a layer up or down in the Layers List. You can also send a layer directly to the top or bottom of the list as well as move a layer in or out of a mask.

- **Use as Adjustment Layer/Use as Masking Layer**: These two options will take the selected layer and turn it into an Adjustment Layer or a Masking Layer. For more information on Adjustment and Masking Layers, see Chapter 16.

- **Use As Transition Layer**: You’ll use this option when creating your own Transition Effects. For more information on creating Transitions, see Chapter 14.

- **Copy**: This is an exceptionally useful option, that actually expands to give you four very powerful copy options.
  
  o **Copy to All Slides**: this selection will copy the currently selected layer to every slide in your entire show. This can be handy when you’ve created a particular background or other image that you want to see in all your slides.

  o **Copy to Selected Slides**: rather than copying the layer to every slide in your show, this option copies the layer only to the slides you’ve chosen in the Slide List. You can select slides by moving the Slide Options window up a bit to see the Slide List and hold CTRL or Shift on the keyboard to pick the slides you want to include in the selection.

  o **Copy to Specific Slides**: this option opens the Copy Layers window. You can use this window to choose exactly which layers you want to copy and choose only those slides that you want to copy the layers to. Simply expand and check the layers you want to copy in the left column and check the destination slides you want those layers to be copied to in the right column. Click on Copy once you’ve made your choice, or just choose Copy & Close.
- **Copy Settings**: choosing this option will let you copy specific settings or adjustments you've made to the layer to any other layer in your show. This is done using the **Copy Settings** window, and choosing the source layer in the left column, checking the options you want to include in the center column, and selecting your destination layers, or slides, in the right column. You can learn more about copying layers, settings, and other slide items in far more detail in Chapter 26.

![Copy Settings Window](image)

- **Remove**: This option offers you the ability to either remove a single layer or **Remove All Layers**. Both appear in the fly-out menu when you click on the **Remove** entry. Selecting **Remove All Layers** will strip your slide down to a ‘blank’ slide. It doesn’t delete the slide but it does remove all of the images or video you have added to it.

- **Reset Layer**: This option will return your selected layer to its default value. This effectively makes it as if you just added that layer to the slide. Any changes you have made to the layer are removed.

**Summing Up the Layers List**

There’s quite a bit of information packed into the **Layers List**. Thankfully, most of it can be accessed with a quick glance. It's a good idea to get comfortable with the options available here as you'll use it just about every time you create a custom show.
Slide Background

In a way you can think of the Slide Background as a “non-layer, layer”. If you recall the chapter on Show Options, you’ll remember that you can set the background for your entire show at once. The Show Background covers all of that.

The Slide Background is a background which you can configure on a per slide basis. When enabled, a Slide Background, will override the default show background. Slide Backgrounds are often important pieces of a slide’s composition, but it’s important to remember that they aren’t normal layers and they will not be found in your Layers List. Your background is always going to be beneath every layer on the slide, no matter how many you have.

To Set a Custom Slide Background

1. Open Slide Options and locate the Background+ Sounds area.

2. Click the Background tab. When no image is selected as a Slide Background, you should see this labeled as Default Background.

3. In the Background Source area, select the radio button for the background type you want. Choose from Default for Show, Solid Color, Gradient, or Image.

4. Configure the color/gradient, or locate the image you would like to use as the background.
Once the source is selected, use the **Adjustments** and **Editing Tools** to change the look of your background however you'd like. More details about those options can be found later in this chapter.

**Note:** When you override the default background for your show, you’ll find that any new slides that you add to the show which appear next to the slide with the custom background will feature the same custom background. This happens because ProShow assumes that you’re going to want to use that background across multiple slides. To revert back to the **Show Background**, simply choose the radio button option **Default for Show** for any slide on which you don’t want to use the custom background.

**Making Changes to a Layer**

As mentioned earlier in this chapter, layers are independent, and each layer that you add to a slide will have its own settings. Once added to a slide, there are three categories of "things that you can do to a layer", each with unique options that we'll cover in this chapter.

The three categories are:

- **Layers Settings** Here you define the basic information about the layer, including the name, the type of layer it will be in your slide, and the initial zoom settings and position of the layer.

- **Adjustments**: Here is where you will find the editing tools that can be used to adjust how your layer will appear in the slide.

- **Effects** From this tab, you the control motion and adjustment effects that will happen as your slide plays.

Each of these categories is accessed by selecting their tab located above the **Preview** in the **Slide Options** window.
Layer Settings

When you add a new layer, you should always start with the Layer Settings and define the basic information about your layer. Let's take a look that the available options.

Layer Name and Notes

In Slide Options, to the right of the Preview you'll see the Selected Layer pane. Here you find a thumbnail preview to help you quickly identify which layer is which. Above the thumbnail preview you'll see the Layer Name displayed along with the type of file that is used in the layer.

The Layer Name can be changed at any time to help you organize the slide. To change the name of your layer, click Rename located just below the slide name.

Beneath the thumbnail preview you'll also see three additional options, browse, editor and info. Use these tools to change the content that appears in the layer, open an external editing program to modify the content, or click info to view the content properties (resolution, size, type, location etc).

Just below the Preview, you find the Notes area. Use this area to help stay organized while making your show. Any notes you type to yourself about the layer will not be seen by anyone watching your show. The Notes are there simply to give you a place to type any information about the layer that may help you while you’re making the slide. If you need to take a break or revisit a show later on, Notes are also a great way to mark any layers in your show that still need work or require special care.
When you add a note to your layer, a green information icon will appear above the layer checkbox in the **Layers List**. As you hover over the green icon, a tool tip window will appear and display the layer note.

**Layer Type**

Immediately beneath the **Preview**, you find the **Layer Type** pane. You'll use this pane to identify when a layer has specific properties. For example, when working with **Mask** or **Adjustment** layers, you'll use this area to toggle the **Mask** or **Adjustment** on or off, as well as select the type.

You'll also use this area when creating your own **Slide Styles** and **Templates** or when making **Live Shows**. (These options are all covered in detail in later chapters.)
Layer Setup

When you add a layer to your slide it’s going to be positioned right in the center of the slide using the default **Scaling** value you’ve selected.\(^4\) The **Layer Setup** area is where you go if you wish to change the initial positioning and sizing of each layer.

![Layer Setup](image)

Scaling and Layer Size

When you add an image to your slide, the resolution of the image is not directly factored into the size of how it appears in your slide. Instead, the proportions of the image are the most direct influence on the size of your image. **Scaling** determines how those proportions fit within your slide.

There are three kinds of scaling values that are used: **Fit**, **Fill**, and **Stretch**. You use these options to set the base size of your layer.

The size of your layer based on the **Scaling** becomes what ProShow considers to be 100% Zoom for the layer. Any changes to the size of the layer using the **Zoom** value will start with the appearance of the layer based on its size using **Scaling**.

The scaling mode is set using the **Scaling** option. Generally, you don’t need to adjust this for every layer. Most users will either use the default, or set their own default and use that for all new layers.

Let’s take a look at how each option affects an image when added to a slide.

\(^4\) Default scaling values can be changed in the Preferences, in Chapter 27.
**Fit to Frame:** The first option, and the default for ProShow, is Fit to Frame. This option makes sure that your entire image fits within the frame of your slide. The difference in the proportions don’t matter between the frame and the image – fit to frame will keep the whole image visible.

![Fit to Frame example](image)

**Fill Frame:** The second option will tell ProShow to increase the size of the layer to fill the entire slide frame. If the layer and the frame aren’t the exact same proportions you may lose some of the image. This can be cut off on either the top and bottom or the left and right edges of the frame. Using Fill Frame is a great option to choose when you want to make sure the background is hidden, or when you do not want blank space on your slide.

![Fill Frame example](image)
8. Layers

**Stretch to Frame** The third option is one that you should use sparingly. Unlike the other two options, **Stretch to Frame** will adjust the proportions of your image to make it fit exactly inside the slide frame. When the proportions of an image are changed you can often see distortion in the image itself. So be careful with this option. It’s best to use **Stretch to Frame** with images that won’t suffer from distortion such as abstract backgrounds.

---

**Fit and Fill Safe Zone** The final two scaling options will **Fit** or **Fill** your layer within the **Safe Zone** of your slide frame.** Fit** and **Fill** behave just as they do when using **Fit to Frame** or **Fill Frame**, only instead of the full frame of your slide, you limit the **Fit** or **Fill** to the pre-defined safe area.

---

5 You can read about the Safe Zone in Chapter 4.
Layer Position in the Slide Frame

After setting your Scaling, it’s often best to set the position where you actually want the layer to appear in your slide frame.

By default your layer is going to appear right in the middle of the slide. This is a Position value of 0 x 0.

Consider the slide frame as a grid; it has a series of values for both the X (horizontal) and Y (vertical) axes. The total range for each axis is 100. This is a range from -50, to 0 in the center, to 50.

For the X axis, -50 is the left side of the slide frame and 50 is the right side. On the Y axis -50 is the top and 50 is the bottom.

When setting the position, the left Position value is for the X (horizontal) axis and the right value is for the Y (vertical) axis. Notice how the arrows go side to side for the horizontal (X) axis and up and down for the vertical (Y) axis.
The position is always measured based on the center of the frame and the center of the layer. With this in mind it’s easy to determine where you want to place your layer. For example, changing your **Position** values to 25 x -25 would place the center of your layer in the upper right corner of the slide frame, centered halfway to the edge.

For most practical edits, you probably won’t worry about the exact position of a layer. Instead, you’ll mostly likely "eyeball it" and drag and align the layer until it looks good to you. This is possible as the **Preview** window in **Slide Options** is interactive – just click and drag the layer to any spot on the slide. You’ll notice that the **Position** values update automatically as you drag the layer around.

Later in this manual, you’ll learn how to apply motion to your layers. How does the **Position** you set here affect your motion? By default, a new layer doesn’t have motion. Changing the position here will change the position of the layer, but won’t create motion.

If you already have panning motion applied to your layer, changing the position here will change the **starting position** of your motion.
**Zoom**

We’ve established so far that the **Scaling** option you choose sets the base size for the layer on your slide. The scale you go with becomes the base **Zoom** value of 100%. All of your layers are going to default to 100% **Zoom**, based on the scale, once you add them to a slide.

You can further adjust the **Zoom** value for each layer from there. Moving the **Zoom** slider to the left and right will decrease or increase the size of your layer, respectively. You also have the option to type a number directly into the value field.

The slider will let you adjust your **Zoom** from 0% to 500%. A **Zoom** value of 0% effectively makes the layer invisible; the layer is so small that it can’t be seen. A **Zoom** value of 500% increases the layer to 5x its normal size.

If you need more size you can manually type in any **Zoom** value you want. If you want your layer to be particularly large try typing in a value of 1200%.

![Zoom slider](image)

**Note:** Changing the **Zoom** value doesn’t actually change the size of the image. You’re essentially just taking a closer look at it. This means that zooming in on low resolution images can cause the image to appear pixilated, as the individual pixels that make up the image become large enough to be seen. If you want to use very deep zooms but don’t want to lose image quality it’s best to use high resolution images. The higher resolution your image – the better it looks when at high zoom levels.

Just as you saw with position, changing the zoom from the **Layer Settings** tab is related to the zoom you can apply with motion effects. When your layer doesn’t have motion, changing the zoom level here will zoom the layer, but will not add motion.

If you already have zooming motion on your layer, changing the zoom here will change the *starting zoom* of your motion.
Using the Preview to Position Layers

The preview area of Slide Options gives you a quick way to change the zoom and position of a layer without thinking about the numbers. In most cases, you’ll find it’s much easier to adjust zoom and position settings by using your mouse to manipulate the preview.

To change the position of a layer in the preview, just click anywhere on the layer and drag it to the desired position while holding the mouse button down.

To change the zoom for a layer, you have two options. First, you can use the scroll wheel on your mouse to zoom the selected layer in and out. Second, you can click and drag any of the small boxes, or ‘knobs’, found along the edges of layer’s gold control outline.

In the corners of the selected layer, you’ll also notice some small curved arrows. These areas are the rotation controls. To rotate the current layer, just click and drag these rotation icons.

By default, clicking on another layer in the preview will select that layer. You can change the behavior of clicking on layers, or turn off the control outline all together by right clicking in the preview area.
Creating a Layered Arrangement

Now that you know what a layer is, how to read the layer list, and how to arrange layers on your slide, you have the basics covered. Now, let’s do something a bit more practical with your knowledge.

In the following example you’re going to create an arrangement of images. You’re going to supply the images used, so pick four images that are complimentary of one another. It doesn’t have to be perfect – just pick four that work well together.

To Create a Layered Arrangement

1. Start with a new slide and using the first of your chosen images. Set the Slide Time to 5 seconds. Leave the Transition Time at default.

2. Hold CTRL on the keyboard and drag the three other images you chose on to the new slide. You can select them all as a group or drag & drop them one at a time.

3. Double-click on the slide to open the Slide Options window. Select any layer from the Layers List and select the Layer Settings tab from above the Preview.
These steps have set you up with a new slide that contains four layers. The bottom layer, **Layer 4**, will become a backdrop for the rest of the layers. The other three will be placed around the slide to make things look interesting.

As you work with each layer, remember that you can hide the layers on your slide -often making it a little easier when creating montages like this one. To hide a layer, uncheck the box next to the layer number, or right-click on a layer and go to **Visibility > Hide**.

4. Click on **Layer 4** in the **Layers List**. In the **Layer Setup** area, change the **Scaling** value to **Fill Frame**.

5. Change the **Layer 4 Position** values to -25 x 0.

Your backdrop layer has been set. The **Scaling** change increased the size of the layer so that it fills the slide frame. Adjusting the **Position** values moved the layer to the left a bit which gives you some blank space to work with on the right side of the slide.

Now let’s focus on the other three layers.

6. Click on **Layer 3** in the **Layers List**. Change the **Zoom** value to 50%.

7. Move **Layer 3** using the mouse, in the **Preview** window, so that it’s placed in the upper-right corner of the slide frame.

8. Click on one of the **Rotate** anchor points to rotate the layer slightly.
The first of your image layers has been arranged. Notice that we placed it so that it overlaps the blank background of the slide and the image you’re using as a backdrop.

9. Click on Layer 2 in the Layers List. Change the Zoom value to 40%.

10. Position Layer 2 below Layer 3 on the slide frame on the center right edge.

11. Click on one of the Rotate anchor points to rotate Layer 2 a bit in the opposite direction you chose for Layer 3.

You only have one layer left to do and your arrangement will be finished.

12. Click on Layer 1 in the Layers List. Change the Zoom value to 45%.

13. Arrange Layer 1 below Layer 2 in the slide frame, in the lower-right corner.

14. Use the Rotate anchor to rotate Layer 1 slightly in whichever direction you prefer. The end goal is to have the images fan out along the side.
That’s it. You’ve got an arrangement of four layers on your slide that should look pretty good. Once you’ve had a moment to take a look at the results, feel free to tweak the placement of the layers until you’re satisfied.

For small, more controlled position adjustments, select the layer you wish to move and hold down the CTRL key as you press the Up, Down, Left or Right arrows on your keyboard. To nudge the layers a little further, hold CTRL and SHIFT as you press the Up, Down, Left or Right arrows.

**Layer Editing and Adjustments**

ProShow gives you the ability to do quite a bit more than adjust the position of your layers. Editing a layer gives you control over the appearance of the layer – everything from the color balance of the image to the parts of the image you want to see.

The editing features available in ProShow are similar to what you will find in most image editing software. You can crop images, remove red-eye, change color levels, adjust opacity and quite a bit more. There’s also one major benefit to using the editing tools in ProShow that you’re not going to get from an image editor: editing images in ProShow is completely non-destructive.
What Non-Destructive Editing Means

When you make edits in ProShow, your original images are never altered, no matter how radical the changes are. Instead, you are simply telling ProShow how to interpret and display your original material.

Because you don’t need to worry about your original files being changed, you’re free to be creative and experimental with what you do to your images as part of your show.

ProShow will go back and use your original images once you start making your show output. The editing changes will be made to the output, using your original images as the source while the output is being created. That means that you get the full quality of your original images, with edits included, without ever touching your original files.

Why Edit Images for Slides?

It’s important to remember that there’s a distinction between the edits that you may make to a photograph that you intend to print and put in an album versus what you do with a photo that you include in a slideshow.

Because a slideshow is a multimedia presentation it’s far more likely that you’re going to make dramatic changes to the look of your images that wouldn’t be well suited for a traditional print. This can be everything from changing a photo from color to black & white or including multiple crops of an interesting photo to make a slide more dramatic.

Approach the editing you make for a slideshow as a separate process from the edits you make for print. They’re two different mediums and should be approach with that mindset.

Layer Editing Options

Once you’ve added a new layer to a slide and positioned it just right, your next stop in Slide Options is the Adjustments tab.
There are two major editing groups that you can work with. The first is **Adjustments** and the second is **Editing Tools**. These break down to cover two basic editing types.

### Adjustments

In the **Adjustments** area below the **Preview**, you'll have the options to control the color and appearance of your layer. **Adjustments** are used to change things like the **Brightness**, **Contrast**, and **Opacity** of your layer.

Additional options found here are the ability to adjust the **White Point**, **Black Point**, **Contrast**, **Hue** and **Saturation**. You can also **Sharpen** or **Blur** the contents of a layer.

### Editing Tools

The **Editing Tools** options are designed to let you change major aspects of the look and layout of your layers.

While the Adjustments focus on colors and aesthetics, the **Editing Tools** mostly focus on shape, size and orientation.

Using these tools will let you **Rotate** or **Flip** your layers, as well as **Crop** them. Additionally, this is where you'll go when you want to access the **Red-Eye**, **Vignette**, **Chroma Key**, **Colorize**, **Shadow** and **Outline** features.
A combination of these two sets of tools will allow you to radically change the appearance of your layers to meet whatever ideas you have in mind for your slide.

Let’s take a look at each of the options in the Editing Tools area.

**Rotate**

Rotate is used to quickly make exact rotations in your layers. You can choose from 90, 180, and 270 degrees in the Rotate dropdown list.

This does exactly what you would expect and rotates your layer to the right equal to the degrees you select. This is most often used when you want to quickly turn a layer upside down or over at an angle.

**Flip**

Flip gives you the ability to actually change how the content on your layer appears. You can use Flip to make the content of a layer appear upside down with the Vertical option, or on opposite sides of the layer using the Horizontal option. You can also combine both together by checking both boxes at the same time.

Flip doesn’t rotate the layer – it just flips around how the image in the layer appears. It’s best used when you have a certain layout for your slide in mind but the images don’t fit. Let’s say there’s a picture of a bride lounging on the right side of your image. You want to put some other layers on the right side, so you Flip the layer Horizontal to move the bride over to the left side of the layer. It’s like looking at the layer in a mirror.
In the **Selected Layer** pane, you'll see a before and after view of the **Flip** changes as you check or uncheck the options.

**Vignette**

Historically, a **Vignette** is most often thought of as the rounded, usually dark, soft corners seen in photos from the 1800’s-early 1900’s.

In ProShow, vignettes can be created to recreate that look, or be customized in a variety of ways to create very stylized borders for your images or video clips.
**Vignette Type** is where you will select the Shape and Type for your effect.

![Vignette Type](image)

**Shape** options include *Rounded Rectangle* - which softens the edges of your layer, and *Ellipse* - which softens the edges as well as alters the shape of your layer into the more traditional "old style photo" vignette shape.

There are also three **Type** options:

- **Transparent** is the most commonly used vignette type. This option gradually blends the edges of your layer so that it mixes seamlessly with any underlying layers or background.

- **Solid Color** uses a color of your choosing to define the edge of your layer.

- **Gradient** allows you to use a gradient to define the edge of your layer. Gradient options are covered a little later in this chapter.

**Vignette Options** is where you customize the look and feel of your vignette. Enter a numeric value or use the slider to adjust the **Vignette Size**, **Border Size** and **Corner Size**.

When creating a **Solid Color** or **Gradient** vignette, you also have the option to fill the **Corners** of the layer as well as the create a solid **Border** where your gradient and layer meet.
As an example of just how customized vignettes can be, take a look at the image example below.

On the left is a sample of a more traditional Transparent Ellipse vignette. On the right, the Type is set to Solid Color, the Shape is a Rounded Rectangle, and both the Corners and Borders options have been checked.

**Red-Eye**

**Red-Eye** is a common problem with when taking pictures of people. A camera flash in just the right (or wrong) spot and now your family members all have glowing red eyes.

Image editing software and even many cameras can help reduce **Red-Eye**, but if you don’t have access to those, ProShow also features a quick tool to remove **Red-Eye** from your images.

If you have someone in your picture that has **Red-Eye**, click on the **Red-Eye** button in the **Editing Tools** pane. This will open the **Red-Eye** window.
Use your mouse wheel to zoom in on a image. To pan across a layer, right-click and hold the mouse button as you drag the eyes into position. Left click to release the pan-and-drag.

Now use a normal left-click to create and drag a selection area around each spot where you see Red-Eye in the picture. Try to get the circular region of the selection area over just the red spots.

When you release the mouse cursor to create the selection area, you’ll see an entry appear in the Red-Eye Areas section on the right of the window.
This entry gives you a thumbnail view of what is being removed by the **Red-Eye** tool. If you don’t like how it looks you can adjust the selection area by dragging it with your mouse, or change the size using the anchor points. You can also delete selection areas by selecting them in the **Red Eye Areas** list and clicking on **Remove (-)** button at the top of the list.

It’s best to zoom in closely on the areas affected by **Red-Eye** so that you can be as precise as possible when removing it.

**Crop**

The **Crop** window gives you the ability to create a selection region that will be the new shape and image of the layer. Whatever you draw the box around is what will show up.
Your selection region can be changed in two ways: you can change where the selection is placed on the image, and you can change the size.

To change the size and shape of your selection region, click on any of the anchor points that appear in each of the corners and on all four sides. These anchor points can be dragged to adjust the selection region.

Changing the position of the selection region is just a matter of click and dragging the whole region to a spot where you want it to be.

The values beneath the **Crop Preview** are used to be more precise about how you want the cropping to be made.

![Crop Preview](image)

The **Size** values show you the actual size of your selection region in pixels. If you have a specific resolution in mind for the crop, or if you want to make sure that your crop is the same size on different layers, you can manually type the size here. The left value is the **Width** of the selection region and the right value is the **Height**.

The **Rotate** slider can be moved left or right to rotate the image to the left or right. If you know exactly how you want to rotate your crop you can type that value, in degrees, into the value field. Remember that negative rotation will rotate the image to the left, while positive rotation will go right.

The **Crop Left, Right, Top and Bottom** fields all give you the distance, in pixels, your selection region is from the edges of the actual image. This can be handy when you’re trying to cut an image into equal cropped pieces and you need to know right where one cropping region stops so you can make you next selection.
Chroma Key

With the **Chroma Key** feature, you can use the Hollywood style "green screen" technique to make part of your image layers transparent. This is a great way to remove backgrounds or parts of an image and superimpose layers on top of one another.

Thankfully, you're not limited to only having green backgrounds in all of your photos.

Choosing Images to Use with Chroma Key

**Chroma Key** can't just make whole swaths of an image transparent if there's a lot of color variety. It works best with images that have a consistent region of color in them. This doesn't just have to be the background. If you want to make someone’s shirt appear transparent for an effect, and the shirt is mostly one color, give it a shot.

You’re free to try the feature with any image but you’re going to get the best results if the image has one consistent color throughout the area you want to turn transparent.

To Enable and Use Chroma Key

1. Open the **Slide Options** window for the slide you want to use with **Chroma Key**.
2. Select the layer you wish to edit and click on the **Adjustments** tab.
3. Click **Chroma Key** button to activate the option and open the **Chroma Key Transparency** window.
Once you’ve enabled **Chroma Key** the options will become available for adjustment. Your first step is to choose a key color.

4. Click on **Set** next to the **Key Color** entry.

5. Click on the eyedropper icon in the upper left of the **Color Picker**.

6. Use the eyedropper mouse cursor to click on the color you want to work with from the **Preview** window.

Choosing the color you want to use as your key from the **Preview** window means that you’re getting the exact color. You don’t have to guess or estimate – just sample the color you want.

The remaining step for creating the actual transparency isn’t exactly a fine science. In fact, finding the right balance is usually a trial and error process.

7. Adjust the **Hue/Intensity** sliders to find the desired level of transparency.

There are five sliders you can adjust in order to make your selected color become transparent.

- **Hue Threshold** controls how much hue variation is factored into making the key color transparent
- **Hue Drop Off** adjusts how much of the edge of the hues of your key color will be removed
- **Intensity Threshold** adjusts how much color intensity variation will be used in the adjustment
- **Intensity Drop Off** factors in color intensity changes at the edge of your key color pixels
- **Color Suppression** changes the colors of your layer to help compensate for large variations in color hue or intensity
The values you enter for these sliders will change based on the image properties and key color you choose. The values can even be different when used to create transparency on the same image in two different shows.

Thankfully there’s a set methodology you can use to get solid results. You don’t even need to know exactly how the sliders work.

Here’s how you go about it:

1. Begin at the top of the sliders, with **Hue Threshold**, and adjust the slider slowly to the right while looking at your image in the Preview. Adjust the slider to the right as far as you can without causing regions you don’t want to alter to become transparent.

2. Begin moving the **Hue Drop Off** slider to the right in the same way once you’ve adjusted **Hue Threshold** as much as you can.

3. Continue in this manner to the bottom of the sliders.
By the time you reach the last slider you should have solid results with your selected color becoming transparent. If you don’t, go back to the top slider and start the adjustments again from where you just set them.

If you get to the bottom of the sliders and still don’t have the results you’re looking for, try picking a different key color.

If you still can’t get the transparency to work just right you may be using an image that isn’t well suited to Chroma Key. It doesn’t work equally with all images.

Once you have created your transparent area you can work with that layer just like any other image with transparency built in. Try combining it with other layers to create interesting visual arrangements or effects.
Colorize

The Colorize allows you to change all of the colors in your layer to a shade of whatever color you choose. It’s often used to give full color images a black & white, or even vintage sepia look.

To enable the Colorize option, click the Set button. This will open the Color Picker.

Choose a Color Using the Color Picker

- Use your mouse within the color wheel
- Use the Eye-dropper in top left corner and select a color from the Preview
- Enter the RGB (Red Green Blue) number values for a color
- Press the Hex button and enter a color name or web-color hexadecimal value (most common color names will work)

Once you have a color selected, press the Set Color button to apply the effect.

To vary the intensity of the Colorize effect, use the Strength slider located just to the right.
Shadow and Outline

Both the **Outline** and **Shadow** options are great ways to add some depth to your layers. **Outlines** can help your layers stand out from one another, especially when stacked on top of each other. Using a **Shadow** will help give your slide the appearance of some distance between your layers.

The **Outline** option is simple. Turning it on will draw an outline all the way around the outside edge of your layer. The **Color** of your **Outline** can be chosen using the same method as you did for the **Colorize** feature. You can change the thickness of the **Outline** by clicking on the **Size** value and dragging the slider that appears to the left and right.

The **Size** of an **Outline** can be 1 to 5, with 5 being the thickest **Outline** possible.

The **Shadow** option creates a shadow in the shape of your layer that appears along the bottom and right edges of the layer. Just like with **Colorize** and **Outline**, you can change the color of your **Shadow** to whatever you want to use.

The **Opacity** of the **Drop Shadow** works just like **Opacity** for your layers. The more **Opacity** you add, the darker and more solid your shadow will be. Less **Opacity** causes the shadow to become more transparent.
Layer Effects

So far in this chapter, all of the options have addressed how your layers look in your slides. The Effects options determine what your layers will do as the slide plays.

Effects will be covered in much more detail in Chapters 15 and 17. For now, let’s take a look at what the effects options are and get familiar with the tools you’ll be using to bring your layers to life.

In ProShow, there are two different types of Effects: You can apply Motion, or you can make Adjustments. You’ll find these options under the Effects tab in Slide Options.

Motion

Just beneath the Preview are the Motion effects. These options allow you to control how your layers move around the slide frame as the slide plays. From here you can configure the Pan, Zoom, Tilt and Rotation for a layer.
• **Pan** controls the left and right or up and down movement of a layer.

• The **Curve** value affects your **Pan** as your layer moves between multiple keyframe points in your slide. The default setting of 50% typically gives you the best feeling of natural, organic movement.

• **Zoom X** and **Zoom Y** adjust the zoom level of a layer. These two are usually locked together. However, you can adjust the X (horizontal and Y (vertical) zooms separately by clicking the lock/unlock icon in between these two sliders.

• **Vertical Tilt** is one of the options to control the perspective tilt of a layer. Moving the slider to the right creates a positive tilt. This will cause an layer to essentially lean forward. Moving the slider to the left creates a negative tilt. This will cause an layer to appear as if it's leaning backward.
• **Horizontal Tilt** is the second perspective tilt option for a layer. Moving the slider to the right creates a positive tilt. This will make the right side of a layer appear to be closer to you as the left side appears to get smaller as you look toward the center of the slide frame. Moving the slider to the left creates a negative tilt. This will make the left side of a layer appear closer and the right side more "off in the distance".

• **Rotate** allows you to rotate a layer. Unlike the Rotate option in Layer Settings that only allows you to rotate in 90 degree increments, here you have much more control over the rotation value. Use the slider, the rotation anchors in the Preview, or type in a number between 0 and 360. Negative numbers will rotate to the left, positive number to the right.

• The **Rotation Center** value allows you to set the point on which your layer will rotate or tilt. By default, this is set to 0 x 0, which is the middle of the layer.
Motion effects can also be used to control the volume of your show Soundtrack. When adding a new motion effect, simply adjust the slider to raise or lower the master volume of your soundtrack.

Effects than combine motion and volume changes are covered in more detail in Chapter 17, Keyframing.

Adjustments

Most of the options you'll find in the Adjustments pane are the same options that you have under the Adjustments tab. You can Blur, Sharpen, Colorize or adjust the Opacity, Brightness, White Point, Black Point, Contrast, Hue or Saturation for any layer in your slide.

The key thing to remember is that adjustment changes made in the Adjustments pane under the Effects tab affect the layer over the duration of a slide.
Applying Effects

Changing the effects options is a very straightforward process. However, for beginners, making the actual effects can sometimes take a little getting used to.

Let’s create a simple adjustment effect to see how effects work and get you used to using the Preview to create effects.

In this example, let’s take a regular color photo and turn it into a black and white image.

Create a Color to Black & White Adjustment Effect

1. Create a new slide with one image layer. Any color image will do.
2. Double-click on that slide to open the Slide Options
3. Select the layer in the Layer's List and click on the Effects tab at the top of the window.

Right away you’ll notice that the Effects Preview is slightly different than other preview windows in Slide Options.

In the middle of the window, you'll see a large preview. To the right of the large preview, you'll see a smaller preview. You'll use both of these previews to create the effect.
Each of the previews you see represents a different point of time within the slide. In this example, one preview represents how the slide will begin (the Starting Position), the other represents how the slide will end (the Ending Position).

As you click on each preview, you'll see a text indicator at the top of the preview that lets you know what point you have selected within the slide.

Below the preview, you'll also see a blue selection bar above a timeline. The timeline shows you the total time for the slide including transitions. The selection bar shows you the where your selected point in time is within your slide.

When a preview is selected, any changes to the **Motion** or **Adjustment** settings will be applied to that point of time within the slide.

For this example, we want to turn a color photo into a black and white image. To make that happen, we need to colorize the Ending Position of the slide.
4. Click on the smaller preview labeled **Next**, just to the right of the larger image. This will select the Ending Position of the slide and toggle the image so that the Ending Position is now active in the large preview. ProShow does this to help you identify which part of a slide you are editing, as well as to give you more room to create and see your effects.

If you have been clicking around during these steps, you may not see a small preview on the right, it may be on the left. That's ok. This just means you're a step ahead. To verify that you are in the right place, look at the text indicator above the preview, it should read "Ending Position"

5. With the Ending Position selected, go to the **Adjustments** pane below the **Preview** and check the **Colorize** box.

6. **Set** your color to gray.

7. At the bottom of the **Slide Options** window, press the **Play** icon to see the effect.

When the slide begins, your image will be in color. As the slide plays, the **Adjustment Effect** will gradually turn it into a black and white image.
Layers and Transparency

ProShow has full support for any image formats that contain transparency. Specifically, images which have alpha channel transparency, which is the most common form.

There are quite a few image formats that support transparency. Some of the most common are PSD, TIF, PNG, and TGA files. Feel free to use any images you’ve got which have transparency in them. They can be useful to make slides more interesting.

When working with these kinds of files, there is nothing special that you need to do in order for the transparency to appear. If the transparency appears in the image, it will appear in your slide. Keep in mind that sometimes you may not notice the transparency right away. For example, if you’re using a background that blends well with the transparent areas of the image, it might take a second look to notice.

Using Transparency in Slides

There’s a wide range of uses for image transparency in your slides. One of the most common is in the creation of borders or frames.

A border is most commonly made as a simple image with a transparent rectangle or square cut out of the center of it, making it look something like an everyday picture frame. These borders can make great accents to other layers you have on your slides. Just add the border as your topmost layer and position the images you want to appear inside the border beneath it.

Transparency also works well with Transparency masking. This form of masking is almost like working with stencils and so it lends itself very well to being used with images that contain some transparency. If you’re interested in learning more about masking you can find that in Chapter 16.
Gradient and Solid Color Layers

In addition to the files you drag and drop onto a slide, ProShow also gives you the ability to create two kinds of layers inside the program without needing an external image editor.

These types of layers are:

- **Gradients**, which are layers that have a blend of color or value.
- **Solid Color** layers, which are layers of one flat, uniform color.

These layers can be used on their own as artistic accents or as additions to your slide. Both of these kinds of layers are also used very frequently when working with **Masking** and **Adjustment Layers**

Let’s start with **Solid Color** layers since they’re very easy to make.

To Create a Solid Color Layer

1. Open the Slide Options for any slide and go to the Layers List.
2. In the Layers List Tools, click on the Add (+) icon.
3. Choose Add Solid Color from the menu that appears.

The **Solid Color Layer** window will appear. This window is used to configure the settings for your new **Solid Color** layer.

4. Change the color for your layer by clicking on the Set button next to the Color option. Use the Color Picker to make your color choice and click on Set Color.
5. Adjust the Opacity to the value you want to use for the layer.
6. Specify a Resolution, in pixels, for your new layer and click Ok.
Opacity Note: The Opacity you set for your Solid Color layer will become the base Opacity for that layer. Meaning that if you choose something very see-thru when you create the layer, that’s how the layer will normally appear in your slide. If you were to go to your Adjustments tab, you’d see that "100%" for that layer would be very see-thru as that’s how the layer was created.

In most cases you’ll probably prefer to leave the Opacity at 100% in step 6, and change the opacity of the color layer using the Layer Settings options.

Resolution Note: The Resolution value of a new Solid Color layer is set to match the aspect ratio of your slide and fill the frame of your slide. For a widescreen show, the new layer will be set to 1280 pixels wide by 720 pixels tall. For a standard show, the layer will be 960x720. If you’d like to make custom sized solid color layer, simply enter your desired dimensions.

Editing Solid Color Layers

A Solid Color layer is just like any other layer you add to your slide except that it doesn’t have an image in it. You can still apply all of the Layer Settings and Adjustments to it as you would with any other layer.

If you decide that you want to change the Color, Opacity, or Resolution of a Solid Color layer after you’ve created it, this can be done by using the Layer List Menu to editing the layer.

To Edit a Solid Color Layer

1. Right-click on the Solid Color in the Layers List.

2. Click on the Edit Layer entry in the menu that appears.

3. Select Solid Color Options in the fly-out menu that opens.
This takes you back to the **Solid Color Layer** window. From here you can change any of the base settings for your **Solid Color** layer. The changes are applied immediately when you click on **Ok**.

Creating a **Gradient** isn't any more difficult than making a **Solid Color** layer, but there are a few extra steps involved. Because **Gradients** can be fully customized to suit your preference in look and color, there are quite a few more options to control them.

**To Create a Gradient Layer**

1. Open the **Slide Options** for any slide and go to the **Layers List**.

2. In the **Layers List Tools**, click on the **Add (+) icon**.

3. Choose **Add Gradient** from the menu that appears.

This will open the **Gradient** window. This window has all of the tools you'll need to customize your own **Gradient** layer.
4. Begin in the upper-left with the Presets dropdown list. Choose a color Preset that is close to what you want to use.

5. Next, choose your Gradient Type. These types will determine the shape of your gradient.

6. In the Gradient Setting area, choose the Resolution, and customize the Position and Angle of your gradient.

7. Select the Color you want to use by clicking on Set next to the Color option.

8. Adjust the color bands of your Gradient by moving the Color Stays left and right in the Color Bar.

9. Adjust the Opacity as desired.

10. Click on Ok when finished.

Customizing a Gradient

As you can see there are quite a few options available to you when creating a gradient. Let’s break down what each of the options allows you to do.

- **Presets** gives you a dropdown list of all the basic settings you can choose when you’re setting up a Gradient.

  Presets are designed to quickly help you choose color types that you want to use. Metals, for example, will give you a variety of metallic colors to start with.
- **Gradient Type** controls the shape and variety of gradient that you’re making. Use this option to configure what kind of shape is used to make a change from one color to another.

  o **Linear** is the standard gradient that most of us are used to seeing. It’s a straight line that slowly changes from one color to another.

  o **Radial** changes color in a circle. The inner circle is one color and, as you move further toward the edges of the layer, the color changes.

  o **Angular** is a gradual wipe from one color to another. Almost like a radar screen – the Angular option will be one color starting at the angle you select and change colors as the angle changes around the layer.

  o **Rectangular** is very similar to a circle. The rectangle in the center of the layer is one color which changes as you move further toward the edges of the layer.

  o **Diamond** is yet another shaped gradient. The Diamond shape in the center of the layer is the base color which changes as you approach the edges.

  o **Plasma** is the most unique of the gradients. Plasma will generate 'cloud like' color changes in a random pattern of blobs throughout the layer. You can change the random pattern of the Plasma by clicking on the Seed button in the Gradient Settings pane. You can give your seed a specific numerical value or use the Randomize button.
Once you’ve selected your Presets and Type options, you need to choose the basic gradient look that you want to use or modify. You’ll find these basic looks just below the Presets area.

Sometimes, you will you’ll find a preset gradient that works great as-is, and doesn’t require any changes. Other times, you might pick something close, and then customize it using the options in the window.

There’s no ‘correct’ option to choose. It’s simply a matter of picking the basic look that matches what you want to see on your slide.

**Customizing Gradient Colors**

When the preset samples aren’t exactly what you need for your slide, you can customize them by changing the Colors.

Within the Colors pane you’ll see the Colors Bar. This bar has two markers on either side, called Color Stays. These Color Stays tell the gradient how to change from one color to the next.

Let’s create sample gradient to see how this works. Begin by defining the Presets and Type for the gradient. Set the Preset to Simple and the Type to Linear.

From the Gradient Samples area, select the option that looks like a gray box.
The gradient should appear in the preview window as nice and smooth blend of white on the left to black on the right.

Click on the right Color Stay and drag it to the left. You’ll see that this creates a new Color Stay which is black as well. As you drag this new one to the left, it adds more black coloration into the Color Bar -which you'll see in the Gradient Preview.

Each Color Stay is configured individually. You can set the Opacity and Position for each Color Stay you have in your gradient. Try changing the black Color Stay you created to 50% Opacity. You’ll see that a range of the black coloration around that Color Stay becomes partially transparent.

The Position value is where that Color Stay is placed on the Color Bar. The total range of the Color Bar is from 0 to 100. If you wanted a Color Stay to be right in the middle of the Color Bar, set it to 50.

If you decide that you don’t like a Color Stay that you have adjusted, you can delete it by clicking on the Remove (-) icon above the Color Bar, or by right-clicking on the Color Stay.

The Colorspace option is available if you have a preference for the type of colors you use in your gradient. HSV is the default value, which stands for
Hue, Saturation, and Value. It’s a more accurate display of color changes. RGB, which stands for Red, Green, Blue, is your other option. This is the more traditional method of displaying colors on a monitor. All you need to do is pick the one that you think looks the best – though HSV is considered the more modern and ‘correct’ version.

Gradient Settings

When you add a gradient layer, by default the layer will be created so that it fills the frame of your slide and matches the aspect ratio of your show. If the default size doesn't suit your needs, try adjusting the Resolution. Simply type in the pixel dimensions that work best for your slide. Set the width on the left and the height on the right.

In the Gradient Settings pane. You may see that the Position, Seed or Angle options are grayed out. This is because they are only available when you select certain types of gradients.

With Linear and Angular gradients, you can set the Angle. Angle is the direction the line of your gradient is oriented. This can be changed by clicking on the Angle value and dragging the slider left or right. You can also change the Angle by clicking and dragging the mouse cursor in the Gradient Preview window, or by typing in a value.
If you set your **Type** to **Radial, Angular Rectangular or Diamond-shaped**, the **Position** option becomes available. The **Position** option controls where the shape of your gradient will appear on the layer. The **Position** values are set by the center point of your shape. By default, the Position is set to **50 x 50**, which puts the center of your shape exactly in the center of your slide frame.

The **Position** values here are very similar to the grid you use to place your layers on your slide frame. In this case, though, the center point of the layer is 50 x 50. That means that the X axis has a range from 0 to 100, left to right. The Y axis has a range of 0 to 100, top to bottom.

As an example, a **Position** of 0 x 100 would put the center point of the shape all the way to the left (0) and all the way to the bottom (100).

Of course, you can also click and drag in the **Gradient Preview** window to adjust the position visually if you prefer.

The final option in **Gradient Settings** is **Seed**. This option is only available when you set your **Type** to **Plasma**.

You’ll notice that **Plasma** can’t change **Position** or **Angle**. Instead, **Plasma** is changed either by clicking the **Randomize** button, or by typing in a seed value. When you select **Randomize**, this will generate a new random pattern for your gradient. You can control the number of color changes in the **Plasma** type by adding more **Color Stays**.

Once you have your gradient customized to suit your preferences, click on **Ok** and it will be added to your **Layers List** immediately.

If you want to save your customized gradient as a new preset, you can add it by clicking on the **Add (+)** icon next to **Presets** at the top of the window. This will add your gradient to the presets already listed, making it available any time you use the program. Gradients that you add are saved in the application data folder so that they do not get lost when you upgrade or reinstall ProShow.
9. Video Layers

Slideshows Aren’t Just for Images

Photo/Video Fusion or Hybrid Photography are buzz terms for an extremely popular visual media trend that can be seen just about everywhere these days. The basic concept is to blend traditional photography with videography in order to create slideshow/video hybrids. The final product combines the high quality of still images with the life and action that video can provide. Basically, it’s making a show that features the best of both worlds.

This concept is nothing to be scared of. In fact, these kinds of shows are quite easy to make. As you read in the previous chapter, ProShow works with layers and layers are interchangeable. It doesn’t matter if a layer is an image or a video, ProShow works the same way. The tools you use to work with your images are the same tools you use to include video in your shows.

Here’s the fundamental rule to remember about videos:

- ProShow treats video in your show like any other layer. You can move it, change it, apply edits to it, and use all other effects like you would with any other layer (save just a select few).

Understanding this rule makes it much easier to work with video in your show. Remember that ProShow really only cares about layers. It doesn’t matter what’s in that layer – image or video.

Since ProShow treats video just like other content, you can do some pretty creative things. You can apply motion or adjustment effects to video. You can have multiple videos visible at the same time. You can use video as a mask (see Chapter 16 for information about Masking). You can even use video with Slide Styles.
Working with Video

Layers are just layers, so you can think of a video as an image layer that does a little something extra. While that layer is present on the slide, the video will play.

When we talk about video in ProShow, we’re also talking about animations. ProShow supports animations like animated GIF files that are found all over the Web and in many clip-art packages. Everything you see here about working with video also applies to animations.

Adding video to your show uses the exact same method you already use to add images.

To Add Video to a Show

1. Use the Folder List to open a folder which contains your video.
2. Select the video in the File List.
3. Drag & drop the video into the Slide List to create a new slide.

You can also use the same keyboard shortcuts to add video to existing slides. For example, hold CTRL on the keyboard and drag the video to a slide to add it as a layer to that slide.

Using Video Files

ProShow will directly import almost all video files you want to use in your show. It’s a simple process of dragging and dropping the video into your show and letting ProShow do the rest.

There are some cases where you may want to use an alternative method for importing video files. If that’s the case, you can find a more detailed explanation of codecs and how video files work in Chapter 20.
Importing Video Files

Unlike images, ProShow must import video files that you use in your show so that they can be easily worked with.

This process can take different amounts of time based on how large your video clips are. Once you’ve added the video to the show you can see the import progress displayed on the Task Monitor.

Customizing Video in your Show

Video files have a dedicated section of the Slide Options window which you can use to control how the video is played, make clips, adjust the volume, and more.

To Access the Video Settings

1. Open the Slide Options for a slide which contains video.

2. In the Layers List, select the layer that contains the video clip, and go to the Layer Settings tab.

3. The Video Clip Settings will be on the bottom right side, just above the Ok button.

Note: If you do not have a video layer selected, the Video Clip Settings pane will be hidden.
Using the Video Clip Settings

The options in the Video Clip Settings area allow you to trim your video clip, adjust audio settings and make changes that affect your slide timing.

Let’s begin with options that affect your slide.

Adjusting Video Clip Settings

It’s important to remember that videos play for a set period of time based on how long that video is. This is not part of your Slide Time. If your Slide Time is longer than the video, your video might stop before the slide ends. If the Slide Time is shorter than your video, the slide will end before the whole video can be displayed.

Let’s review the settings that affect Slide Time:

- The Length value shows you how long your video clip is, in total. This is so you know exactly how much time that video will take if you want to view the whole thing. When you create a new slide using a video file the Slide Time will default to the same value as your video. Remember, total Slide Time also includes Transitions.

- Looping causes the video to play on repeat until the slide comes to an end. This can be a quick and easy way to make sure your video plays for the whole slide if your slide is longer than the video. Just check the box to turn on Looping. You’ll find this very handy when using video layers as backgrounds.

- The Slide Time checkbox lets you lock the time of your slide to the length of the video. If you never want the Slide Time to change beyond what is required to exactly match the video, check this option.

- The Speed option changes the rate at which the video is played. This can make the video seem faster or slower. It’s important to remember that changing the speed of a video will disable the video’s sound to prevent it from being distorted.
You also have 3 buttons in the **Video Clip Settings** pane. These are used to further customize how your video will appear within the slide.

- **Trim** button opens the **Trim Video** window, which we’ll cover in more detail in a moment. The **Trim Video** window is used to make shorter clips from your videos when you have longer video clips but only want to feature smaller portions in your slideshow.

- **Preview** button plays the video file and shows you how it will look based on the changes you have made to it so far.

- **Sync Time** will change the time of the slide to match the length of your video. This option is useful if you want to make sure the **Slide Time** and video time match, but don’t want to lock the times together.

If your video clips have audio, you’ll also find some **Volume** control options in this pane. Using the slider, you can mute the volume by moving the marker all the way to the left, or boost the volume to 200% by moving to the right. Additionally, you can adjust the **Fade In** and **Fade Out** times for the audio within your video clips.

You also have the option to override the default show settings for Soundtrack volume when ProShow detects audio within a video clip. This can come in handy when you don't need a change in the Soundtrack volume to hear the audio in your video clip. You can learn more about controlling the music and sounds in your show in Chapter 12.

---

**Customizing Videos with the Video Trimmer**

The **Video Trimmer** is an excellent tool to use when you have long video clips, but you only want to feature a small portion of the video in your slideshow.

Let’s say you have a video of a family member getting married. The video includes the walk down the aisle, the kiss, and the departure from the ceremony.
Now if you only want to include the kiss in this part of your show. You can use the Video Trimmer to cut the video down to just that section and include it on the slide.

Just like with all editing in ProShow, the trimming a video is a non-destructive edit. Your original video file will not be changed in anyway. You’re simply telling ProShow which parts of the original video you want to use.

**To Access the Video Trimmer:**

1. Open the Slide Options for a slide which contains video.
2. In the Layers List, select the layer that contains the video clip, and go to the Layer Settings tab.
3. In the Video Clip Settings area, click the Trim button.

The Trim Video Clip window gives you access to quite a bit of information at once.

At the top of the window you'll see the Video Timeline. The timeline shows you still frames from different points within the video. It also shows you an audio waveform for any sound in the video.
Along the top, you'll find the video length. Just below the audio waveform is a slider bar that you can use to move to different points in the clip.

Using the Video Timeline, you can visually pick just the part of the video that you want to include in your slide.

Below the Video Timeline, you'll find three preview panes. All the way to the left is the Preview window. Use the playback controls to preview the changes you've made. If you want to reset the video to the original state, simply press the Reset icon.

Just beneath the preview you will also find time and frame information.

This information will update as you move your mouse over the Video Timeline. You'll find this very useful when making precision edits.

In the Start Frame and End Frame windows, you will see the exact frame and time where the video will begin and end. You can select these points using the Video Timeline, or by typing in time values. The back and forth arrows below the Start and End Frame previews also make it easy to advance one frame at a time in either direction.
At the very bottom of the **Trim Video Clip** window you'll find the **Zoom** slider. When you need to make precision edits, you'll use this to "zoom in" on the timeline to see smaller increments of time, right down to individual frames of the video. You can also control the Zoom using the scroll wheel on your mouse.

The last bits of information you'll find in the **Trim Video Clip** window are details about video file you are working with. The file location, the original video length and the trimmed video length can all be seen in the lower left corner.

**Picking Just the Clip you Want**

The **Video Trimmer** is designed to make using just the right part of your video as easy as possible.

Begin by finding the area in the video where you want the trimmed down clip to begin playing. You can do this by moving the mouse cursor across the **Video Timeline**. Notice that the **Preview** window updates to show you exactly what you'll see at that point in the video.
Once you’ve found where you want your video to start, go ahead and click in the Video Timeline. This will place a marker in the spot where you clicked.

In the Start Frame preview, click the Set Start Time icon. This will move the starting position of the video clip to the marker you set in the timeline.

Now do the same thing for the End Frame. Move the mouse across the Video Timeline to find where you want to stop the video. Once you’ve found that point, click to place a marker and click on the click the Set End Time icon.

The highlighted region between the two markers is your clip. You can see how the clip looks by clicking on the Play button. If the clip looks good, click on Ok to apply your changes.

You can also trim your clip by clicking and dragging the start and end time flags. The amount of the video in between those flags will be the trimmed clip.
Making a Clip with Precision

For quick edits, you'll probably find typing in values for the **Start Frame** and **End Frame** to be very useful. Have a 30 second clip, but only need 5 seconds of it? Just type in 10 and 15 then press ok. Your clip has now been trimmed to 5 seconds long.

When you may need to be extremely precise with your edits, as mentioned previously, there are several areas in the **Trim Video Clip** window that help you determine very specific points in time.

With the **Zoom** slider, you can stretch out what you see in the **Video Timeline** to show your clip in time increments as small as 1/10th of a second. As you hover over the timeline, you'll be able to see each individual frame of the video in the **Preview**.

When you find the right spot, set your marker, or go ahead and enter the value in the **Start** and **End Frame**. For extreme precision, as you type in 10ths or 100ths of a second values, you'll even see the number of the frame change as well.

**Note:** like the other editing features in ProShow, creating a clip of your video will not change or alter the source video in any way. Making your own clips is a completely **non-destructive** process. It doesn't save changes to the original video so you're free to be as creative as you wish.

Using Clips of the Same Video

So what happens when you have one long video and you want to use several different trimmed clips from that video in your show?

Not a problem! Simply go back to your **Slide List** and re-add the same, original video as a new slide in your show. The process is exactly the same as making the first trimmed clip. You’re simply creating a new clip that features a different section of the original video.
10. Captions

Creating and Working with Captions

When you use text in ProShow, you are either creating Captions or Text Layers—and in some cases, both. In this chapter we'll be focusing on using Captions, but keep in mind that most of the features you'll learn also apply to using Text Layers.

So why use captions in a show? For many, the answer is ‘to share basic information’. For example, making a title slide to begin your show, or adding a credits slide at the end. Others use captions to display the name of a person or location as an image appears on screen.

These basic uses are nice, however captions become much more interesting when you consider using them creatively as a part of your visual storytelling. That type of integration requires knowing how to create and manage your captions while also understanding how these tools can be used creatively.

We will cover both how to create and use captions, as well as how to use them with some creative suggestions, in this chapter.

Captions Start as Text

It’s helpful to think of captions in the same way you think of text in a word processor. You still type your caption into ProShow, choose a font, color, and size. The only departure comes when you choose where you want your caption to appear on the slide and how you want it to behave.

This means that coming up with how you want your caption to look is just the same as if you were creating some text for a document. Type it in and set up the visuals. From there, you place your caption on the slide just as you would with a layer – drag and arrange it.
Let’s begin by learning how to use the caption tools to create a fully customized introduction caption. This is something that you’re likely to use often since almost all slideshows have an introduction in them.

As you create this example, you will also learn how each value works and what it is used for.

Creating a Title Slide

For this example we’re going to work with a completely blank slide. Rather than work images into the equation, we’ll stick exclusively with a caption. This example combines some caption customization and caption effects to get a strong introduction sequence.

How to Create a Title Slide

1. Right-click at the beginning of your Slide List and select Insert > Title Slide in the sub-menu that appears.

   OR...

   Click the Add Title icon in the Build or Design Workspace Toolbar.

Creating a title slide is a great way to quickly get started if you’re only working with captions. Selecting this option creates a slide with no images on it and takes you automatically to the Caption Settings for that new slide.

2. Begin typing your caption in the Select Caption Text field, which appears just to the right of the Preview.

When you have no captions on a slide, simply typing into the text field will create the new caption. Once a single caption is added, you’ll need to use the Add (+) button in the Captions List pane to create additional captions on the slide.
3. Type “Learning Slideshows” into the **Selected Caption Text** field. Your new caption will appear in the **Captions List** on the left side of the **Preview**.

![Captions List](image)

The **Captions List** is very similar to the **Layers List**. Your captions are shown in the order they stack with one another. The first caption is above the rest, just like layers.

**Note:** captions are always on top of layers. No matter how you position your layers, captions will always appear above them. You can think of the two as separate stacks. The captions are always the top stack, ordered as the captions appear in the list. The layers are beneath the captions stack, appearing in their own order. If you want to have text positioned behind layers in a slide, you'll need to convert your caption to a **Text Layer**-which is covered in greater detail in the next chapter.

4. In the **Caption Format** area, select a **Font** from the dropdown list. For this example, let's choose ‘Impact’ as your font choice.

ProShow can use all TrueType (.ttf) and Open Type (.otf) fonts that you have installed on your PC. ProShow automatically checks to see which supported fonts have been installed in Windows. If you have a collection of fonts that you use for other programs, these will also be available for use in ProShow.

5. Select the **Case** for your text from the dropdown list. You can leave your text exactly as you typed it, or convert all characters in your text to Upper or Lower case.

6. Click on the **Size** dropdown list and choose 36.
ProShow uses the default available point sizes for your installed fonts. This doesn’t mean that you can’t use other sizes, though. If you click on the **Size** field, you can type any value you want to use. This means you can always get a size that works for you.

7. Try enabling either Bold, Italic, or both, by clicking on the **B** and **I** which appear at the bottom of the **Captions Format** area.

Bold and Italic settings can be used with any caption you create to make the message stand out. They work just as you’ve come to expect when using them in a word processor.

8. Click on the **Set** button for the **Color** value. Change your color selection to whatever you prefer.

Caption colors can be adjusted to any value you want to use. You can even use the **Eyedropper** tool to choose colors from your slide or images. This makes it easy to color coordinate your captions and layers.

At this point, you have a complete caption. The text is in place and the appearance has been customized. From here we’re going to adjust the alignment of the caption and give it some effects to complete the first part of the introduction.
Precisely Positioning Captions

Setting the position of your caption, and understanding how that position is calculated is very helpful when creating precise and well ordered captions.

1. In the **Caption Placement** pane, change the **Alignment** value of your sample text to **Centered**, which is the second-to-left option.

![Caption Placement](image)

The **Alignment** options are exactly like what you would find in a word processor. The default alignment, left, is what you see in a book like this. Centered text is often used for titles, and helps center multiple lines of text. Right aligned is the next option, which isn’t used that often in print. Finally, Fill aligned text creates a solid block, but can result in some strange spaces between letters and words to achieve the effect. You often see fully justified text in newspapers and magazine articles.

The alignment of your caption determines where ProShow calculates the center point of the caption. The center point of your caption is used to determine where your caption is placed in the slide frame.

- **Left** aligned text places the center point in the middle of the left-most character.
- **Center** and **Fill** place the center point right in the middle of the caption.
- **Right** alignment places the center point on the right edge,

2. If your caption is not already in the middle of your slide, set the **Position** to 50 x 50. This will place it perfectly in the center.
The point that ProShow uses to position your caption is based on the **Alignment** value that you choose.

The **Position** value is similar to the one used for layers, only it uses a slightly different grid.

The position grid for layers uses values traveling from -50, to 0, to 50 as you move from left to right or from top to bottom. The caption grid doesn’t use negative numbers. Instead, the caption grid is from 0 to 100 from left to right, or from top to bottom.
Using Caption Behaviors

Now that you’ve adjusted the caption’s location on the slide, let’s change one final piece – the **Caption Behaviors**.

**Caption Behaviors** are pre-made effects that can be used to enhance the way your captions look. **Caption Behaviors** are separate from the other types of effects that you learned about in Chapter 7,

Each caption has three behaviors that can be configured.

- **Fly In** determines how the caption will first appear on your slide
- **Normal** defines what your caption does as the slide plays
- **Fly Out** tells the caption what do to as the slide ends

In a way, you can think of **Caption Behaviors** as transitions for your captions.

Let’s set the **Caption Behaviors** for the sample caption to see how these affect your text.

1. With your caption selected in the **Captions List**, click the **Effects** tab located above the **Preview**.

   Beneath the **Preview**, you’ll find the text effect options in the **Caption Behaviors** area.
The **Fly In** effect is used when your slide starts. By default, your caption will appear at the very beginning of your slide. The way it appears is determined by the **Fly In** effect you choose.

2. In the **Caption Behaviors** area, click the **Browse** button next to **Fly In**. The **Choose Caption Behaviors** window will appear.

3. On the left, you will see a full list of all available **Fly In** effects. Select **Pan Right** from the list. In the Preview, you’ll see how this behavior will affect your text. Click on **Apply**.

4. The **Pan Right** effect will now appear in the **Fly In** dropdown list.

Once you become comfortable with what each of the effects does, you can quickly select them from the dropdown list without clicking on the **Browse** button.
To complete this example:

5. Click on the **Browse** button for the **Normal** effect.

The **Normal** effect is an effect that is used while your slide is playing. This is what the caption will do after it has appeared on the slide using the **Fly In** effect, but before it leaves the slide in the **Fly Out** effect.

6. Scroll through the list of effects and select **Slide Right**. Click on **Apply**.

7. **Slide Right** should now appear in the **Normal** dropdown list.

Now let's set the behavior for what the caption will do as the slide ends by choosing the **Fly Out** effect.

8. Click on the **Browse** button for the **Fly Out** effect.

9. Locate the **Pan Right** effect and click on **Apply**.

At the bottom of the **Slide Options** window, click on the **Play** icon to preview your slide.

You should see the caption pan in from the left side of the slide, continue to slowly slide to the right, and finally pan out of the right side of the slide frame. All of this is being done for you by the **Caption Behaviors**

**Fly In** causes your caption to pan to the right, as you chose. The **Normal** effect picks up right after the **Fly In** effect is complete, causing the caption to continue to slide to the right. Finally, the **Fly Out** effect starts at the end of the slide, panning your caption off of the right edge of the slide frame.
Caption Behaviors Tip:

- Using the Choose Caption Behaviors window, you can set all three behaviors before applying your changes. Simply use the dropdown box that appears above the effects list to cycle through the behaviors.

- You can also preview how all three behaviors will perform using the Choose Caption Behaviors window. At the bottom of the window, check the option box to show the Fly in, Normal and Fly behaviors combined.

- You can reset Caption Behaviors individually by right-clicking on either the drop-down list, or the browse button for each type. To reset all of the behaviors at once, use the Reset icon in the top right corner of the Caption Behaviors pane.

Caption Styles

If you like to use a consistent look for your captions that you include in your shows, you may find Caption Styles to be useful.

Styles for captions are a bit different from Slide Styles, though they are both designed to help you save time. A Caption Style is simply a saved appearance for a caption.

Creating a Caption Style saves all of the information about that caption, from font type and size to color or texture. This makes it easy to use certain captions that you find yourself using often in your shows.
How to Access Caption Styles

1. With your caption selected in the Captions List, click the Caption Settings tab located above the Preview.

2. On the right, locate the Caption Format pane and click the Styles button.

The Caption Styles window shows you a list of the caption styles you can apply to your text. On the left, you’ll find a list of all available styles, including several styles that are built in to ProShow.

You’ll also use this window to manage caption styles or create your own.

To Apply a Caption Style

1. Create a caption on your slide.

2. In the Caption Format area, choose a style from the dropdown. The caption style will instantly be applied or

   1. Create a caption on your slide.

   2. In the Caption Format area, click on the Styles button.

   3. Select your desired style and press Ok.

Using caption styles is a great way to save time and avoid the repetition of setting all of the options for each caption that you add to a new slide or show.
To Create New Caption Styles

1. Create a complete caption with all of the settings you want to preserve. This is primarily the font, size, color, and alignment.

2. Click on the Styles button to open the Caption Styles window.

3. In the New Style area, click the Add New Style button.

4. In the Add a New Caption Style window, enter a name for the new style, and select the Style Settings that you want to associate with the new caption style.

5. Click on Add to create the new caption style.

Your new caption style will appear in the list. At any time, you can use that style with a new caption, even in a new show, to quickly have the same settings.
How to Update Existing Caption Styles

1. Create a new caption and arrange the look of the caption to what you want to use in the updated style.

2. Click on the Styles button.

3. Select the style you want to update in the caption styles list.

4. In the Selected Style area, click the Update button.

   [Image of Selected Style dialog box]

   OR

1. Create a new caption and select the existing style you want to update in the Style dropdown list.

2. Make changes to that style to suit your new preference.

3. Click on the Styles button.

4. Select the style you want to update in the caption styles list.

5. Click on Update.

Caption styles can be quickly updated to something more current or useful using this method. This will help ensure that all of your styles are beneficial to you. If you no longer need a style, simply delete it from your list.
To Delete a Caption Style

1. Click on the Styles button in the Caption Format area.
2. Select the style you want to delete in the caption styles list.
3. Click on Delete.

Caption styles you add are saved in your computer’s application data folder so that they will not be lost if you upgrade or reinstall ProShow.

Caption Enhancements

Under the Caption Setting tab, there are two settings that you can use to enhance the look of your captions: Outline and Shadow. Both are great for adding depth and helping captions stand out when placed directly over image layers.

As with layers, you can add an Outline or Shadow of any color.

To Apply an Outline or Shadow to a Caption

1. At the bottom of the Caption Placement pane, toggle on or off the options for each caption in your slide.
2. For each option, click the Set button and choose a color for your Outline or Shadow.
The Captions List

As you saw in the example above, the Captions List shows the captions you’ve applied to your slide. From the Captions List, you can add and remove captions, select which caption you are working on, and more.

Just like the Layers List, there are several buttons along the top. Add (+) will insert a new, blank caption. Remove (-) deletes the selected caption.

Your captions are stacked one on top of one another and numbered in the list, just like your layers. You can change the order of your captions by clicking on the Up or Down arrows.

The Captions List Menu button on the right of the toolbar opens a menu which provides several options for adding, removing, copying, duplicating, moving and as well converting captions to text layers. You can also right-click on any caption in the list to access these options.

Each caption displayed in the list is shown in the font you’ve applied to that caption, with the bold and italic options applied as you’ve set them. This makes it easier to match the items in the list with what you’re seeing in the preview. Captions will be displayed using the first line of text that is not blank. Captions containing multiple lines, or captions that are too long to fit entirely in the list will have ellipsis at the end.

Again, just like when working with layers, on the right side of the list is a small checkbox, this is the Hide / Show Caption option. When checked, the caption is visible. When unchecked, the caption is hidden on this slide. Use this to temporarily turn off captions while you’re working, or to make a Show Caption not appear on a slide.
Caption Setup

Just below the Preview under the Caption Settings tab you'll find the Caption Setup options.

The first option is Show Caption. When checked, your selected caption will appear on every slide in your show. As you add new slides to your show, ProShow will automatically add the Show Caption to the new slide.

Often you'll use a show caption for things like company branding, adding a copyright notice or any piece of information that you always want to have visible in your show, regardless of the images.

If you have a Show Caption but don't want it to appear on specific slides (like a title slide for example), in the Slide Options for those slides, simply uncheck the Hide / Show Caption box in the Captions List.

The second option determines how your captions will behave during transitions between slides.

Let's create a quick example to demonstrate how the Slide Transition option works.

1. Go ahead and add two images to your Slide List and create two new slides.

2. Add a caption on the 2nd slide. Be sure to set all three Caption Behaviors to None.

3. Leave the Slide Transition box unchecked, and click Ok to close Slide Options.

Now play your show and see what happens with your caption. As the second slide begins, your caption will appear very suddenly. Before the
slide ends, your caption will disappear just as abruptly. This happens because the caption is not included in the slide transition effect.

4. Go back to **Slide Options** for the second slide and check the **Slide Transition** box for your caption.

5. Click **Ok** to close **Slide Options**.

When you preview your show again, this time you'll notice that the caption will now transition in or out with the slide instead of "popping" into place.

Advanced users may find this helpful when creating their own effects, but in most cases you'll leave this option unchecked as the **Caption Behaviors** you choose will keep text from coming and going so abruptly.

**Caption Setup Tip:**

- You can copy the Slide Transition option to other captions by right-clicking on the check box.

**Caption Placement**

Under the **Caption Settings** tab, you'll notice that you have quite a few options to help you define your **Caption Placement**. In addition to the **Alignment** and **Position**, you can also have options that affect how your captions will look when placed in the slide. Let's take a look at all of the options and cover exactly what they do.
Opacity

Opacity controls how transparent the caption is. By default, your captions are 100% opaque, which means they’re solid. You can reduce this all the way to 0% by moving the slider to the left. A caption with 0% Opacity is completely transparent, making it invisible.

Skew

Skew angles all of the characters in your caption to the left or right. It’s determined in degrees, since it has some common ground with rotation.

Changing the Skew value causes all of the characters in your caption to lean to the left or right. The values can be anything from -360 degrees to a full 360 degrees. Just as with rotation, a negative Skew value leans the characters to the left, while positive leans them to the right.

Rotate

Rotate behaves identically to layer rotation. Adjusting the Rotate value into the negatives will rotate the entire caption and all characters to the left. Giving the caption a positive Rotate value will turn it to the right. Just as with layers, you can adjust the rotation in the Preview by clicking and dragging one of the anchor points located in the corners of the image.
Character Rotate

This is simply rotation for each character in the caption. Rather than the entire caption rotating around, each character rotates in place. The value ranges and directions of rotation are otherwise the same as other rotation options.

Character Spacing

Character Spacing allows you to set the amount of blank space that appears between each individual character in your caption. By default, your caption will be set to 100%. Adjusting the value to the left will reduce the space between characters, while adjusting it to the right will increase it.

This can be very useful when arranging a caption for artistic use in your slide. In publishing, this adjustment is known as “kerning”.

Line Spacing

Line Spacing does the same job as character spacing, but it spaces out entire lines of text, rather than individual characters. When you have multiple lines of text in your caption, you may find that you want those lines to be closer or further apart, similar to adding double-spacing in a word processor.

Moving the slider to the left will decrease the space between lines, while moving the slider right will increase it. In publishing, this process is called “leading”, pronounced like the metal.

Let’s create an example that demonstrates how these additional Caption Placement options can be used. We’re going to create a caption that reads vertically, rather than horizontally.
Creating a Vertical Caption

You may find at some point that you want a caption to appear on your slide, but the standard horizontal caption won’t do the trick. You need to use some blank space that is vertical.

When this happens, you can always create a caption and adjust it to read vertically by changing some of the Caption Placement values.

To Create a Vertical Caption

1. Create a new Title Slide.
2. Make a new caption that reads “Learning Slideshows”.
3. Change the Font to Georgia and the Size to 11.
4. Set the Alignment to Left Justified and the Position to 0 x 50.

You have now created the base caption and arranged it so that it appears against the left side of the slide frame.
Now we’re going to adjust the caption so that it reads from top to bottom, rather than from left to right.

This is going to call for a combination of caption rotation and character rotation.

5. Change the **Rotate** value to 90 degrees.

6. Change the **Character Rotate** to -90 degrees.

This has rotated the caption to be vertical, and rotated just the characters back to the left so that they’re standing upright. The only remaining problem is that the space between the characters is too small. Thankfully, this can be adjusted, too.

7. Change the **Character Spacing** value to 210%. Alternatively, you can just adjust the slider to the right until the characters are spaced well enough apart to read.
By combining rotation values along with Alignment and Position, you are able to create a vertical caption. You can also set your captions to read from bottom to top, or create diagonal captions in this way.

Caption Effects

Just like working with layers, caption Effects give you the same flexibility to control how your captions look and behave as each slide plays. The Effects options for captions allow you to add Motion, or make Adjustments. You can use these separately or combined with Caption Behaviors.

With a caption selected in the Captions List, click the Effects tab to access all of your options.
Caption Motion & Adjustment Options

Just beneath the Preview you'll find the Caption Motion & Adjustments pane. These options allow you to control how your captions move around the slide frame or change in size/color as the slide plays. Let's review all of the elements you can configure here.

- **Font** controls the size of your text. When creating an effect, think of this like the zoom option for a layer.

- **Color** allows you to adjust color of the caption as the slide plays. For example, you can have a caption begin a slide as red text, but change it to white text by the end of the slide.

- **Position** lets you change the location of the caption. The value on the left is the X (horizontal) value. The value on the right is the Y (vertical) value. You can change the position of a caption by entering values in these boxes, or by clicking and dragging the caption in the Preview.

- The **Curve** value affects your Position as your caption moves around your slide. The default setting of 50% typically gives you the best feeling of natural, organic movement.

- **Rotate, Character Rotate, Skew** and **Opacity** work just as they do in Caption Placement. Use these options to rotate or skew your captions and control their visibility during playback.
Just like when creating motion effects with layers, caption motion effects can also be used to control the volume of your show Soundtrack. When adding a new motion effect, simply adjust the slider to raise or lower the master volume of your soundtrack.

Effects that combine motion and volume changes are covered in more detail in Chapter 17, Keyframing.

## Applying Effects to Captions

As you learned early when working with layers, changing the effects for caption options is an easy process.

Let's create a simple adjustment effect to see how effects work with captions and get you used to using the Preview to create effects.

In this example, let's take a simple caption and have it grow in size and change color during playback.

### Create a Caption Adjustment Effect.

1. In the Build or Design Workspace Toolbar, click on the Add Title icon to create a new title slide. This will open the Slide Options window and place you in the Caption Settings tab.

2. In the Selected Caption Text pane, type the word "slide".

3. In the Caption Format area, choose a bold font that uses large, thick letters. The font Impact font works very well.

4. Set the Color to white and choose a font that is large but not too large. If you’ve selected Impact as your font, try setting the size to 48.

5. In the Caption Placement pane, set the alignment to Center. Be sure your Position is 50 x 50. This should put your caption right in the middle of the slide.

6. Next, click on the Effects tab at the top of the window.
Right away you'll notice that the **Effects Preview** is slightly different than other preview windows in **Slide Options**.

In the middle of the window, you'll see a large preview. To the side of the large preview, you'll see a smaller preview. You'll use both of these previews to create the effect.

Each of the previews you see represents a different point of time within the slide. In this example, one preview represents how the slide will begin (the Starting Position), the other represents how the slide will end (the Ending Position).

As you click on each preview, you'll see a text indicator at the top of the preview that lets you know what point you have selected within the slide.

Below the preview, you'll also see a blue selection bar above a timeline. The timeline shows you the total time for the slide including transitions. The selection bar shows you the where your selected point in time is within your slide.
When a preview is selected, any changes to the **Caption Motion & Adjustment** settings will be applied to that point of time within the slide.

For this example, we want to turn a have the caption grow in size and change color. To make that happen, we need to change the settings in the Ending Position of the slide.

7. Click on the smaller preview, just to the right of the larger preview. This will select the Ending Position of the slide and toggle the window so that the Ending Position is now active in the large preview. ProShow does this to better identify what part of your slide you are editing, as well as providing more room for you to create and see your effects.

If you have been clicking around during these steps, you may not see a small preview on the right, it may be on the left. That's ok. This just means you're a step ahead. To verify that you are in the right place, look at the text indicator above the preview, it should read "Ending Position".
8. With the Ending Position selected, go to the Caption Motion & Adjustment pane and change the Font Size to something larger. If you’re using Impact as your font, try 200.

9. Change the Color to red.

10. At the bottom of the Slide Options window, press the Play icon to see the effect.

When the slide begins, your caption will be white and smaller. As the slide plays, the Adjustment Effect will gradually turn the caption red as it grows in size.

Motion Effects can be applied to your Captions as well. We’ll discuss how to add motion later on in Chapter 15, Motion and Chapter 17, Keyframing.

Using Texture on Captions

Color works well for adding some extra punch to your captions, but when color doesn’t quite do enough, try adding some texture.

Texture is a term in the graphics industry that means a “skin” of sorts. It’s an image that is used to change the appearance of something. In the case of captions, a texture is an image that appears only on the characters in the caption.

This allows you do things like make your caption appear to be made up of an actual image, rather than a solid color. Effectively using an image as a “skin” for the caption.

There are two different kinds of textures you can add to your caption in ProShow: a Gradient texture, or an Image texture. Each of these types can be adjusted in appearance to get just the results you want on a caption.

When working with texture, it's generally best to choose a font with wide characters. The font Impact is a good example.
Adding an Image Texture to a Caption

1. Create a new caption with any text, font, and size you prefer.
2. Click the check box at top of the Use Texture on Caption pane.
3. Select the Image radio button and click on the Browse icon to choose the image you want to use from your system.
4. Click on Select Image File from the menu that appears.
5. Locate the image you want to use as a texture and click on Open.
6. The image will now appear on your caption as a texture.

If you would rather use a Gradient as your texture, you can make that selection instead.

Adding a Gradient Texture to a Caption

1. Create a new caption with any text, font, and size you prefer.
2. Click the check box at top of the Use Texture on Caption pane.
3. Select the Gradient radio button and click on Edit Gradient to adjust the appearance of your gradient.
4. The texture will appear on your caption.

Once you have added a texture to your caption, it may not appear exactly as you would like. Certain looks call for certain texture applications.

---

6 For more information on customizing gradients, see Chapter 8.
Adjusting Textures

You can adjust how the texture appears on the caption by changing both the **Zoom** and the **Scaling** values. Each one has a different impact on how the texture appears.

The **Scaling** option has the most obvious effect on your texture’s appearance. Let’s look at how each option changes the texture.

**Fill Character** causes the texture to appear within each character of the caption. If you use an image texture, you’ll see the same image appear on each character of your caption.

This option works best when your texture is more abstract, creating a regular pattern across your caption.

**Fill Caption** causes the texture to take up the size of the caption. Each character will show a different part of the same single image or gradient.

This option is best when you want to capture the whole texture in the caption, but still want to see most of the details of it.

**Stretch to Frame** will adjust the proportions of your texture to make it fit exactly inside the slide frame. When the proportions of an image are changed you can often see distortion in the image itself.

**Stretch to Caption** is similar to Fill Caption but will adjust the proportions of the texture to fit inside the caption. It’s best to use the **Stretch** options with textures that won’t suffer from distortion such as abstract backgrounds.
The **Zoom** value changes the size of the texture regardless of which **Scaling** option you choose. You can use the **Zoom** value to fine tune the size of your texture to get just the look you want.

There’s no one correct **Zoom** value to use with each **Scaling** type – it’s simply a matter of changing the value a bit to get the results you think look good on the caption.

### Caption Macros

ProShow supports a wide range of text-based macros. These macros will cause certain conditional text to appear in the caption while the slide is displayed.

These macros open all sorts of options for your shows. For example, if you’re creating a show and you want to display the name of each image in the show as it appears, rather than type the name for each image on each slide, you can use a **Show Caption** with a macro. That macro will reference the name of the image and display it for each slide.

There are four kinds of macro options in ProShow: **Symbol, EXIF, IPTC and Predefined**. Depending on the contents of your slide, the macros that are available may vary from slide to slide.

### To Add a Caption Macro

1. Create a new blank caption by clicking the **Add (+)** icon at the top of the **Captions List**.
2. In **Caption Settings**, click the **+ Macro** button located in the **Caption Format** area.
This will open the **Insert Macro** window.

3. In the **Insert Macro** window, chose your **Macro Type** from the dropdown list.

4. Choose your desired macro from the list.

5. If you're only adding one macro, click **Add & Close**. If you want to add more than one macro to a caption layer, select a macro, press **Add** and repeat as often as desired. Press the **Close** button when finished.

When using multiple macros in one layer, keep in mind that you may wish to edit the caption later and add some space in between the macros.

**Symbol Macros**

From time to time you may find yourself needing to insert a text symbol like a copyright or a foreign currency symbol. In these cases, the Symbol Macro option gives you the ability to insert those characters quickly.

**To Insert a Symbol Macro**

1. Open the **Insert Macro** window.

2. Select **Symbol Macro** from the **Macro Types** dropdown list.

3. Locate the symbol you are looking for in the **Value** field.

4. Select that macro and click **Add & Close**.

5. The macro for that symbol will be added and the symbol will appear in your caption.

The available caption macros are of the **Insert Macro** window gives you a wealth of information. The **Caption Macro** heading tells you what the actual macro is for that function.
For example, if you use the copyright symbol often, it can be helpful to know that just typing “\0169” into the caption text will add it.

The Field heading tells you what the actual ASCII code for that character is. ASCII code is used universally throughout Windows and is a shortcut to type that character.

For example, if you wanted to type a copyright symbol into any document or caption, you would hold the ALT key and press 0169 on your number pad. The symbol will appear when you release ALT. That gives you results like this “©”. Make sure you have Num Lock turned on when you do this.

### Predefined Macros

Let’s take a look at a practical use for using a macro - displaying the file name of an image as a slide plays. This kind of automated caption requires a Predefined Macro. These are macros that have been made to perform ProShow specific tasks.

**To Insert a Predefined Macro**

1. Open the Insert Macro window.
2. Select Predefined Macro from the Macro Types dropdown list.
3. Locate the information you want to display in the Field heading.
4. Select the macro you want to use and click Add & Close.
5. The macro will be inserted and the action will be performed when the slideshow is played.

Some common Predefined Macros you’ll often use include the filename (\f), current slide number (\p), and total number of slides (\P). These macros work great for photo proofing shows.
To access a full list of what each macro does, see the macro listing in the index of this manual.

**EXIF Macros**

EXIF macros let you display information about your images directly through captions. EXIF data, if you’re not already familiar with it, is information about your images which is stored in the image file. EXIF data includes all kinds of different things, like the orientation of the image, the width and height, or the compression method used.

**To Insert an EXIF Macro:**

1. Open the **Insert Macro** window.
2. Select **EXIF Metadata Macro** from the **Macro Types** dropdown list.
3. Locate the effect you want the macro to perform in the **Field** heading.
4. Select the macro you want to use and click **Add & Close**.
5. The macro will be inserted and the data will be displayed when the slideshow is played.

There’s an important difference between EXIF macros and the others. EXIF macros only appear if that EXIF data is present on the image. An image with no EXIF data in it won’t have any available EXIF macros at all. The same is true for IPTC macros. The available EXIF and IPTC macros depend on the EXIF and IPTC data available within the image.

**Macros and Multiple Layers**

Many macros, including EXIF macros and most predefined macros, add information about an image to your slide. When your slide contains multiple layers, these macros *always* refer to the top layer.
Caption Interactivity

When creating PC Executable, Autorun CD or Presenter output, captions don't have to be limited to displaying information, they can also become an interactive part of your show.

Caption Interactivity creates active links from your captions. Just like links on a web page, interactive captions let you perform a special action when the user clicks on them. These links can be clicked on to skip to various slides in the show, send an e-mail to an address that you choose, open a website, and more.

Any caption can become interactive. You just need to assign an action to it.

How to Create Interactive Captions

1. Open the Slide Options for a slide to which you want to add Caption Interactivity.
2. Click on the Caption Settings tab.
3. Create or select the caption you want to use in the Captions List.
4. Pick an Action and a Destination, if necessary, for your caption.

Just like a link on a website, once you make a caption interactive, it will become clickable. When you preview your show, you can see how the caption will pulse with your selected Highlight color. However, the Action will not be active until the show has been created.

There are a wide range of Actions that you can use with your captions:

- **Toggle Pause**: clicking on the caption will pause the show. Clicking on the caption again will un-pause the show.
- **Pause**: clicking on the caption will pause the show. Requires clicking on a caption set to the **Resume from Pause** action or **Play** keyboard shortcut to start playing the show again.

- **Next Slide**: clicking on the caption will skip to the next slide in the show. The show will end if there’s no following slide.

- **Previous Slide**: clicking on the caption will go back to the slide prior to the one the caption is on.

- **Jump to Slide**: clicking on the caption will skip straight to the specified slide. Requires that you enter a slide number you want to jump to in the **Destination** field. For example, jumping to slide 10 in the show would require a **Destination** value of 10.

- **Next Show**: clicking the caption skips to the next show in the overall show. If you don’t have multiple shows the current show will end.

- **Previous Show**: clicking the caption will go back to the previous show in the group. If you don’t have multiple shows it will go back to the start of your show.

- **Jump to Show**: clicking the caption will skip to a specific show in your group. Requires that you enter the show number in the **Destination** field. Show numbers are displayed in **Project** pane found in the **Publish Workspace**. They are also shown in the **Shows** tab when creating output.

- **Return to Menu**: clicking on the caption will take the viewer back to the main menu of the show. The show will restart if no menu is present.

- **Exit**: clicking this caption will end the show and close the show window.

- **Open URL**: clicking this caption will act as a link and load the PC’s default web browser to the URL specified. Requires that you enter a full URL in the **Destination** field. Full URLs include http://.

- **Write E-mail**: clicking the caption opens the PC’s default e-mail client with the To: address filled using the e-mail entered in the **Destination** field. Requires that you enter an e-mail address in the **Destination** field.
10. Captions

- **Run Program**: clicking on the caption will launch a program which is specified in the **Destination** field. Requires a full path to the program EXE in the **Destination** field, like “C:\Program Files\Photodex\ProShow Producer\proshow.exe”. Note that not all programs may be installed in the same place on different PCs and that “virtual” folders aren’t supported. These are folders like My Documents or My Pictures in Windows.

- **Run Program + Exit**: clicking on the caption starts the specified program as above but also stops the show and closes the show window.

- **Toggle Full Screen**: clicking on the caption will cause the show to display in full screen mode. Clicking on the caption again will take it back to normal size.

- **Activate Full Screen**: clicking the caption will cause the show to display in full screen mode. You can’t change the show back to regular display without using the keyboard shortcut CTRL + Enter.

- **Deactivate Full Screen**: clicking on the caption will cause the show to exit full screen and display at normal size. Requires CTRL + Enter or the Activate Full Screen action to go back to full screen.

Creating interactive captions is just a matter of deciding what your caption should do when clicked in the **Action** dropdown list and choosing a **Destination** for the **Action** if required. There’s a wide range of uses for **Caption Interactivity**. Consider some of these:

- Create an interactive gallery using captions. Create a main slide that acts as a “hub” and displays various areas that the viewer can get a closer look of. Include captions which link to slides that show them the closer look. Make links back to the hub slide in each of these closer looks.

- Create a contact and summary page for the end of your shows. Include captions which link to your website or send you e-mails.

- Create “virtual controls” in your show to pause, toggle full screen, and more using your own graphical style for the captions. Disable **On-Screen Controls** when you use this method to keep things looking consistent.
11. Text Layers

Layers Without Images

As you read in the previous chapter, text can be used in a variety of ways to enhance the storytelling in your shows. Captions are great, but sometimes you need even more creative freedom when working with text - and that’s where Text Layers come in.

A Text Layer is type of layer that you’ll find in the Layers List. Essentially, it’s both a caption and a visual layer. Text Layers combine the utility of text with the creative control of layers. As a result, they can take advantage of just about all of the options available for both objects.

Adding Text Layers

As Text Layers can be considered a hybrid between captions and layers, they naturally have two different ways in which they can be added to your shows.

The first option is to convert an existing caption.

To Convert a Caption to Text Layer

1. With a caption selected in the Captions List, right-click on the caption and select Convert to Layer
This will change your caption into a **Text Layer** and move it into the Layers List. Any settings for size, font, placement, texture, behavior and any effects you may have applied will remain intact.

Basically, this simply takes what you already have and turns on some new options for you.

Not all settings will transfer however. Because you’re converting a caption into a layer, the **Caption Interactivity** and **Caption Setup** options will no longer apply.

The second option is to create a brand new **Text Layer** from scratch using the **Layers List**.

**To Add a Text Layer from the Layers List**

1. In the **Layers List**, click the **Add (+) icon** and select **Add Text Layer** from the sub-menu

   or

   Right-click anywhere in the list, or click the ‘gear’ icon in the **Layers List**, and select **Add Layer > Add Text Layer** from the sub-menu

2. Type your desired text into the **Add Text Layer** window, then click **Ok**

Once added, you'll have access to nearly all of the options that are available for photo or video layers.
Text Layers are Stackable

One attribute that clearly separates a **Text Layer** from a Caption is stackability. As you read in the previous chapter, Captions always appear on top of your images no matter what.

**Text Layers** on the other hand are objects in the **Layers List** - just like a photo, video or solid color layer. That means they can be re-ordered anyway you’d like. This gives you the ability to have text layers appear underneath your images.

![Text Layer Preview](image)

Working with Text Layers

Once you create a **Text Layer**, above the preview you'll notice that you now have access to both layer and caption options. These are the exact same options you learned about in the previous chapters, only now these settings can be combined to create some truly amazing effects using text.
Changing Settings and Applying Effects to Text Layers

Seeing **Layer Settings** and **Text Settings** side by side can seem a little overwhelming, so let's take a look at exactly how these settings affect your **Text Layers**.

Let's start with the following, basic rule:

- **Layer Settings** affect the entire layer. **Text Settings** only affect the text.

As you learned in Chapter 8, it’s often helpful to think of a layer as a container or a box. The **Layer Settings** define the attributes of the box. How big is that box, where is it on the screen, does it move, is the box a certain color, etc.

The **Text Settings** are used to define what’s inside the box. How big is the font, what color is it, etc.

This means that if you configure any options under the **Layer Settings**, **Adjustments** or **Effects** tabs those changes will be applied to everything in your text layer. Whereas changes made to **Text Settings** or **Text Effects**, only affect the text.
In this figure, you can see an example of the differences.

Each image represents a text layer. Under the Layer Settings tab, the zoom has been set to 50% for both. With regards to the container/box concept, this means that the size of the "box" is the same for both layers.

Under the Text Settings tab, the layer on the left has a font size of 50, while the layer on the right has a font size of 200.

The layers are the exact same size. However, because the Text Settings for the layer on the right has a greater font size value, the text becomes so large that it’s no longer fully visible on the layer. Continuing the container idea, the font size is now so large that all of the letters won’t fit inside the box.
By contrast, in this figure, the font sizes are set to 50 for both layers.

Under the Layer Settings tab, the zoom value for the layer on the left is 100%, while the zoom value for the layer on the right is set to 50%.

![Text Layers](image)

In this case, we made the box bigger, but left the font size unchanged. The result is that we now have more than enough room for all of the letters to fit inside the box.

**Text Layer Settings**

Text Layers use the exact same caption and layer tools that you learned about in previous chapters.

As you cycle through each tab, you'll see there are some subtle differences when it comes to the available options.

Let's take a look what you can do with Text Layers.
Layer Settings

For the most part, Text Layers can use just about every feature you’ll find under this tab. The Layer Setup options for Zoom, Scaling, Position and Aspect Ratio are the same tools you use for images or video. You can also add Notes and Rename a Text Layer.

Keep in mind, if you Rename a Text Layer, you are NOT changing the text. You are simply changing the name of the layer as it appears in the Layers List and Selected Layer pane.

Going back to the container/box concept -the Rename option basically changes the label on the outside of the box, not the contents.

In the Layer Type pane you’ll begin to see why Text Layers can be considered a hybrid between captions and layers:

- Text Layers can be used as Mask or Adjustment layers - something a normal caption cannot do.
- Text Layers can be replaceable or non-replaceable when used to create a Slide Style or Template - just like normal layer.

Masks, Adjustment layers, Slide Styles and Templates are all covered in detail in later chapters.

Text Settings

The options you’ll find here are just like the options found under the Caption Settings tab when working with a caption. This is one of the places you'll go to control "what's inside the box".
When working with a **Text Layer**, under this tab you can adjust the **Size**, **Font**, **Color** and **Placement** options, or apply a **Texture**.

Using the **Selected Caption Text** window, you can also edit or change the actual text being used within your **Text Layer**.

Because **Text Layers** are a type of layer (not a type of caption), you'll notice that the Caption Interactivity and the Caption Setup options are not available.

**Adjustments**

Continuing with the container metaphor, **Adjustments** are another group of settings that apply to the entire box. The choices you make here affect the entire text layer—including the "contents inside the box".

These options really separate **Text Layers** from captions as they offer completely different creative controls.

Under this tab you'll find many of the same options that are available to image layers. Here you can change settings for **Blur**, **Sharpen**, **Opacity**, **Brightness**, **White Point**, **Black Point**, **Contrast**, **Hue** and **Saturation**. You can also **Flip** or **Colorize** a **Text Layer**.

These options can be used separately, or combined with **Text Settings**.

**Effects and Text Effects**

This is where the hybrid nature of **Text Layers** really comes into play. Under these two tabs you'll find all of the same options that are available for creating effects with image layers and captions. This allows you to create effects that apply to the entire layer, the contents of the layer or both.

You'll learn much more about motion in Chapter 15, but for now, let's put together a quick example to see what **Text Layers** can do.
Text Layers In Action

In this example, we're going to use a Text Layer to re-create the intro title sequence for the most popular TV show to ever co-star a Smoke Monster.

As you follow along, keep in mind that the settings don't need to be exact to make this effect work.

Smoke Monster Show Intro

1. In either the Build or Design Workspace, click the Add Blank icon in the Toolbar to create a new blank slide

2. Change the slide time to 15 seconds, then double-click to open Slide Options

3. In the Layers List, click the Add (+) icon and select Add Text Layer from the menu. Type in the word "Found"

4. Click on the Text Settings tab. In the Caption Format pane, change the Font to Arial, the Case to Convert To Upper Case, set the Size to 24 and the Color to white.

5. In the Caption Placement pane, set the Alignment to center, and Rotate the caption a little. A setting of -20 works well.

6. Next, click on the Adjustments tab and set the Blur to around 24%

7. Click on the Effects tab. In the Staring Position, in the Motion & Audio pane, click on each of the options and change the motion type to Linear.

   This will make sure all motion happens at a constant rate.

8. Next, change the Vertical Tilt to around -20 degrees, and the Horizontal Tilt to 45.
11. Text Layers

9. Now click on the Next keyframe (the *Ending Position*).

10. In the **Motion & Audio** pane, apply the following settings:

   - **Pan**  
     -45 x 10
   - **Zoom**  
     220
   - **Vertical Tilt**  
     15
   - **Horizontal Tilt**  
     50
   - **Rotate**  
     50

11. To complete the example, click on the **Text Effects** tab.

12. With Keyframe 2 (the *Ending Position*) selected, in the Caption Motion & Adjustments pane, change the **Font Size** to 250 and set the **Rotate** value to 0.

13. In the Caption Behaviors area, set the **Fly In** to Fade In and the **Fly Out** effect to Fade Out.

Now preview the effect to see how it looks.

The keys things to learn from this example are:
a) **Text Layers** can do things Captions cannot do and b) the layer (container/box) and text (the content inside the box) can be changed independently of each other, or they can be combined to create some pretty amazing effects.
Text Layers and Zoom Effects

When creating zoom effects with Text Layers, keep in mind that you have two ways to "zoom in" on a Text Layer. You can increase the zoom for the layer and you can increase the font size of the text.

The most common mistake made is starting off with a small font size and zooming in on the layer. Often what you'll see in these cases is that your text will become blurry and unreadable.

To make your zoom in effects with Text Layers look their best, consider the following options:

- Choose a larger font size under the Text Settings tab and reduce the Layer Settings Zoom for the Starting Position of your Effects to less than 100%
- Use the Text Effects to change the font size between starting and ending points on a slide. If a font starts at 10 and ends at 50, the result is a "zoom in" effect.
- Use both Effects and Text Effects to "zoom in" on both the layer (the container/box) and the text inside the layer.

Text Layers and Slide Styles

Just like photo/video layers or captions, Text Layers may also be included with slide styles. When creating a Slide Style, all of the settings you enter for the Text Layers on a slide will become part of the style.

When you apply a Slide Style that uses Text Layers, all you need to do is change the text to fit your show. Simply go to the Selected Caption Text pane under the Text Settings tab for that layer.
Captions or Text Layers

Simply put, there's no one, right answer. While very similar, they each have their own unique features. For some shows, captions are perfect. In others, your text may need the extra visual impact only Text Layers can provide. The best advice is to use whatever works for the show you are creating.
12. Music and Sound Effects

Making a Show for the Senses

A show that is strictly limited to visual elements can work, but it’s when you make a show that has both visuals and audio that you get something which really captures the audience.

Thankfully ProShow has an entire suite of tools which are designed to let you include both music and sound effects in your show which are fully customized to your preference.

Let’s start with the basics – adding and setting up music in your show. From there we’ll move on to sound effects, and finally cover how to tweak all of these to get just the results you want in your show.

Audio Files Supported

ProShow supports almost all major audio types that are available. You can use everything from WAV files, to MP3 files, to audio which you take directly from one of your CDs. If it’s a digital audio file that is available the chances are high that you can use it in ProShow.

For more details on what files are supported, please see the Supported File Types list located in the Help section of our website at http://www.photodex.com
Adding Music to your Show

Creating a soundtrack for your show is designed to be as easy as working with images. All you need is some music in digital format on your PC, or on a music CD.

There are several different ways to add music to your show.

To Add Music to a Show

1. In the Build Workspace, use the Folder List to browse to a folder where your music is saved.

2. Locate the music you want to add to the show in the File List.

3. Drag & drop the music from the File List to the Soundtrack bar which appears beneath your Slide List, or right click and choose Add to Soundtrack

OR

1. Use the Soundtrack list in Show Options.

There are several ways to open this window and manage your soundtrack.

- Click on the Music icon in the Build Workspace Toolbar or Design Workspace Toolbar

- Double-click on the Soundtrack bar, just underneath your Slide List

- From the Menu Bar, select Audio and Manage Soundtrack

- Use the keyboard shortcut, CTRL + M
2. Click on the Add (+) button in the Soundtrack List.

3. Choose Add Sound File from the menu that appears.

4. Browse your system for the music you want to add, select it, and click Open.

5. Press Ok to close the window and return to your workspace.

Your music will appear on the Soundtrack bar as a waveform. If you play a preview of the show you will immediately hear the music that is now included. When looking for music, you can double-click on any music file in the File List to play it.

Adding Multiple Music Tracks

Adding more music to your show is just a matter of repeating the process outlined above. Drag & drop or manually add more songs. These will play in order from start to finish during your show. In the Soundtrack Bar, your tracks will alternate between green and blue to help you stay organized.

If you don’t want to be any more detailed with your music than that, you’re done. Just add the tracks you want to use and play the show. You’ll learn more about customizing and adjusting your music a bit later in the chapter.
Automatically Fade Your Soundtrack

Now that you've added songs to your Soundtrack, let's take a look at one of the best ways to wrap up a show -by making your soundtrack fade out at the same time your show ends.

Later in this chapter you'll learn how to edit your Soundtrack with more precision, but for now, let's take a look at how ProShow can do this for you automatically.

To Automatically Fade Music at the End of a Show

1. Double click on the Soundtrack bar to open the soundtrack options for your show.

2. On the right, locate the Fade Soundtrack at end of Show pane and click the check box to turn the option on.

3. From the dropdown menu list, choose how you want your fade to behave by selecting a Duration option. There are three to choose from:

   - **Duration of Last Transition**: This will match the fade out to the length of the last transition in your show.

   - **Duration of Last Slide**: When choosing this option, your soundtrack will begin to fade out as soon as the last slide in your show begins.

   - **Custom Duration**: This option allows you to create a custom fade out length. This is not based on any slide or transition time. Instead, enter in a number of seconds, and the fade out at that many seconds before the end of the show.
4. Click Ok to apply the changes and return to the workspace.

This is one of the fastest and easiest ways to "Drag, Drop and Go" when making a slideshow.

Because this is an automatic process, it doesn't matter if you only have 1 minute worth of slides and a 3 minute long song. ProShow will automatically fade out your Soundtrack at the end of that 1 minute of show time. You don't need to edit the track separately.

If you add or remove slides, ProShow will adjust the fade out based on the selected Duration option.

**Adding Sound Effects to your Slides**

Any audio that you add to your Soundtrack is considered to be part of the show's overall soundtrack. It doesn’t matter if this is music, ambient sounds or sound effects.

If you want a sound effect that plays in time with certain slides, you’re going to want to use a Slide Sound. A Slide Sound is an audio track that begins to play when the slide they are attached to begins. You can use Slide Sounds for all kinds of things:

- Sound effects that compliment the slide, like clapping, laugh tracks, camera shutters, etc.
- Ambient sound accompaniment like a waves, blowing wind, birds chirping
- Voice narration to explain what’s happening in that particular slide or image

**Slide Sounds** are just as easy to add to your show as music. Let's take a look at how you can do that.
To Add Slide Sound to a Slide

1. Use the **Folder List** to browse for a folder which contains the sound effect you want to use.

2. Select the sound in the **File List**.

3. Drag the sound from the **File List** and drop it onto the slide that you want to have the sound.

   **OR**

1. Double-click on the slide to which you want to add a **Slide Sound**.

2. In **Slide Options**, locate the **Background + Sound** area on the bottom left side and click the **Slide Sounds** tab.

3. To the right of the **Preview**, you'll see the **Current Slide Sound** area. Click the **browse** button.

4. Choose **Add Sound File** from the menu that appears.

5. Browse your system for the sound file, select it, and click **Open**.

6. Click **Ok** to return to your workspace.
You’ll know you’ve successfully added a sound effect to your slide when you see a red waveform in your Soundtrack bar. You'll also notice a speaker icon appear on the slide thumbnail.

As you add additional Slide Sounds to your show, the tracks will alternate between red and yellow to help you stay organized.

When you play the show, you’ll hear that sound effect right as the slide it’s attached to begins to play. You’ll also notice that ProShow automatically decreases the volume of the soundtrack so that you can better hear the sound effect. This is a behavior that you can adjust if it doesn’t quite suit your preferences. We’ll learn more about that later in this chapter.

Adding Sounds from a CD

Another way to add music or sound effects to your show is to use the Save Music from CD option. This allows you to import music from an audio CD into your show. This option is only recommended if you have the proper music licensing rights to use the audio tracks for the purpose of making slideshows. Typically this will be referred to as "royalty-free" or "rights-cleared" music. If you are unsure whether or not you have the rights to use music from a CD in a slideshow, please consult the source or publisher of your audio CD.
12. Music and Sound Effects

To Save Music from a CD

1. Double click on the Soundtrack bar open the soundtrack options for your show.

2. In the Soundtrack Tools pane, select Save Music from CD

3. Select the tracks you wish to import from the Available Audio Tracks list

4. If you’d like to import the track(s) directly into your show, check the Import box.

5. Select the format you would like to save the files as, and select Save Track.

6. Choose a save location on your computer.
Syncing Music to a Show

ProShow has a range of ways to sync your music to your show. As you learned in the introduction of the manual, ProShow can’t change the timing of the music— that would result in some bizarre sounding audio. Instead, ProShow syncs your music by adjusting the timing of the show.

There are three quick options to sync your music to your show and one more thorough option which lets you control exactly how the sync will be done.

We’ll start with the first three:

To Quick Sync your Music to your Show

1. Click on **Audio** in the **Menu Bar**.
2. Click on either **Quick Sync – Entire Show, Selected Slides**, or **Selected Slides to Track**.

The first will apply the sync immediately. The latter two require you to have slides selected in your **Slide List**. Click **Ok** make the changes.
Quick Sync – Entire Show

Using **Quick Sync – Entire Show** is the most straightforward of the sync options. This selection doesn’t concern itself with how many tracks you have or which slides are changed. It’s going to do the following:

- Match the length of the show to the length of the entire soundtrack – all tracks included

The time is evenly distributed across all your slides, and will adjust both your slide time and transition time. This method doesn’t provide any prompt and changes are applied to your show as soon as you make the selection.

You verify the sync has taken place by using the Slide List and looking at the end of your show. The soundtrack should end at the same time your last slide ends. You can verify the sync by comparing the show time and audio length time listed just below your workspace selection tabs.

This method will result in all your slides having the exact same duration, regardless of how they were timed before. All of your transitions will have a uniform time as well. Transitions will be limited to no more than 3 seconds each in order to prevent uncomfortably long transition effects.

**Quick Sync Tip:**

- You can also perform a Quick Sync of your entire show by using the keyboard shortcut **CTRL + Q**.
Quick Sync – Selected Slides

Using Quick Sync – Selected Slides will only change the times of those slides you have chosen when your audio is synchronized. Only the slides selected when you choose this option are modified – the rest of your slides are left with their original times.

This is most useful when you have certain slides in your show that require precise times. For example, if you make a fast effect that relies on very short slide times. If the time of this slide were to be increased by the sync then your slide would no longer look as you configured it.

This is avoided by only changing the time to sync audio on the slides you hand-pick. Here’s how this works:

1. Click on the slides which can have their times changed in the slide list.
   a. To select them one at a time, hold CTRL while you make your selection.
   b. To select a range of slides, click on the first slide, hold SHIFT on the keyboard, and click on the last slide in the range.
2. Click on Audio in the Menu bar.
3. Choose Quick Sync – Selected Slides from the menu.
4. Click Ok when the prompt appears, which informs you about how the times will be adjusted.

Now your entire soundtrack will end at the end of your show, but only those slides you selected will have their times changed.

This method has an important difference from the Entire Show option. This method will adjust times proportionally, rather than making all times the same.
When you apply Quick Sync – Selected Slides, the times applied to the selected slides maintain the proportions you had already specified in their original times. In other words, if slide 1 was twice as long as slide 2, it will still be twice as long after you apply the sync.

**Quick Sync – Selected Slides to Track**

This feature is best used when you want to limit one of the audio tracks in your show to a particular section.

Let’s say that the first song in your show is meant to be played during the introduction, which is 10 slides long. Once the intro is over you want to move into your second song.

If you were to use either of the other two sync options you would find that ProShow doesn’t care about where the first song ends. It only cares about where the whole soundtrack ends.

**Quick Sync – Selected Slides to Track** will let you choose which range of slides you want to sync to a specific track in your soundtrack. That way your first song will play for the first 10 slides, at which point the second song will start. Here’s how it works:

1. Click on the first slide in the range that you want to sync, hold SHIFT on the keyboard, and click on the last slide in the range.
2. Click on Audio in the Menu bar.
3. Choose Quick Sync – Selected Slides to Track.
4. Choose the track you want to sync to, if you’re following the example, it would be track number 1.
5. Click on Ok when the prompt appears to tell you how the times will be changed.
Now you will notice that the slides you selected had their times adjusted so that the slide group ends at the same time track 1 comes to an end. Your second track will begin playing from that point.

Note that this won’t change when the selected slides start playing. It won’t line up the slides with the start of the track. This option just sets the total time of the selected slides to match the time of the selected music track.

**Sync Slides to Audio in Detail**

All three of the *Quick Sync* tools determine how the sync will be performed. If you want to choose the specifics of what will be changed, and how, you can use the full audio sync tool.

1. Click on **Audio** in the menu bar.
2. Choose **Sync Slides to Audio** in the menu that appears.
3. Select how you want the sync to be performed in **Synchronize Show to Soundtrack** window.
4. Click on **Sync** when complete.
12. Music and Sound Effects

OR

1. Double-click on the Soundtrack bar or click on the Music icon in Build Workspace Toolbar or Publish Workspace Toolbar.

2. In the Soundtrack List, select a track and locate the Soundtrack Tools area. Click on the Sync Slide to Audio button.

3. Control how you want the sync to be performed Synchronize Show to Soundtrack window.

4. Click on Sync when complete.

Sync Slides to Audio Options

You have a few major options categories that you can adjust to determine how the sync is performed when you use the full Sync Slides tool. Let’s go through each one of these:

- The Which Slides pane lets you choose the slides that ProShow will change to sync the audio. You can either use all slides in the show or just the slides you have selected.

- The Which Times pane lets you determine which times on your slide will be adjusted to sync the audio. You can select just the slide time, just the transition time, or both.

- The How to Adjust pane lets you choose how the timings of your slides are changed. You can choose Keep proportions the same as existing times or Make all times the same. Keeping the proportions means that the times will change but the times in relation to one another will remain the same, for example longer slides and shorter transitions. Making all times the same will change them all to the same value. You can also choose to limit the length of your transition time changes so that they don’t get unreasonably long.
• The **Select Audio Track** pane lets you choose whether you will make these sync changes to the whole soundtrack or just a specific song. If you want to use a specific song, click on the **Match to length of selected track(s)** radio button and choose the track(s) you want to use in the **Soundtrack List** that appears.

This takes a bit more time than one of the **Quick Sync** options but gives you very precise control over exactly how the sync will be done.

**Note:** it’s best to save audio sync until one of the last steps in your show. If you sync audio early and make changes to the length and timing of your slides, you’ll have to sync again before the show is complete.

**Sync Slides to Audio Tip:**

• You can also open the **Synchronize Show to Soundtrack** window using the keyboard shortcut **CTRL + T**.

**Syncing Audio to a Beat**

Fast shows usually have a strong, driving beat in their music. It’s very common to want to adjust the timing of your slides so that they change as the beat strikes during the song. This is where the final sync option comes in handy.

The feature that allows you to do this in ProShow is called **Record Slide Timing**. With this option, you can listen to the track(s) in your show and press keys on your keyboard or mouse to cause the slides to transition.

This means that you’re listening to the music and pressing keys along with the beat. You create a transition to the next slide each time you press a key. The transition you use is up to you.
To Access Record Slide Timing

1. Double-click on the Soundtrack bar.

2. In the Soundtrack Tools options, Click the Record Slide Timing button located in the Soundtrack Tools pane.

The Record Slide Timing window will open. The main display of the Record Slide Timing window shows you the first slide in your show and those that come after it. Beneath the slide thumbnails is a graphic for your mouse and number keys 1 through 0. Each of these keys has a transition icon beneath it.

This means that as you press that key, it will insert that transition for you. If you hold the key down, the transition will continue until you release the key. You can change which transition is associated with each key by clicking on the transition icon. This will open the Choose Transition window - just like you would see when changing transitions between slides.

Using Record Slide Timing

Once you’ve set your transitions to your keys, click on Start. You’ll hear your soundtrack begin to play. When you hear a beat that you want to set to a transition, just press the key for the transition you want to use.

Keep in mind that the longer you hold down the key, the longer the transition time will be.
Once you’re done, either at the end of the soundtrack or the show, click on **Stop**. If you want to give it another shot, just click on **Start** again.

Once you’ve made the changes you’re happy with, click on **Apply**. The timing changes will be made to your slides. Click on **Close** to exit **Record Slide Timing**.

## Controlling Soundtrack Volume

One of the more common problems when working with audio is that not all of files are created using the same base volume level. This means that some of your songs might be louder than others, sometimes by very noticeable amounts.

You can deal with this and the general volume of your show by making changes to your show volume and the volume of your individual tracks.

### To Adjust the Volume of a Show

1. Click on the **Music** icon in the either the **Build Workspace Toolbar** or **Publish Workspace Toolbar**.

2. Select any track in the **Soundtrack List** and adjust the **Master Volume** slider just below the waveform preview.

   **OR**

   - Double-click on the **Soundtrack** bar to open the **Soundtrack options**.

   **OR**

1. Click on **Audio** in the **Menu Bar**.

2. Choose **Manage Soundtrack** from the menu that appears.
The **Master Volume** controls the overall volume level of the entire show. When you have problems with different volume levels per track you will need to change these individually.

Here’s how:

1. Click on the track you want to adjust in the **Soundtrack List**.
2. Change the **Volume** slider which appears in the **Track Settings** pane just below the waveform preview on the left.

Each track in your soundtrack can be controlled individually so that you can decrease the volume on one while you increase the volume on another. Working this way can help make sure that the overall volume level of your audio is balanced.
Controlling Other Volume Settings

You've likely noticed that there are some other volume controls you can work with. These are used to control two different things: the default volume level that your Slide Sounds will use, and the default volume that your soundtrack will use when Slide Sounds are playing.

The Defaults for Slide Sounds option sets the volume level for the sound effects that you attach to your slides. This is only the default. If you need to adjust the volume levels of your sound effects individually, you can do this using the options for that specific slide.

The Soundtrack During Slide Sounds slider sets what level your soundtrack will change to, automatically, when a sound effect begins playing. This is set at 50% by default, but you may find that you prefer it to be lower or higher. You can also adjust this on a per slide basis for more exact control.
Fade Times

Each **Volume** slider, aside from the **Master Volume**, also comes with a **Fade In and Out** slider. These are used to set how long, in seconds, your audio will fade in from 0% volume or fade out to 0% from whatever volume level you set.

Setting a fade time is based purely on personal preference, but it’s recommended that you use at least the default of **0.1** second. This helps avoid pops or clicks that can occur when one song or sound begins playing immediately without volume change.

Controlling Volume with Keyframes

**Keyframing** gives you the ability to have volume changes on a slide by slide basis, rather than an overall show basis. In fact, using keyframes, you can even have multiple volume changes on a single slide.

**Keyframing** offers you much greater control over the volume of your **Soundtrack** - including making it easy to coordinate changes in layer motion and **Soundtrack** volume at the same.

You’ll find the options to control volume using keyframes in the **Slide Options** window under the **Effects** tabs.

For more information on keyframing, please see Chapter 17.
Setting Soundtrack Offset Times

Each of the tracks that you add to your **Soundtrack List**, as well as your **Slide Sounds**, has an **Offset** option. This option is used when you don’t want a particular song or effect to play right as another one ends.

An **Offset** is a time, in seconds, that ProShow will wait to play that song or effect. The description says “from previous track”, but for the first track, this means "from the start of the show".

For example, if you set the **Offset** of the first track in your show to 5 seconds, the music won't play until 5 seconds of your show has elapsed.

**Offset** is most valuable when you want some gaps in your audio. There are times when a break from the end of one track to another can be used to great effect in your show. Adding some time to the **Offset** of the following track will accomplish this.
Working with Slide Sounds

Your Soundtrack isn’t the only area of the audio that you can control with great detail. You also have full control over the Offset and Volume levels of your Slide Sounds. Here’s how:

1. Open the Slide Options for the slide you want to adjust sound effects for.

2. In the Background + Sound area, click on the Slide Sound tab.

You’ll notice that you have two options panes for Slide Sounds which let you control volumes and fades. Both of these are unchecked by default. That’s because these are currently being controlled by the Default for Slide Sounds and Soundtrack During Slide Sounds settings in your Soundtrack options.

If you want to change the volume levels for just this slide and its sound, you need to enable the Custom or Override settings for the slide.

Click the checkbox next to the options you want to use. You can also enable them both at the same time.

- **Custom Slide Sound Settings** lets you control the volume and fade levels of the sound effect you have attached to this slide.

- **Override Soundtrack During This Sound** lets you force the soundtrack that is playing during this slide to a specific volume or fade value.

Both of these options ignore what you have set in your Soundtrack options when enabled. This gives you the ability to customize how your audio behaves for the duration of this slide.
Changing How a Slide Sound Behaves

There are a few options that can be adjusted to determine how a Slide Sound will behave when attached to a slide.

These options can be found in the Sounds Timing pane, just below the Preview.

The first of these options is Offset. Just as with a song in your Soundtrack, you can enter a time, in seconds, that ProShow will wait to play the Slide Sound.

The next option is Continue. Selecting Continue means that the sound will keep playing even after the slide it is attached to has ended. This option is enabled by default. This is useful when you have a sound effect that is longer than the slide you are using it with, but you want to continue to hear the effect.

This happens most often with voice narration. If you want to continue to hear the narration once that slide is over, make sure that the Continue option is enabled.

The Slide Time option locks the slide time and matches it to the length of the Slide Sound. If you enable this option, the Slide Time will be changed to match the time of your Slide Sound. You won’t be able to change the Slide Time while this is enabled. If you use any syncing options, other slides may be affected, but a locked slide's time will not be changed.
Next, the **Sync Slide Time** button will automatically change the time of your slide to match the time of your **Slide Sound**. This can be a fast way to make sure your slide and sound are of the same time without locking the two together.

Finally, you’ll find the **Edit Fades and Timing** option. Clicking this button will open up an audio trimmer that will allow you to crop the **Slide Sound** and adjust the **Fade In** and **Fade Out**. We’ll go over how to use the audio trimmer a little later in this chapter.

## Removing a Slide Sound

If you decide that you want to remove a sound from your slide, you can do so by clicking on the **Remove** button located in the **Current Slide Sound** area.
Adding Narration to Slides

Slide shows are great places to create travel diaries or just add some narration to the show you’re putting together. ProShow has the **Record** feature which is designed entirely to let you create your own narration for a slide in just a few steps.

**To Record a Voice-Over**

1. Open the **Slide Options** for your slide.
2. In the **Background + Sound** area, click on the **Slide Sound** tab.
3. Ensure your microphone is connected, turned on, and working.
4. In the **Current Slide Sound** area to the right of preview, click the **Record** button and begin speaking.
5. Click **Stop** when finished.
6. Click **Done**.

Your recording is saved as a digital audio file in the Ogg Vorbis format, and added to the slide as the **Slide Sound**. You can use all of the same trimming and adjustment features with a voice-over that you would with any other sound.
If you have more than one sound card, or microphone, you may need to make sure you’ve chosen the correct device from the **Record Using** dropdown list which appears in the **Record Sound** window.

Remember that you can also choose where that voice-over is saved by clicking **Browse** next to the **Save As** field and selecting a location on your computer.

### Working with Audio in Video Clips

By default, if you have a video clip that features sound on a slide, ProShow will refer to the **Defaults for Slide Sounds** and **Soundtrack During Slide Sounds** settings. Essentially treating the audio within the video clip as if it were a **Slide Sound**.

But keep in mind that you have much more control available to you on a slide by slide, and even a layer by layer basis.

In the **Slide Options** window, you’ll find several **Volume** control options for video layers.

Under the **Layer Settings** tab, look for the **Video Clip Settings** pane. Keep in mind, you will only see this pane if you have a video layer selected in the **Layers List**.
Let's take a look at the available options:

- While it may not seem like it, the **Speed** option actually does affect the volume of the audio in a video clip. If you change the speed of a video, the audio will automatically be muted. This is done to prevent it from being distorted during playback.

- The **Volume** option allows you to set the volume for each video layer separately from each other, and/or separately from the default show settings for Slide Sounds. Setting the volume to 0% will completely mute the audio within a video clip.

- Additionally, for every video layer, you can adjust the **Fade In** and **Fade Out** times for the audio individually.

The final option for video layer audio is the **Prevent default soundtrack fade during this video** setting. This will override the default show settings that normally reduce your Soundtrack volume when another sound is detected.

This option is most beneficial when using videos that have sound effects that wouldn't require a drop in Soundtrack volume, and when using Keyframing to control the Soundtrack volume.
Editing Music and Sounds in ProShow

ProShow gives you a set of tools which you can use to edit the audio you’re using in your show. These tools let you pick only certain clips of the audio to use, trim silence from a song, or cut off a portion of the audio that you don’t want.

In all cases, this tool is called Edit Fades and Timing, which is often referred to as the Audio Trimmer.

Accessing Edit Fades and Timing for Audio

1. Open either the Soundtrack or Slide Sounds options.

2. Click on the Edit Fades and Timing button for the selected track, or slide sound.

Clicking on Edit Fades and Timing opens the Audio Trimmer window which is used to make changes to your audio. The Audio Trimmer is the same whether you’re using it to work with your Soundtrack or Slide Sounds options.
Using the Audio Trimmer

The largest feature of the Audio Trimmer is the waveform preview that appears at the top of the window. There are two waveforms that represent the Left and Right channels of your stereo audio. You can consider this to be one waveform for the sake of making changes.

Beneath the waveform are the tools you can use to choose which part of the audio you want to use. Let’s start with an example which will trim the silence from the start and end of a track. The steps below will generally work with just about any sound file.

To Trim Silence from Audio

1. Open the Audio Trimmer.

2. Adjust the Zoom slider to get a closer look at the sound file. As you move to the right, you’ll be looking at smaller and smaller increments of time, down to 10ths of a second.

3. Move the Position slider all the way to the left so you can see the beginning of the audio file. Notice that there is an area at the start of the waveform which is flat. This is silence.
12. Music and Sound Effects

4. Click on the waveform where the silence ends and the waveform begins to take shape. A marker will appear where you clicked.

5. Now click on the **Set Starting Time** icon in the playback controls area beneath the waveform preview. The **Start Playback** indicator will appear at the point where your marker was located.

6. Now move the **Position** slider all the way to the right so that you can see the end of the audio.

7. Click on the waveform where the silence begins and the waveform becomes a flat line. A marker will appear where you clicked.

8. Click the **Set Ending Time** icon. The **End Playback** indicator will now appear at the point where your marker was located.

9. Move the **Zoom** slider back to the left to see the entire sound file in the preview.

You will see that the playback indicators are now ignoring the silence at the start and end of the track.

The areas which are going to be played are highlighted in blue. That will always be between the **Start and End Time Indicators**. Everything that isn’t highlighted won’t be heard during playback.
Click on Ok to apply the changes to your audio.

**Note:** these changes are non-destructive. Your original audio file will not be edited in any way.

**Selecting Part of an Audio Track**

You can choose just one section of a song you want to hear using the same method for trimming silence. Rather than placing the **Start and End Time Indicators** only inside of the silent areas, place them exactly where you want the song to start playing and exactly where you want it to end.

**Making Precise Adjustments with the Audio Trimmer**

If you want to make exact changes to the **Start and End times** of your audio you can use the **Start** and **End** values which appear beneath the waveform. Here you can enter the exact time, in seconds, where you want the audio to start playing and where you want it to stop.

This can make it much easier to make a clip if you know exactly where the section you want starts and ends.

You can also adjust the **Fade In** and **Fade Out** times for your audio by changing the times in either value field.

**Previewing Changes**

You can preview the changes you have made to your audio by clicking on the **Play** button beneath the waveform. This will play the audio as you have currently have it set.

You can also **Pause** the playback at any time. The playback marker will remain in position on the waveform so that you can see exactly where that event in the audio takes place.
Trimming Audio with the Mouse

You can make quick adjustments to your audio using the mouse. Both the Start and End Time indicators can be dragged into position by clicking on the white, triangular flags which appear at the top of the waveform.

You can change the Fade In and Out times by clicking on the gradient flags which appear at the bottom of the waveform. This makes large changes much faster and easier to perform.
Using the Timeline View

You can take complete control over your Soundtrack audio without going into a single menu. In all three workspaces, you can access the Timeline View to adjust and control your audio while looking at your show.

This is often the fastest and easiest way to work with the audio in your show.

To Access the Timeline View

- Just above the Slide List, click on the Timeline tab.

OR

- Press the TAB key on the keyboard while in the main workspaces.

Timeline view changes the Slide List from focusing on slides to focusing on your Soundtrack. Once in Timeline View, your slides and transitions will be seen as smaller thumbnails above the waveforms of your audio tracks.

The width of each thumbnail is based on the duration of each slide and transition. When the time is greater, the width of the thumbnail area will be wider. Shorter times will have thumbnail areas that are more narrow.
12. Music and Sound Effects

The waveform for your audio will be significantly larger in this view. Additionally, if you have any Slide Sounds in your show, you'll be able to see the red and yellow waveforms for those sounds above the green and blue waveforms of your Soundtrack.

Navigating the Timeline View is slightly different from using the Slide List. As you hover over the Soundtrack bar, you can zoom in or out on the Soundtrack by using the mouse wheel.

You can also use the Zoom sliders which appear in the bottom-right corner as you mouse over the Soundtrack bar.

Moving the horizontal (bottom) slider to the right will zoom in on the soundtrack, giving you the option to see waveform details in 1/10th of a second increments. Moving it to the left will zoom back out.
The vertical slider (on the right) will also zoom in and out, only instead of focusing on Slide and Transition times, this slider focuses on the volume of your Soundtrack. As you move the slider up, you'll be able to see more volume details.

**Note:** This does not increase the volume of your Soundtrack. This simply zooms in or out on the waveform.

**Expanding the Timeline View**

If you need more "real estate" when working with audio, you can very easily expand the Timeline view.

Simply hover your mouse to the top edge of the Soundtrack pane, just as you would if you wanted to tear the pane out of the workspace.

Instead of tearing out the pane, simply click and drag the pane upward. You can expand the view to generally fill about 60-70% of the entire Workspace. (Maximum size will vary based on overall window size.)
The expanded view only affects the **Timeline**. If you click the **Slide List** tab, or press the **TAB** key on your keyboard, you'll toggle back to the normal sized **Slide List**.

Later in this chapter you'll learn how you can use this option to more precisely adjust your **Soundtrack** volume.

### Making Audio Edits Using the Timeline View

Audio in your **Soundtrack** can be freely adjusted in **Timeline View**. You can change the offset, adjust volume and fades, or make a clip of your audio all from the **Timeline**.

Let's start with the basics:

#### To Change Audio Volume Using Timeline View

1. Above the **Slide List**, click on the **Timeline** tab, or press the **TAB** key on your keyboard to open the **Timeline** view.

2. Click on the track you wish to edit.

   Notice that a blue control border appears around the track. This means that the track is active and ready for editing.

3. Click on the blue control border at the top and drag it down. This will decrease the master volume for this sound in your Soundtrack.

   To increase the volume, simply drag the bar back up.

**Note:** You can adjust the volume from 0% to 200%. When increasing volume, you may need to expand the **Timeline View**, or use the vertical Zoom slider to see the blue control border around the waveform.
Add a Fade In or Fade Out in Timeline View

At the beginning and end of the track are three anchor points on the waveform. The yellow anchors at the top and bottom control the master volume of your sound. The blue anchor in the middle represents the starting or ending point of your sound.

In between either yellow point and the blue point, click on the blue control border and drag it over to the right (at the beginning of a sound) or to the left (at the end of a sound).

When you drag that line over, you are creating a **Fade In** or a **Fade Out** for the track.

The **Fade** time is indicated by the triangle of the border and by the pinching of the waveform at the point where the fading starts.

You'll also now see blue anchor points at the top and bottom of the waveform. These two points of the triangle indicate where your fade effect is at full volume. The single point at the apex of the triangle is where your fade effect is at its lowest volume.

To change your fade time, click and drag either the top or bottom point, or click and drag the blue control border line connecting those points.
Create an Offset using the Timeline View

To create an Offset, press and hold the CTRL key on your keyboard as you click and drag a track to the left and right.

Timeline View tip: When creating fades or offsets, try visually matching up the peaks of a waveform to the beginning of a slide.

Set the Beginning or Ending Point in Timeline View

There are two ways you can choose where a track starts and stops using the Timeline View:

The first option is to use the control border around selected track.

1. Click on a sound in your Soundtrack.

2. At either the very beginning or end of the track, click on the blue control point in the middle of the track. Drag in to the right or left to change the starting or ending point.

OR

1. Right-click at the point in time where you want to start or stop your track.

2. Select either Start or Stop Track Here from the menu that appears.
Changing Slide Times using the Timeline View

One of the benefits of the **Timeline View** is that it allows you to compare the waveform of your music to the slides and transitions in your show.

Using the thumbnails of your slides, you can adjust the slide time and transition time to better match the volume or energy of your soundtrack.

As you hover over a thumbnail, a tool tip will appear and give you more information including:

- The current slide
- Slide time
- Transition time
- The transition effect

To adjust the total duration for your slide, click on the right edge of the transition. Both the slide time and transition time will change proportionally as you make your adjustment. Drag to the right to increase the slide length, drag to the left to decrease the length.

To adjust the slide or transition time, click the defining line between the slide and transition. Dragging to the right will make your slide time longer and your transition time shorter. Dragging to the left will increase the time for your transition and will make your slide time shorter.
Controlling Slide Sounds using Timeline View

**Slide Sounds** can also be adjusted using **Timeline View**, but not all of the same options are available. **Volume** and **Fade** cannot be changed, but you can **Offset** your **Slide Sounds** by dragging them into a new position.

To **Offset** a **Slide Sound**, just click on the red or yellow waveform and drag it to where you want the sound begin playing in your show. You can even drag it to another slide entirely.

Duplicate and Split Tracks

When working in the **Timeline View**, you'll find two very helpful tools when you right-click on a sound in your show Soundtrack. These options are **Duplicate** and **Split**.

Let's take a look at each one:

- **Duplicate**: Creates a copy of your track and adds it immediately after the original. Any edits you've made to the sound length, fade values or master volume will be copied. Advanced volume edits using **Volume Control points** or **Keyframing** are not copied.

- **Split**: The **Split** options allows you to break a sound into two pieces.

  This is an excellent way to remove part of a soundtrack, offset pieces of the same audio track or splice different parts of a track together.
Crossfading Audio Tracks

When you have more than one song in your Soundtrack, you may find that you want to blend the tracks together so that one gradually fades out as the next song fades in. This is called a crossfade.

When you set up a crossfade, you’ll need to change the **Fade In** and **Fade Out** for the tracks involved as well as the **Offset**.

You can adjust these values manually by using your Soundtrack options, but it’s much easier to do this visually using the Timeline View.

**To Crossfade Audio Tracks Using the Timeline View**

1. With two songs added to your show, select the **Timeline** tab located above the **Slide List**.

   Depending on how many slides you have and how long your show is, you may need to add more slides so that you can see both tracks. Remember, tracks will alternate between green and blue.

   2. Click on the first song in your Soundtrack to activate the track for editing.

   3. Go to the end of the first song and click on the blue control border, in between the center point and either the top or bottom point.

   4. Drag the control line to the left. This will create your fade out.

   5. Now click on the second track.

   6. Go to the beginning of the second song and click on the blue control border, in between the center point and either the top or bottom point.

   7. Drag the control line to the right. This will create your fade in.
8. Next, press the **CTRL** key, click on the second track and drag it to the left. This sets the **Offset** for the second track to a negative value. This means the second track will now start before the first track ends.

9. Release the **CTRL** key when you have the tracks crossfaded to your liking.

In the **Timeline** you’ll notice that the waveforms have come together to create a teal color (the blending of green and blue) to visually let you know that the tracks now crossfade.
Using Volume Control Points

As you learned earlier in this chapter, when you select a track for editing, at the beginning and end of track, you'll find yellow *Volume Control Points* at the top and bottom of the control border.

By default, these are anchor points that represent the master volume for the track - which is generally set to 100%.

Using the *Timeline View*, you can insert additional *Volume Control Points* anywhere you'd like within a track.

This allows you to create custom changes in volume all throughout the playback of a track.

**To Add a Volume Control Point**

1. In the *Timeline View*, select a track for editing.

2. Locate where you'd like to add a new point and right-click on the track.

3. From the menu that appears, select *Add Volume Point*

   or

   Press the *ALT* key on your keyboard as you *left click* on the waveform.

Once added, click and drag the *Volume Control Point* left or right to adjust where the volume change will occur. As you move the point, a tool tip will appear that shows you the exact time and volume for each control point.
To Set the Volume Level for a Volume Control Point

- Using your mouse, click and drag the **Volume Control Point** up or down to raise or lower the volume.

**Or**

- Right click on the **Volume Control Point** and choose the **Adjust** option.

This will open a **Set Volume** window. From here you can enter the exact volume you'd like your track to be at this point. You can set the volume from 0% to 200%.

To Remove a Volume Control Point

- Right click on the **Volume Control Point** and choose the **Remove Volume Point** option.

You can also completely reset your track and remove all volume points by right-clicking on any part of the selected track and choosing **Reset Volume Points** from the menu.
Volume Control Point Tips

Using **Volume Control Points** to create custom volume changes can really add a creative and highly polished feel to your show. However, this is a tool that takes a little effort.

Before adding **Volume Control Points** to audio in your shows, consider the following items:

- **Soundtrack During Other Sounds**: Often, the goal of volume control is to have the soundtrack fade out while some other sound plays, such as a narration, sound effect or the audio from a video clip. Instead of using **Volume Control Points**, keep in mind that ProShow will adjust the **Soundtrack** volume *automatically* when other sounds are detected. You can fine tune that automatic behavior by double-clicking on the **Soundtrack** bar.

- **Using Keyframes**: Another desired result is to have audio volume changes match effects in your show. Rather than adding **Volume Control Points**, you may want to coordinate volume changes at the same time you create your effects. You can do this very easily using Keyframes -which is covered in more detail in Chapter 17.

When adding **Volume Control Points** is the best choice for your show, consider the following helpful tips:

- **Expand the Timeline View**: Expanding the **Timeline View** gives you more surface area to work with -making incremental adjustments easier.

- **Use the playback indicator.** The play head just above the Slide List is connected to a marker that is displayed in the Soundtrack. You can use this marker to help you visually identify where to add new **Volume Control Points**.
12. Music and Sound Effects

- **Matching Volume Control Points**: If you want two points to line up so that they have the exact same volume, instead of trying to align them by clicking and dragging, just right-click.

  Choose **Set Volume**, and then select which neighboring point you’d like match up with.

- **Add Volume Control Points LAST**: As part of your show creation workflow, be sure you're 100% happy with how your show looks visually before adding any custom volume changes.

  **Volume Control Points** often require precision timing adjustments. Adding/removing slides, or even making a small change to a transition or slide time can have a negative impact on any custom volume controls that you apply to audio in your show.
Additional Volume Control Points

When you add Slide Sounds, enable the Fade Soundtrack at End of Show option or use Keyframes to control the soundtrack, you will see some slightly different Volume Control Points in the Timeline View. These control points will appear as black dots in the timeline.

Unlike normal Volume Control Points, these points cannot be moved using the Timeline View. To make changes to these points, consider the following:

- For show wide changes, double-click on the Soundtrack bar and apply changes to the Soundtrack options for Slide Sounds and Other Sounds. Or uncheck the Fade Soundtrack at End of Show setting.

- For changes that affect a slide, open the Slide Options window for the slide, and either adjust the keyframes or Slide Sounds audio options.

To learn more about controlling the Soundtrack using Keyframes, see chapter 17.
12. Music and Sound Effects
13. Slide Styles

Using Slide Styles

As you learned in Chapter 7, Effects, Slide Styles are pre-built, ready-made effects that you can apply to any slide. When you apply a Slide Style, the style acts as a blueprint. Within that blueprint are all of the instructions ProShow needs in order to create the desired effect. The number of layers, the layers' appearance, motion effects, adjustment effects, captions and even slide sounds - all of that information is stored within the Slide Style.

Applying a Slide Style, begins with a slide. Go ahead and pick some images and drag them to the Slide List. You can pick any images you want because styles are designed to be flexible and will work with any content that you add to a show.

There are two ways that you can apply Slide Styles: from the Effects window, or by using the Slide Options.

How to Access Slide Styles

Using the Effects (FX) window:

1. Click the FX icon in the Build Workspace or Design Workspace Toolbar

2. At the top of the window, select the Slide Styles tab

OR ...
Using **Slide Options**:

1. Double-click on a slide to open the **Slide Options** window.

2. Click on the **Slide Style** tab located in the top left corner of the window, under the **Slide Options** navigation label.

The **Effects (FX)** window is great for those times when you want to quickly apply the same style to several slides at once. Simply select a range of slides in your **Slide List**, choose your style and click **Apply to Slide**. This is also where you’ll go to manage your **Slide Styles**.

Accessing **Slide Styles** using **Slide Options** offers the advantage of seeing a preview of the effect before it’s applied. When making more customized shows or when creating your own effects, choose this method.

For the rest of this chapter, we’ll be using **Slide Options** to cover all of the details. The windows will look a little different, but all of the same styles, information and management tools are available in both.
Using **Slide Options** go ahead and select the **Slide Styles** tab

Beneath the **Preview** you’ll find the **Slide Styles List**. From here you have access to all of the slide styles that you can apply to your slides. This list includes built-in styles, as well as any effects that you create or install separately.

Now that you know how to access the **Slide Styles** let’s make a quick slide and apply a style so that you can see exactly how it works

### Creating a Slide with Slide Styles

1. Create a new slide with one image of your choice.
2. Double-click on the slide and select the **Slide Styles** tab from **Slide Options**.
3. In the categories list on the left, select **Slide Styles – Built In**.
4. From the available styles that appear on the right side of the list, choose the style ‘**A Moving Backdrop**’.
5. Click the **Apply Style** button, just below the **Slide Styles List**.
6. Click on **Ok**.

Notice that your single image has been duplicated, customized, and enhanced with motion. You clicked just a few times to apply the style. Now that it’s done, the image you chose has been fully integrated into a complete effect.
Understanding the Style Options

You’ve seen styles in action. Now it’s time to learn how to choose just the style you want to use by working with the options available to you. Let’s start with the Preview.

The Slide Style Preview

The most obvious aspect of the Slide Styles options is the animated preview that plays. You can watch this preview to get a sense of exactly what the style is going to look like once it’s applied to your slide— including the images you’ve added to the slide and the slide and transition durations. You can toggle the animated preview on and off by clicking on the Play/Stop icon that appears at the bottom of the Slide Options window.

If there are any sounds associated with the style, those will play as well. If you don’t want to hear the sounds, just click on the speaker icon that appears at the top of the Selected Slide Style Pane to toggle the sounds on and off for the preview. This won’t affect whether the sounds are used when the style is applied.
The Selected Slide Style Pane

Just to the right of the **Preview** is the **Selected Slide Style** pane. This is where you can view all of the details about the style you have selected.

The **Selected Slide Style** pane also includes descriptive information about the style you’re looking at.

First is the name of the style. Next is information about who made the style, how many layers it’s designed to work with, what aspect ratio works best with the style, and the suggested time for the slide.

There’s also a text description of what the style does, giving you a sense of the purpose for the slide style.

At the very bottom of the pane, you’ll also see which categories the style has been associated with.

The Slide Styles Pane

The **Slide Styles List** is where you will find all of the styles currently installed on your PC. Think of this collection of styles as your ‘library’ of styles. Learning how to choose just the style you want from your library is important to using slide styles quickly.

The **Slide Styles Pane** is located beneath the **Preview**. From here you’ll have access to all of the styles that you can apply to your slides.

On the left you’ll find the Categories list, depending on the category you choose, different styles will be available in the list of Styles on the right.

Above the list you’ll find filters for browsing your styles, **Slide Style** management tools, **Slide Styles List** display options and a counter that shows how many styles are currently listed.
Using the filters will help you pick just the right style for your slide.

- The first filter is ‘Aspect Ratio’. This category helps you choose a style based on the aspect ratio you’re using in your show. By default this is set to ‘Match Show’ to automatically select the correct ratio for your show. You can also choose to show ‘All Aspect Ratios’, or the individual aspect ratio options of ‘4:3 - Television’, ‘16:9 - Widescreen’, or ‘Custom’.

- The second filter is ‘Layers’. This allows you to choose a style based on the number of layers it works with. You can choose any number of layers. If you have 4 layers on a slide, you can filter to see just those styles that are made to work with 4 layers. You can also select ‘Match Slide’ which will automatically select the styles appropriate for the number of layers you have added. By default this is set to show ‘All Layers’.

On the far right side of the Slide Style pane, you’ll find the list display options. Choose a thumbnail view by clicking the icon on the left. The icon on the right will show a condensed text-only list. The text-only list displays less information about each style, but lets you see more styles in the list at once.

When you select your filtering options, ProShow will limit the styles that appear in the list to just those that meet your chosen criteria. This makes it as easy as possible to see just those styles which will work best with your slide. Click on each Style to see it in action, or use the Previous/Next icons to browse through your filtered list.

If you want to hide a style in the list, such as one that you don’t use often, you can do that by editing the style from the Manage Styles window. Managing and editing styles is covered in more detail later in this chapter.
Slide Style Entries

The slide styles that appear in your Slide Styles list are displayed here to help you make a quick choice about just which style you should use.

The title of the style is displayed in large text. The titles are meant to be descriptive indications of what the style will do to help you identify useful styles at a glance. If you know the name of a style, click on any style in the list and type the first few characters of the style name on your keyboard, the selector will quickly jump to that part of the list.

Once you find your preferred style, below the title you’ll see ideal slide and transition times that recommended when using that style. On the right, the aspect ratio icon indicates the aspect ratio the style was designed for. These will display as ‘4:3’, ‘16:9’, or ‘Any’ for a style that will work with both.

The number of layers that the slide style is designed to use will appear on the far right. You can apply a style that requires more layers – you’ll be able to add photos to those layers after you apply the style.

If a style is applied, that will also be indicated in the entry.

The Slide Styles pane also has four buttons that you’ll use when working with styles:

- **Create**: opens a dialog window to create your own styles. You will find a dedicated section on creating your own styles later in this chapter.

- **The Reset Icon** will remove the current style from your slide and restore the default settings for all layers and captions on the slide.
13. Slide Styles

- **Manage**: opens the Effects (FX) window. From here you can add create, remove, edit, categorize or export styles that are in your library.

- Use the **Favorites Icon** to single out your favorite effects. Simply choose a style from the list and click the **Favorites (star) icon**. You'll see an orange star appear on the right side of the style entry. Favorite effects will now also be grouped together in the Favorites category on the left.

You’ll find more details on using favorites and managing styles a little later in the chapter.

**Applying Styles to Multiple Slides**

As mentioned earlier in this chapter, when you want to quickly apply the same style to several slides at once, you’ll want to use the Effects (FX) window to apply your Slide Styles. Simply select a range of slides in your Slide List, choose your style and click **Apply to Slide**.

When making more customized shows, you’ll generally spend most of your time in Slide Options, editing your show one slide at time. As a shortcut for moving between slides, use the Previous/Next icons that appear at the bottom of the Slide Options window.
Where to Get More Styles

*Slide Styles* can be really handy and quite addicting to use in your shows so you’re probably going to want to get more of them.

One option is to purchase *Style Packs*. Photodex offers library add-ons of nothing but high quality *Slide Styles* that you can purchase. These add-ons can be downloaded or shipped to you on disc. You can find more details about *Style Packs* on the Photodex website (www.photodex.com).

You can also find more styles from other vendors on the Internet. Try some web searches for terms like “ProShow styles” or something similar to find other packs available online.

Photodex Style Packs come with their own built-in installation process, but for third party styles, use the Add button found in the Effects (FX) window to add the style to your library. You can also double-click on a PXS file (.pxs is the file extension for slide styles in Windows) to have ProShow automatically install it for you. Adding styles is covered in more detail a little later in this chapter.

Making Changes after Applying a Style

Applying a style isn’t necessarily the end of your work on that slide. It’s very possible that the style you picked doesn’t do exactly what you want to see on that slide. If that’s the case you can always make changes.

The best thing about a slide style beyond the fact that it does most of the heavy lifting for you, is that it’s completely flexible. You can change whatever you want after you’ve applied the style.

Is there a layer that moves from right to left and you’d rather see it move from left to right? Select the layer, go to the Effects tab, and change the way it moves.
13. Slide Styles

To help you stay organized, any layers created as a part of the style will be labeled "From Slide Style" in the Layers List.

If your style recommends specific slide or transition times, simply click the Set Slide Times icon at the bottom of Slide Options and type in the new settings.

While styles are meant to be as universally correct as possible, the style might not work flawlessly with the images in your slide. Feel free to make any adjustments that you need to make each slide look its best.
Creating Your Own Styles

We’ve spent quite a bit of time covering how you can use pre-made styles in your shows. One of the most valuable aspects of styles, however, is your ability to make your own styles from any effect you create.

Creating your own styles can be an incredible time saving tool over the long term. Each time you make a new effect you can save it as a style. As you create more and more effects, you are effectively creating a complete toolbox of effects that you can quickly access and modify. You’ll find that shows will take you less and less time as you build up your library of your favorite or most often used effects.

Creating styles doesn’t require you to have to start from scratch. If you have a collection of shows that you’ve already made, you can turn any of those slides from those shows into new styles by using the steps below.

Creating your own slide style follows this basic process:

1. Create a complete slide with all settings configured.
2. Click the Create button in the Slide Styles pane.
3. Fill out the information fields displayed.
4. Click Ok to save your new style.

Once you save your style it will be displayed in the Style List along with every other style you have installed. From that point forward you can select and use it just as easily as any pre-made style.

Let’s talk about the Create a Slide Style interface in a bit more detail.
Using the Create a Slide Style Window

To create your own styles, you’ll need to access the Create a Slide Style window. You can open this window by clicking the Create button the Style Style pane. You can also open this window using the Effects (FX) window.

This Create a Slide Style window is where you’ll enter all of the information about the style you are creating.

There are a few fields to fill out and some options to check. Let’s go through each one.

- **Name**: this is the title of your style that will be displayed in both the Style List and the Selected Slide Style pane. Make sure the name is a quick and accurate description of what your style does.

- **Categories**: These are the categories that are applied to your new style. You can change the categories by clicking the Select button. Changing categories is also covered in more detail later in this chapter.

- **Publisher Name**: this is your name, as you’re the creator and publisher of the style. Just enter your name or perhaps a business or studio name if you have one.

- **Publisher Website**: here you can enter the address to your website, blog or social media site.
• **Aspect Ratio:** if you don’t check this box, ProShow will assume that this style will only work with the aspect ratio applied to the show at the time you created the style. If you check the box, you tell ProShow that this style is appropriate for all aspect ratios. For more information about aspect ratios and styles, see **Styles and the Show Aspect Ratio** later in this chapter.

• **Compatibility:** both ProShow Gold and ProShow Producer can use styles, but Producer has features that cannot be used in Gold. If you want your style to work in both versions of ProShow, check this box. Keep in mind that doing so will disable any Producer specific features in the style. This includes things like keyframes, masking, etc.

• **Description:** the description tells you exactly what this style will do. Description text appears in both the **Style List** and the **Selected Slide Style** pane. Try to make sure your description is thorough and accurate to make sure you can remember what the style does.

When you have filled out the information about your new style, click on **Ok**. The style will be saved and will immediately appear in your library for use on this and any other shows you create in the future.

Remember that creating a new style starts by making a complete slide. Get all of your layers moving, sound effects in place, and everything else configured first. Once you’re done with the slide, then you can create the slide style.

**What's Included when Creating Slide Styles**

When you create a new slide style, the style retains almost every detail needed to recreate the effect except the images. Items that require hands on configuration, like **Chroma Key** and **Crop** are omitted, but this functionality is what allows the style to work with any images you choose. ProShow doesn't care what images were used to create the style. ProShow is only concerned with what happens to the layers that are used and how they create the effect.
In some cases however, you may not want ProShow to disregard some of the content you used to create the effect. Certain images, videos or Text Layers may be critical pieces that are required in order to recreate an effect. This is often the case if you’re making a style that has an image background that you always want to appear the same way, or perhaps a logo, border or text layer that you always want to appear when this style is used.

Remember that ProShow works with layers. These layers are basically containers for your images, videos or text. When you make a style, you’re telling ProShow that the layers and settings are important but the content within those layers is not. ProShow will recreate the style by applying the settings to your slide, regardless of which content you choose to fill the layers.

That’s why if you want a layer to retain a certain image or text layer as part of a Slide Style, you have to tell ProShow to make that happen.

In these cases, you need to instruct ProShow to include that image or Text Layer as part of the style. This is done using **Layer Settings**.

**To Include Content in a Style**

1. In the **Layers List**, select the image layer or text layer that you want to keep as part of the style.

2. Select the **Layer Settings** tab and go the **Layer Type** area.

3. Uncheck the option for **Style / Template Replaceable Image**.

4. The image will now be included as part of the style.
Undoing a Slide Style

You may find that you’ve chosen a style for your slide that doesn’t do what you had in mind. If you ever find yourself in a situation where you want to remove a style from a slide, here’s how:

1. Open the Slide Options for the slide you want to adjust and select the Slide Style tab,

2. In the Slide Styles pane, click on the Reset icon.

This will remove the style settings you’ve chosen. It will also restore all the layers and captions on the slide to their default values. This can be used to restore everything to default even when you don’t have a slide style applied.

Managing Slide Styles

As you create new styles or add additional styles into your library, you may reach a point where you want to re-organize your collection a bit, create favorites or perhaps delete older styles that you no longer use. This is where managing your library comes into play.

In addition to editing or deleting styles, you can import new styles and export styles you have created using this window. It’s your single stop for all style related upkeep in ProShow.

To Manage Slide Styles

1. In the Build Workspace Toolbar or Design Workspace Toolbar, click the FX icon to open the Effects (FX) Window.

2. Select the Slide Styles tab at the top of the window. All of your management tools will be available at the bottom. Keep in mind that some options require you to select an effect before they are activated.

OR
13. Slide Styles

1. Double-click on a slide to open the Slide Options.

2. Click the Slide Styles tab.

3. Click on Manage button in the Slide Style pane. This will open the same Effects (FX) window that you access using the FX icon in your workspaces.

4. Select the Slide Styles tab at the top of the window, and choose your desired action.

When you open the Effects (FX) window you will see the Slide Styles list. On the left are your effects categories, in the middle you’ll see your styles, and on the right will be a Slide Style Information area. The list you see here is functionally identical to the list you work with in Slide Options. It’s the buttons on the bottom that give you additional functionality.

Add

New styles can be added into ProShow for use in shows using this tool. The process is the same whether you’re adding a style that you downloaded from someone else or restoring a style that you backed up.

To add a style, just click on the Add button, locate the style you want to add by browsing your computer, and click on Open. ProShow will add it to the library and it will be immediately available for use.
Note: You can also double-click on a PXS file in Windows to install it automatically. If you are downloading a PXS file from the web, you can choose Open when prompted by your web browser to begin installation.

To Import a Slide Style

1. Open the Effects (FX) window.
2. Click on the Add button at the bottom of the window.
3. Use the file browser to locate the PXS file you want to import and click on Open.

OR

1. Double-click on the PXS file in Windows to install the style automatically.

Create

Clicking Create opens the Create a Slide Style window you learned about earlier in this chapter. When you click Create in the Effects (FX) window, ProShow will make a new style using the settings in the slide you currently have selected in the Slide List. All of the timing and layer settings you’ve applied will be converted into a new style for your library.

To Create a Slide Style

1. In the Slide List, select the slide that features the settings you want to convert into a style.
2. Open the Effects (FX) window using the FX icon in your workspace, or by clicking the Manage button found in Slide Options when the Slide Styles tab has been selected.
3. Click the Create button to open the Create a Slide Style window.
4. Fill out the information for your new style.
5. Click Ok to create the new style.
Remove

Remove is as simple as it sounds. Selecting a style from the list and clicking on Remove will delete that style permanently from your PC. You should only select this option if you know, without a doubt, that you no longer want to use this style.

To Delete a Slide Style

1. Open the Effects (FX) window.
2. Click on Remove.
3. Click on Ok to confirm your selection.

Edit

Editing a slide style doesn't change the way it works or the effect it applies. Instead, editing a style gives you the ability to change some of the details and information about that style.

When you click on a style and select Edit, you will be given the option to change details like the name, description, category, and other options about the style.
Note: Editing a style cannot replace the name of the publisher and publisher website. This is done intentionally to protect the creations of those who choose to share slide styles. The only time the publisher name and website can be entered is when a new style is created.

In addition to changing the name, description, and category of a style, you can also choose whether to Hide it in the main listing or not. This is often useful if you don’t use a style that often, but still want to keep it installed on your system. Any changes you have made while editing a style are saved when you click Ok.

Categorize

The Categorize option will let you add or change which categories your various styles are part of. You can do this by changing one style at a time or by selecting a group of styles and changing their categories all at once.

The Categorize feature will also let you add styles to multiple categories. Do you have a style that is both a Basic Montage and Image Adjustment? You can put that style into both categories.

Using Categorize to Change Slide Style Categories

1. Open the Effects (FX) window.
2. Click the Categorize button.
3. Click on the checkbox to the right of each category you want to change. When checked, this means the style belongs to that category. Selected categories will become highlighted and their title will appear in bold text.
4. Click on Apply to save your category changes.
You can also create new categories to help keep your library of effects organized. This really comes in handy if you know that you have certain effects that work best with specific types of shows. For example, if you have styles that you know are perfect for wedding shows, go ahead and add a Wedding category and populate it with those favorite styles.

**To Create a Slide Style Category**

1. In the **Styles List**, select the styles you wish to add to a new category. You can select multiple styles by press the **CTRL** key as you click on each style.

2. Click the **Categorize** button.

3. Click the **Add** button.

4. Give your new category a name and press **Ok**. The selected style(s) will automatically be added to the new category you have created.

5. Click on **Apply** to create the new category.

You don’t have to have all of your styles selected before you create the category, but you do need to have at least one selected before the **Categorize** option becomes available in the toolbar. Once a category is created you can add or remove styles from the category as needed.

To remove a category, select the category in the **Categories List**. Next, set your filters to show all aspect ratios and layers so that you can see all of the effects tied to the category. Click the **Categorize** button and uncheck all of the effects that are tied to the category. Once there are no effects associated with a category, the category will no longer appear in the list.
Using Categorize with Multiple Styles

You can change the categories of groups of styles at one time by selecting more than one in the Slide Styles list. This slightly changes the way the categories behave.

1. **Select multiple styles in the Slide Styles List.** You can select multiple styles by holding CTRL on the keyboard and clicking on each one, or by holding Shift and clicking on the first and last in the range you want to choose.

2. **Click on the Categorize button.**

3. **Categories** that are used by some, but not all of the selected styles will be partially selected in the checkbox. There won’t be a check, but you will notice that the box is colorized.

4. Click on each category to which you want to add the styles, making sure the box is checked.

5. Uncheck the boxes for any categories you don’t want the group to be a part of.

6. **Click on Apply to save your category changes.**

**Note:** you can’t selectively add styles to categories while changing groups. Your styles will all be in a selected category or all removed from a category. If you want to ignore the changes you’ve made click on **Cancel** rather than **Apply.**

Favorites

The **Favorites** icon, allows you to single out, and easily access the effects that you use most often or like the best.

Simply select a style and click the **Favorites (star) icon.** An orange star will appear on the right side of the style entry, indicating that the effect is one of your favorites.
Once selected, these effects will also be grouped together in the Favorites category, located near the top of the categories list on left.

To remove a favorite from your list, simply select the effect and click the Favorites (star) icon again.

Export

Clicking on Export opens a file browser window. This tool is used to export slide styles from your library. This tool allows you to save your style as a .PXS file. This file contains all of the information about your style.

Exporting a style prepares it to be shared with others, or to be saved as a backup. The PXS file can be uploaded to the internet or e-mailed to a recipient to let them use the style in their own shows. Alternatively, you can burn the PXS file to disc or save it to another hard drive to back up your style in the event of a system failure.

When you click on Export, simply choose where you want to save your style, give it a name, and click on Save.

To Export a Slide Style

1. Open the Effects (FX) window.
2. Select the style(s) you want to export in the Slide Styles List.
3. Click on Export.
4. Choose the location on your system where you want to save the style, type in a name and click on Save.
You can export multiple styles at once by selecting all the desired styles in the list before you click Export. You’ll still be prompted to specify a name for each one, but ProShow will remember the folder you’re exporting to and will default to saving with the existing style name.

**Note:** The export function is provided as a quick way to save a style you’ve created to another location. It operates very similar to a ‘save as’ feature – it just creates a copy of the style file. If you choose, you can also just copy the .PXS file directly using Windows Explorer or your favorite backup utility.

### Replacing or Updating Styles

At some point you may want to update a style with some new tricks you’ve learned, or replace a style you already have with a slightly modified version. This is done by overwriting the style that already exists in your library.

If you apply an already existing style, make changes to it, and decide that you want the style to work that way for good, you just need to create a new style with the same name.

### To Replace or Update an Existing Style

1. Apply the style that you want to update to a slide.
2. Make your desired changes to the style.
3. In the **Slide Styles** pane, click the **Create** button.
4. Use the **exact same name** for the new style as the old style.
5. Click on **Ok**.

ProShow will ask if you want to overwrite the old style. If yes, click on **Ok** and your changes will be saved. This is a great way to refresh older styles you have created, or to personalize styles you have downloaded to suit your preference.
13. Slide Styles

Styles as a Training Tool

Slide styles make an excellent training tool for you if you’re still learning how features work in ProShow. Try applying any style and then looking through the various options for the layers in the style.

You’ll see how each setting was configured as well as all of the other details about what makes that effect work. Taking a look at styles is a great way to learn the program by reverse engineering how each effect was put together. Never underestimate the training value of looking at the work of others.

Preserving Styles

At some point you may update to a new version or ProShow, or uninstall ProShow. You can rest assured knowing that updating to a new version or uninstalling the program will not delete the styles in your library. Feel free to do either as often as you want.

If you need to completely reinstall Windows or format the PC, however, you will lose your styles unless you back them up. Use the Export tool to save all of your styles as PXS files and save them in a safe place. Once you have reloaded your system, or moved to a new one, use the Import tool in ProShow to bring all your saved styles back into the library.
Slide Style PXS Files & Structure

**Slide Styles** are contained in a single file on your PC called a **PXS** file. These files hold all of the information that’s used to create a style when you choose that option.

The PXS file is basically like a complete show file, with instructions for how it’s put together, all in one place.

There are two different ways that PXS files are stored. Let’s go into those now so you have an understanding of how they’re put together.

**Where PXS Files are Saved**

ProShow comes with a group of built-in styles that are ready for use from the time you install the program. These are installed along with the rest of the program in the default installation path (unless you entered a different path during installation):

C:\Program Files\Photodex\ProShow Producer\styles\ 

If you open this folder on your PC you’ll see that it’s full of PXS files. These are what ProShow uses to create the styles you choose while you’re making a show.

The situation is slightly different for styles that you create, import, or get from a **Style Pack**. These aren’t part of the default installation of ProShow so they go in this folder:

**For Windows 7, 8 and Vista:**

C:\ProgramData\Photodex\Proshow\Styles\ 

**For Windows XP and previous:**

C:\Documents and Settings\All Users\Application Data\Photodex\Proshow\Styles\
These folders are going to be hidden by default in Windows regardless of which version you’re using. If you want to see these folders you need to enable the **Show Hidden Files and Folders** option in Windows Explorer.

Inside this application data style folder, you’ll notice a sub-folder named ‘Cache’, which may contain copies of some of your styles. This folder is used by ProShow to speed up work with styles, and contains temporary files. You can delete this folder any time you like – ProShow will recreate it as needed. Be careful, however, not to change the contents of the Cache folder, as adding, deleting or changing the contents of this temporary folder may result in unexpected behavior with your styles.

**Note:** PXS files are stored in two different folders on your PC to protect your styles and follow Windows best practices for storing user application data. The styles that ProShow comes with are installed in the normal program folder. The styles that you create or add are all saved in the ‘AppData’ folder. That’s because the AppData folder contents don’t change when you uninstall or reinstall ProShow. It gives you the ability to remove or change ProShow without accidentally deleting all the styles you downloaded or created.

If you edit or change a built-in style, the changes will be saved in the application data folder. This protects the original installation, and ensures that your changes won’t get lost if you reinstall ProShow. Built-in styles cannot be removed, but they can be hidden using the editing window.

If a style exists in both the application data folder and in the program folder with the same name, the style from the application data folder is always used.

You can determine which location any given style is located in by looking at the details displayed in the Manage Styles window when that style is selected.
Working with PXS Files

PXS files can be copied and moved around on your PC just like any other file. Keep in mind that moving a PXS file out of the two locations just mentioned will prevent ProShow from seeing them, though. Generally, you should only copy styles in and out of the application data folder. Styles which are copied into the program folder may be lost if you reinstall.

What Doesn’t Get Applied By a Style

There are some options that aren’t applied by slide styles whether they’re included in the original creation of the style or not. These kinds of settings are typically things that just don’t work well when they’re added automatically to a slide.

Most of these come in the form of Editing changes. When you apply a slide style, these features from the Adjustments tab > Editing Tools aren’t included:

- **Crop** isn’t included because ProShow has no way to figure out which section, of the potentially infinite images you could use with the style, should be chosen to crop.

- **Red Eye** isn’t included for the same reason. ProShow has no way to figure out which sections of the image should automatically get Red Eye, or if that’s even appropriate for the image you chose.

- **Chroma Key** isn’t used because the values you use to make Chroma Key work properly change on an image to image basis.

- **Rotation** is also disregarded only because you might not want to automatically rotate an image as part of a style. (Note that rotation applied using Motion Effects will be saved with the style.)

There are two other items that aren’t applied as part of a style. These are the Slide Time and Transition Time of your slides.
Styles and Timing

It’s not a good idea to assume that every slide using a certain style should always be the same length or have the same transition settings. Because of that the style doesn’t actually change your Slide Time or Transition Time. Instead, the style will suggest an ideal Slide and Transition Time for you. These suggested times are based on the timing settings applied when the style was created. You can choose to use the suggested times by entering them yourself, or you can ignore it and use a time that looks best to you.

The suggested times appear beneath the name of the style in the Slide Style List, as well as in the Selected Slide Style pane.

Styles and the Show Aspect Ratio

You might have noticed that quite a few styles indicate that they’re made for specific aspect ratios. Some say that they’re appropriate for 16:9 while others are 4:3 styles.

Styles are made for specific aspect ratios because certain arrangements of layers on the slide will only work well in a particular aspect ratio. If you have a really large landscape image in the background of your slide and you’re displaying images on the far left and right edges of the slide frame, you’ve got a slide that’s probably going to work best in 16:9.

If someone were to load that slide up as a style on a 4:3 slide they’re going to cause the whole effect to look incorrect or just not show up within the edges of the slide frame. That’s why some styles call for specific aspect ratios.

This is also why you’ll often find two versions of the same style. One has been made to work best in widescreen while another has been adjusted to work well on a standard TV.
Making a Style for All Aspect Ratios

If you want to make a style that works well with both 16:9 and 4:3 aspect ratios you’re going to need to consider image spacing and arrangement.

Take a look at which styles come with ProShow that work for any aspect ratio. These styles are mostly single image enhancements or motion-based effects. Using a smaller group of images and keeping those images close to the center of the slide frame will work best for either aspect ratio.

You start to get into trouble when you have images or captions placed around the outer edges of the slide frame. So long as you avoid that you’re probably going to have a style that works well on both. Just remember to test your style on both to make sure that’s the case.

If you’ve created a style that should work for all aspect ratios, remember to check the Aspect Ratio checkbox when creating your style.
13. Slide Styles
14. Transitions

The Art of Getting from Slide to Slide

Transitions are the visual effects that occur as one slide ends and the next slide begins. Every slide in ProShow has one. It doesn’t matter whether it’s the first slide in the show or the last – there’s a transition at the end of every slide.

Transitions help define the pacing as well as the visual appearance of your slide show. For a slower paced show, try using longer transition times and simple blending effects. When making a faster paced show, try shorter transition times or more energetic effects.

Choosing transition effects and adjusting transition timing is easy to do and often an important part of making a great show. Whether using built in effects or creating your own, transitions are an integral part of making your shows look their best.

Using Transitions

Choosing a Transition Effect is fast and easy. Simply click on the Transition Icon located on the right side of any slide in your show and select the desired effect.

How to Apply a Transition Effect

1. In the Slide List, click the Transition Icon located to the right of your selected slide(s).

2. From the Choose Transition window, select the effect you wish to add to your show.

3. Click Apply at the bottom right
Using the **Effects (FX)** window:

1. Select the slide you wish to work with and click the **FX** icon in the **Build Workspace** or **Design Workspace Toolbar**.

2. At the top of the window, select the **Transitions** tab.

3. Choose your desired transition and either double-click or press the **Apply to Slide** button at the bottom of the window.

**Note:** You can change the **Transition Effect** for multiple slides at once. Simply select all of the slides you want to change and click any of the **Transition Icons** for the selected slides or open the **Effects (FX)** window.

Once you pick a new **Transition Effect**, all of the selected slide transitions will change to the same transition.

To select multiple slides, hold the **CTRL** key on the keyboard and click to highlight the slides you wish to work with. To select or a range of slides, select your first slide, then hold the **Shift** key as you click on the last slide. All slides between the two will be selected. You can also select every slide in the show by clicking on any slide in the **Slide List** and pressing **CTRL + A** on the keyboard.

The **Effects (FX)** window is great for those times when you want to quickly apply the same style to several slides at once. However, the **Choose Transition** window offers the advantage of showing you a preview of how the transition will look effect before it's applied.

Regardless of the method you choose, all of the same transitions, information and management tools are available in both windows.
Choosing Your Transitions

The Choose Transition window is where you preview effects and decide which transition you would like to apply to your slide(s).

The Choose Transition window is divided into four sections:

- The **Preview and Information** area - is where you'll find basic information about an effect as well as additional management tools.

- The **Categories List** - Use this list to help filter through your effects.

- The **Transitions List** - This list contains all of the effects associated with the selected category.

- The **Transitions Toolbar** - Use these shortcuts to quickly apply recently used transitions.

Preview and Information

Located at the top of the window, here you will see the name of the effect you have selected, a basic description of what the effect will do and a preview of how the effect will look when applied to your show.
You will also find several transition management tools that are accessible by clicking the following icons:

- The pause icon disables the active preview. Click the play icon to turn the active preview back on.

- The **Settings** (the gear-shaped) icon opens the **Effects (FX)** window which allows you to browse, categories import and export transitions.

- The Transition Selection mode is indicated by the hand icon. The on or off state of this option determines how you preview and apply a transition.

By default, the Transition Selection option is toggled off - appearing as a gray box. In the off state, when you click on a transition in the Transitions List, the name, icon and description will be displayed in the Preview and Information area along with an active preview of what the effect will look like. To apply the transition, either double click on the transition or select **Apply** at the bottom right.

When this option is enabled, you'll notice the icon changes from gray to blue. As you hover over an effect in Transitions List, information about the effect will appear in the Preview and Information area. Clicking the effect will immediately apply it to your slide and close the Choose Transition window.
The Categories List

On the left side of the Choose Transitions window you'll find a list of all of the categories that are used to sort and manage your transitions. As you select a category, all of the effects associated with that category will appear in the Transitions List.

Use the Categories List to filter through your effects until you find the transition you wish to use.

Clicking All Categories will display every transition available based on the current show's aspect ratio. For example, if you are making a widescreen show, clicking All Categories will show you transitions that have been designed to work with a 16:9 aspect ratio.

To add new categories or manage how your transitions are sorted, click the Gear icon in the Preview and Information area to open the Effects window and manage your transition effects.

The Transitions List

The Transitions List is where you will go to choose your desired effect. Click on an effect to see the active preview. This is will the effect will look when applied to you slide.

To apply the transition, either double-click, or single click and press the Apply button located at the bottom of the Choose Transition window.
The Transitions Toolbar

On the bottom of the Choose Transitions window is the Transitions Toolbar. The icons found here are basically shortcuts that will apply that specific transition without having to browse through categories.

The icons on the left do not change. These four options apply the following transitions:

- **Cut**
- **Crossfade (Blend) - Linear**
- **Crossfade (Blend)**
- **Random**

In the middle of the toolbar you will see the ten most recently selected transitions. As a workflow tip, look at this toolbar first before browsing for additional effects. Chances are your favorites, or most often used transitions, will already be listed here.

Random Transitions

Another transition option is to let ProShow choose effects for you at random. When you use the random option, ProShow will choose an effect from the Random Transition Effects list. If there are transitions you prefer not to apply randomly, simply go to the Random Transition Effects list and customize it to include only your desired effects.
To Apply a Random Transition

1. In the Slide List, select the slide(s) you wish to change and click the transition icon.

2. Select the Random (?) icon in the Choose Transition window.

OR

1. Select the slide(s) you wish to change in the Slide List.

2. Right-click in the Slide List. From the context menu, select Randomize > Randomize Transitions.

The Random Transition Icon

While each method will apply random effects, the Random (?) transition icon works a little differently than using the Randomize > Randomize Transitions option.

When you choose the Random (?) icon, the transitions will be different each time you preview or output your show. Not all transitions will be used when this type of random effect is used.

To randomize effects using all available transitions, use the Randomize Transitions menu option from the Slide List instead.

The Randomize Transitions Menu Option

When you choose the Randomize Transitions option from the context menu, ProShow will choose from any transition selected in Random Transition Effects list. Once applied, the transitions will appear in the Slide List as if you had chosen the effect normally.

There are two benefits to using this option. First, using Randomize Transitions allows you to apply any transition installed on your system, including third party transition packs and any effects you create. Additionally, once applied, transitions will not change each time you preview or output your show. The only way to change the transition is to select Randomize Transitions again or manually select a new effect.
To Customize the Random Transition Effects List

1. In the Build Workspace or Design Workspace Toolbars, click the Show Options icon.

2. In Show Options, click the Show Settings tab.

3. In the Show Setup pane, you will see the Set Random Transition button. Click the button to open the Random Transition Effects list.

OR

1. In the Menu Bar, select Edit > Preferences.

2. Select the Show Defaults tab and click the Select button next to Random Transition Effects in the Default Slide Settings area.

In the Random Transition Effects window, simply uncheck any transitions you do not wish to be available when using the randomize feature.

Click Apply to save the changes.
Managing Transitions

As you add additional effects to your library, you may reach a point where you want to re-organize your collection, or delete transitions you no longer wish to use. This is where the Effects (FX) window once again comes into play.

In addition to editing or deleting transitions, you can import new effects and export transitions you have created using this window.

To Manage Transitions

1. Click on the transition icon to the right of any slide.
2. Click the Settings (gear) icon in the Preview and Information area.

OR

1. In the Build Workspace Toolbar or Design Workspace Toolbar, click the FX icon to open the Effects (FX) Window.
2. Select the Transitions tab at the top of the window. You’ll find your management tools at the bottom of the Effects (FX) window.

You’ll notice that the options under Transitions tab in the Effects (FX) window are similar to the Choose Transitions window. Both allow you to browse by category, show you a list of effects and provide information about the transitions.
14. Transitions

The primary difference is that the **Choose Transitions** window will show you a preview of the effect while the **Effects (FX)** window will show you more information, allow you to browse the transitions list by typing the first few letters of an effect, and give you access to the effects management tools.

**Sort Transitions by Aspect Ratio**

The **Choose Transitions** window will only display effects that match the aspect ratio of your show. The **Effects (FX)** window allows you browse effects regardless of aspect ratio.

Above the **Transitions** list, simply use **Aspect Ratio** link to filter your effects.

![Effects window](image)

**Add**

New transitions can be added into ProShow using this tool. The process is the same whether you’re adding a transition you downloaded from someone else or restoring a previously archived effect.

To add a transition, click on the **Add** button, locate the PXT file that contains the transition you want, and click on **Open**. ProShow will then add the transition to your library. You can also import multiple transitions by selecting all the desired transition files before you click Open.
To Add a Transition

1. Open the Effects (FX) window and select the Transitions tab.
2. Click the Add button at the bottom of the window.
3. Use the file browser to locate the PXT file you wish to import and click on Open.

OR

1. Double-click on the PXT file in Windows to install the transition automatically.

Create

Clicking Create opens the Create a Transition window. When you click Create in the Effects (FX) window, ProShow will make a new transition using the settings in the slide you currently have selected in the Slide List. All of the layer settings you've applied will be converted into a new transition for your effects library. Creating transitions is covered in detail a little later in this chapter.

To Create a Transition

1. In the Slide List, select the slide that features the settings you want to convert into a transition.
2. Open the Effects (FX) window using the FX icon in the Build or Design Workspace Toolbar, and select the Transitions tab.
3. Click the Create button to open the Create a Transition window.
4. Fill out the information for your new transition.
5. Click Ok to create the new transition.
Remove

Remove is as simple as it sounds. Selecting a transition from the list and clicking on **Remove** will delete that transition permanently from your PC. You should only select this option if you know, without a doubt, that you no longer want to use this effect.

**To Delete a Transition**

1. Open the **Effects (FX)** window and select the **Transitions** tab.

2. Select the transitions you wish to delete from the **Transitions List**.

3. Click on **Remove**

4. Click on **Ok** to confirm your selection.
**Edit**

Editing a transition doesn’t change the way it works or the effect it applies. Instead, editing a transition gives you the ability to change some of the details and information about that effect.

When you click on a transition and select **Edit**, you will be given the option to change details about the effect, including: the name, the categories it belongs to, the icon for the effect, the aspect ratio and the description.

![Edit Transition dialog box](image)

**Note:** Editing a transition cannot replace the name of the publisher and publisher website. This is done intentionally to protect the creations of those who choose to share transitions. The only time publisher name and website can be entered is when a new effect is created.

In addition to changing the name, description, and category of a transition, you can also choose whether to hide it in the main listing or not. This is often useful if you don’t use an effect that often, but still want to keep it installed on your system.

Any changes you have made while editing a style are saved when you click **Ok**.
Categorize

The Categorize option will let you add or change which categories your transitions belong to. You can do this by changing one transition at a time or by selecting a group of transitions and changing their categories all at once.

How to Change Transitions Categories

1. Open the Effects (FX) window and select the Transitions tab.

2. Select an effect in the Transitions List and click the Categorize button.

3. Click on the checkbox to the right of each category you want to change.

4. A checked category means the transition is a part of this group. Selected categories will be highlighted, and the title will appear in bold text.

5. An unchecked category means the transition is not part of that group.

6. Click on Apply to save your category changes.

The Categorize feature will also let you add transitions to multiple categories. This is especially handy when you have favorite effects that you know will work well for different types of shows. You can create a category for vacations and another for family gathers and assign that effect to both groups.
To Create a Transition Category

1. In the Transitions List, select the effects you would like to add to a new category. You can select multiple transitions by pressing the CTRL as you click on each effect. Use the SHIFT key to select a range of effects from the list.

2. Click the Categorize button.

3. Click the Add button.

4. Give your new category a name and press Ok. The selected transitions will automatically be added to the new category you have created.

5. Click on Apply to create the new category.

You don’t have to have all of your styles selected before you create the category, but you do need to have at least one before the Categorize option becomes available in the toolbar. Once a category is created you can add or remove styles from the category as needed.

To remove a category, select the category in the Categories List. Next, set your filters to show all aspect ratios and layers so that you can see all of the effects tied to the category. Click the Categorize button and uncheck all of the effects that are tied to the category. Once there are no effects associated with a category, the category will no longer appear in the list.

Favorites

Just as with Slide Styles, the Favorites icon allows you to single out, and easily access the effects that you use most often.

Simply select a transition and click the Favorites (star) icon. An orange star will appear on the right side of the effect entry, letting you know the transition has been set as a favorite.
Once selected, these transitions will also be grouped together in the Favorites category, located near the top of the categories list on left.

To remove a favorite from your list, simply select the effect and click the Favorites (star) icon again.

Export

Clicking on Export opens a file browser window. This tool is used to export transitions from your library. This tool allows you to save your effect as a .PXT file. This file contains all of the information about your transition.

Exporting a transition prepares it to be shared with others, or to be saved as a backup. The PXT file can be uploaded to the internet or e-mailed to a recipient to let them use the transition in their own shows. Alternatively, you can burn the PXT file to disc or save it to another hard drive to back up your effect in the event of a system failure.

When you click on Export, simply choose where you want to save your transition, give it a name, and click on Save.

To Export a Transition

1. Open the Effects (FX) window and select the Transitions tab.
2. Select the transitions you wish to export in the Transitions List.
3. Click the Export button at the bottom of the window.
4. Choose the location on your system where you want to save the style, type in a name and click on Save.

You can export multiple transitions at once by selecting all the desired effects in the list before you click Export. You’ll still be prompted to specify a name for each one, but ProShow will remember the folder you’re exporting to and will default to saving with the existing transition name.
**Note:** The export function is provided as a quick way to save a transition you’ve created to another location. It operates very similar to a ‘save as’ feature – it just creates a copy of the transition file. If you choose, you can also just copy the .PXT file directly using Windows Explorer or your favorite backup utility.

**Note:** Not all transitions can be edited -some are "hardwired" into ProShow. If you try to edit one of these effects, you'll be prompted with a notice informing you that the effect you have selected cannot be edited, categorized or exported.

### Creating Your Own Transitions

Not only does ProShow include hundreds of transition effects built-in, but it also allows you to create your own effects. Creating your own transitions is a great way to expand your collection of effects.

Creating a transition is very much like creating any other effect. It helps to remember that a transition is just an effect that involves two slides. Just like you might create a Slide Style that moves layers around – creating a transition is simply a matter of building an effect that moves two slides around.

The first time you create a transition, it can be a little daunting. Even though it uses all the ProShow layer options you’ve used to create Slide Styles and other effects, transitions introduce just enough new stuff that it can take a few tries to get your head around it.

Transitions are created by building a slide that contains the effect. You use special layers called **Transition Layers** to represent the slides that come before and after the transition. By applying effects to these layers, you are controlling what the slides do during your transition.

Let’s start with a very basic example. Let’s build a crossfade. This simple example will show you the basics of creating a transition.
Building a Custom Crossfade Transition

1. Create a new slide by clicking Add Blank icon located in the Build Workspace and Design Workspace Toolbars.

2. Set the transition times for your new slide to zero seconds by clicking in the transition times and typing ‘0’.

   **Note:** When building a transition, you can’t have any transition times.

3. Double-click the new slide to open the Slide Options.

Now that we’ve got our slide created, it’s time to add our transition layers. You can use any layer as a transition layer – it can be an image, video or a solid color layer. For this example, we’ll use solid color layers.

4. In the Layers List, click the Add (+) icon and choose Add Solid Color from the menu. Pick a color (any color), and click Ok.

5. Repeat step 4 again to add another solid color layer. Be sure to pick a different color – this will make it easier to see if your effect has been set up correctly later on.

Let’s make these layers into Transition Layers. This will tell ProShow that these layers represent slides. Remember that a transition happens between two slides – the slide you’re coming from (the source), and the slide you’re going to (the destination).

6. Right click on Layer 1. From the menu, pick Use as Transition Layer and select Source Slide from the sub-menu. This marks Layer 1 as representing the slide before the transition.

7. Right click on Layer 2. From the menu, pick Use as Transition Layer > Destination Slide. This marks Layer 2 as representing the slide after the transition.
You’ll notice that in the Layers list, your layers now say ‘Transition Source’ and ‘Transition Destination’. Now it’s time to actually add the fade that will create our effect.

8. Select Layer 1 and click on the Effects tab at the top of the window.

9. Select Layer 1 (Transition Source), and set the Ending Position’s Opacity to 0. This will make layer 1 fade out over the course of the effect. We want the source to start visible, then slowly fade out.

10. Select layer 2 (Transition Destination), and set the Starting Position’s Opacity to 0. This will make the destination start out hidden, then slowly fade in.

At this point, if you play the preview in the window, you should see the effect taking shape. Now all that’s left is to save this effect as a transition.

11. At the top of the Slide Options window, click the Slide Settings tab.

12. In the Slide Tools area, click the Create Transition button.

13. In the Create a Transition window you can specify various settings for your transition. These are covered in more detail later in this chapter. For now, be sure the name is set to Transition 1, and click Ok.
That’s it. You’ve just built a crossfade transition! To see it in action, add some images to your show, go open the **Choose Transition** window and look for your new transition under the **My Own Transitions** category. This is the default category for transitions you create.

### Creating More Advanced Transitions

The crossfade example was very simple – it was just a basic fade in and fade out. When you’re creating transitions, you’ll usually be building something more complex.

Transitions can use just about any effect you can create with ProShow. You can use motion to move the slide around (i.e. make the source slide zoom out while the destination zooms in). You can use adjustment effects like brightness, blur, and colorize. You can even use masks and adjustment layers.

The key to creating a transition is to remember that you’re just building an effect using two special things – your source slide and your destination slide. Anything you can do with those layers will happen to the slides during the transitions.

Here are a few things to keep in mind while creating transitions:

- **Always set the transition times to zero.** ProShow will remind you if you don’t.

- **You must have at least one source layer and at least one destination layer.** A transition requires that you start with something and end with something.

- **You can have more than one source and destination layer.** If your effect needs more than one copy of the source or destination slide, just mark multiple layers as the source or destination.

- **For best results, start with your source layer filling the screen.** If at least one of your **Transition Source** layers doesn’t start exactly filling the screen, you may see the slide pop, snap, or jump when the transition starts.
For best results, end with a destination layer filling the screen. Along the same lines, if your transition doesn’t end with a Transition Destination layer full screen, you’ll probably get a pop or jump when the next slide starts.

Many advanced transitions you build will make use of mask layers, or content that you will want to include with the transition (like backgrounds, video overlays, etc). For these layers, you don’t need to do anything special. Just add the masks or other layers as desired. ProShow will automatically include any content that is not marked as a source or destination layer with your transition.

For example, if you are adding a mask that hides part of your Transition Source layer, you do not need to mark the mask as a transition layer. Just use the mask as you would in any other slide.

Only mark a layer as a Transition Source or Transition Destination when you want that layer to be completely replaced by the source or destination slide.

Using the Create Transition Window

When you click Create Transition, ProShow will open the Create a Transition window. This window is where you enter all of the information about the effect you are making.

There are some fields to fill out and some options to check, so let’s take a look at each one.

- **Name:** This is the title of your transition. This will appear in the Preview and Information pane as well as in the Transitions List. The best names will always be a quick and accurate description of what your transition does.

- **Categories:** These are the categories that are applied to your new transition. You can change the categories by clicking the Select button. Changing categories is covered in more detail later in this chapter.
14. Transitions

- **Published By**: This is where you can enter the name of the transition creator. If you are selling or sharing transitions, feel free to enter your business name.

- **Website**: Enter the address to your website in this field. If you don’t have a website, direct someone to your blog or a social media page.

- **Transition Icon** – This is the image that will be displayed to represent your transition. By default, ProShow will generate an icon image that is a snapshot of the midpoint of effect you are creating. To change the icon, click the **Browse** button and navigate your computer to find your preferred image. You can return to the default icon by pressing the **Reset** button. For best results, use a small image – around 32 pixels wide and 24 pixels tall.

- **Aspect Ratio** – Checking the box will make the transition compatible with all aspect ratios. If the box is unchecked, the transition will only be available to those shows that share an aspect ratio with the current show. The transition will not be displayed in the **Choose Transition** window for shows of any other aspect ratio.

  **Note**: Most transition effects will function at any aspect ratio. You should test your transitions after they have been created to see if there are any aspect ratio compatibility issues. This setting can always be updated after a transition has been created.

- **Description** – This is where you can add extra information about the transition. Use this area to describe what the effect does or how it can be used in a show. You can also include recommended transition time if you like. This information will be displayed below the transition name in the **Preview and Information** pane the **Choose Transition** window.
After you have finished entering the information, click **Ok**. The transition will be saved to your library and available for immediate use.

### Including Video in your Transitions

Some of the more amazing effects you can create when making a custom transition will involve the use of video files. If you include a video as part of a transition effect, the key point to remember is that the video playback speed will be determined by whatever time is entered as the transition time in the **Slide List**. Because transitions are designed to be flexible, ProShow will speed up or slow down the video playback to fit the transition time.

If you create a slide that works best with a certain transition time, simply include that information as part of the transition description.
14. Transitions

There are two different ways that ProShow will handle video clips in your custom transitions:

- **When the loop video option is on**, ProShow will not adjust the speed of your video clip at all. Your clip will be looped as necessary to fill the transition. Use this option if your video clip is designed to loop, like when using a video as a background.

- **When the loop video option is off**, ProShow will adjust the speed of your video as the length of the transition changes. For example, you create a 3 second transition with a video that lasts 1 second. When the transition is applied and set to 6 seconds, your video will last 2 seconds. ProShow just speeds up or slows down your clip so it takes up the same percentage of the effect as you originally specified. When the video clip speed is adjusted, any audio in the clip is automatically muted.

Transitions and Modifiers

The way a modifier behaves is dependent on the duration of the slide it is applied to. However, transitions are designed to be flexible and are not dependent on any specific timing. If you create a transition that uses modifiers, you'll want to set the scaling of the modifier to make sure that it always behaves as intended.

To scale a modifier based on a specific time, simply check the box located in the **Modifier Target** page in the **Modifier** window and enter a value. You can also click the **Set to Slide Time** button to automatically apply the current timing of whatever slide you are working with.

When this option is off, the modifier will change when the transition time changes. When this option is enabled, your modifier will always maintain the same time, regardless of the time being applied to the transition.
Preserving Transitions

At some point you may update to a new version or ProShow, or uninstall ProShow. You can rest assured that updating to a new version or uninstalling the program will not delete the transitions in your library. Feel free to do either as often as you want.

If you need to completely reinstall Windows or format the PC, however, you will lose your transitions unless you back them up. Use the Export tool to save all of your styles as PXT files and save them in a safe place. Once you have reloaded your system, or moved to a new one, use the Add tool in ProShow to bring all your saved transitions back into the library.

Transition PXT Files & Structure

Transitions are contained in a single file on your PC called a PXT file. These files hold all of the information that’s used to create a transition when you choose that effect.

Where PXT Files are Saved

ProShow comes with a group of built-in transitions that are ready for use from the time you install the program. These are installed along with the rest of the program in the default installation path (unless you entered a different path during installation):

C:\Program Files\Photodex\ProShow Producer\transitions\

If you open this folder on your PC you’ll see that it’s full of PXT files. These are what ProShow uses to create the transitions you choose while you’re making a show.

The situation is slightly different for transitions that you create, import, or get from a Transition Pack. These aren’t part of the default installation of ProShow so they go into different folders:

For Windows 7, 8 and Vista:

C:\ProgramData\Photodex\Proshow\Transitions
**For Windows XP and previous:**

C:\Documents and Settings\Username\Application
Data\Photodex\Transitions

These folders are going to be hidden by default in Windows regardless of which version you’re using. If you want to see these folders you need to enable the **Show Hidden Files and Folders** option in Windows Explorer.

Inside this application data style folder, you’ll notice a sub-folder named ‘Cache’, which may contain copies of some of your transitions. This folder is used by ProShow to speed up work with transitions, and contains temporary files. You can delete this folder any time you like – ProShow will recreate it as needed. Be careful, however, not to change the contents of the Cache folder, as adding, deleting or changing the contents of this temporary folder may result in unexpected behavior with your effects.

**Note:** PXT files are stored in two different folders on your PC to protect your transitions and follow Windows best practices for storing user application data. The transitions that ProShow comes with are installed in the normal program folder. The transitions that you create or add are all saved in the ‘AppData’ folder. That’s because the AppData folder contents don’t change when you uninstall or reinstall ProShow. This gives you the ability to remove or change ProShow without accidentally deleting all of the transitions you downloaded or created.

Built-in transitions cannot be removed, but they can be hidden using the editing window.

If a transition exists in both the application data folder and in the program folder with the same name, the transitions from the application data folder is always used.

You can determine which location any given transitions is located in by looking at the details displayed in the **Effects (FX)** window when that effect is selected.
Bring Slides to Life

Creating motion in your slideshow is a major part of making your show interesting and dynamic. A still image works for certain presentations, but a moving image is almost always better. Just look at documentaries by Ken Burns. The vast majority of those are made up of images which pan and zoom to voice narration. It’s very simple but very compelling.

These kinds of effects are exactly what ProShow’s motion tools are designed to allow you to make. The whole system is set up to let you quickly put the motion together, no matter what kind you want. Make a layer pan slowly across the slide or make it dynamically rotate and zoom as it quickly zips from one point to another – it’s all up to you.

The Fundamentals of Motion

Creating motion in ProShow is fundamentally about where you want your layer or caption to start and where you want it to end. If you want a picture to move from left to right, you’ll start it on the left and end it on the right. ProShow handles the rest of the motion for you.

It’s important to remember that there’s no tedious plotting of individual points for motion, or recording how you want a layer to move as you drag it around. Just tell ProShow where the layer will begin and where it comes to a stop. That’s it.

Also keep in mind that motion works the same for both layers and captions. It doesn’t matter if the layer is a photo, video or a text layer.
Motion and Time

Motion and time are linked together in ProShow. Movement happens as time passes in your slideshow. This means that a long slide has a longer time for the motion to occur and vice versa for a shorter slide. Here’s the simple version: slide motion starts at the beginning of the slide and ends at the end of the slide.

ProShow makes motion by comparing where you have set a layer at the start and end of the slide. If the slide is 3 seconds long, that’s how long the motion will take to complete. If the slide is 6 seconds long, the same motion will take place, but it will take twice as long to get there. By the same token, a slide that is 1.5 seconds long will take only half the time to finish the motion.

The fundamental rule is that the speed of your motion is controlled by how much time it has to move. If you want something to move fast, keep the time short. If you want a layer to move more slowly, give it more time to get there. If you want to have exact precision over how your layers behave you need to use keyframing. You can read more about keyframing in Chapter 17.

Getting to the Motion Effects

Motion can be added to any slide you create. As long as you have at least one layer in place, you’re ready to make it move. To get started with motion, you’re going to need to know how to access the Effects options. That’s where all the work is done.
To Access the Effects Options

1. Double-click on a slide you have created to open the Slide Options window.

2. In the Layers List, select the layer you want to apply a motion effect to.

3. Click on the Effects tab. You'll find the Motion & Audio options beneath the preview.

OR

1. In the Build or Design Workspace, click on the Edit Slide icon in the Toolbar.

2. In the Layers List, select the layer you want to apply a motion effect to.

3. Click on the Effects tab. You'll find the Motion & Audio options beneath the preview.

As you learned in the Layers and Captions chapters, the Effects tab is a little different than the rest of the Slide Options. You're options appear below as usual, only here you'll also have a very different Preview that features more than one view of your slide.
There are also some additional navigation elements and a timeline—which we'll cover in more detail in Chapter 17, Keyframing. For now, let's take a look at the Preview and see how we use it to make **Motion Effects**.

### The Effects Preview

The most visually dominant item under the **Effects** tab are the **Preview** windows. When you first open a slide to start creating motion you'll notice a few things:

- There is a large preview in the center of the window and one smaller preview off to the right labeled **Next**
- The images within the previews are of the same layer.
- Both images feature a number. By default, they are 1 and 2

The larger preview is the active preview. This means that any changes you make to the settings in the **Motion & Audio** pane will be applied here.

The smaller preview is a navigation preview. You'll use this to click back and forth between different points within your slide. For instance, the start of a slide is one point, the end of the slide is a second point.

When you click on a navigation preview, it becomes the larger, active preview. To create your motion effects, you'll use both of these windows.
The Preview Windows

Most other areas of the Slide Options only have one preview window. So the obvious opening question is “Why have more than one Preview window?“ In short, more windows makes creating motion easier.

Remember that ProShow only needs you to tell it where you want a layer to start moving and where you want it to stop. The rest is all done automatically. The Preview windows are used to show you where you'll be applying the changes to your slide to create that motion.

The larger preview is the active preview. When you adjust settings here, those changes will be applied to that point in time within your slide. By default, when you first create a slide and open this tab, that point in time will be the starting position, or where your layer will start when the slide begins.

The smaller Preview on the right is the next point in time for the slide. By default, this is the ending position, or where the layer will be located when the slide ends.

Your goal in creating motion is to place the layer where you want it to appear when the slide starts and ends. ProShow handles the rest.

The Timeline

Just below the previews you'll find the Timeline. The Timeline is a visual representation of the total duration of a slide. This includes slide time and transition times.

You will always have two points on a timeline, the Starting Position and the Ending Position. These points in time are numbered sequentially. The number 1 will always represent the Starting Position, the highest number will always be the Ending Position.
Each of these points are **Keyframes**. You'll learn more about keyframes in chapter 17, but for now, the important thing to know is that a keyframe is simply a point in time when something happens. In the case of creating motion, that "thing that happens" can be a pan or zoom, etc.

The **Timeline** shows you visually where those points in time (keyframes) are within your slide.

### Identify an Active Preview

In addition to the active **Preview** being larger, when you select a point in your slide, you'll see a blue indicator line that connects the active preview to the timeline -this is the **Keyframe Selector Ribbon**. The **Keyframe Selector Ribbon** shows you where you are making changes within your slide.

In the figure below, you'll see that the ribbon shows us that the active point we're making changes to is at the very beginning of the slide.
Identify a Keyframe

In addition to the **Keyframe Selector Ribbon**, there are several other ways that ProShow helps you identify which point in your slide you are working with.

You'll find the first **Keyframe Indicator** above the previews on the top left side. This lets you know if you are at a Starting Position, Ending Position or any keyframe that appears in between the beginning and ending of your slide.

You'll also see the point in time where that keyframe exists. This will always read as 0 for the very beginning of a slide, and will always show the total slide time (including transitions) for the last keyframe in a slide.

The next **Keyframe Indicator** is also found just above the preview, only this time on the right side. Here you'll find the **Previous/Next Keyframe** icons.

The **Previous/Next Keyframe** icons allow you to move quickly between each point in your slide and will show you which keyframe is currently selected.
The third way to identify a keyframe is to look in the previews themselves. Each preview will feature a chevron icon that is numbered. The number 1 will always be at the beginning of a slide, the highest number will always be the final keyframe in a slide.

Changing Preview Modes

In ProShow, the active preview is larger by design - this is to give you more room to create and preview your effects. This default state is called Previews mode. In this mode, your active preview will be large and in the center of the window. On either side, you'll have navigation previews that you'll click on to go to the previous or next keyframes.
If you prefer, you can change the look of the Effects Preview and select Two Previews mode. In this mode, instead of having two sizes of previews, both your active preview and next or previous keyframe will be the same size.

To change modes, simply click the Three Previews or Two Previews icons at the top of the window.

As mentioned earlier in this chapter, we'll cover Keyframing in more detail in Chapter 17. For now, just keep the following in mind:

- A Keyframe is simply a point in time when something happens
- Every slide always has two keyframes - a Starting Position and an Ending Position.
- When creating motion effects, all you're doing is telling ProShow "this is where I want a layer to begin, and this is where I want a layer to end" - the software does the rest.
The Motion & Audio Pane

Beneath the Preview windows you'll find the **Motion & Audio** pane. This pane features all of the settings you will use to create the motion you want to see in your shows. For example, **Pan** makes a layer move around the slide while **Zoom** makes a layer increase or decrease in size.

We’ll go into the details of each motion setting in a later section of this chapter. For now, let’s just start making some motion to get a good sense of how quickly you can start working.

Creating Motion Quickly

The example you’re going to create should help you understand just how easy it is to jump right in and start making simple motion effects.

In this example, you’re going to work with one layer and cause it to pan and zoom across the slide – something similar to what you would see in a Ken Burns film.
To Create a Traditional Panning Layer

1. Create a new slide using any photo you'd like.

2. Double-click on the slide to open the Slide Options window.

3. Select the layer in the Layer's List and click on the Effects tab.

Here's where you will get a good idea of how easy motion can be to arrange. You're not going to need to worry about the values in the settings panes. This will just be a bit of dragging and some mouse wheel work.

Note: if you don’t have a mouse wheel, you can follow the instructions by dragging the Zoom slider, found in the Motion & Audio pane. Dragging the slider to the left zooms out, while dragging it to the right zooms in.

Remember, the Zoom X and Zoom Y sliders are locked together by default. This means you only need to adjust one value, the other will change automatically.

By default, you should already be in the Starting Position for your slide and ready to go. Verify this by looking at the Keyframe Selector Ribbon (it will show a blue line connecting the preview to the beginning of the slide in Timeline), or by using the Keyframe Indicator above the previews.

4. In the active preview window, use the mouse to click and drag an interesting part of your photo to the center of the slide.

5. Using your mouse wheel, rotate the wheel forward to zoom in on the image. Keep zooming in until you can only see the part of the photo you want to focus on.
You have set up the starting motion for your slide just by making these two adjustments. To finish the motion, you only need to do the same thing in the ending position.

6. Click on the navigation preview that is labeled Next.

This next point in time will now become the active preview. You'll notice that the **Keyframe Indicator** and the **Keyframe Selector Ribbon** will show you that this is the Ending Position for the slide.
7. In the active preview, your image should look exactly the same as when you first added to the slide. Now click and drag so that you’re focusing on another interesting part of the image and adjust your zoom however you’d like.

That’s it. You’re finished!

At the bottom of the **Slide Options** window, click the **Play** icon to see your motion effect.

What you should see is a subtle effect that pans your layer across the screen as the image zooms in or out (depending on your choices).

You have created a motion effect by simply arranging the layer the way you wanted it to look when the slide began and ended.

If you switch to the **Two Previews** mode, you'll be able to see both of the starting and ending positions for your motion effect.

---

**Using the Preview to Set Motion**

You’ve already been introduced to the basics of using your Preview panes to configure motion, but it’s important enough that it bears repeating. Remember that all of the major motion adjustments can be set without manually typing a value or adjusting a slider.

Zoom is set on the fly by choosing the layer you want to adjust, putting the mouse cursor over the Preview pane, and rolling the mouse wheel forward or back.
Position is changed by clicking and dragging the layer you want to move in the Preview pane.

Rotate is adjusted by clicking on the Rotate anchor points which appear on the four corners of the layer. You can even snap your rotation to 45° angles by holding Shift on the keyboard as you drag the Rotate anchor points.

Remember that you’re making motion by creating differences between the starting and ending positions. You can drag and place the layer in both the starting and ending positions without ever manually adjusting the values. It’s a great time-saver.

**Previewing Your Motion**

The Preview pane covers many uses beyond what you’ve already learned. For example, the Preview pane can show you how your slide-in-progress looks. At any time during slide creation you can click on the Play button that appears at the bottom of the Slide Options window.

This will play the full slide time, which if you recall, includes the Transition In time from the previous slide, the Slide Time and Transition Out time of the slide itself. It’s a great way to constantly monitor how your slide is coming together and whether or not it’s going to need tweaks.

**Motion Settings**

Now that you have seen how easily motion can be made, let’s learn a bit more about how the values you adjust actually create that motion. We’re going to look at each of the motion values that you can adjust to figure out what each one does.

---

7 If you do not see the Layer Control outlines, simply right-click in the Preview and enable them in the menu that appears.
Pan

The Pan value controls the actual placement of your layer within the slide. When a layer moves from one place to another, it’s panning.

The Pan setting is divided into two values: X and Y. The X value is on the left and the Y value is on the right. These two values are just the same as you may have worked with when doing graphing.

The X axis is the horizontal axis. The pan values on this axis move the layer to the left or right. The Y axis is the vertical axis. The Pan values here will move the layer up or down. Knowing the values you can use within the slide frame can help you decide what you want to use for your Pan values. Remember that you can also drag your layer around the Preview window, as you learned in the Layers chapter, to change its position.

Every slide is an invisible grid. It has a total range of 100, with the middle point of the slide being 0 on both the X and Y axes. The full range on the X axis is from -50 on the far left side of the slide, to 50 on the far right. That gives you a total range of 100.
The same is true for the Y axis. The very bottom of the slide is 50, with the very top being -50. This gives you a total vertical range of 100.

The position of a layer is calculated by the center of that layer. The very middle of each layer is where that layer is currently placed on the slide grid, regardless of the zoom level of the layer.

For example, if you were to set your Pan values to 25 x -25, this would place your layer in the upper right corner. It would be offset to the right because your X value is positive, and offset upward because your Y value is negative. The center point of your layer will be resting exactly at 25 x -25 on the slide.

**Zoom**

The Zoom value controls the size of your layer. The setting is based on a percentage of the layer’s default size. That means that a layer you have just added to a slide will be shown at its normal size, or 100% zoom.

The Zoom value can be adjusted from 0% to 500%. At 0% Zoom, a layer is effectively invisible. It’s so small that you can’t see it. At 500% Zoom, you have increased the size of your layer by 5 times. You can also type in a Zoom value manually which has no limitations. Want 1200% Zoom? Go for it.

You may notice that you have a slider for both Zoom X and Zoom Y. This allows you to control the horizontal and vertical size of your layers independently, should you wish. To do this, click on the chain link icon that appears to the right of the Zoom sliders. When this is broken, you can change either value individually. This causes your layer to change proportion, so use it carefully, it will stretch and distort images.
The main use for breaking the X and Y **Zoom** values is to grow or shrink a layer in only one dimension. This can be great for making false perspective or intentionally causing a layer to appear thinner or shorter.

There's something to note about the default size: layers are initially sized according to the scaling method you select under **Layer Settings** *(Fill Frame, Fit to Frame, etc)*. A **Zoom** of 100% refers to that size. For example, when the default ‘Fit to Frame’, the image is sized so that the entire image fits into the window. This becomes the default size, or 100% **Zoom**.

Finally, you can change your **Zoom** value in the Preview window by using either the mouse wheel or the anchor points on the layer outline. Click on the layer in the Preview window and roll your mouse wheel back and forth to see the **Zoom** changes. Click on an anchor point and drag your mouse cursor to see the **Zoom** changes applied that way.

**Tilt**

The **Tilt** options are used to control the perspective tilt of a layer. There are two types of tilt you can apply to a layer, **Vertical Tilt** and **Horizontal Tilt**.

Tilt values are measured in degrees and can go from -360 to 360. When using a **Vertical Tilt**, a positive value will cause a layer to look as if it's leaning forward. Moving the slider to the left creates a negative tilt. This will cause an layer to appear as if it's leaning backward.
**Horizontal Tilt** is the second perspective tilt option for a layer. Moving the slider to the right creates a positive tilt. This will make the right side of a layer appear to be closer to you as the left side appears to get smaller as you look toward the center of the slide frame.

Moving the slider to the left creates a negative tilt.

This will make the left side of a layer appear closer and the right side more "off in the distance".

**Rotate**

**Rotate** is used to cause your layer to spin. This value is calculated in degrees, just as you would normally look at rotation.

The **Rotate** value can go from -360 degrees to 360 degrees, giving you two complete turns. If you wish, you can extend this further by typing your own rotation value into the field. For example, if you wanted 720 degrees of rotation, just type that in.

The direction of rotation is based on the value. Negative rotation degrees will make your layer rotate to the left, while positive degrees will rotate your layer to the right. Making objects spin is just a matter of creating a difference between rotation values, leading to the direction you want the spin to occur.

For example, if you wanted a layer to spin one full rotation to the right, you would start the layer at 0 degrees and end at 360 degrees. You can accomplish the same thing by starting the layer at -360 degrees and ending at 0 degrees.
Rotate Center

The **Rotate Center** value allows you to set the point on which your layer will rotate or tilt. By default, this is set to 0 x 0, which is the middle of the layer.

These two values can be adjusted in the same way as your **Pan** values. The left is the X axis and the right is the Y. The same kind of grid applies to your layers. It has a range of 100, from -50 to 50, for both axes.

Moving the **Rotate Center** will cause your layer to rotate or tilt around that point, rather than the middle of the layer. The **Rotate Center** can be changed at different points in your slide time, causing the point to travel as the layer moves. If the layer is rotating while this takes place, the center point of the layer will move and adjust the rotation in real time.

It’s a very powerful feature but it takes some experimenting to get a strong sense of how it works. Feel free to try moving the **Rotate Center** around as you rotate or tilt a layer and see what you get.

Curve

**ProShow** automatically makes your motions look more organic and natural by adding some curve to their motion paths. This means that abrupt changes in direction are softened into gradual sweeps. This does not control the smoothness of your playback. Rather, it controls how ProShow smoothes the motion between multiple points.
While setting a curve is nice to have in most cases, there are situations where having too much curve might prevent an effect from working the way you intend. If you were making an effect that had very mechanical attributes, for example, you might want very precise and linear motion.

The best way to see Curve in action is to create some motion and then enable the Motion Path.

To Enable the Motion Path

1. Right-click on the Preview window.
2. Click on Show Motion Path in the sub-menu that appears.
With the motion paths visible, you can see lines drawn showing how your layer is going to move. Once these are on, try dragging the Curve slider left and right. As you do this, you will see the lines become more sweeping as curve value goes up, or much more direct as curve goes down.

**Motion and Layers**

As you read in Chapter 8, layers retain all of their settings individually. That means that you can configure each layer by itself without those settings applying to your entire slide.

This is true with motion as well. Any motion you create for a layer will work on only that layer. This means that it’s possible to have multiple layers all moving in different directions, with completely different motion settings.

Using multiple layers with motion is a key piece of creating advanced effects within ProShow. Now that you have learned how to create motion, and what each motion setting does, we’re going to put another example together.

In this example, you will use four layers to create a combination of motion. Four layers will start in the center of the slide. From there, each layer will rotate and pan into the four corners of the slide frame.

**To Create an Exploding Collage**

1. Create a new slide with 4 images you have chosen. Any 4 will work, but the effect looks best if they are all the same size.

2. Double-click on the slide to open the Slide Options.

3. In the Layer's List, select Layer 1, then click on the Layer Settings tab.

4. In the Layer Setup pane, change the Zoom value to 40%.

5. Right-click on the Zoom value and select ‘Copy Zoom to All Layers on This Slide’. This will set all of your layers to have a 40% Zoom.
Now you have a stack of layers, all of the same size, on top of one another. That’s all you need to do for the setup of the effect. Now it’s time to add the motion.

6. Click on the Effects tab.

7. Choose Layer 1 in the Layers List.

8. Select the Ending Position for this slide by clicking on the small preview, or by using the Next Keyframe icon.

9. Click and drag Layer 1 so that it is in the upper left corner of the slide.

10. Change the Rotate value to -360 degrees.

With this arrangement, your first layer will start in the center of the slide and pan to the upper left corner. Because you added some rotation to the motion, it will also rotate. This rotation will be in the direction it’s moving, left, because you used a negative value.
Now we’ll set up the other three layers.

11. Choose Layer 2 from the Layers List.

12. In the Ending Position (Keyframe 2), drag Layer 2 so that it is in the lower left of the slide.

13. Change the Rotate value to -360 degrees.

Layer 2, the second layer to move left, is now finished. The right corners are the only ones left to do.


15. In the Ending Position (Keyframe 2), drag Layer 3 so that it’s in the upper right corner.

16. Change the Rotate value to 360 degrees.
15. Motion

Notice here that we changed the Rotate value to be positive. That’s because this layer is panning to the right, so we also want it to rotate to the right.

17. Choose Layer 4 from the Layers List.

18. In the Ending Position (Keyframe 2), drag Layer 4 so that it’s in the lower right corner.

19. Change the Rotate value to 360 degrees.

Your effect is all finished. Press the Play button to take a look at what you’ve made. Each layer will rotate and pan into the corners of the slide, giving you a great looking exploding collage effect.

This kind of effect is incredibly flexible. You can change it up by selecting different images, changing the background color of your slide, or doing things like adding shadows or outlines to the layers to make them a bit more distinct.

To increase the speed of the layer motion, try making your Slide Time shorter.

Feel free to experiment more with effects like this to get a firm understanding of how motion and layers can be used together.
Copying Motion

There are going to be times when you’re creating motion that requires some careful adjustment between positions, or just has a lot of repetition. In these cases, you can save a lot of time by copying your motion settings from one position to another.

The Copy icon appears at the bottom of the Slide Options window. If you click on this icon you’ll see several options:

- **Copy Settings**: this selection opens a sub-menu of Copy Settings options. Each option will open the Copy Settings window which allows you to copy individual layer, caption or keyframe settings to any other destination in your show. It’s a very powerful tool for copying and can be read about in more detail in Chapter 26.

- **Copy Captions/Layers**: Each of these options allows you to copy a selected Layer or Caption to other slides in your show.

- **Copy to Previous Keyframe**: Copies the settings used in the current keyframe to the previous keyframe in your slide. The All Layers option will perform this operation for every layer on the slide.

- **Copy to Next Keyframe**: the opposite of the above. Copies the settings used in the current keyframe to the next position in your slide. As above, the All Layers option will do the same operation for every layer on the slide.

- **Copy First Keyframe to Previous Slide**: this option will copy the layer and that layer’s starting position to the previous slide in your show. As above, the All Layers option does the same operation but includes every layer on the slide in it.
• **Copy Last Keyframe to Next Slide**: this option will copy the layer and that layer's ending position to the next slide in your show. ProShow will create a new slide with the layer if you don’t already have one to copy to. As above, the **All Layers** option does the same operation but includes every layer on the slide in it.

• **Copy Layer to Previous**: this option will copy the entire layer, both starting and ending position, to the previous slide in your show. This can be done for one layer or for **All Layers** on the slide.

• **Copy Layer to Next Slide**: this option will copy the entire layer, both starting and ending position, to the next slide in your show. This can be done for one layer or for **All Layers** on the slide.

**The Benefits of Copying**

Copying settings between positions or slides can be a great time saver during show creation. There are a few especially common reasons for using the tools while you’re setting up a slide.

Copying the start to the end of a layer is a great way to “hold the layer in place”. When your layers have the same settings in both the start and the end, they’re not going to move. If you want to make sure a layer holds still for a period of time, just copy the start to the end.

Copying these positions around is also a great way to set a common baseline for an effect. For example, if you wanted to make sure that you started your motion from the same place in all positions, you can copy those positions around and use that as the starting point for your motion effects.

The tools become even more valuable as you start working with keyframes, so it’s worth becoming comfortable with them early.
Matching Motion

The ability to match motion is very similar to copying settings from one slide to another. Matching enables you to lock a layer’s position to the position of a layer on another slide. You can use this to force a layer to start where another one stops.

Matching, simply put, makes your layers do the same thing during a slide transition. To set up a matching arrangement you’re going to need to make sure you have a slide after your current slide to match in the ending position, or before the slide to match in the starting position.

You can match a layer from one slide to any other layer on another slide. It doesn’t have to be simply Layer 1 matched to Layer 1 on another slide. You can match layers together in any way you like.

Here’s how:

1. Click on the **Match** button in the toolbar just above the preview. This will open the Layer Matching window

2. Click on the dropdown list for **Match Start to Previous Slide** or **Match End to Next Slide** based on whether you want to match to the preceding or proceeding slide.

3. The dropdown list will display which layers from the other slide you can use for a match. Click on the layer you want to use and the matching will be done.

You can think of matching as a form of linking layers together. As an example, if you match the ending position of one layer to the starting position of another, try adjusting the starting position of the layer you’ve linked to.

Once you have made some changes to that starting position, watch the ending position of the layer that you set up to match with it. It’ll be configured to the same settings in the ending position. Matching is primarily used to help make transitions between slides seamless if you’re trying to continue an effect across multiple slides.
Keyframing has largely replaced this method of coordinating motion between multiple slides, but the option is still available should you want to use it.

**Motion Speed**

Next to each of the **Motion Effects** options, you'll see a label, for example, Pan -Smooth.

This label indicates the type of motion speed used by the effect.

The **Motion Speed** selection allows you to control the speed of how your layers will actually move from one place to another. In a way, these settings are similar to adjusting the **Curve**.

To change the **Motion Speed**, simply click on the label and choose from the following options:

![Motion Speed Options]

**Linear**

Changing your motion speed to **Linear** will cause your layer to move at one constant speed. From the very start of the movement, it will never change in the pace at which it moves. This type of motion is perfect for motion occurring in the middle of an effect.
Smooth

Smooth motion speed means that your layer is going to accelerate at the beginning of the motion, reach a top speed, and begin to decelerate once it comes to its stopping point. This is the default value and looks the most natural.

Accelerate

Accelerate means that your layer will constantly speed up while moving. It will start moving slowly and begin moving faster until it comes to an abrupt stop at the end.

Decelerate

Decelerate is exactly the opposite of the Accelerate motion style. In this case, your layer will start by moving very fast and gradually slow down until it stops at the ending point.

Motion Speed is considered an advanced feature and may not be something you work with on a regular basis. It does have uses in the right effects, though.

As an example, let’s say you’re going to pan a picture of a car across the slide. Rather than use the default Smooth motion (which will start slowly, speed up, then slow down), try changing the motion style to Accelerate. As the car pans across the screen it will move faster and faster as the slide plays.

Removing Motion

There are likely to be times when you just want to remove the motion you set up on a layer. There are a couple of different ways to do this depending on how much of the motion you want to get rid of.

Let’s start with getting rid of a specific setting, like Zoom.
If you've decided that one of the settings you've configured just isn't working for you, right-on the value for the setting and select, Reset. That will reset the value to defaults.

If you want to strip all of the motion from a layer and stop it entirely you can remove all the motion by clicking the Reset icon that appears at the top of the Motion pane.

All of the motion on your layer will be removed and the layer will be restored to its default settings when it was first added to the slide.

Randomizing Motion

There are likely to be times when you just don’t need custom motion on a slide. Often times your “filler” slides can get by just with some simple random motion effects that make them look more interesting than simply sitting in one place.

Random motion can be applied to a single slide or a group of slides

To Randomize Motion

1. Select the slides you want to give random motion.

2. Right-click on one of your selected slides and choose Randomize > Randomize Motion Effects.

3. You will see a second fly-out window which gives you the ability to randomize all three motion effects or choose just one from Pan, Zoom, and Rotate.

4. Make your selection and the randomized motion will be applied immediately.

Keep in mind that random motion tends to be subtle because ProShow tries to keep your images inside the slide frame. Fast, or more dramatic motion would be far more likely to cause you to lose sight of the major visual elements in your image.
Also note that applying random motion is not necessarily the same as applying *Slide Styles* or more produced effects.

If you'd like to apply those kinds of effects randomly:

1. Select the slides you want to give random motion.

2. In the Build or Design Workspace, click on the Remix icon in the Toolbar. This will open the Wizard and let ProShow select random effects for you.

The Remix option will only use the Wizard to apply effects to the selected slides, the rest of your slides will not be affected.

**Motion and Captions**

Everything you have learned about moving layers also applies to the captions you add to your slides. After all, a caption is simply another type of layer that you can add to a slide.

With *Caption Motion Effects*, you have the same flexibility and capability to control how your captions look and behave that you find when working with layer *Effects*.

**Bringing Captions to Life**

We’re going to learn how to use the options found in the Effects tab to create caption motion by building an example that demonstrates what you can do with the features.

This example will cause a caption to appear, and zoom into place using Caption *Effects*. 
15. Motion

Panning and Zooming a Caption

1. In the **Build** or **Design Workspace Toolbar**, click the **Add Title** icon to create a new **Title Slide**. This will create a new slide and open the **Slide Options** window for you.

2. Under the **Caption Settings** tab, in the **Selected Caption Text** pane, type "Slideshow".

3. In the **Caption Format** pane, change the **Font** to **Georgia**, the **Size** to 20, and enable **Bold**.

4. In the **Caption Placement** area, change the **Alignment** to **Center Justified** and drag the caption so that it is centered and at the top of the **Preview** window.

So far this uses only the tools you learned about in the **Captions** chapter. Once you have a caption you'll use the options found in the **Effects** tab to set up the motion for the caption.

5. Click on the **Effects** tab above the preview.

6. Click the small preview on the left labeled **Next** (Keyframe 2). Use the **Keyframe Indicators** or **Keyframe Selector Ribbon** to make sure you have the **Ending Position** selected and in the active preview window.

7. In the **Caption Motion & Adjustments** pane, change the **Font Size** to 72. This increase in font size basically does the same thing as zooming in on a layer.

8. In the active preview, click and drag the caption to the bottom of the screen.

Press the **Play** icon at the bottom of the **Slide Options** window to see the results. You'll notice that the effect you have created for the caption is just like panning and zooming a layer. When the slide begins, your caption is smaller and at the top of the screen. As the slide plays, the caption grows in size and moves to the bottom.
For additional effects, you can also combine this pan and zoom with the Caption Behaviors. Simply choose a Fly-In or Fly-Out effect.

Other Caption Motion Options

You’ll find that the Effects tab for captions shares similar options that you have for moving layers: Position and Rotate are the same for both captions and layers. Font Size is basically the same as Zoom.

You can also control the Motion Speed for these three options exactly as you would for a layer. The only difference here is that captions use Linear Motion Speed by default.

Options that are unique to Captions are Character Rotate and Skew.

As you learned in Chapter 10, Character Rotate rotates each of the characters in a caption rather than the whole thing. Skew will stretch a caption out to cause it to lean to the left of right. When combined with motion, these options can be used to create a wide variety of text effects.

Experiment with caption motion to see what you can create. Try making some of the other examples found in the manual, normally intended for layers, with captions. You’ll find that you can do the same kinds of effects working only with text rather than just with images. You don’t even have to learn a new set of tools.
Motion and Soundtrack

The volume slider at the bottom of the **Motion & Audio** pane may seem out of place, but it’s actually a very interesting tool. This option allows you to make changes to your **Soundtrack** volume that correspond with motion on a slide.

For example: Let’s say you have a video layer with audio. As the layer zooms in, you can adjust the soundtrack volume to be lowered, allowing the video’s audio to be heard more clearly. This tool is generally most effective when working with keyframes, which are covered in more detail in Chapter 17.

Motion and Keyframing

**Keyframing** gives you the ability to have multiple starting and ending positions on one slide. Rather than telling a layer or a caption to go from point A to point B, you can tell it to go from point A, to B, to C, and beyond.

**Keyframing** is a major piece of advanced effects in ProShow and is covered in a dedicated chapter of this manual. For more information on keyframing, please see Chapter 17, **Keyframing**.

Motion and Modifiers

**Modifiers** are an advanced tool which can be used to perform and create effects that might be very difficult to do with keyframes or with standard motion effects. It’s one of the most advanced features in the program but comes with some excellent benefits. If you’re interested in learning more about **Modifiers**, see Chapter 18.
16. Masks & Adjustment Layers

Creatively Controlling How Layers Appear

Some of the best, and most interesting visual effects you can create in ProShow come from the ability to turn normal layers into Masks or Adjustment layers. Using these types of layers, you can control exactly how much of your images and videos will be shown within a slide, as well as alter how they look.

Masks and Adjustment Layers are similar in nature as they affect how your content will appear within a slide, but creatively they are used for different purposes.

Let's begin by taking a closer look at using Masks.

Masking and Producer

Masking is about controlling what is visible. When you work with masking in Producer, and other software packages for that matter, you are determining what can be seen and what can’t. Masks themselves can’t be seen – only their effects. It’s important to remember that you are always determining what can be seen when you create masks.

There are two kinds of masks in Producer that you can work with – grayscale masks and transparency masks. Each controls which parts of your layers you can see in slightly different ways, but both ultimately do the same thing – change what you can see, and what you can’t. Keep that in mind as you move through this chapter.
Masks & Adjustment Layers

Traditional Masking

Prior to the creation of software for making visual art, masking was used most often in painting. When you wanted to make a specific shape on something you were painting, you used a mask. It went something like this:

*You want to paint a large white wall in black, but you want to leave only a circle of white in the middle. To do this, you cut out a circle in paper or in tape, and stick that to the surface you are painting. From there, you paint the black over the surface and the mask as well. When you are done, you remove the masked circular area. This leaves an unpainted section on the wall in the shape of a circle.*

The point here is that traditional masking also determined what you saw in the final product by preventing paint from being seen on a particular area of your composition. Digital masking is similar because it gives you the ability to define areas that you can see and areas that you don’t. Digital masking is better in a number of ways, too. You can create and adjust masks with more precision, and the whole process is much faster.

Masks in software are also dynamic, which means that they can update as the scene changes. This gives you incredible flexibility when making visuals with masks.

Masking is a key tool in making some of the best visual effects Producer can offer. You will find that almost any high-quality show created with Producer features mask use heavily when creating visual effects. It’s a great tool to know and become comfortable with.
Using Masking in Producer

Masks are a special type of layer, but they are still "just a layer", and simply one more type of thing that can be added to a slide. You’ll find the masking options available under the Layer Settings tab in Slide Options. From there, configuring and working with a mask brings together a range of other tools such as creating new layers, adjusting the layer appearance, adding vignettes, and more.

To Access the Masking Options

1. Open the Slide Options window.
2. Click on a layer in the Layers List and select the Layer Settings tab located above the Preview.

You’ll find the masking options in the Layer Type area, just beneath the Preview. There aren’t many options that you need to configure to create a new mask:

![Layer Type](image)

To Create a New Mask

1. In the Layers List, select the layer you want to convert into a mask.
2. Check the box next to the Mask option.
3. Select the type of mask you want to add using the Mask Using dropdown list.

You’ll likely notice that if you have only one layer on your slide, the masking option can’t be turned on. That’s because masks inherently work with other
layers. Think of it this way: masks control what can be seen, if the only layer
on your slide is a mask, there is nothing for the mask to control.

Before we go into depth on the mask types and how they work, let’s
consider the traditional example of masking discussed at the beginning of
the chapter. That involved painting a white surface black, but leaving a
white circle in the middle. We can make a digital re-creation of this example
by setting up some layers. This will demonstrate how masking works in
digital form.

To Create a Traditional Masking Example:

Remember that we want to create a black slide frame with a single white
circle in the middle. To do this, we need to set a white color layer in place
along with a black color layer. Then we add the mask to give us only a
white circle.

1. Create a blank slide and
   open the Slide Options
   window.

2. In the Layers List click the
   Add (+) icon and select Add
   Solid Color from the menu.

3. Change your solid color to
   black, then click on Ok.

4. Create another Solid Color layer, this time white.

You now have your two colors in place. We have the black that will
become our background color on the slide, and we have the white, which
we will mask into a circle. If you look at the slide as it is now, the white layer
is Layer 1 and the black is Layer 2. Leaving it like this, you would see only a
solid white slide. We need to mask that white area to create a circle.

5. Add a new Solid Color layer, but change the resolution to 600 x
   600, making it a square.

6. Change the Color to red and click on Ok.
This makes the layer that will become our mask. We picked red as the color because for the mask type we’re about to use, color makes no difference.

This is going to act as our “tape” that will block out an area for the white to show up. Since the “tape” isn’t seen in our show, the color doesn’t matter.

7. Because we know this will be our mask, to stay organized, go ahead and rename this layer. In the **Selected Layer** pane, click on the **Rename** link and change the name of this layer to “Masking Layer”

Remember our goal is to make a circle, and right now the mask is a square. To get the layer into the correct shape, we’re going to use the vignette feature creatively.

8. Click on the **Adjustments** tab.

9. Make sure **Layer 1**, your red layer, is selected and click on the **Vignette** button located in the **Editing Tools** pane.

10. Change the **Shape** to **Ellipse** and the **Type** to **Solid Color**.

11. Change the color in the **Solid Color** box to red, then click on **Ok**.

Notice that because your layer is in a square shape, the ellipse is forced into a perfect circle.

You’ll find that lots of features in the program can be used for creative solutions like this one. The last few steps involve converting your red layer into a mask, defining that circle.

12. Click on the **Layer Settings** tab.

13. Make sure **Layer 1** is selected and then check the box for the **Mask** option in the **Layer Type** pane to enable the mask.

14. Change the **Mask Using** option to **Transparency**.
15. Click **Ok**.

When you look at your slide in the preview window, you’ll notice that it appears just as we wanted.

The slide frame is black with a white circle showing up in the middle, masked out just as we had in mind.

Why does this work the way it does? That comes down to the type of mask used and how masking controls what you can see. There are a few things to note here.

When you converted **Layer 1** into a mask, did you see how it attached itself to **Layer 2**, which was then indented? That’s fundamentally how a mask works. It becomes associated with other layers and then determines what can be seen within that layer.

A **Transparency** mask determines what you can see based on the size, shape and position of the layer. Since we changed our mask layer into a circle, it only allowed us to see the white color within the borders of that circle. Because of that, every other part of the white layer is hidden – it is outside the edges of the mask.

Now that you have seen masking in action, it’s time to learn what each mask type does and where you would use one or the other.
Masks Are Not Visible

It’s important to understand that masks control what is visible, but they are not actually visible themselves. When you play back a show, you never see the mask – just the effects of the mask. In this first example, we used a red layer as our mask, but when you play back the show you don’t see any red. That’s because masks control visibility even though they themselves are not visible. Masks work behind the scenes of many great effects.

Indentifying Masks in the Layers List

Now that we’ve created our first mask, let’s take a look at how masks appear in the Layers List. You’ll notice that as soon as you turn the top layer into a mask, the layer became displayed differently in the list.

Mask layers get marked with a ‘Mask’ icon. This lets you quickly spot layers you’ve configured as masks.

The layer description explains that this is a Solid Color - Mask Layer, which lets you keep track of how this layer was created.

The name for the layer defaults to whatever the name of the layer was before you made it into a mask. In this case it was originally called ‘Solid 3’.

When working with complex slides, it can be very useful to rename your masking layers so that you can keep track of what each layer does. In this example, the layer was renamed to ‘Masking Layer’.

You’ll notice that Layer 2 is indented and appears under the mask layer. Layers that are indented can be referred to as being ‘masked’. These are the layers that the mask controls the visibility of. Notice that Layer 3 isn’t indented – it is outside of the mask and isn’t affected by the mask. You can have as many layers as you want that are masked by a single mask layer. You’re not limited to one layer. Note, however, that you cannot put a mask inside of another mask.
The **Mask Bracket** along the left edge of the list starts on the mask layer and extends down to include all the layers included in your mask. Not only is this another visual indicator of which layers are masked, but it also provides you with a quick way to change which layers are affected by the mask. You can click and drag the bottom of the **Mask Bracket** to include or remove layers from a mask.

You can move layers in and out of masks in a few different ways.

### To Move a Layer Into or Out of a Mask

- Click and drag any layer to a position inside your mask.

  OR

- Click and drag the bottom of the **Mask Bracket** to include or remove a layer.

### Masks and the Preview

You’ll notice that when you are working with a mask, the **Slide Options Preview** shows the mask rather than the effects of the mask. To see the actual effects of the mask, you have to play the preview. ProShow does this because in many cases, it would be difficult to work with your mask if the still preview showed the results.

It is easy to quickly check the results of your mask. Just click the **Play** icon located at the bottom of the **Slide Options** window. The current slide will play back in the preview area. During playback, you’ll see exactly the effect your mask will have on the slide, complete with any motion or adjustment effects you’ve applied.

Just remember that when the preview is playing, you’re looking at the result of the mask. When the preview is stopped, you’re looking at the mask itself.
Creating Masking Layers

Everyone’s workflow is a little different, so ProShow provides a few different ways to create a mask. Remember that there are a few rules that restrict what can be turned into a mask:

- **The bottom layer in a slide can’t be a mask.** If the layer is at the bottom, there’s nothing for it to mask.

- **If you only have one layer in your slide, it can’t be turned into a mask.** If you only have one layer, that layer must be on the bottom, which means it cannot be mask.

- **You can’t create a mask inside of another mask.** A mask can contain only other layers.

Let’s start with the method we’ve already covered.

**To Change an Existing Layer into a Mask**

1. Select the layer you want to be a mask.

2. Click the Mask checkbox in the Layer Type pane of your Layer Settings.

   **OR**

   1. Right-click on the layer you want to be a mask in the Layers List.

   2. Select Use as Masking Layer from the menu.

   **OR**

   1. Select the layer in the Layers List.

   2. Click the Layer List Menu icon located at the top of the Layers List.

   3. Select Use as Masking Layer from the menu.
Frequently, you’ll want to add a new layer and make it a mask all in one step. This is something you’ll do quite a bit once you get comfortable with masking. This method lets you quickly add an image, a gradient, a vignette, or solid color mask.

**Add a Layer and Make it a Mask**

1. Click the **Add (+)** icon in the **Layer List** toolbar.

2. Select **Add Masking Layer** from the menu to expand the menu of masking options.

3. Select the type of layer you’d like to use as a mask.

**The Two Types of Masks**

As you read earlier in the chapter, there are two different types of mask layers: **Grayscale** and **Transparency**. These two types accomplish the same goal – they hide and show parts of a layer. Where they differ is in deciding which parts of the layer remain visible. In the next couple of sections we’re going to explain both types of masks in detail. Keep in mind that while they may sound very different, they are just different ways of processing your mask layer. You can use either one for almost any type of effect. Which one you use will depend more on the image or layer you want to use as a mask and less on the effect you are trying to achieve.
Grayscale Masking

The first of the mask types we’re going to discuss is grayscale masking. This type is most often used to blend images together on the same slide frame. That’s because grayscale masking works very well with gradients and other changes in value, allowing for gradual blends of masked images into the rest of the layers on your slide.

Working with grayscale masks requires that you remember one fundamental rule:

Light reveals, dark conceals.

Grayscale masks work by attaching to images and looking at the differences between light and dark values of gray in the mask. This means that lighter areas, moving up to completely white, will allow the image to appear. Dark values of gray, moving to black, will hide the image.

What Images Work with Grayscale Masks

Any image will work as a Grayscale mask. The images that are best for this are any images that contain high contrast between light and dark areas. For example, a photo of a door in a dark room with light pouring in would make a great grayscale mask. There’s enough difference between dark and light to act as an effective mask.

When you select an image layer to turn into a grayscale mask, Producer will automatically convert that image into shades of gray. This means that even if you have a color image, you can use it as a grayscale mask.

You can use Grayscale masks with more than just images. Creating gradient layers in Producer is a great way to create masks to use in this way. Remember that the gradient creation window even has an entire series of presets dedicated to masks.

The best way to understand how a Grayscale mask works and what it’s useful for is to put it into action yourself. In the next section, you’ll learn
how to blend two image layers together on the same slide using an grayscale mask.

To Blend Images with Grayscale Masking

This example can be used with almost any set of images, whether they’re complimentary or contrasting. It’s a great way to bring images together in the same slide.

1. Create a new slide with two layers.
2. Open the Slide Options, Click on layer and go to the Layer Settings tab.
3. Position Layer 1 largely on the left side of the slide frame.
4. Position Layer 2 largely on the right side of the slide frame, allowing overlap with Layer 1.

By placing each layer on one side of the slide frame or the other, you have given a bit more space for the blend to occur in the middle of the slide. Next you must create the gradient that will act as your mask, and there’s a great way to do it in just a few steps.

5. Select Layer 1.
6. Click on the Add (+) icon and choose Add Masking Layer > Add Gradient from the sub-menu that appears.
7. In the Gradient window, choose Masks as the Preset and Linear as the Type.
8. Choose the second gradient from the left.
9. Change the Angle to 360°.
10. Click on Ok.
Notice how your gradient has been configured. The white, or light area, is on the left side. That’s where you placed Layer 1. The dark area is on the right side where you have placed Layer 2. When the mask is created, it will attach to Layer 1 showing it in the light area, and causing it to vanish in the dark. Where Layer 1 can’t be seen, Layer 2 will show. Let’s set up the mask to complete the look.

11. Select your gradient, Layer 1.

12. Make sure the Mask Using selection is set to Grayscale.

13. Click Ok.

Now in the Workspace Preview, you’ll see the two images blending together along the seam between the light and dark areas of your mask.

The blend might not look perfect on your first try, so feel free to adjust the position of both Layers 1 and 2 until they look well-blended.

In the Layer Type options for Mask Using, you may have also noticed the option Grayscale Inverted. This does exactly what you would expect. Instead of light revealing and dark concealing, a Grayscale Inverted mask will reveal anything under the dark area and conceal anything in the light area.
Transparency Masking

Transparency, masking is similar to what you have learned with grayscale masking. It’s used to control what you see and what you don’t, but transparency masks do this in a more straight-forward way. This is because Transparency masks don’t care about color, value, or gradients. The only thing that a Transparency mask is concerned with is where the mask is located.

Think back to our re-creation of the traditional masking example. You created a circle by adding a vignette to a square solid color layer. When you converted that circle into a transparency mask, it blocked out a circular area to display the white color layer it was attached to. That’s literally all transparency masks do. They show the masked layer where they are located, and hide it everywhere else.

This means that Transparency masks are great for using with stenciled shapes or prepared images. Creating images with transparent regions in any image editor and bringing them into Producer for use with transparency masking works well. If you want to create a heart, snowflake, or other object to mask out an image, you can do that with a tool like Photoshop®, then add that image to your slideshow and convert it into an alpha mask. The exact process to create an image with transparency varies with each editing tool. Check your editor’s documentation for help with creating images that use transparency.

Not all file types support transparency. JPEG, a very common format for digital photography, does not support transparency, so you won’t be able to use JPEG files as transparency masks. To use an image as an alpha mask, you’ll need to look for a file format that supports transparency. Some common formats include PSD, PNG, GIF and TIFF.
Let’s say you use an image of a heart. You would add the heart to your layers list, convert it into a mask, and it would attach itself to the layer beneath it. This would cause your masked image to appear in the shape of a heart.

Just as with Grayscale masks, you can also select a Transparency Inverted mask type. In this case, the inverted mask would block out everything inside the heart shape.

Even without creating your own mask images, you can make great looking slides with Transparency masks. Let’s put together an example that makes a moving collage with two images. One will serve as a background while the other will be masked and create an interesting addition to the slide. You can pick any of your own images for the effect.
To Create a Transparency Mask Blend

1. Create a new slide with any two images you want to use.

2. Change the Slide Time to 6 seconds and the Transition Time to 2 seconds.

3. Open the Slide Options, click on any layer and go to the Layer Settings tab.

4. Pick which image you want to make into the background, and move this to Layer 2.

Now you will make some visual changes to the slide to get it set up for the effect, starting with the background.

5. Select Layer 2 and change the Scaling to Fill Frame.

6. Click on the Adjustments tab.

7. Turn on Colorize for Layer 2, leaving the color set to gray.

8. Click on the Layer Settings tab.

From here, we will create the mask that will allow us to control how Layer 1 is seen on the slide.


10. Click the Add (+) icon to create a new layer. Select Add Masking Layer > Add Solid Color from the sub-menu.

11. Set the color to red and click Ok to add the new layer. Keep in mind that for transparency masks, the color doesn’t matter. Red makes a good choice for keeping masks organized.

12. Under the Layer Settings tab, in the Layer Type pane, change the Mask Using selection to Transparency.
Your mask should now be attached to **Layer 1**. To complete the effect, we’ll add some motion to the mask.

13. Click on the **Effects** tabs.

14. Select **Layer 1** (the masking layer). In the **Starting Position**, enter the following values:
   a. **Pan** -30 x -15
   b. **Zoom** 35%

15. In the **Ending Position**, enter the following:
   a. **Pan** 25 x 5
   b. **Zoom** 45%
   c. **Rotate** 120°

Click on **Ok** and view your slide in action.

There are a few things to note here. First, notice that the transparency mask displays **Layer 2** only where the mask is actually located. As the mask moves and changes position, it reveals the layer in only that spot. Second, you can move a mask, the layer it’s masking, or both.

Masks that are digital can update as things change. That’s one of the things that make the feature so powerful. You can move your masks at will, and the effect of the mask will change based on how the mask is manipulated.
Using Motion, Editing and Effects with Masks

As you saw in the previous example, you can apply motion to masks just like you would any other layer. Using motion on a mask is a key part of making cool effects with masking. Even though a mask is a special type of layer, it’s still a layer, and all of ProShow’s tools for layers apply.

Use the **Motion** options found under the **Slide Options > Effects** tab to apply any type of motion to a mask, remembering that you can use keyframing to control the timing of your motion. You can also use the **Adjustments** under the **Slide Options > Effects** tab to unlock some great potential for masking when working with grayscale masks. Since grayscale masks work off of the levels of gray in the layer, and adjustment effects can alter those levels using keyframes, you can create some great effects. When working with grayscale masks, try playing with white point and black point adjustments. With transparency masks, play with opacity and blur.

Using Videos or Animations as Masks

You’re not limited to just still images when you create a mask. ProShow lets you mark video layers as masks. You’ll need to be very selective when choosing what video to use. For video masks, you’ll always be working with grayscale masks, as ProShow doesn’t currently support transparency in video.

The best videos to use are videos which provide high contrast black and white footage. You can find a variety of these online from many different sources.

When you use video as a mask, be sure that you’ve set the mask type to Grayscale. Aside from that, there’s nothing special you need to do. Anything you can do with a still image mask can be done with a video mask.

If you absolutely need to combine animation with transparency, try using an animated GIF file. While these files typically are low resolution, they do support transparency.
Using Text Layers as Masks

In addition to images and videos, you can also use **Text Layers** as masks. Let's build a quick example using a Grayscale mask.

**Creating a Grayscale Mask using a Text Layer**

This example can be created with any image or video clip, but abstract content will generally create much better results.

1. Create a new slide with any image or video you'd like. For this example, it helps to have a large contrast between the slide background and the colors used in the content you choose. If you select an image with darker colors, try changing the slide background to white.

2. Double click on the slide to open the **Slide Options** window.

3. In the **Layers List**, click the + (Add) icon to create a new layer. Select **Add Text Layer** from the menu.

4. Type in your text. For this example, let's just type in the word **mask**.

5. With the **Text Layer** selected, click the **Text Settings** tab above the **Preview**.

6. For this type of effect, you'll want to use very broad fonts. In the **Caption Format** pane, set the **Font** to Impact. Let's also set the **Case** to Convert to Upper Case and let's pick a **Size** that fills a large chunk of the preview. Something around 120 should do.

7. Set the **Font** to White. Remember, for a grayscale mask, light reveals while dark conceals. The more white the font is, the more the underlying layer will come through the mask.

8. Next, click on the **Layer Settings** tab. In the **Layer Type** pane, toggle on the **Mask** option and set the mask type to **Grayscale**.
Preview the slide and you'll see that your underlying image or video will fill the word "Mask" that you added as your text layer.

To make the slide more interesting, try adding some motion effects to one or both of the layers.

Also, try taking advantage of one of the unique attributes of Text Layers by going back to the Text Settings tab and changing the attributes or the text itself.

**Masking Versus Borders and Frames**

You may be asking yourself “Why would I use a mask when I can just add a transparent border or frame to my slide and get basically the same thing?” Masks trump borders in one major way – they’re completely flexible. Look at it this way:

You want to make a heart similar to what you saw above. Rather than using a mask, you’re just going to create a heart image with some transparency and drop that into place. This avoids masking, but you will run into some limitations. What happens when you want to move your heart around on the slide? Rather than just centering the heart, you want it to actually move from place to place.

With a frame, you will see the edges of the frame and your effect will be ruined. You can’t move that frame much at all without hitting limitations. To make things worse, what if you wanted to move the frame and the image? What if you’re using multiple images? All of those will cause you to worry about where the edges of the frame are located.
Practical Applications for Masking

You’ve now learned how to use masking, so the question that is left to answer is: what exactly would you do with masking?

The most interesting aspect of masking is that it provides such a range of creative freedom that it can be tough to pin down exactly what kinds of effects use it well. To help you come up with some ideas, here’s a list of various ideas for integrating masking into your slideshows:

- Blend two images together with various angles of gradients and grayscale masking. Cause one image to zoom in, while the second zooms out, giving a great sense of visual depth.

- Make windows, doorways, and other areas in your photos come to life by placing a transparency mask into those openings, letting you display other images inside of them.

- Combine two versions of the same image with masking. Use one in the background, while another version in the foreground is combined with a transparency mask to draw attention to interesting parts of it.

- Create letterboxes by changing the size of a transparency mask to a long rectangle in the middle of your slide. Images can be moved inside the letterbox without breaking the proportions of the slide frame. Enhance this just a bit more by adding another image into the foreground.

- Give images an interesting texture by converting the actual image into a grayscale mask and attaching it to an image that features an abstract texture or pattern.

- Make a moving spotlight by adding two versions of the same image to your slide – one with reduced brightness. Add an transparency mask to the bright version in the shape of a circle, and move it around. Now you have a light source that appears to move around the darkened image, highlighting it.

One of the best ways to get ideas for your own masking effects is to watch what other people have done with the feature. You can find plenty of great
Producer shows that feature masking by liking us on Facebook, visiting our blog, or by visiting the Photodex YouTube channel at:

www.facebook.com/photodex

www.slideshowblog.com

and

www.youtube.com/photodexcorporation
Adjustment Layers

Adjustment layers have quite a few similar traits when compared to masks, especially when it comes to function and behavior. However they do have some key differences.

For many, the most commonly asked question about adjustment layers is “Why not just use a mask for this?”

Masks are versatile and can be used for quite a few things, but there are situations where adjustment layers are the preferable option. In most cases, you’ll find that adjustment layers are well suited for subtle enhancements to your slides, rather than being the keystone of an effect as is often the case with masks.

When working with Adjustment Layers, it helps to understand how masks work in Producer to better understand what makes adjustment layers different.

How Adjustment Layers and Masks are Similar

- Adjustment layers aren’t visible by themselves.
- Adjustment layers work with groups of layers at a time and affect layers beneath them, changing their appearance based on how the adjustment layer has been configured.
- The types of adjustment layers and the visual changes those types can make are similar when using adjustment layers or masks.

How Adjustment Layers and Masks are Different:

- Adjustment layers affect all layers beneath them, including the slide background. Masks only work with layers you’ve added to the mask, which will never include your slide background.
- Masks control what you can see, Adjustment layers control how the layers beneath them look. This means any edits or other changes you’ve applied to the adjustment layer will be seen on every layer beneath it.
Masks & Adjustment Layers

- Light areas on an adjustment layer don’t make a layer visible – they make the changes you applied to the adjustment layer visible on layers beneath it. Dark areas hide these changes. Transparency does the same, only where the adjustment layer is present, rather than based on light or dark values.

The Two Types of Adjustment Layers

Just as with masks, there are two types of Adjustment layers: Grayscale and Transparency. These two types of Adjustments accomplish the same goal – they apply an adjustment of some kind to any layers beneath them. Where they differ is in deciding which parts of the underlying layers are affected by the adjustment.

Grayscale Adjustments Layers

A Grayscale Adjustment is based on the light and dark values of the adjustment layer. The main rule of thumb is "Light reveals, dark conceals". With adjustment layers, light areas reveal the changes while dark areas conceal the adjustments.

Using a Grayscale Adjustment

This example can be used with any image, but looks best when you have a large area of blank or "negative" space. For example a sunset, a view of the water from the beach, or any kind of spacious landscape image.

1. Create a new slide by dragging your image to the Slide List.
2. Open the Slide Options for the new slide.
3. In the Layers List, click the Add (+) button and select Add Gradient.
4. In the Gradient window, set the Presets to Masks and the Type to Linear. Select the second mask from the left.

5. In the Gradient Settings pane, set the Angle to 270, and click OK to create the new Gradient Layer.

6. The goal is to create a gradient that will reveal changes above the horizon of the landscape image. In the Layers List, select the new gradient layer and adjust the scaling, zoom and position as needed so that the light part of the gradient is above the horizon and the dark area is below.
7. With the gradient layer selected, click on the **Layer Settings** tab. In the **Layer Type** pane, click the check box next to the option for **Adjustment**. Set the Adjust using to **Grayscale**.

If you preview the slide it will appear as though nothing is different. This is because adjustment layers on their own are not visible, and you have not applied any changes (adjustments) to the layer yet.

8. With the gradient layer selected, click the **Adjustments** tab above the **Preview**.

9. In the **Editing Tools** pane, **Colorize** the layer to something that is drastically different the colors in your image.

Remember, the rule for a Grayscale Adjustment is "light reveals, dark conceals". With the sample adjustment layer you just created, the lighter portion of the gradient layer is what is be affected by the colorize change you just made. The darker portion won't be affected.

Preview the slide again and you'll see that you have now colorized only the top part of the image - that part of the image that is underneath the white portion of the gradient in Layer 1.
Transparency Adjustment Layers

Just as with Transparency masks, light and dark values do not matter for this type of adjustment layer. Any adjustments that you apply for this type of layer will only affect the underlying layers based on the size, shape and position of the adjustment layer.

Using a Transparency Adjustment

Again, this example can be used with any image, but it works especially well with images taken indoors. The end result will use the Adjustment layer to create a spotlight effect.

1. Create a new slide by dragging your image to the Slide List.
2. Open the Slide Options for the new slide.
3. In the Layers List, click the Add (+) button and select Add Solid Color.
4. Set the Color to Red. Remember, for Transparency masks and adjustments, the color doesn't matter. Red makes a good choice because it's easy to spot in the Layers List and it stands out as "something different".
5. Set the Resolution to 600 x 600.
6. Under the Layer Settings tab, go ahead and enable this as an Adjustment layer. In the Layer Type pane, set the Adjust using to Transparency.
If you preview the slide, once again you'll notice that the original image hasn't changed. So now it's time to add some adjustments.

This time the goal is to make a spotlight. So once again we're going to start with a square and use the vignette option to adjust the shape.

7. With the Solid Color layer still selected, click on the Adjustments tab above the Preview. In the Editing Tools pane click on the Vignette button.

8. Change the Shape to Ellipse and the Type to Transparent.

9. Change Vignette Size to 100, then click on Ok. This will now create a circle with very soft edges. This will help diffuse the "spotlight" so that you don't just have one solid circle appearing on the underlying image.

10. Next, in the Preview window, click and drag the Solid Color/Adjustment layer so that your spotlight will "shine" on an interesting part of the image in the Layer 2 position.

11. Now that the spotlight is in place and that shape is set up, go to the Adjustments pane and increase the Brightness and White Point. The values will vary depending on your image.

Preview the slide again to see the spotlight in action. For more interesting effects, try adding some zooming or panning motion to Adjustment layer so that it "spotlights" more, or different parts of the image.
17. Keyframing

What is Keyframing?

Keyframing in Producer is all about creating motion and effects for your layers and captions. Keyframing is what all of the effects in Producer are built on. A keyframe is used to control what will happen to your layer or caption, and when that will happen in time. In short, a keyframe is a point in time where something will happen. That “something” is where you come in.

The History of Keyframing

The term “keyframing” comes from traditional forms of hand animation, dating back to the early days of companies like Warner Brothers and Disney. Creating all of the individual pictures that would be rapidly combined together to give the illusion of motion was a big job. To make this process easier, animators were broken into two groups. There were the lead animators and the junior animators. The lead animators created critical pieces of the animation sequence, which were called keyframes. Each one of these would be created for a major change in the animation, such as at the start and end of an action.

The junior animators would take these major pieces, or keyframes, and create all of the pictures that would have to appear in order between those two keyframes. This process was called “tweening”. In short, the lead animator would draw how he wanted something to appear at the start and end. Then he would pass it to the junior animators who would fill in the gaps between the two, making the motion complete.
Modern keyframing follows this same approach, with one major exception. ProShow handles the “tweening” process, only requiring you to set your keyframes – that is, where you want your slide to start and end. This makes your job much easier, because ProShow handles the hardest and most time consuming part of the job for you.

**How to Think In Keyframes**

Working with keyframing requires a bit of an adjustment to the way you think about creating movement and setting up what you want your slide to do. Thankfully, keyframing is an incredibly linear process, letting you determine what you want your slide to do and working from there.

It’s best to start with a concept of what you want to see in your slide. Do you want your image to pan across the slide, revealing part of the image that may be in one corner? What you want to see happen is the entire plan you need to create your effect. From there you can approach your effect almost like reading directions on a map. Remember that keyframing involves setting up what you want each major point in a slide to look like. With that in mind, you start setting up the basics. If you want to pan a layer from one side of your slide to the other, you have your two main points of action, or keyframes. Point 1 will be on one side of the slide, and Point 2 will be on the opposite side.

No matter how many keyframes you work with, the thought process is the same. Figure out where you want your layer or caption to start, where you want it to go, and make each destination one keyframe at a time – just like reading directions.

Finally, remember that as you learned in the earlier chapters, each layer or caption that you add retains all settings individually. This includes keyframes, so every layer/caption will have its own set of keyframes to work with.
Where Keyframes Are Used

You will use keyframes for two kinds of different kinds of Effects in Producer:

- Effects that create motion for Layers or Captions
- Effects that apply Adjustments to Layers or Captions

Each area uses the exact same keyframe interface, so you don’t have to learn how to use keyframes in two different ways. The only differences between these are the values you can adjust and the visual results you’ll see. Let’s start by looking at what each is designed to do:

- **Effects that create Motion.** These are used to create any kind of motion for your layers or your captions. This is where you can cause your layers/captions to pan, zoom, or rotate around the slide. These types of effects are staples of most any show.

- **Effects that create Adjustments.** These options are used to change the visual look of your layers or captions over time. This gives you the ability to change the color, opacity, brightness, blur, and other settings for your layers or captions as the slide plays. With adjustment effects, you can cause objects to change color, go in and out of focus, and other great looking changes.

In Chapter 15, Motion, you learned some of the basic elements of working with keyframes. Let’s recap some of those items, beginning with a more detailed look at the all the tools you’ll use to create effects using keyframing.
Understanding the Keyframing Interface

As you've read in previous chapters, keyframes are found under the Effects tab when working with either layers or captions in Slide Options.

Let's review all of the elements found under the Effects tab in more detail.

To Open the Effects Options

1. Create a new slide with any image you'd like.
2. Double-click on the slide to open the Slide Options window.
3. Select the layer from the Layers List and click on the Effects tab at the top of the screen.

OR

1. In the Build or Design Workspace, click on the Edit Slide icon in the Toolbar.
2. Select the layer from the Layers List and click on the Effects tab at the top of the screen.

Note: You can also follow the steps above to create keyframing effects using captions. The only difference is selecting a caption from the Captions List.
There are several parts to the **Effects** tab that you should become more familiar with:

1. **Keyframe Previews:** These will show you the current, active preview for the keyframe you are applying changes to, as well as the next or previous keyframe on your slide.

2. **Keyframe Timeline:** This is the heart of the keyframing interface, and controls when each of your keyframes will appear within your slide.

3. **Keyframe Selector Ribbon:** A keyframe identifying tool, this blue line visually shows you where you are making changes within your slide.

4. **Keyframe Indicators:** These are the different ways to identify which keyframe is currently selected for editing.

5. **Effects Values:** These are the options that you configure on a selected keyframe to "make something happen" at that point in your slide.

6. **Keyframe Toolbar:** Here you have quick access to commonly used keyframe and preview tools.
The Keyframe Previews

The most visually dominant part of the Effects tab are the Preview windows. The larger preview is the active preview. This means that any changes that you make to the motion or adjustment settings will be applied to that selected keyframe.

The smaller preview is a navigation preview. You'll use this to click back and forth between different keyframes within your slide. When you click on a navigation preview, it becomes the larger, active preview.

Remember that creating an effect means that you are setting up how you want a layer or caption to change between two points in time (keyframes) within your slide. That's exactly what these two preview windows display.

Think of the previews as showing ‘Point A’ and ‘Point B’. Producer will figure out how to get from Point A to Point B. All you need to do is set up the points to look the way you want.

Just like most other previews in ProShow, the keyframe previews are interactive. You can control a variety of things by clicking and dragging in the preview. You can also right click to access options for customizing the previews.
These previews have some special elements called *motion paths*. You can turn them on and off by right clicking in the previews and using the **Show Motion Paths** option.

When enabled, motion paths show you where your layer will be at each keyframe. Keyframes are represented by small shield icons (more on those in a moment). Lines that connect the icons show how your layer will move between those keyframes.

**Changing Preview Modes**

In ProShow, the active preview is larger by design - this is to give you more room to create and preview your effects. This default state is called **Three Previews** mode. In this mode, your active preview will be large and in the center of the window. On either side, you’ll have navigation previews that you’ll click on to go to the previous or next keyframes.

If you prefer, you can change the look of the **Effects Preview** and select **Two Previews** mode.
17. Keyframing

In this mode, instead of having two sizes of previews, both your active preview and next or previous keyframe will be the same size.

To change modes, simply click the Three Previews or Two Previews icons in the Keyframe Toolbar at the top of the window.

Changing the Preview Canvas Size

From time to time you may create effects that feature layers or captions that begin or end "off the screen". To help you better manage what those objects are doing when not "on screen", use the Zoom Slider found at the bottom of the Slide Options window to zoom out and enlarge your overall canvas/workspace.
In this figure below, the black area is the normal slide frame that usually fills the preview. As you can see, we've zoomed out a bit so that we can see exactly where the layer will be positioned once it leaves the slide frame.

You'll also notice a directional arrow that tells us that this layer is moving to the upper right side of the canvas.

Keyframe Timeline

Just beneath the preview windows is the Keyframe Timeline. This timeline is where you place, add, and adjust the keyframes that you will use with this layer. The Keyframe Timeline shows you all of the important timing details of your slide, from slide time to keyframe placement. Let’s break down how you read it.

First, note that at the top of the Keyframe Timeline, at the far left and right ends, you have a marker that looks like a shield. This marker is labeled 1 on the left, and 2 on the right. These are keyframes. Every slide you create, whether you apply any kind of effect or not, will always have two keyframes.
17. Keyframing

You can also see tic marks across the top of the timeline, showing you time values. If you’re using the default 3 second slide time and 3 second transition time for your slide, you should see values indicated for every second. This is how you read exactly how much time is set for your slide, or for keyframes. You can switch between displaying time in a traditional hour: minutes format and a seconds-only format by right-clicking in the keyframe timeline and changing Time Format option.

Some advanced effects may rely on keyframes happening at very specific times in a show. In those cases, you can also right-click on the Keyframe Timeline, go to the Time Format options and select Show Keyframes as Show Time. This allows you to toggle between either showing the default slide times values, and showing the time relative the entire show.

The tan colored bar in the timeline will display any sound that plays during the slide. Music from your soundtrack will show up green, and any slide sounds for this slide will show up red. This lets you line up keyframes with beats in your music.
At the bottom of the keyframe timeline, you have shaded regions that represent the different times that apply to your slide. You will see a shaded region for **Slide Time**, and a darker region to the right of that for **Transition Out**. These shaded regions tell you what your slide is doing at that point in time.

**Slide Time** refers to that area where the slide is being fully displayed. **Transition Out** is when the slide is going through the slide transition to either the next slide, or the end of the show. This will change based on how you setup your slide. If you have a transition of 1 second, the **Transition Out** shaded area will only be one second long. If you have a transition from a previous slide before this one, you will have a **Transition In** shaded region on the left side.

Finally, beneath the very first and very last keyframes on your timeline you will see a transition icon. Clicking on this icon allows you to choose a transition for that individual layer. This is how a layer or caption will appear and disappear on the slide. We’ll go into more detail on layer transitions a little later in this chapter.
The Default Keyframes

You’ll notice that even before you make any changes, your slide has 2 keyframes. **Keyframe 1** is at the very beginning of the **Transition In** and **Keyframe 2** is at the very end of the **Transition Out**.

Every layer *always* has at least two keyframes, and they default to being at the very beginning and end of the slide.

Why does this happen?

The default state for any new layer or caption is to appear on the screen for the entire duration of slide. In order for that to happen, a keyframe (**Keyframe 1**) must exist that tells ProShow "this object now appears on screen".

To make the slide no longer be visible, a second keyframe (**Keyframe 2**) must exist in order for ProShow to know that at a certain point in time, something is happening. By default that 'something' is "this object no longer appears on screen".

Note that these initial keyframes don’t create any type of effect. This is because the two default keyframes start out with all their settings set to exactly the same values. In order to create effects, you have to make changes to the values. If the settings between two keyframes are exactly the same, the layer will simply appear on screen and stay still.
The Different Keyframe Icons

Depending on the state of a keyframe, it may appear differently in the timeline. The following are some of the different icons you can expect to see.

**Normal keyframe** icons indicate a standard keyframe that is not selected. This is a keyframe that is not currently shown in either preview.

**Selected keyframe** icons are used to identify which keyframe is in the active preview. Any motion, adjustments or time changes will be applied to this keyframe.

**Matched keyframe** icons are displayed when the layer is matched to the previous or next slide. Matching is discussed in more detail in chapter 15.

**Temporary keyframe** icons, more accurately referred to as ‘points in time’ are not keyframes at all. These icons are used to indicate when the preview is showing a point in time that doesn’t line up with a keyframe. For more information, see the section about these found later in this chapter.

The Keyframe Numbering Process

There’s a simple rule that applies to keyframes: they must always be in numeric order, starting from 1. This is why when you have two keyframes, they start at 1 and end at 2.
Notice that if you click on the + Add icon in the Keyframe Toolbar, to create a new keyframe, the new keyframe will appear right in the middle of the timeline. This new point will now become Keyframe 2, and the last keyframe will now become Keyframe 3. None of the values or settings has changed – just the number. This is done to always keep your keyframes in logical order.

Imagine what a mess your keyframe timeline would become if you had a keyframe order that looked something like this: 1>4>3>2. It would be nearly impossible to keep up with what keyframe was doing which effect. Keeping the keyframes in order helps you stay on top of your effect.

**Keyframe Selector Ribbon**

When you select a keyframe to make adjustments, you'll see a blue indicator line that connects the active preview to the Keyframe Timeline - this is the **Keyframe Selector Ribbon**. The Keyframe Selector Ribbon shows you where you are making changes within your slide.

In the figure below, you'll see that the ribbon shows us that the active keyframe we're making changes to is just a little bit after the slide begins, on Keyframe 2.
Keyframe Indicators

In addition to the Keyframe Selector Ribbon, there are several other ways that ProShow helps you identify which point in your slide you are working with.

You'll find the first Keyframe Indicator above the previews on the top left side. This lets you know if you are at a Starting Position (First, Keyframe 1, etc), Ending Position (Last), or any keyframe that appears in between the beginning and ending of your slide. You'll also see the point in time (in seconds) within that slide where each keyframe exists.

At the beginning of the slide, this time will always be 0:00:00. When the last keyframe of a slide is selected, you'll always see the total slide time, including transitions. If you select any keyframe in between the first and last, the time stamp will show you exactly when that keyframe exits on the slide.

The next Keyframe Indicator is also found just above the preview, only this time on the right side in the Keyframe Toolbar. Here you'll find the Previous/Next Keyframe icons. The Previous/Next Keyframe icons allow you to move quickly between each point in your slide and will show you which keyframe is currently selected.
The third way to identify a keyframe is to look in the previews themselves. Each preview will feature a shield icon that is numbered.

The number 1 will always be the first keyframe, the highest number will always be the final keyframe in a slide.

**Effects Values**

Beneath the *Keyframe Timeline* are the values that you can adjust for each keyframe. Making changes to these settings creates your motion and adjustment effects as you move from keyframe to keyframe.

The *Expand* icon at the top of each pane changes the look of each pane to give you more information about the keyframes that come before or after the currently selected keyframe.

This is very handy when you’re working with multiple keyframes and need to get a better idea of how values are changing.

When expanded, you also have the option to reset individual settings with more ease.

To return to the normal view, simply click the icon again.
The Keyframe Toolbar

Just above the previews, you'll find the Keyframe Toolbar. Each icon in toolbar that provides quick access to important tools that you'll need when creating effects using keyframes. Let’s review these tools starting on the left.

+ Add: The first icon is as simple as it sounds, this is what you click to add one new keyframe exactly half-way between the currently selected keyframe and the next keyframe in the slide. If you have selected the last keyframe in a slide, it will place the new keyframe half-way between the last slide and the previous slide.

Multiple: When you click this button, you’ll be asked how many new keyframes you would like to add to the slide. Each new keyframe will be spaced evenly throughout the slide.

Reset: There are two reset options in the Keyframe Toolbar. The first is the Reset icon. Clicking this will reset the motion and adjustment settings for a selected keyframe. The second option is the Reset All button. This will reset all of the settings for every keyframe used by the selected layer or caption in your slide.

Remove: Just like reset, there are also two remove options in the Keyframe Toolbar. The first is the Remove icon. Clicking this will remove a selected keyframe. The second option is the Remove All button. This will remove all keyframes you have added and return the slide to the default state having only a beginning (Keyframe 1) and an end (Keyframe 2). Any settings you changed for those two keyframes will remain intact.

Add Time: The next option allows you to add more time after a selected keyframe. Once added, the total slide time and later keyframes will be adjusted accordingly. To remove time, enter a negative number. Keep in mind that if you add time to a keyframe that appears in the darker, Transition In or Out areas of the Keyframe Timeline, you will increase the transition duration.
**Match:** Matching enables you to link layers from two different slides together. For example, you can match the last keyframe of a layer on Slide 1 to the starting position of another layer on Slide 2. Matching is primarily used to help make transitions between slides seamless when you’re trying to continue an effect across different slides.

**Preview Mode selector:** The next two buttons allow you to change between **Three Previews** and **Two Previews** mode. Regardless of the preview mode you prefer, the way you create effects with keyframes is the same.

**Previous/Next Keyframe:** The final buttons in the toolbar allow you to navigate between all of the keyframes for each layer or caption. These navigation buttons will also let you know which keyframe is currently selected.

### Additional Keyframing Tools

At the bottom of the **Slide Options** window you’ll find some additional options that really come in handy when working with slides that feature multiple keyframes.

### The Keyframe Editor

When you are working with multiple layers, each with their own keyframes, it’s easier to manage timing when you can see all of the layers and their keyframes at once. That’s exactly what the **Keyframe Editor** allows you to do.

The **Keyframe Editor** is primarily designed to work with timing, rather than editing what your keyframes actually do. When it’s open, you can see every layer on your slide, each with its own timeline that features all the keyframes for that layer. This makes it very easy to see how keyframes for each layer line up in time. It’s also the best way to make sure that effects relying on multiple layers with precise timing are going to work the way you expect.
To Open the Keyframe Editor

Click on the Keyframe Editor icon that appears at the bottom of the Slide Options window.

Working in the Keyframe Editor

You’ll notice that the most prominent part of the Keyframe Editor is the list of layers and the timeline with keyframes that appears for each layer. This list is organized from top to bottom, just as your layers list is shown. Layer 1 is at the top, while the rest are in order to the bottom.

The Keyframe Timeline that appears here is functionally the same as your normal Keyframe Timeline, with just a few enhancements. Rather than setting up motion or effects, the keyframe timeline here is concerned with time. You can drag keyframes to different times on the timeline, right-click on them to set times manually, or even select groups of keyframes.

Try dragging a selection lasso around all of your keyframe 1 markers. Notice how they’re all selected? Now you can click on the Set Time button in the Tools pane to change the time for all of them at once. You can also right-click on one of selected keyframes and choose Set Time.
Of course, you can also drag keyframes to arrange them in time just as you would normally. Notice that as you hover as well as click and drag a keyframe, the tool tip will tell you exactly where you are in time within the slide.

The real benefit of the keyframe editor is the ability to see all of your layers and keyframes, in relation to one another, all in one place.

If you’re trying to time the appearance and disappearance of multiple layers together for an effect, you’re going to find that the keyframe editor makes the coordination of those keyframe times much, much easier.

**Copying Effects**

As you read in Chapter 15, Motion, clicking on the **Copy** button at the bottom of the **Slide Options** window allows you to easily copy layers, captions and settings between slides and keyframes. For this chapter, let's focus on the options that really help with keyframing.

- **Copy Settings**: this selection opens a sub-menu of **Copy Settings** options. The options you'll use most often when creating advanced keyframing effects are the **Between Layer Keyframes** and **Between Caption Keyframes** options.

  When you select these options, you open the **Copy Settings** window. From here you can copy individual keyframe settings to any other destination in your show. It's a very powerful tool for copying and can be read about in more detail in Chapter 26.

- **Copy to Previous Keyframe**: Copies the settings used in the current keyframe to the previous keyframe in your slide. The **All Layers** option will perform this operation for every layer on the slide.

- **Copy to Next Keyframe**: the opposite of the above. Copies the settings used in the current keyframe to the next position in your slide. As above, the **All Layers** option will do the same operation for every layer on the slide.
• **Copy First Keyframe to Previous Slide**: this option will copy the layer and that layer’s starting position to the previous slide in your show. As above, the **All Layers** option does the same operation but includes every layer on the slide in it.

• **Copy Last Keyframe to Next Slide**: this option will copy the layer and that layer’s ending position to the next slide in your show. ProShow will create a new slide with the layer if you don’t already have one to copy to. As above, the **All Layers** option does the same operation but includes every layer on the slide in it.

**Note:** The ‘Next Slide’ settings, used to copy layers and keyframes to following slides, are best used to create slides that sync together. For example, if you want to create a sequence of slides that all follow one after the other with precision, you need to make sure that your slides are identical from one slide end to the beginning of the next slide. Using these copy tools can make that much, much easier.

### Creating Keyframes

As you have learned, all layers and caption, whether you create any effects or not, will always have two keyframes. There will be one at the very beginning and one at the very end. You’ll find that this will work for most simple motion effects, but when you want to create something detailed or really impressive, you need to start adding more keyframes to complete the effect. Here are the various ways you can create keyframes:

#### To Create One New Keyframe

- Click on the + **Add** icon on the **Keyframe Toolbar**, above the preview windows.

This method will create a new keyframe that appears directly between the selected keyframe and the next keyframe.
If you were to select last keyframe and click the `+Add` icon again, the new keyframe would appear halfway between the last keyframe and the previous keyframe.

**To Create One New Keyframe at a Specific Time**

1. Right-click on the **Keyframe Timeline** where you want the new keyframe to appear.

2. Click on **Insert** from the sub-menu that appears.

**OR**

1. Double-click in the **Keyframe Timeline**.

This approach gives you the ability to create a new keyframe right where you want it to appear. If you know that you want a new keyframe to be set to a certain time, you can place it right there.

If you already know exactly how many keyframes you want to use for an effect, you can always add a whole group at once:

**To Add Multiple Keyframes Simultaneously**

1. Right-click anywhere on the **Keyframe Timeline**.

2. Click on **Insert Multiple** in the sub-menu that appears.

3. Type in the number of keyframes you want to add in the Set Value dialog window that appears.

4. Click on **Ok**.
OR

1. Click on the Multiple icon on the Keyframe Toolbar, above the preview windows.

2. Type in the number of keyframes you want to add in the Set Value dialog window that appears.

3. Click on Ok.

This method will add that number of keyframes in addition to the existing keyframes. They will all be evenly spaced between the selected keyframe and the next keyframe. From there, you can begin making adjustments to suit your effect.

Remember that you can blend these methods together at any time. If you start by adding multiple keyframes and then realize you need a few more, you can always use the other methods to add extra keyframes.

Deleting keyframes will probably also be needed from time to time. Keyframes are very flexible, so this can be done at any point.

To Delete a Keyframe

1. Right-click on the keyframe marker you want to remove.

2. Click on Delete in the sub-menu that appears.

The keyframe will be deleted immediately, along with any settings you had created for it.

OR

1. Select the keyframe you wish to delete and press the Remove (X) icon in the Keyframe Toolbar.
Selecting Keyframes

As you work with keyframes, you’ll need to switch between the different keyframes you’ve created. Remember that keyframes are always selected and edited one at a time.

When a keyframe is selected, it will be moved to the active preview. In **Three Previews** mode, this will be the large window in the middle of the screen. If you’re using **Two Previews** mode, the active preview will always be highlighted with a large blue outline.

The **Keyframe Selector Ribbon** will also draw a line that connects the preview to the **Keyframe Timeline** and **keyframe icon** to show you exactly what keyframe you have selected, and where it is located in your slide.

**To Select a Keyframe**

1. Click directly on the keyframe icon in the **Keyframe Timeline**.

**To Move to Another Keyframe**

- Either click directly on the keyframe icon in the **Keyframe Timeline**.

  OR

- Click on the **Previous** or **Next** icons in the **Keyframe Toolbar**.

  OR

- Hold the SHIFT key on your keyboard while also pressing the Page Up or Page Down keys
Editing and Adjusting Keyframes

With the ability to add and delete keyframes, it’s time to learn how to change their time and position. There are a few things to keep in mind now that you have reached this point. Let’s begin by remember exactly what a keyframe is:

A keyframe is simply a point in time when something happens.

You set where you want your keyframe to appear in the time of your slide, and then change the values to determine what you want to happen at that keyframe.

Remember that keyframes can always be adjusted, so a big part of creating keyframe effects is to set where your keyframes appear on the timeline. Less time between keyframes gives Producer less time to create the effect, so the effects happen faster. Longer time gaps between keyframes do the opposite, and create a slower effect.

To Change the Time of a Keyframe

1. Click on a keyframe marker and drag it to the new time in the Keyframe Timeline. As you hover and/or move the marker, a tool tip will appear to let you know the new time.

   OR

1. Right-click on any keyframe for which you want to change the time.

2. Choose Set Time for this Keyframe from menu that appears.

3. Enter the time in seconds where you want the keyframe to appear.

4. Click Ok. Your Keyframe will now be moved to that time.
Note: A keyframe cannot be moved past the keyframes that precede or follow it.

For example, you cannot take Keyframe 2 and move it past Keyframe 3. This would cause the keyframes to be out of order. If you want to move Keyframe 2 to 6 seconds, and Keyframe 3 is currently set to 5 seconds, Producer will not let you do this. You will need to move Keyframe 3 back to something later than 6 seconds, and then move Keyframe 2. You can change the times of keyframes, but not the order.

To Add or Remove Time to a Keyframe

In addition to setting the time where you want your keyframe to appear, you can also add or remove time from a keyframe. This can be useful when you want to make a small adjustment to the timing of a particular effect.

1. Right-click on a keyframe marker.

2. Select Add/Remove Time from Keyframe in the menu that appears.

3. Choose the Keyframe and Time value from the window that opens.

4. Enter a positive time value, in seconds, to add time.

5. Enter a negative time value, in seconds, to remove time.

6. Click on Ok.


**OR**

1. Click the **Add time** button in the **Keyframe Toolbar**.

2. Choose the **Keyframe** and **Time** value from the **Add Time** dialog window.

3. Enter a positive time value, in seconds, to add time.

4. Enter a negative time value, in seconds, to remove time.

5. Click on **Ok**.

When you add or remove time using this method, it’s important to understand how it works and what is being created.

If you have three keyframes, and you add one second to **Keyframe 2**, you will add that time value in between keyframes 2 and 3. **Keyframe 2** will stay at the same time, and **Keyframe 3** will be moved back one second. This adds one second to the whole slide, but only between that pair of keyframes you choose. Effectively, this means that you will always add time after the marker you have selected.

Again, this method is best used when you only want to adjust the time at a particular portion of your slide, rather than altering the whole slide.

You would use **Add/Remove Time from Keyframe** time for a couple different things:

- You want to add time at the end of a slide, and want all your keyframes to stay where they are. Remember that if you change the time of a slide using normal methods, your keyframes will scale, meaning that they will all change times as they move in proportion with the change to the slide. Sometimes, you don’t want your keyframes to move.

- You want to add additional time at the end of a slide so you can add more effects. Use Add/Remove Time to accomplish this. Just add time to the last keyframe. You’ll get the extra slide time you need, and all of your existing keyframes will remain where they are.
17. Keyframing

- You need more time on one of your keyframes, but you want everything after that keyframe to shift just enough to make room. Just use Add/Remove time to add the time where you need it. Keyframes after it will all slide to the right by whatever amount of time you add.

Keyframes and Layer Visibility

There’s one final important thing to note when you’re working with keyframes, and this involves the very first and very last keyframes on your slide.

Here’s a fundamental rule to remember: when there are no keyframes present for a layer at a certain point in time, then that layer isn’t visible. In essence, the layer might as well not exist.

For example, let’s say that **Keyframe 1** doesn’t start at the beginning of the slide. Instead, it starts at 2 seconds.

If you preview the slide, you’ll notice that you see only the background until the 2 second point. At 2 seconds, the layer will suddenly appear, then go through whatever keyframes you have set up as normal.

This is also the case if you take your last keyframe and place it before the end of the keyframe timeline. The layer will abruptly disappear.

This behavior is normal. This happens because when a layer has no keyframes present for a point in time, Producer treats the layer as "not being there". This is a valuable tool to you, because this gives you the ability to decide when a layer is going to appear and disappear within a slide, rather than being limited to just the slide time.

It’s this rule that lets you add and remove multiple layers within the same slide, creating some great collages and image sequences.

When would you use something like this?
Imagine you want three images to appear side-by-side. You want the first one to appear, followed by the second one 2 seconds later, followed by the last one after another 2 second delay.

To do this, you’d set Keyframe 1 for Layer 1 at 0 seconds, making it appear at the start of the slide. You’d set Keyframe 1 for Layer 2 at 2 seconds, making it appear 2 seconds later. Finally, you’d set Keyframe 1 for Layer 3 at 4 seconds, making it appear 2 seconds after the previous layer.

Whatever time you’ve placed keyframe 1 at is when the layer will appear on the slide. Whatever time you’ve placed the last keyframe at is when the layer will disappear.

Keyframes and Caption Visibility

All of the same principals for timing and layer visibility also apply to captions. By default, a caption begins at the beginning of a slide, Keyframe 1 time, 0 seconds.

To have the caption come in later in the slide, simply change the timing of keyframe 1 to fit your effect.
Layer Transitions

A Layer Transition is an effect that controls how the layer appears or disappears. These work just like transitions between slides, except that they can be applied to each layer within a slide, separately from the slide transition.

By default, the transition type for all of your layers will be a Cut. If you click on that transition icon, you will open the Transition Chooser window. Notice that this is slightly different window you use when setting slide transitions, as only certain effects are available for layer transitions.

When you pick a transition for a layer that happens over time, a crossfade for example, you get a time indicator associated with that keyframe. You can adjust the time of the transition by dragging the bar that appears in the middle of the keyframe timeline at the end of the transition effect.

Layer Transitions work just like slide transitions, controlling how the layer fades in or out. There are two differences between slide and layer transitions. The first is that the slide transition affects everything in a slide, while layer transitions only affect the layer they are applied to.

The second is that layer transitions can only use certain transitions, which will exclude some built-in transitions as well as any transitions you have created or installed separately.

You can create some very interesting effects by applying layer transitions to special layers like masks or adjustment layers.
Layer Transitions allow you to add and remove layers during your slide by choosing how you want them to appear in the first keyframe, setting up any motion for the following keyframes, and choosing how you want it to disappear at the last keyframe – all before the slide ends.

How to Set a Layer Transition

1. Open Slide Options

2. Select a layer from the Layers List and click on the Effects tab

3. In the Keyframe Timeline, click on the transition icon for either the first or last keyframe, and select a transition.

As you hover over a Layer Transition in the Keyframe Timeline, a red box will appear to let you know that the Layer Transition is activated and ready for editing. You will also see a tool tip appear that shows you the time of the Layer Transition.

To Set The Timing for Layer Transition

1. Click and drag the edge of the transition in the Keyframe Timeline. As you drag the edge, the tool tip will show you the adjusted time.

   OR

1. Right-click in the Keyframe Timeline, between the transition and the edge of the timeline.

2. Choose Set Transition Time from the menu.

3. Enter the new Layer Transition Time and click Ok.
Caption Behaviors and Keyframing

As you learned earlier in this manual, **Caption Behaviors** are effects that change the way your captions appear and disappear from a slide. If it sounds familiar right now, it's because a **Caption Behavior** is basically the same thing as a **Layer Transition**, only for text instead of images or video. Applying them and changing their timing using keyframes works just like changing the timing or effect for a **Layer Transition**.

**How to Set a Caption Behavior**

1. Open **Slide Options**

2. Select a caption from the **Captions List** and click on the **Effects** tab

3. In the **Keyframe Timeline**, click on the **Fly-In** or **Fly-Out** icon for either the first or last keyframe, and select a caption behavior.

   OR

1. In the **Caption Behaviors** pane, choose a **Fly-In** or **Fly-Out** effect. Notice that if you choose a behavior here, the **Keyframe Timeline** will update to show you that you now have an effect.

   ![Keyframe Timeline](image)

Just as you would with a **Layer Transition** as you hover over a **Fly-In** or **Fly-Out** effect for a caption in the **Keyframe Timeline**, a red box will appear to let you know that the **Caption Behavior** is activated and ready for editing. You will also see a tool tip appear that shows you the time of the **Fly-In** or **Fly-Out** effect.
To Set The Timing for Caption Behavior

1. Click and drag the edge of the Fly-In or Fly-Out effect in the Keyframe Timeline. As you drag the edge, the tool tip will show you the adjusted time.

OR

1. Right-click in the Keyframe Timeline, between the edge of the effect and the edge of the timeline.

2. Choose Set Effect Time from the menu.

3. Enter the new Layer Transition Time and click Ok.

Using Transitions & Behaviors with Text Layers

As you learned earlier in this manual, Text Layers are a hybrid slide object that allow you to use both layer and caption tools. This applies to keyframing as well.

When working with Text Layers, you can actually apply a Transition Layer AND a Caption Behavior at the same time. Which can deliver some amazing results.

Simply toggle between the Effect and Text Effects tabs to apply your changes to Layer Transitions and Caption Behaviors.
Previewing Keyframe Effects

As you work with keyframes, you’ll find that it’s critical to preview your work often. There are two different ways to preview keyframes from within the keyframe interface.

Previewing the Entire Slide

As with all previews in the Slide Options window, you can play the preview at any time. At the bottom of the window, click on the Play icon.

In Three Previews mode, the larger, active preview will playback the slide. If you’re using Two Previews mode, you’ll see the playback in the window on the left. This works great when you want to see how the entire effect looks from start to finish.

You can stop the playback at any time by clicking on the button again.

But what if you just want to view a particular section of your slide, without playing the entire slide? That’s a situation where scrubbing is used.

“Scrubbing” Your Work

As you begin using the keyframe timeline to create effects, you may find that you want to get a quick look at what your effect is doing at some point in the timeline. You can do this using “scrubbing”.

Scrubbing is an easy way to see what is happening at any point in time. Scrubbing is used in the main ProShow interface and in the keyframe timeline. When you scrub, you are controlling the playback by dragging your mouse. You can start and stop whenever you want, and the speed you drag determines how fast your show will play.

To scrub your keyframe timeline, click and drag the mouse pointer beneath the keyframe timeline. This will cause a red time marker to appear. As you drag the marker, the preview window will display what is happening at that point on your slide. You’ll also see a real-time update showing you the exact point in time that the marker is highlighting.
You can quickly scrub back and forth to see exactly what is going on within your slide at any point, or drag slowly to get a closer look at every moment of the effect.

Auto and Manual Keyframe Settings

One thing you may have noticed is that there is a box next to each option value in the Motion & Audio, Adjustment and Caption Motion & Adjustments panes. You may have also noticed that sometimes these boxes are checked, and other times they are not. These check boxes indicate the difference between setting that is being created by ProShow, or a setting that you have manually configured.

Earlier in this chapter, we introduced the concept of “tweening”, which is what ProShow does between keyframes. You know that creating motion, or any other effect, is done by setting up how you want the effect to go from point a to point b and letting ProShow do the rest.

The Auto/Manual check boxes are there to help you identify when a particular frame has settings you have chosen and when it has settings created by ProShow as part of the tweening process between other keyframes.

To get a better sense of when you might see this in action, perform the following exercise:

1. Create a new slide with 1 layer.
2. Select the layer in the Layers List and click on the Effects tab.
17. Keyframing

3. Using the options in the **Motion & Audio** pane, create a very simple zoom-in from **Keyframe 1 (Starting Position)** to **Keyframe 2 (Ending Position)**.

4. Preview the slide to see your simple motion in action.

You have some basic motion set up. Take note that the boxes which appear next to the values in **first** and **last keyframe** are gray. We’ll go into that in a moment.

5. Add a new keyframe to the timeline. Do not configure or adjust the keyframe in any way.

6. Preview the slide again.

Notice that you added a new keyframe and previewed the slide, but the effect is exactly the same. Take a look at the check box next to the Zoom values for **Keyframe 2**. The boxes are empty. That means that the values at this point in the effect are being automatically calculated by ProShow.

These values are automatically created because ProShow has not yet been given any settings for **Keyframe 2**. All ProShow knows is what you want it to do with the layer in **Keyframe 1** and **Keyframe 3**, the first and last.

The values are gray for the first and last keyframes because those are **always** manual. You must set those values for anything at all to happen on the slide.

7. Change the Zoom value for **Keyframe 2**.

You'll notice that there is now a white check in the box. This indicates that you have selected a specific value for the keyframe that will override the automatic setting for that point in time.

Disabling the checkbox will return the setting to the automatic value.
During the previous exercise, if you had applied several changes to the ending position instead of just the zoom, there’s a right-click option you may find helpful.

When you added the new keyframe in step 5, you could have right-clicked on that keyframe and selected the **Convert to Static Keyframe** option. This will automatically convert all settings on a layer to manual. This is a helpful tool to use if your workflow for creating effects is to create the beginning and ending first and then add keyframes in between.

In most cases you won’t need to worry about Auto or Manual settings interfering with your show. For most people, the more natural process when creating an effect is to work in a linear, step by step process from the first through the last keyframe. This workflow will generally result with all keyframes being set to manual.

However, it’s good to be aware of the feature should you start to wonder why a layer might seem to be doing something on its own, especially if you’re modifying a pre-made effect, like a Slide Style.

**Temporary Keyframes**

While working with keyframes and multiple layers, you may come across a window that asks you if you’d like to add a temporary keyframe. The idea of a temporary keyframe may sound a little confusing at first, but it’s a really useful addition to the program that can help you coordinate motion between layers.

A temporary keyframe is a marker or placeholder, for a point in time, where no keyframe exists. These appear when you are working with multiple layers and your layers don’t have the same number, or placement, of keyframes.
17. Keyframing

You can make one yourself to see how this works:

Create a new slide with two layers. Position the two layers on the slide so that you can see both of them at the same time. Once that’s done, follow the steps.

1. Create a slide with two image layers. In **Layer Settings**, set both layers to a zoom value of 45%. Position the layers so that they are side by side in the preview.

2. Create one new keyframe for **Layer 1**. It doesn’t matter where it appears on the timeline. (To give you a total of 3 keyframes)

3. Select the new keyframe in the timeline.

4. In the **Preview** window, click on **Layer 2**. Note: you must click on Layer 2 in the active preview window. If you select it in any other way, the temporary keyframe will not appear.

5. A window will open and ask you if you’d like to create a temporary keyframe. For this example, click the **Add Temporary** button.
6. A temporary keyframe will now appear where Keyframe 2 was located for **Layer 1**.

What you are seeing is the temporary keyframe representing the point in time where a keyframe was placed on **Layer 1**. Since a keyframe for that point in time doesn’t exist on **Layer 2**, but ProShow assumes you still want to work with that same range, you will see a temporary keyframe. It’s basically a placeholder for a keyframe that ProShow assumes you’ll want to add.

If you make any changes where the temporary keyframe appears, ProShow will create a keyframe there automatically, removing the placeholder.

**Practical Examples of Keyframing with Motion**

One of the best ways to learn how to do something is to practice, and that’s exactly what you will find here. In the following section, you will find a step-by-step guide to creating a motion effect with multiple keyframes. This will help you understand the tools better, and give you a good frame of reference for your own motion effects.

**Zoom, Freeze then Move**

For this effect, you will be working with one image layer. We will create a motion effect that works in a few stages. First, we want to begin with the image layer zoomed all the way out, so that your audience can’t see it. From there, we want it to zoom in to fill the center of the slide frame. Once it’s zoomed in, we’ll hold it in place for a moment to let the audience appreciate the picture. From there, we’ll move the image off of the slide by panning it to the right, out of view.
Since you know what the layer should be doing before you get started, this makes it much easier to plan for the number of keyframes you need to complete the effect.

Let’s break down the motions for the effect into what will happen in each keyframe:

- The image layer will start zoomed out at 0%.
- The image layer will zoom in to 70%.
- The image layer will be held in place at 70%.
- The image layer will pan to the right, off of the slide frame.

After breaking the concept for the effect down into pieces, we know exactly how many keyframes we’ll need before we get started. It’s going to take four keyframes to get the job done. Let’s begin working in Producer to create the effect.
To Create Zoom, Freeze then Move

Follow these steps one after the other, which will walk you through the complete creation of the effect.

1. Create a new slide by dragging and dropping any image you want to use into the Slide List.

2. Change your Slide Time to 5 seconds, and your Transition Time to 1 second.

3. Double-click on the slide to open the Slide Options window.

4. Select the layer in the Layers List and click on the Effects tab.

Now the slide has been created and we’re ready to begin adding the keyframes that will make the effect work. Remember that we need 4 keyframes, so we’ll add these all at once.

5. Right-click on the Keyframe Timeline and choose Insert Multiple. You can also click the Multiple button in the Keyframe Toolbar.

6. Remember, we need a total of 4 total keyframes to create this effect, and every slide always has 2 keyframes, no matter what. In the Number of Keyframes window, we want to add 2 more keyframes. Click Ok to insert the new keyframes.

   In the Keyframe Timeline, you’ll now see that you have 4 evenly spaced keyframes for this layer.

7. Click on the marker for Keyframe 1. In the Motion & Audio pane, change the Zoom value to 0% for either Zoom X or Zoom Y. (These values should be locked together, so you should only need to change one to apply the setting to both)

8. Now click on the marker for Keyframe 2 and change the Zoom value to 70%. Be sure the Manual check is visible.
We want the layer to freeze here, so we’ll need to manually set the Pan values to 0 x 0. If we don’t set the values, ProShow will automatically apply values to this keyframe later on when the motion effect is applied.

The first part of your effect has been configured. If you playback the slide, you’ll see the image start as not visible, and zooms up to 70%. Remember that Producer handles the tweening to make the changes between the two keyframes happen. Now we can set up the rest of the keyframes.

9. Right-click on Keyframe 2. In the menu that appears, select **Copy to Next Keyframe**. This will copy the **Zoom** value you just adjusted to **Keyframe 3**.

This copying of settings creates the next part of the effect. The settings for **Keyframes 2 and 3** are now identical, which effectively holds the layer in place. Since it’s exactly the same between those two keyframes, nothing will happen during that time.

10. Now select **Keyframe 3**. Once again, right-click and select **Copy to Next Keyframe**. This will make sure the zoom of 70% stays the same for **Keyframe 4**.

11. Finally, select **Keyframe 4**. In the active preview window, drag the layer so that it is off to the right side of the slide frame. Simply drag it to the right until you can’t see it.
12. Click on the Play icon at the bottom of the Slide Options window to see the effect you have created.

The slide will zoom from not being seen to 70%. It will pause for a moment, and then move off the screen to the right as the slide ends.

**Note:** This final movement is why you needed to enter a Pan value of 0 x 0 or check the manual box earlier. If you did not set a manual value for Keyframes 2 and 3, what you would see is the layer panning off to right as it zooms in and it would not pause.

This effect is a simple and easy way to add some interesting motion to your image. It’s also a good way to set up your slide for multiple images. You can have other image layers appear after the first has panned out, moving in the same way.

To create a multi-layer effect, you would increase your slide time to accommodate the other images, and then time the first and last keyframes of your layers to start as the previous one ends.

### Pausing Motion

ProShow features some right-click options that can help you make effects similar to the previous example with even fewer clicks.

In this first example, we'll be using the *Pause Motion Until Here* option. We'll start with a static object that holds in place for a moment, then moves and zooms in.

### Using Pause Motion Until Here

1. Create a new slide by dragging and dropping any image you want into the Slide List. Change the Slide Time to 5 seconds, and the Transition Time to 1 second.

2. Double-click on the slide to open the Slide Options window.

3. Select Keyframe 1, set the Pan values to -25 x 0 and the Zoom values to 50%
4. Select **Keyframe 2**, set the **Pan** values to 0 x 0 and the **Zoom** values to 100%

If you preview the slide, you'll see a very basic zoom in that fills the slide frame from the left side of the screen.

5. Next, right-click on the **Keyframe Timeline** in between the 1 and 2 second marks. From the menu, select **Pause Motion Until Here**. This will add new keyframe at this point with settings that are the exact same as the keyframe that comes before it.

In this case it will create Keyframe 2 and copy Keyframe 1’s settings. It will also set all options on this newly added keyframe to manual.

When you preview the slide again, the image layer will be still for a moment, and then fill the screen.

In this second example we’re going to start with a basic zoom, then add keyframes that will create a pause, then move effect.
Using Pause Motion

1. Drag and drop an image into the **Slide List** to create a new slide. Change the **Slide Time** to 5 seconds, and the **Transition Time** to 1 second.

2. Double-click on the slide to open the **Slide Options** window.

3. Select **Keyframe 1** and set the **Zoom** values to 25%.

4. Select **Keyframe 2** and set the **Zoom** values to 100%.

5. Next, at around the 2 second mark, double-click on the **Keyframe Timeline** or right-click and select **Insert** to add a new keyframe.

As you learned earlier in this chapter, when a new keyframe is added between two other keyframes, ProShow automatically applies values to that new point in time. If you select keyframe 2, you'll see that the Zoom should be something close to 50%.

In the **Zoom, Freeze then Move** example, you applied settings to each keyframe manually. This time, let's make ProShow do the work for us.

6. Right-click on **Keyframe 2** and select **Pause Motion** from the menu.

In the **Keyframe Timeline** you'll notice that ProShow has added a new keyframe for you (Keyframe 3).

With one click, ProShow has converted the settings for Keyframe 2 to manual, inserted a new keyframe and copied the settings from keyframe 2 to keyframe 3. All of this causes the layer to zoom in, freeze, then continue to zoom until the end of the slide.
Practical Example of Keyframing with Adjustments

The great thing about working with keyframes is that they don’t change from one keyframing type to another. The way you create and use keyframes to build a motion effect is the exact same process you use to create an adjustment effect.

Adjustment Effects use keyframes to make visual changes to your layers over time. You use the same kinds of settings that you would normally find under the Adjustments tab, but rather than being static, they can change as the slide plays. This gives you the ability to change brightness, opacity, and all kinds of other settings over time. Having the ability to do this opens quite a few creative options for you.

One of the most often requested and popular slide effects is to cause an image to appear to change from color to black & white, or vice versa. This is something that adjustment effects and keyframing are perfect for creating. In the following example, you will enhance your “Zoom, Freeze then Move” effect with some color shifting to get a sense of how adjustment effects work.

Enhance Zoom, Freeze then Move With Adjustments

1. Double-click on the slide you created during the “Zoom, Freeze then Move” example.

2. Select the layer in the Layer's List and click on the Effects tab.

The first thing to point out is that you will not need to create any new keyframes to create this effect. Instead, you’ll be using the keyframes that you have already added to create the motion effect. Remember, a keyframe is simply a point in time when something happens. That can be motion, an adjustment or both.
3. In the Keyframe Timeline, select Keyframe 1. In the Adjustments pane below the preview, click on the check box for the Colorize option.

4. Set the color to gray.

5. Click on the Keyframe 2 marker and Colorize this keyframe, making it gray as well.

6. For both Keyframe 3 and Keyframe 4, turn Colorize on and then back off again. This will ensure that it stays off.

7. Click on the Play button to see what you have created.

Notice in this enhancement that when the image first appears, it's black & white. Once the image zooms in and holds in place, it changes from black & white to a full color image before panning off of the slide.

Here you can see that motion and adjustment effects are designed to work hand-in-hand with one another. The keyframes are shared, and these kinds of effects perfectly complement one another.

Keep in mind that you can perform any adjustment using keyframes. In the example you just created, try setting the blur for Keyframe 1 to 100%. Now preview the slide again to see it zoom into focus and change from black & white to color.

A Practical Example of Keyframing with Captions

Keyframing can also be used to add motion or adjustments to the captions on your slides. With keyframing, you have you precise control over the timing and behavior of your captions. This kind of precision allows you to create effects that do exactly what you want – when you want to see them.
In this example, creating the appearance of a caption being written by hand can be done by timing when your captions appearance and using a specific Caption Behavior.

1. Create a new slide with any image. This image will be the backdrop for the slide. Ideally, try to choose something like an abstract background, an image that looks like a piece of paper, or even a photo that has room for text.

   In the next figure, you'll see an image of a notebook. Any text that appears on top of this image should stand out nicely.

2. Set the Slide Time to 10 seconds and the Transition Time to 3 seconds.

3. Double-Click on the slide to open the Slide Options window. Select the layer and the use options found under the Layer Settings and Adjustments tabs to position or edit your layer however you feel it looks best to compliment the captions you’re about to add.
Now that the layer is setup and adjusted, let's add the first caption.

4. In the Captions pane, click the Add (+) button to create a new caption.

5. In the Selected Caption Text area, under the Caption Settings tab, begin typing some text.

One of the keys to this effect is choosing the right font. You'll want to select a font that looks like handwriting. Windows has several script fonts installed that will work nicely including Segoe Script. ⁸

In the next figure, you'll see that we have typed "Santa's Nice List". The color was sampled from the image using the Eye-Dropper. This will ensure that the font color will compliment the colors within the image.

The size and position were adjusted by using the preview to visually move, line up, and rotate the text. For more precise caption alignment, use the options in the Caption Placement pane.

6. With this first caption selected, click on the Effects tab.

---

⁸ Available in Windows Vista, 7 and 8.
7. Change the **Caption Behaviors** for both the **Fly In** and **Fly Out**. You can either use the dropboxes in the **Caption Behaviors** pane, or you can click on the **Caption Behavior** icons in the **Keyframe Timeline**.

For the **Fly In**, choose **Fade Right**. For the **Fly Out**, choose **Fade Out**.

8. In the **Keyframe Timeline**, right-click on the **Keyframe 1** marker and select **Set Time for this Keyframe**. Set the time to 1 second. This will tell caption to not appear at the very beginning of the slide. Instead, the caption will appear 1 second after the slide begins.

9. Click and drag **Keyframe 2** all the way to the end of the slide. This will keep the caption visible all the way through the end of the slide. Your image and text will now both end at the same time.

Go ahead and preview the slide to see how the timing of the caption has been affected and to see how the **Fade Right Caption Behavior** creates the feel of the text being written on the screen.

To complete this effect, you’ll need to add multiple captions and adjust the timing of each so that they enter the slide one at a time.

10. In the **Captions** pane, right click on the caption you previously created and select **Duplicate Caption**. This shortcut will make sure that your font, color, size, Caption Behaviors and keyframe adjustments are identical for the next caption on your slide.
11. Go back to the **Caption Settings** tab and select the duplicate caption (caption number 2 in the **Captions List**).

12. In the **Selected Caption Text** pane, change the text to something else. In the figure below, you'll see that we have added the name "Randy" to Santa's Nice List.

13. Because we duplicated the previous caption, the new text will appear on top of the first caption. Move the new caption to appear beneath the first by clicking and dragging in the **Preview**, or by using the **Caption Placement** options under the **Caption Settings** tab.

If you preview the slide again, you'll see that both captions will appear at the same time. To make it feel more like handwriting appearing on the screen, you'll need to adjust the timing of Keyframe 1 on the second caption.

14. With **Caption 2** selected, click on the **Effects** tab.

15. In the **Keyframe Timeline**, right-click on the **Keyframe 1** maker and select **Set Time for this Keyframe**. Set the time to 3 seconds.

Preview the slide one more time and now you'll see that slide begins without any text on the screen. One second after the slide begins, the first caption appears to be written. Two seconds later, the second caption appears to be written on the screen.
17. Keyframing

In this case, because we are writing a list, we would need to repeat steps 10-15 for each new name on “Santa’s Nice List”. With each new name, you would change the time of Keyframe 1 so that each caption appears a little later.

For example the time for Caption 3, Keyframe 1 would be 5 seconds, and the time for Caption 4, Keyframe 1 would be 7 seconds.

As a finishing touch for a handwriting effect, try adjusting the length of the **Fly In**. Remember, the shorter that time is, the faster the text will appear. If you have a caption with more text, try using a longer **Fly In** time to make the caption appear more slowly.

Remember that the **Keyframe Editor** also works for Captions.

With this type of effect, timing is critical. This is when the **Keyframe Editor** becomes a very helpful tool. Use it to view and make adjustments to keyframe timing and/or behavior for each caption.
Controlling Your Soundtrack with Keyframes

In addition to creating motion and adjustment effects, you can also use keyframes to control the volume of your soundtrack during a slide.

The Soundtrack Control Slider

To adjust the soundtrack volume, with a keyframe for either a layer or caption selected, simply move the slider left or right. You can mute a track by reducing the volume level to 0%, or increase the volume to 200%.

As your show plays, when it reaches the point in time when the keyframe, happens, the change to the soundtrack will be applied.

Tip: To help you understand when a keyframe exits in time in relation to your show length, right-click on the Keyframe Timeline, go to the Time Format options and select Show Keyframes as Show Time.

The control slider is located in Slide Options:

- For images, videos and Text Layers, you’ll find the control slider at the bottom of the Motion & Audio pane under the Effects tab.

- For Captions, the Soundtrack control slider is in the Caption Motion & Adjustment pane under Effects.
You can adjust the soundtrack volume using any keyframe that exists in a slide. This means on any slide, you can go to any or all of the tabs listed above and apply a volume adjustment to a keyframe.

**Tip #1:** When you have a slide with multiple objects using keyframes, the Keyframe Editor will help you see how all of those keyframe times line up, making it easier to coordinate volume changes.

**Tip #2:** If your goal is to make volume changes that do not go hand in hand with something happening on a slide, it's always a good idea to stick to using only one of the tabs listed earlier and entering all of your volume changes there.

**Tip #3:** When you have a slide with multiple objects, sometimes you may find yourself applying different volume levels to the same point in time within a slide.

For example: For Layer 1, you add a keyframe at the 4 second mark. Under the Motion & Audio pane, you set the volume level to 25% for that keyframe.

Then with a caption selected, you add a keyframe at the 4 second mark. Under the Caption Motion & Adjustment pane, you set the volume to 85%.

When this happens, ProShow will always use the lowest volume setting.

**To Control the Soundtrack Using Keyframes**

1. Add 5 images to a show, then drag and drop an audio file onto the Soundtrack bar.

2. Double-click on slide 3. (For best results with this example, we need to make sure there are slides before and after the slide we'll be editing).

3. With the layer selected in the Layers List, click the Effects tab above the preview.
Remember: every layer or caption always has at least 2 keyframes. That means by default, you can make two changes to your soundtrack volume. The first when the slide begins (Keyframe 1) and the second when the slide ends (Keyframe 2).

4. Select Keyframe 1. At the bottom of the Motion & Audio pane, locate the Soundtrack control slider and change the volume to 10% then click OK to apply the change.

Now back in the Workspace, click on slide number 2 and press play in the preview.

As the transition between those slides begins, you’ll hear the soundtrack volume drop from 100% to 10%. How long that takes will be determined by the transition length.

As slide 3 continues to play, the volume will gradually return to full volume. This happens because we did not change the volume of Keyframe 2. The volume at that point is still set to be 100% (the default master volume of the Soundtrack).

If you press the TAB key on your keyboard to open the Timeline View, you’ll see how the keyframed value has affected the volume of your soundtrack.
17. Keyframing

So far in this example, we've only changed one keyframe value. So let's go back the slide and make a few more adjustments.

5. Return to the **Slide List** view and Double-click on slide 3 to open the **Slide Options** window.

6. Under the **Effects** tab, click the multiple button above the preview and add 2 additional keyframes, for a total of 4 keyframes on the timeline

7. Select keyframe 2 and adjust the **Soundtrack** control slider to 150%

8. Select keyframe 3 and set the slider to 0%

9. Select keyframe 4 and, adjust the slider to 75%

10. Click **OK** to apply the changes.

Now back in the Workspace, click on slide number 2 and press play in the preview. This time you'll hear the volume change drastically as the show plays.

If you go the **Timeline View** you'll be able see just how drastic those volume changes are.
Controlling Sound Without Damaging Effects

99.9% of the time, you'll create your effects first, before adding any music to you show. So what happens when you use keyframes to create an effect, only to discover later that you also want to control the soundtrack volume? Thankfully, you can do that without "breaking" anything. All you need to do is add more keyframes.

Following along with this next exercise to see this in action:

Adding Soundtrack Keyframes to an Existing Effect

1. Add 5 images to a show, then drag and drop an audio file onto the Soundtrack bar.

2. Double-click on slide 3 to open the Slide Options window.

3. With the layer selected in the Layers List, click the Effects tab above the preview.

4. Select Keyframe1. In the Motion & Audio pane, set the Zoom value to 0. Next, select Keyframe 2 and set the Zoom to 100% This will create a very standard zoom in effect.

5. Now, Click the Add button above the Preview to insert a new keyframe. This will put the keyframe halfway in between your original two.

Notice that the Zoom value for the new keyframe has a zoom value of 50%.

As you read earlier in this chapter, if you already have an effect created, when adding a new keyframe, ProShow will automatically apply whatever values are appropriate for that point in time. It's all part of ProShow doing the tweening between the original 2 keyframes.

When adding the new keyframe in Step 5, ProShow knows that in order to make the zoom go from 0 to 100, this point in time needs to have a value of 50%
17. Keyframing

Most importantly, the process of adding a new keyframe doesn't mean you are changing anything. You're simply adding another point in time in which something could happen -and that something can be a change in the soundtrack volume.

6. Select Keyframe 2, using the **Soundtrack** control slider, set the volume to 0%.

7. Click **Ok** to apply the changes and return to the Workspace.

Now click on slide 2 and preview your show.

As slide 3 begins, you'll hear the fade out completely, then return to full volume. As that happens, your image zooms in from 0 to 100%.
Controlling Sound As Part of Your Effects

One of the creative advantages to controlling the Soundtrack with keyframes is that it gives you the ability to coordinate volume changes along with your effects.

For example, if you have an image fly onto the screen and hold still for a few seconds, you can also lower the soundtrack volume at the same time, allowing your audience to focus more on the image and less on the music.

The reverse is also true. If you have an image that really connects with certain words or a melody, try increasing the volume as that image appears on screen.

Video Layers and Soundtrack Keyframes

Keyframing your soundtrack is especially helpful when using video layers that contain audio.

As video layers begin to play, you can customize the Soundtrack volume using keyframes to make sure the audio within the video clip isn’t overpowered by your Soundtrack.

This also gives you the ability to have multiple video layers on the same slide with completely different Soundtrack volume levels as each video layer is played.

For more information about using video layers with audio, see Chapters 9 and 12.

How Keyframes Affect the Timeline View

When using Keyframes to control the soundtrack, you will see some slightly different Volume Control Points in the Timeline View. Control points made using keyframes will appear as black dots in the timeline.
Unlike normal **Volume Control Points**, these points cannot be moved using the **Timeline View**. To make changes to these points, you need to return to the **Slide Options** window for the slide that's controlling the **Soundtrack**, and adjust the timing of the keyframes.

Keep in mind keyframes are part of the slide, *not* the Soundtrack. If you change the timing or move a slide, the keyframes for that slide will affect different parts of your Soundtrack.
18. Modifiers

Working with Modifiers

Modifiers are one of the most advanced features found in ProShow. They are not for the faint of heart. Modifiers are intended to provide advanced users with advanced functionality and control that goes beyond what can be configured in the normal ProShow interface. Because of this, they come with a certain amount of complexity that can’t be removed without limiting their capabilities. Simply put, modifiers are just a complex concept, and are not intended for all users.

It’s important to remember that while modifiers are incredibly powerful tools to enhance your shows, they have pretty limited uses. For the most part, you will use modifiers to create effects that would be incredibly tedious to do with keyframes or other features. They won’t completely change how you create shows, or make your show creation an automated process. They are intended only to act as a compliment to the rest of the tools you have available.

What is a Modifier?

A modifier applies a change to a setting. It takes whatever values you’ve entered for your layer’s Effects in Slide Options and makes more refined changes. Changes can be based on some set value, based on another layer or caption, or derived from some algorithm. Modifiers are a way to have ProShow automatically adjust the normal settings for your slide based on some value. Want something to pulse? Modify its brightness based on a wave. Want a layer to follow another? Modify its position based on another layer’s position. A modifier is just some value that gets added to a setting.

In their simplest form, modifiers change, or “modify” a value you have set in Producer. You can also think of a modifier in terms of what it does. It’s a combination of values that will change what they are attached to, automatically.
There are different types of modifiers, but the most basic modifier is a **Constant**. This means a constant value is applied, and that value doesn’t change. So, let’s say you want to modify your **Zoom X** value for a layer. If you apply a constant modifier that is set to add 5, your zoom will be 5 more than what you specify manually for the layer. The modifier will constantly apply that addition. Here, we come to the concept of time:

A **Constant** modifier will apply the value you set for the entire duration of the slide. It is “constantly” applying that value change, no matter how long or short the slide time is. So, a modifier that is set to add 5 to a zoom will add that 5 to the zoom value of the layer for the entire slide – start to finish.

Constants make a good starting point to understanding modifiers, because they don’t change. It’s a constantly applied value, so it’s predictable. You know exactly what it’s going to do if you set it to add 5 to your zoom value. The other modifier options work the same way, but their values can change based on variables you select. We’ll go into that as we address each modifier type.

When you create a modifier for a setting, you can combine different changes to create a single modifier. Each type you apply is an **Action**. A modifier is the total of all its actions. This total is the amount that is applied to the setting. For example, you could add 5, subtract 2, and multiply by 4. These would be three separate actions. The end result of the modifier would be to add 12. (Five minus two is three, three times four equals twelve). You can stack as many actions as you want, in whatever order you want. Keep in mind this can quickly become a little confusing, so try to limit yourself to 1 action at time until you get the hang of it.

Ultimately, a modifier does exactly what you design it to do, and nothing more. Mastering modifiers is learning to control your variables to get predictable results.
What Can Be Modified?

Modifiers can be applied to almost any value you set under the **Effects** tab for a selected layer or selected caption in **Slide Options**. This includes Motion and Adjustments. The process to apply modifiers is simple:

**To Apply a Modifier**

1. Select a Layer or Caption and choose a value you want to modify under the **Effects** tab in **Slide Options**.
2. Right-click on the value and select **Add Modifier**.
3. The **Modifier** window will open and allow you to configure the modifier you want to use.
4. Click on **Ok** when you are done.

When you have applied a modifier to a value, you will see a red “tick” mark on that value, which indicates that it is being modified. If you don’t want to continue using a modifier for that example, you can remove it at any time:

**To Remove a Modifier**

1. Right-click on a value that has a modifier assigned to it, shown by the red “tick”.
2. Select **Remove Modifier** from the context menu.

Because modifiers are often a process of trial and error to get the results you want, you may find yourself needing to make small adjustments to them. You can edit any modifier you have created:
18. Modifiers

To Edit a Modifier

1. Right-click on a value that has a modifier assigned to it, shown by the red “tick”.

2. Select **Edit Modifier**.

3. The **Modifier** window will open and allow you to make any changes you want.

4. Click on **Ok** when you are done.

Before we dive into how to configure and use modifiers with some examples, we need to understand the Modifier window, and what each kind of modifier does.

The Modifier Window

The **Modifier** window is where you set up all the options that will create your modifier. From here, you’ll add and remove different actions for your modifier, create the specific changes for each action, and control the keyframes that the modifier is applied to. To help you keep your bearings, this window also provides a graph that shows how the value will change over time.
The **Modifier** window is where you configure each of the actions that will be part of your modifier. It is broken into a few sections to give you as much control over what you set up as possible.

At the top left of the window, you will see the **Modifier Target**. Here you'll see a description of the setting you chose to modify –what you clicked on to open the **Modifier** window.

In this figure, you'll see that we selected to add a modifier to the White Point value of Layer 2:

![Modifier Target](image)

Just beneath the target value, you will see the **Apply To** options. Here, you can specify if the modifier applies to the entire slide (all keyframes), or just a specific keyframe. If you choose to apply the modifier to a specific keyframe, the drop-down-list to the right will let you choose which keyframe you want it to apply to.

Next is the **Actions** list. Because you can create multiple actions for each modifier, you have a list of them. This list works just like the Layers list. You can add new actions by clicking on the add button, remove them by clicking on the delete button, and change their order with the up and down arrows.

![Actions](image)
Moving down, you come to the **Selected Action Settings** options. This is where you choose how you want the modifier to behave.

These options are where you get down into the details of configuring your modifier.

We will go over these options in much more detail in a moment.

On the right side of the window, you have the **Preview** and **Waveform Preview**. The **Preview**, at the top, displays your slide, just like you’d see in the **Slide Options**.

Beneath the preview window is your **Waveform Preview**. The **Waveform Preview** is where you can see exactly how your modifier is going to change a value over time.

There are a few things to notice here. First, you can zoom in or out on the waveform using the **Zoom** slider at the bottom or the mouse wheel. Second, notice that your keyframe timeline for this layer appears just above it. This is so that you can see exactly when and how the modifier will work.
Just like you’d find in other parts of the program, at the bottom of the modifier window you’ll find several buttons. These buttons let you control the preview and access additional options.

Using the Play button here, you can preview your slide to see what impact your modifier has. The Options button opens a menu allowing you to see additional value settings in the Waveform Preview. The Copy button lets you copy modifiers between keyframes and settings.

The keyframe timeline also provides a convenient way to preview, by clicking and dragging in the bottom of the keyframe area, you can ‘scrub' the preview. Just below the Waveform Preview are a set of checkboxes that allow you to control what is shown on the graph.

We will go into much more detail on the Waveform Preview as you learn how to configure and control your modifiers. For now, let’s move on to the different kinds of actions you can create within a modifier.

Creating Actions for Modifiers

So far, we know that a modifier changes the value you create it for, and that within each modifier you can create multiple actions. These actions are what make the modifier work, and create the effects you see. You can combine actions together to get different results, but before you do that, it’s best to understand exactly what you can configure for each action. Let’s start with the types of actions you can choose.

Each action consists of two different things you can configure: type and variable amount. The type of action determines how this action affects the overall modifier. The amount is how much should be applied by the action. For example, if you specify an action of ‘Add 5’, the type is ‘add’ and the amount is 5. We’ll go into more detail about types and variable amounts below.
Types of Actions

Every action works mathematically, so you have a selection of operations that you can select for your action. These are standard mathematical calculations. You can do all of these:

- **Add to Modifier** this adds to the value you are modifying, and the amount of addition is determined by the variable you set.

- **Subtract from Modifier**: this subtracts from the value you are modifying, configured by the variable you choose.

- **Multiply Modifier** this multiplies the value you are modifying, again, based on how you set your variable. This can only be chosen after you have created an action using Add or Subtract, in other words, a secondary action. The first action must be Add or Subtract and cannot be a Multiply action.

- **Divide Modifier**: just like the above, this will divide your modified value based on the variable you choose. This can only be chosen after you have created an action using Add or Subtract, in other words, a secondary action.

A new modifier with no actions defaults to a value of zero. The actions you apply change that starting value of zero into something else, in the order you specify. Looking back at our example from earlier, let’s say you apply three actions: add 5, subtract 2, and multiply by 4. Let’s see how that affects your resulting modifier.

<table>
<thead>
<tr>
<th>Action</th>
<th>Amount</th>
<th>Result of Action</th>
<th>Total Modifier</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default for New Modifier</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Add</td>
<td>5</td>
<td>0 + 5</td>
<td>5</td>
</tr>
<tr>
<td>Subtract</td>
<td>2</td>
<td>5 – 2</td>
<td>3</td>
</tr>
<tr>
<td>Multiply</td>
<td>4</td>
<td>3 x 4</td>
<td>12</td>
</tr>
</tbody>
</table>

**Total Modifier:** 12
The target setting is always modified by the total amount of all the actions combined. In this example, it would be +12.

Since a new modifier with no actions always defaults to zero, the first action must be either addition or subtraction, since multiplying or dividing zero wouldn’t produce any usable results. This limitation only applies to the first action in the list.

When you get started with a new action, you always start by deciding how it will change the value. Do you want it to add to the value? Do you want to multiply the value to scale the result? For the most part, you will get started with **Add** actions, as they’re the easiest to work with.

### Variable Amounts for Actions

Once you have chosen what type of action you want to use, you can begin to get the variable set up. This amount determines how much is added, subtracted, multiplied or divided.

**Note:** it’s important to recognize that the real use of variable amounts come from the fact that values are changing with keyframes or other modifiers. If the values don’t change over time then they’re constants. For example, if you simply add 5 to the zoom level of a layer, the effect won’t be very exciting. However, if the layer is moving, and you modify the zoom level by the position, the layer will zoom as it moves. When you start using modifiers to link different settings that change over time, the power of modifiers is much more obvious.

You can choose between three different types of variables.

- **Constant Amount** this variable is the same as the constant we discussed at the beginning of the chapter. It applies the same value, based on the action type, for the whole slide or a single keyframe. If you enter 5 for the value and choose **Add** as your action type, it will add a flat value of 5 to the modifier. These are the simplest forms of action, and provide very limited benefit unless they’re used to offset another action by a constant amount. They are helpful for understanding how actions work, though, because they don’t change over time.
18. Modifiers

- **Variable Amount** variable amounts let you choose some other value from any layer on the slide. In short, any of the values that you can modify can be set as a variable. You could use this type of variable to base any setting off another setting. Use this to make **Layer 2** move behind **Layer 1**, by modifying **Layer 2’s** pan values by the pan values for **Layer 1**.

For a more detailed example, let’s say you use brightness – this means that as the brightness on your target layer changes, the action will take place. If you set the action to **Add**, and you set the variable to **Brightness**, you will get this example:

- You have created a modifier for the **Pan X** value. For your action, you set it to **Add**. You choose **Variable Amount**, and base it on the **Brightness** of another layer on the slide. If you use an adjustment effect that changes the brightness of **Layer 2**, the **Pan X** value or horizontal position of this modified layer will change. If the brightness increases, it will move right, or positive X. If the brightness decreases, it will move left or negative X.

You can also set a **Multiple**. This can be used to make the change more obvious, so instead of being a 1:1 change in value, it would be a 1:2 or more. Sometimes, the value you are using as your variable just won’t be dramatic enough. The multiplier lets you amplify the effect to achieve the result you’re after. For example, if we wanted **Layer 2** to zoom twice as much as **Layer 1**, we’d base the zoom off **Layer 1’s** zoom, with a multiplier of 2.

- **Amount from Function** the amount is the value from a mathematical function, represented by a waveform. The waveform can be configured to appear the way you want it to appear. The shape and value of the waveform determines how your action will behave. When you look at the **Waveform Preview** for any particular wave, the way it cycles up and down directly relates to how the value will cycle up and down. There are
several different types of wave functions available for modifier actions.

Available Functions

There are a wide range of functions available to use in your actions, which you can find here:

**Sine Wave** a common and simple waveform, sweeping up and down in gentle motions. This waveform can be customized for the frequency, or how often it “waves”, the amplitude, or how high it “waves”, and the phase, which is when it takes place.

**Cosine Wave** the companion of the sine wave, but otherwise the same in appearance and traits.

**Block Wave**: this waveform features flat plateaus and valleys, with quick and abrupt changes between them. When used in actions, it often creates very abrupt or sharp changes in value. Block waves can be adjusted for amplitude, or how high it “waves, up and down time, which is how long each plateau and valley will be, and phase.
Sawtooth Wave  this waveform looks just like the teeth on a saw. It features an angular ascent, with a very abrupt descent. It can be customized for frequency, amplitude, and phase.

Triangle Wave  this waveform is similar to the sawtooth, except that it has both an angular ascent and descent, equal on both sides. The triangle waveform can also be customized for frequency, amplitude, and phase.

Random Wave  the random wave does just what it describes – it creates a random wave pattern. To control how the random samples appear, you can adjust the range, or how high it will go, the granularity, or hundredths of seconds between changes in value, and the smoothing, which will control how abrupt the changes are.

Linear Ramp  this is a line, rather than a wave. The linear ramp is an angular line that steadily changes value over the time of the slide. You can control the linear factor, or “angle” of the line, the constant or starting value of the line, and the offset, which is when it will start.
Quadratic Curve the quadratic curve is similar to the linear ramp, save that it curves as it increases in value, rather than moving in a straight line. The increase becomes more dramatic as you move further along the curve. You can control the quadratic factor, or height of the end of the curve, the linear factor, or rough “angle” of the curve, the constant, or value of the starting point, and the offset, which is when the curve will start.

As an example of using a waveform, consider making a layer pulse. You could achieve this affect by applying a modifier for brightness, and adding an action to add based on a Sine Wave amount. As the wave pulses up and down, so will brightness.

The different types of waves listed above each have their own shape, which define how the values change. If you want something that changes gradually, a Sine Wave might work. For abrupt changes, a Block Wave might be better. Want something that gradually builds, but quickly goes away? Try a Sawtooth Wave.

When using a wave function, the Wave Begins At drop-down-list will let you specify the starting point for the wave. You can choose to have the wave start at the beginning of the show, the slide, or the keyframe. This option is useful for creating effects that span slides or keyframes. For example, if you want the effect on Slide 2 to start right where Slide 1 left off, you can’t let the wave reset at the beginning of the slide, or the effect would appear to start over. By setting this option to ‘Start of Show’, the wave would reset only at the start of the show, not at the start of each slide.

If you are trying to line up effects across slides using the same wave function, set this to ‘Start of Show.’ If you are trying to line up effects across keyframes, set this to ‘Start of Slide’ to prevent the wave from being recalculated for each keyframe. If you do want the wave to reset at each keyframe, choose ‘Start of Keyframe.’
Each wave type comes with its own set of options for tweaking the shape of the wave. Use those options to control the fine tuning of the wave, and remember to keep an eye on the **Waveform Preview** to see what your tuning is doing to the wave.

As you can see, there are quite a few options available for your actions. The best thing to remember after absorbing this much information is that you don’t have to juggle all of the variables at once. Whatever effect or purpose you are planning for your modifier, there are lots of waveforms available to choose from.

Now that we have described each of the variables and actions you can combine, we can focus on the **Waveform Preview**. This is the real key to working with modifiers, as you will see.

**The Waveform Preview**

The **Waveform Preview** is your core tool for controlling functions and determining how variables will change the look of your layers. It has a few key pieces of information that it displays for you which are immensely helpful in reading what your function or variable will do. Let’s start by breaking down each piece so that it’s easy to understand.
The Waveform Preview shows you the overall effects of your modifier over time. The horizontal axis is time, as represented by the keyframe timeline. The vertical axis is the value you are modifying, as represented by the value bar.

The Keyframe Timeline

Just above the Waveform Preview, and below the slide preview, is the Keyframe Timeline. This works just like the timeline you see when you are setting up any other effects. You can see each keyframe within the layer, plus the total slide time and transition time.

These values relate directly to the Waveform Preview. The left side of the Waveform Preview is the start of the slide, and as you move right, you move through time until you reach the end of the slide on the far right. This is also why modifiers are about time – the wave makes changes over the time of the slide. The keyframe timeline here shows you exactly where those changes will happen.

If you click and drag below the middle bar of the keyframe timeline, you’ll see a red triangle and time counter appear. As you drag, the preview will show you the state of the show at that point in time. This type of previewing, called ‘scrubbing,’ is very useful for quickly checking changes.
The Value Bar

The **Value Bar** is probably the most important piece of the **Waveform Preview** area aside from the waveform itself. The **Value Bar** appears on the left side of the **Waveform Preview**, and it displays the number range for the value you have chosen to modify. These values can change based on what you are currently creating a modifier for. Consider this example:

You have chosen to modify the **Pan X** value of a layer. The X, or horizontal, axis of each slide goes from -50 on the far left, to 50 on the far right. You have a total range of 100. If you choose to modify using a function, you will see the value bar display 100 at the top, and -100 at the bottom. This is the total range the waveform can work with.

There are some waveforms that can go higher or lower than the maximum range. When a value is taken outside of a range ProShow can display, it is “clipped”. We’ll discuss clipping in more detail later. For now, just remember that the value bar will display the range of whatever value you are adding a modifier for. It’s helpful to know what the ranges are for each value.

You can check the range for any value by looking at the slider in the **Effects** tab. The far left position of the slider will be the minimum value, and the far right position will be the maximum. For example, the zoom value can be adjusted anywhere from 0 to 500%. \(^9\)

---

\(^9\) Some values can far exceed their listed capacity, such as Pan, Zoom, Rotate and other motion effects. Adjustment Effects are all capped at their max value.
The Waveform

True control over your variable and the action that is taken using it comes from the waveform itself. It’s important to remember that the waveform will show you exactly what your modifier is going to do, so you never get results that don’t make sense.

By default you will see a green line for your waveform. This green line is what the modifier is currently set to do. If you choose a sine wave, the green line will be just that – a simple sine wave. To read what your modifier is going to do, you need to look at the waveform and compare it to the value bar and the keyframe timeline.

There are four different lines that may appear on the graph. You can turn lines on and off using the checkboxes beneath the graph. You can take a quick peek at a line by holding down the keyboard shortcut for that line.

- **Total Modifier / Selected Action** (Green): the green line is always visible, and represents either the total amount of modification, including all actions, to be applied, or the value for only the currently selected action. You can tell which is being displayed by looking at the text next to the checkbox. Click the box to toggle which one is shown. The keyboard shortcut to peek is SHIFT.

- **Original Value** (Blue): the blue line shows the original, unmodified value. This is value applied in Slide Options, before any modifier is applied. This is what you started with before the modifier. The keyboard shortcut to peek is CTRL+SHIFT.

- **Modified Value** (Orange): the orange line shows the final modified value. This represents the value that will actually be used during playback. This shows the result of your modifier when applied to the slide. The keyboard shortcut to peek is CTRL.
18. Modifiers

- **Interpolated Value (Yellow):** the yellow line is only available in a few cases. This line only applies when you are working with a modifier applied to a specific keyframe, and the adjacent keyframes have their own modifiers. When this happens, the yellow line shows you how the current and neighboring modifiers will interact and what the result will be. A very simplified way to think of this is that the yellow line represents the transition between modifiers. Unless you are dealing with specific keyframes, this line is disabled. The keyboard shortcut to peek is CTRL+ALT.

Let’s consider another simple example using a modifier applied to the **Zoom Y** value. You might want to work along with this one to better understand what’s being done:

Choose a single layer on a slide, and apply a modifier to the Zoom Y value. For your first action, choose **Add to Modifier**, and choose **Amount from Function** as your variable. Let’s go with a sine wave as the function type. You should see the sine wave in green, with the value bar showing a range from -500 to 500. By default the amplitude is set to 250, so you should see your sine wave stop at both 250 and -250. That’s as far as either wave or trough will go with that amplitude. If you want more waves per second, increase the frequency. If you want higher or lower values, change the amplitude.
Now click on the **Modified Value** checkbox at below the graph. You will see an orange line in addition to the blue one. This is the “modified setting”. What this means is that you’re seeing what the modifier will do to the actual layer value.

This is where clipping comes in. The orange line has crests, but each trough is flat at a value of 0 until it reaches the next crest. Those flat areas are where the value is clipped. This happens because you can’t change the zoom to something lower than 0%. So, the modified setting line shows you exactly what that modifier is going to do to your values.

If you compare each value to the keyframe timeline at the top of the **Waveform Preview**, you can see exactly what the value is going to be at precise points in your slide.

Understanding how to read the **Waveform Preview** is very important to understanding and using modifiers. Even if you aren’t familiar with the math involved in each function, as long as you can read and understand the waveform, you can create predictable results that do what you want.

That’s all there is to using modifiers – understanding how to set one up, and reading the waveform to know what it’s going to do with your setting. Now that we’ve gone through the details of how they work, let’s create an example to see them in action.

**Example: “Layer Tag”**

We’re going to use modifiers to cause one layer to chase another around the slide. This perfectly fits the kind of thing that modifiers are designed to do – it’s something that you can do with keyframes if you want, but modifiers make it faster and easier. You’ll also find that your results are more consistent.
To Create “Layer Tag”

1. Create a new slide with two layers. In **Layer Settings**, change the **Zoom** value for both layers to 40%.

2. Select **Layer 1** and click on the **Effects** tab.

3. Configure a 4 keyframe motion series for **Layer 1**. It can be any combination of motion, so do something simple like moving from one corner to another as you go through the keyframes.

4. Select **Layer 2**. Using the default set of two keyframes, select **Keyframe 1** and add a modifier to the **Pan X** (horizontal) value.

5. Set the **Apply To** value to All Keyframes.

6. Set the **Type of Action** to **Add**, choose a **Variable Amount Using** the **Pan X of Layer 1**, and change the multiplier to 1.2

7. Click on **Ok**.

8. Now create a modifier for **Pan Y** (vertical) value of **Layer 2**, **Keyframe 1**.

9. Set the **Apply To** value to All Keyframes.

10. Set the **Type of Action** to **Add**, choose a **Variable Amount Using** the **Pan Y of Layer 1**, and change the multiplier to 1.2

11. Click on **Ok**.

Play your effect and you can watch as **Layer 2** automatically chases **Layer 1** around on the slide.
This example works because **Layer 2** is using modifiers to automatically get its values from **Layer 1** and since those values are offset just slightly by changing the multiplier to 1.2, you can see it move and reflect that offset. If you were to leave the multiplier at 1, it would exactly match **Layer 1** and you wouldn’t see it.

If you want to expand on this example, try changing the **Zoom** value for **Layer 2** to 60%, and leave the multiplier for both modifiers at 1. You will be able to see it as it exactly follows the motion path of **Layer 1** – no keyframes necessary.

In our next example we’ll see how modifiers can enhance effects by creating effects that are timed to movement.

**Example: The “Dog Shake”**

Here, you’re going to create some rotation on a layer using a modifier. By moving the rotation center off, you can make the layer look like it’s shaking from the top. Once the modifier has been set up to create the shake, you will tie a second modifier to that value, and make it blur as it shakes – just like a dog drying off. This example will set a modifier for a specific keyframe range, rather than the whole slide. We only want the shake to happen briefly, rather than through the entire slide.

**To Create the “Dog Shake”**

1. Create a new slide with a single layer. In **Layer Settings**, change the **Zoom** value to 50%.

2. Click the **Set Slide Times** icon at the bottom of the **Slide Options** window and change the **Slide Time** to 3 seconds, and the **Transition Time** to 0 seconds.

3. Go to the **Effects** tab. Add a new keyframe at 1 second, and at 2 seconds for a total of 4 keyframes.
4. Select **Keyframe 2**. Start by setting the **Rotate Center Y** (vertical) value to something that will place the rotation center at the bottom of the image. 50 should be close.

5. Click on the **Copy** icon and select **Copy To Next Keyframe**. That will make sure the rotation center stays the same for both keyframes.

6. Add a modifier to the **Rotate** value of **Keyframe 2**.

7. In the **Modifier Target** pane, set the **Apply To** drop box to **Keyframe 2**

8. Set the **Type of Action** to **Add** and change the variable to **Amount from Function**. Choose **Random** as your function type.

The values of the random wave need to be changed. If you look at them by default, they may be as high as 50 for the range, which would be very severe rotation. You only need some very subtle rotation for this effect, so the range needs to be reduced. At the same time, you want more shakes to happen quickly, so the granularity needs to be reduced for more spikes in the wave.

9. Change the **Range** value to 10.

10. Change the **Granularity** value to 1. That will create lots of little spikes, for more shakes.

The first part of the modifier has been finished. If you notice though, this only creates a positive rotation. If you press the **Play** button to see what you have so far, the image will shake to the right, but not to the left. To get shaking for both directions, we need to add another action to this modifier.

11. Click on the **Add (+) icon in the Actions List**

12. Set the **Type of Action** to **Subtract** and choose **Constant Amount** as the variable.
Now you’re going to use subtraction to remove 5 from the Random range. Remember that negative rotation will rotate the image to the left. These two actions combined together will cause it to rotate both directions. The addition action will go right and the subtraction action will go left.

13. Set the Type of Action to Subtract from Modifier.

14. Select Constant Amount and set the value to 5.

15. Play the slide back and you should see it shake to both the left and right.

16. Click on Ok now that the modifier is set.

The shaking is finished. Remember that you set up the entire motion without using a single keyframe. This is far easier than creating 20 or more keyframes for each little twitch you want the layer to make. With the motion in place, we can set up the blur that will trigger when the layer is in motion.

17. In the Adjustment pane under the Effects tab, add a modifier to the Blur value.

18. In the Modifier Target pane, set the Apply To drop box to Keyframe 2.
18. Modifiers

19. Set the **Type of Action** to *Add* and change the variable to **Variable Amount Using** to *Rotate* from *Layer 1*.

20. Change **Multiply By** to 10.

21. Press **Play** to see your effect in action.

22. Click on **Ok**.

The real magic behind modifiers is what they allow you to do without need for keyframes. The entire effect for this example was made without manually editing a single keyframe. That’s what modifiers are really designed to do – allow you to accomplish tasks that would otherwise take tens, if not hundreds, of keyframes. Once you become comfortable working with modifiers on entire slides or keyframe, you can begin copying those modifiers in your show. This makes the creation of effects even easier.

### Advanced Modifier Features

In this final section, you will learn about the advanced features and tools available for working with modifiers. These include the ability to copy modifiers across your slide, and the interactive fade lines that can be used to refine and enhance modifiers. We’ll begin with copying modifiers.

### Copying Modifiers

When you are working with effects and keyframes it can often be easier to copy certain pieces of your effect to additional keyframes to speed the process. Modifiers follow the same principle. Copying a modifier can be done quickly and yields some great time saving benefits.

Modifiers can be copied within a slide, either between sets of keyframes, or to the whole slide at once. Modifiers can also be copied to other settings on the layer. First, let’s talk about how you copy a modifier.
To Copy a Modifier

1. Create your modifier and actions.

2. Click on the **Copy** button at the bottom of the Modifier window.

3. Choose either **Copy Modifier to Other Keyframes** or **Copy Modifier to Other Settings**.

4. A fly-out menu will appear and allow you to choose which keyframes or settings you want to copy the modifier to. Make your selection and the modifier will be copied.

When you copy a modifier between keyframes, the modifier retains all of its settings. Functions or variables will remain the same, only they will apply on the keyframes you copied them to in addition to the keyframes where you originally placed them. Remember to use the **Waveform Preview** to inspect your modified value to ensure that you are getting results that you want.

Copying a modifier to a different setting will keep the modifier intact, but because value changes are possible between different settings, you may want to check the copied modifier to make sure it will do what you want it to do. For example, a modifier applied to a **Pan** value will have a range from 100 to -100. If you copy that modifier to the **Zoom X** value, it has a range of 500 to -500 and will clip at 0. That means that the values you set for a function may need to be adjusted to get the results you want.
Why Copy Modifiers?

Just like advanced keyframe effects benefit from copying settings, modifier effects can be created much faster when you copy settings as often as possible. Consider the “Dog Shake” example from above. If you want your layer to shake more than once on a slide, it’s best to copy that modifier to another keyframe. This will save you time compared to manually recreating the modifier for a later keyframe. It will also keep your look consistent, so you have the same basic shake in each keyframe.

If your shake happens on keyframe 2, and you want to see it again at the end, just copy it. In this case, a later keyframe might be keyframe 6. Choose the modifier for keyframe 2, use the copy dialog to copy that same thing to keyframe 6. Voila – you have the same shake on another keyframe without any manual work at all.

**Note:** if you are creating effects that call for you to copy keyframes, remember that any modified keyframes will copy with their modifiers intact. So, if you copy a keyframe, that keyframe will include any modifiers applied to it.

There’s one final advanced feature to modifiers that you can use to refine and enhance your functions. This is the **Interactive Fade Line**
Interactive Fade Lines

When you create modifiers based on functions for individual keyframes, rather than the entire slide, you may notice that your keyframes will have fade lines available in the Waveform Preview. These look very similar to the fade in and fade out lines you can use when editing audio. In practice, they have a similar function.

![Waveform Preview](image)

The simple description is that you can adjust the “smoothness” of your function changes by moving the fade lines left or right. Notice that as you move them the waveform will adjust. This is changing how the function is interpolated between the keyframes. It can be used to “soften” or adjust the interpolation to suit the look you want.

Adjusting the fade lines is simple. At the bottom of the Waveform Preview, with your keyframe selected, you will see a tic marked line with a fade anchor at the bottom before and after the keyframes. Click on the fade anchor and drag the fade line left or right to see the change to your waveform.

**Note:** fade lines are not available for the very first and very last keyframe on your slide. These will never display fade lines for adjustment.

Before you begin using modifiers as a regular part of your shows, it’s important to understand one final piece of them. As you have seen above, you can use variables from other layer values, or even other modifiers. What happens when you try to define a variable from the same variable? You get an undefined value.
The basic rule is this: if you try to say that value A is A, ProShow has no idea what the value for A is, and cannot use it. This works no matter how many steps you have in the equation. If you try to say that A is B, but B is A, you still have the same problem. When you create these kinds of loops, you enter what is called a recursive cycle. ProShow will warn you if you try to use a recursive value as you set up the modifier. Just be aware of it, and avoid it, as it can cause completely unpredictable results – or just break.

**Note:** there is a limitation of modifiers applied to the zoom setting for layers. The short version of this is “modifying zoom might be tricky.” Zoom modification won’t always work as expected because of the internal design of ProShow. For example, adding a zoom of 75% to a zoom setting of 200% appears as expected in the modifier dialog and graphs, but will result in a zoom of 150% instead of the expected 275%. In cases like this, it’s because 150% is 75% of 200%.

Although this unexpected result can happen, it usually doesn’t happen, and most modifications of zoom will work as expected. The reasons for this limitation are very complex and beyond the scope of this documentation. If you encounter this kind of unexpected result, be aware that this is a hard limitation and is not going to be changed in the near future.

Often, a different approach to accomplishing the same modification may be the only way to work around this issue. This limitation is only present in the zoom setting and shouldn’t affect the modification of any other settings.

Start experimenting with modifiers and see what else you can come up with. Remember that if you have an idea for an effect that seems difficult because it would take entirely too many keyframes, start looking into modifiers.
Making Discs for Television and PC

Creating a disc is by far the most popular output choice in ProShow. Discs make it easy to share your shows, and they are a very flexible format that allows your audience to watch on both televisions and computers. The most common method right now is still DVD, but that’s changing as more and more people share video online and as newer televisions become more internet ready. Blu-ray is another popular way to get your shows onto your TV. Blu-ray offers superior, HD quality that you can’t get on a DVD, but not all folks have the ability to play them. And, of course, for those who long for early 90's tech, there’s always the Video CD.

These three disc formats, **DVD**, **Blu-ray**, and **Video CD**, have many traits in common. They’re mostly used to play your shows on TVs, they’re rendered and burned on to a disc, and you can almost always play them no matter where you go. In this chapter you will learn how to make each of the three disc types, and what the options for each do for you.

**DVD**

The **DVD**, or Digital Versatile Disc, is currently the most common way to play your show on a TV. Most ProShow users choose this for their show output. It’s a great choice for a few reasons:

- Almost everyone has a DVD player
- It looks decent on TV and PC
- It’s easily portable
- It’s cheap to make

The only real downside for DVD is the limitations on quality. DVD was established long before HD video was available, meaning that in today’s
world of HD televisions, DVD is no longer capable of delivering the quality you expect from your TV.

To put the quality of DVD in perspective, it has about the same resolution as a 0.3 megapixel camera.

**Blu-ray**

**Blu-ray** is a high definition disc format designed to eventually replace DVD. This format is the standard for delivering HD video on disc. Blu-ray is most common for films, but as Blu-ray burners and discs become cheaper, more and more people are creating HD content of their own. There are a few major reasons to choose Blu-ray:

- High resolution, better looking shows
- Designed to work on HDTVs. No stretching, zooming or distortion of video signal.
- The best way to see all the details in high megapixel images

The adoption rate for Blu-ray is actually moving faster than that of DVD. While most people haven’t yet made the switch to Blu-ray, it is becoming increasingly common.

Blu-ray is the highest quality you can get on disc. At the best quality setting (1080p HD), it is roughly equivalent to a 2 megapixel digital camera image.

**Video CD**

The **Video CD** was a precursor format to the DVD. Video CD was frequently used by digital video enthusiasts before DVD burners became common, because it uses the same discs used for music CDs.

The Video CD format suffers from severe limitations in quality and storage space, making it unsuitable for most purposes. Today, we recommend against using Video CD unless you have a specific need to use it. ProShow was one of the few authoring tools for Video CD slide shows prior to the rise of DVD, and Video CD support remains in the current release as a legacy format for those who need it.
Creating Disc Output

When you're ready to create any output, change over to the Publish Workspace in ProShow. This workspace is designed to put all of your output options and show details all in one place. From here, it's just a matter of picking which output format is best for you.

To Create DVD or Blu-ray Disc

1. Complete and save your show.

2. Toggle to the Publish Workspace.

3. In the Publishing Formats pane on the right hand side, select your disc option from the list. Notice that the Size Meter just above the Slide List will update to show you how large your show will be. Use the size meter to make sure all of your data fill fit onto the disc.

4. Either double-click or press the Create button.

5. Once you have configured your disc options, click Create in the bottom-right of the create disc window.

OR
1. In the Publish Workspace, select your disc option from the icons in the Toolbar. DVD and Blu-ray each have their own icon. If you want to make a VCD, click the All Formats icon to access the other publishing options.

2. Once you have configured your disc, click Create in the bottom-right of the create disc window.

Making Your Disc

When you have chosen which disc format you want to use, you will see the Create window. You will use the options here to configure how your output will look and behave before you actually burn it to disc.

There are several tabs across the top of the Create window, and each one has a different use:

- **Menu** allows you to customize and create your own menu for the disc.

- **Shows** gives you the ability to add multiple shows to a disc, change the thumbnails for your shows, and include an intro show that will play before the menu.

- **Options** is where you configure the actual quality and settings for your rendered show.

- **Burning** is where you can adjust or configure the options for how your show is going to be burned to disc.

- **Executable** gives you the ability to include a PC executable file on your disc, which makes it easier for some PCs to view the show.

- **Branding** has tools that let you create a fully customized PC executable, if you include it on the disc.
We’re going to go through the normal process you’re likely to follow while you create a disc, and once we’ve covered that, we’ll go into more detail on what some of the advanced features will let you do.

**Getting Started**

You have a finished show, and you’re ready to make your disc. Your first stop is to choose what kind of disc you want to make. Are you making a standard show on DVD, so just about anyone can watch it? Perhaps you’re making a HD show on Blu-ray to really show off your new HDTV. Decide which you want to use, and then you’re ready to output your show.

Once you’ve decided which type of disc you’re going to make, it’s time to configure the settings for the show. This is going to include things like setting up your menu, adding other shows you want to include on the disc, and making the final burn. In most cases, you won’t need to adjust any of the advanced settings while you’re making a disc.

More often than not, you’ll want to look at these common settings before you burn your disc:

- **Menu** to arrange and create the menu that will appear on your disc
- **Shows** to add any other shows to the final disc as well as add an intro show

When you have all of your settings choices made, click on **Create** to start the creation process.

**The Creation Process**

Once you hit **Create**, ProShow will start rendering your show and burning that content to the disc. There are three operations that take place:

**Rendering** is the first step. During rendering, ProShow streams single images of your show together into a video. Video is broken into a series of frames, and the number of frames you need in a video is determined by a term called Frames Per Second (FPS). Different video formats have different
FPS ratings, but the most common is 29.97 for DVD video. This means that there are nearly 30 images, or frames, flashed on the screen every second to create the illusion of motion. If your show is 3 minutes long, you’re going to have quite a few images to render:

\[
3 \text{ minutes} \times 60 \text{ seconds} = 180 \text{ seconds}
\]

\[
180 \text{ seconds} \times 29.97 \text{ FPS} = 5,395 \text{ frames}
\]

Rendering each of these images, one at a time, can take a while. The speed of this is based on the performance of your computer and the complexity of the show. If you’re creating a Blu-ray, the process can take even longer, as HD video takes longer to prepare. Once you’ve started the rendering, just let ProShow work. It can get the job done whether you’re watching or not.

**Collecting** takes place once the render is finished. All disc formats have a set file structure that has to be used in order for the disc to work. The collecting process is when ProShow takes the newly rendered video file and converts it into the file structure needed for the disc. This often doesn’t take long and is done silently between the rendering and burning process.

**Burning** is the final, and typically the most straight-forward, process. When the rendered and collected show data is ready to go, ProShow accesses your disc burner and writes that data to the disc.\(^\text{10}\)

**What Goes on the Disc**

Your finished disc will have a few items that show up on it:

- Your completed menu, or menus, if you opted to include one
- One or more slideshows that you added using the **Shows** tab
- Any extra content you chose to add to the disc

That’s all a finished disc needs to work. With that data on it, you can drop it into the appropriate player and start watching it immediately. Remember that making a disc is a very quick process: choose your disc type, add a menu, pick the shows you want to add to it, and click on the create button.

\(^\text{10}\) If you have any trouble burning to disc, see Chapter 29.
Making a Menu

When creating disc output, it’s always a good idea to make a menu for your show. Unless you’re using an intro show, the menu is going to be the first thing that someone sees when they watch your show.

If your menu is polished, looks good, and matches the show you’ve made, you’re going to create a great first impression before your show even starts. Put some thought and effort into your menu to make it be a part of your show, rather than a quick addition.

The menu you create works just like the menus you find on DVD and Blu-ray movies. You can use the remote to select what you want to do in the menu. This can be playing shows, moving on to other pages, and more.

The Menu window contains an entire series of options to customize your own menu system that will act as the front page for the disc.

The options for selecting and creating a menu are covered in detail in Chapter 23.
Choosing What Goes on your Disc

You’ve already read that a disc can hold quite a bit more than a show. It will also contain your menu, any additional shows you want to add, an intro show plus any other content that you choose to include on the disc. That additional content can be the original files you used to make the show, or any other folder that you simply want to add to the disc.

Adding Additional Shows

The Shows tab is where you can choose which shows will be included on your disc, what thumbnails those shows will use, and whether you want to use an intro show or not.

Included Shows is a list of all shows you have added to the disc. By default, you’re probably only going to have one show here. This is designed to let you add more than one show to a disc, which will play in order. The menu you configure on the Menu tab allows you to choose specific shows to play, just in case you don’t want to watch them all.
To Add a Show to a Disc

1. Click on the Shows tab in the Create window for the disc option you have selected.

2. Click on the Add (+) icon found in the Included Shows area.

3. Browse your system for the show file you want to add and click Open.

Keep in mind that when add more shows to a disc, ProShow will automatically create a new project that contains all of your shows. For more information about Projects, see Chapter 25.

The show will appear in the list just beneath the show that is already there. Also note that each show has a number listed on the right side of the list. This number is both the order of the shows, and a chapter.

You can add as many shows as will fit on the disc for most formats. DVD, however, has a maximum limit of 99 shows. Since there’s an intro show and other items there, this is more accurately about 95. Keep an eye on the Size Meter at the bottom of the window. This will increase as you add shows. You know you’re almost out of room when the green bar begins to reach the end of the meter. Keep an eye on this to make sure you don’t overload your disc.

When you use the chapter select feature on a DVD player or Blu-ray player, you will be able to jump between shows. If you want to change the order of your shows here, you can click on the up or down arrow icons to move them. If you want to delete a show from the disc at any time, you can click on the Remove (-) icon.

Note: when you’re starting a menu that has multiple shows, you can choose “Play All” from the menu, if enabled, to watch all of the shows in order.
The Intro Show

**Include Intro Show** is where you can choose your own intro show to add to the disc. An intro show is a quick show that plays before either your show, or your menu, begin. This is similar to the previews or production studio logos that appear on movies that you rent or buy on disc.

You can toggle the intro show on and off by clicking the toggle checkbox in the left corner. When the intro show is enabled, it will use the ProShow intro by default.

Not everyone wants to see the ProShow intro show, so feel free to disable this if you don’t want to see it.

**To Turn Off an Intro Show**

1. Click on the *Shows* tab in the *Create* window for the disc option you have selected.
2. Uncheck the option for *Include Intro Show*.

In some instances, you may want to do the same thing to your audience that studios do to you -force your audience to watch a commercial before the feature begins. If you're in the business of selling slideshows, this is a great way to brand your work and do a little extra advertising.

If you want to use your own intro, do the following:
To Use a Custom Intro Show

1. Click on the Shows tab in the Create window for the disc option you have selected.

2. Check the option for Include Intro Show.

3. Click on Select Show.

4. Browse your system for the show file you want to use.

5. Click on Open.

The show you have selected will be added to the disc, and will play as soon as the disc is started. This will happen before either your menu, or your show if you have no menu, begins to play.

As a general rule, keep your intro shows short. These are best used to get some brand recognition for your show. If you’re running a studio or photography business, put your logo up there. It’ll get more visibility for the work you create.

Try not to go too far beyond 3 to 5 seconds for the intro show, but don’t go below 2.5 seconds. Some DVD players have been found to have problems when they try to play exceptionally short video clips.

Including an Executable

An executable is a PC-specific form of show that you can opt to include on the disc. This is primarily for watching the show on a PC that might not have the software installed to watch a DVD, Blu-ray, or video CD.

Executables are entire shows contained in one EXE file. They can be any resolution you want to use, are small in file size compared to video, and very versatile. It’s often a good idea to include an executable on any disc you create.
Creating an executable is the same whether you are making one for a DVD, Blu-ray, or video CD.

**Executable**

This toggle option found at the top of the window enables the use of an executable on the disc. When added to a disc, the executable version of the show will automatically start when the disc is inserted into a PC.

The rest of the options used for creating an executable and configuring how it works can be found in Chapter 22, Creating Output for the PC.

In addition to creating an executable version of your show, you can also brand that executable show with your own startup screen, icon and about show. You can find more information about branding in Chapter 22.

**Advanced Options**

Most of the options you find in this section will often never need you to interact with them. These control things like format and quality levels of your video or audio, as well as how a disc is burned. In case you need them, however, you will find an explanation of each of the advanced options sections and what the various settings there do.

**The Options Tab**

The **Options** tab is where you’re going to find all of the settings that relate directly to the format of your show. Keep in mind that all disc-based shows are rendered into video before they’re burned to disc. The **Options** tab is where you can configure how that video is going to be created.

You’re going to see some differences between the different disc formats here, so we’ll handle each one of them.
**DVD Options**

The DVD options are all based around creating and configuring DVD video. You’re going to find settings for the TV standard you use in your country, what kind of audio format you want to use, and more.

**Note:** If you don’t find that you have a specific reason to change any of these values, they can all safely be left at their default values. Unless you know that you need to change one of these, don’t change it.

**DVD Type** is the quality level and Mbps, or megabits per second, rating of the video you create. This impacts the visual quality of the video you will see.

Higher quality DVDs use more data for each moment in your video. This means less video can be stored on the disc. Choosing a DVD type is all about selecting the right balance between quality and the amount of video you need to place on a disc.

The biggest factor here is a piece of technical information that you’ll probably never need to worry about, the Mbps play rate. This is the amount of data that must be streamed from the disc to the DVD player. Not all players can handle the full speed, mostly cheaper players that cut corners, so you need to choose which one you want to use.

You have a series of options in this dropdown list, when you choose a type, you’ll see the more practical details about your selection in the DVD Type Information area.

- **DVD HQ** (High Quality – Maximum) is the highest quality video you can view on a DVD. It uses the full 9.716 Mbps standard for the format. This selection may not work on DVD players that can’t play the full DVD standard.
19. Creating Output for Television

- **DVD HQ** (High Quality – Safe) is the default that ProShow uses, and plays at 8 Mbps. This won’t look dramatically different from the Maximum option, but is likely to work on all DVD players.

- **DVD SP** (Standard Play) is the low end for the format. This plays at 5.073 Mbps, and should work on all players. A benefit of the lower quality is that you can get longer shows on the disc.

- **DVD LP** (Long Play) is another lower quality option that gives you much more time for a show. You can get up to 3 hours of a show on the disc.

- **DVD EP** (Extended Play) continues the lower quality for longer show trend. This format will let you get 4 hours of show on one disc.

- **DVD SLP** (Super Long Play) sacrifices video quality to allow you to put shows of up to 6 hours on the disc.

- **DVD SEP** (Super Extended Play) is the lowest quality video you can make, but gives you a massive 8 hours of show time to include on the disc.

Each of these types you choose has some give and take. The high quality selections can only fit about an hour on the disc, but look great. As you decrease in quality, you can put more video on the disc. Remember that unless you need to choose another option, it’s best to use the **DVD HQ (High Quality – Safe)** option to ensure the disc looks great and works on most all DVD players.

**TV System** sets the resolution of your DVD video. This resolution is different based on where you are in the world. In the US, we use the **NTSC** standard, which is the default.

If you plan to send your DVD to a viewer elsewhere in the world, you should change this value to **PAL**. A quick search online for ‘television standards by country’ can point you towards several great sources for determining the video standard for any particular country.

**Audio Type** determines how the audio stream is added into the video that ProShow creates. The DVD format supports different types of audio. ProShow lets you choose between two formats because not all players will
handle both formats properly. The default is MP2, and should work just fine in most all cases. If you ever create a disc that doesn’t seem to have audio on one DVD player or another, you can try creating a disc with the PCM option found here. Otherwise, you shouldn’t need to change it.

The audio format determines what kind of audio encoding will be used for the audio stream that accompanies the video. PCM is a larger size and an older format, so it should only be used if MP2 doesn’t work.

**DVD Output Options** gives you a couple of options to optimize the video that ProShow creates. The first of these is **Anti-Flicker**.

If you view a video on a TV without anti-flicker enabled, you may notice that some edges of your images appear to shimmer. DVD requires a video encoding scheme called "interlacing", which uses alternating sets of odd and even horizontal lines. When there is a lot of contrast difference between pixels vertically this shimmering effect can be seen. It’s also called "combing" because it can look like the edge of a comb when interlaced displays show things moving horizontally. Enabling **Anti-Flicker** will fix this problem, but can result in a slight softening of your images. You can choose which you prefer based on the results.
While some professionals may feel strongly about even the slightest amount of softening on their images, in practice, the viewer will usually prefer the softening to the otherwise very annoying flickering.

**Desaturation** removes some of the saturation from your colors in the images. On most all picture tube TVs the color was oversaturated because of the deficiencies in the picture tube. Without using **Desaturation**, your images might appear to be too vivid, making color distinctions difficult. Colors such as bright reds and greens can easily become ‘blown out’ without some amount of **Desaturation** applied.

Even if you’re using a modern LCD, LED or plasma TV you may have this problem, so you probably want to keep **Desaturation** enabled.

When applying Desaturation, you can specify how much desaturation you want. The amount is specified as a percentage. A higher percentage will retain more of the original color, while a lower percentage will remove more color. The default amount of desaturation is 80%. This default was selected because it gives the best balance of color on most televisions. You may adjust this as needed, but keep in mind that other values may look great on some TVs, and not-so-great on others.

**Video Clip Quality** controls the general rendering quality of any video files that you have included in your show. This is similar to what the DVD Type option does for your DVD video, but not as critical to the working of your disc.

Leaving this option on Normal Quality will yield both high compatibility and good visual results.
Blu-ray Options

Creating a Blu-ray show has a few different options because the video format and HD possibilities change the game a bit. Let’s cover what options you have available when creating a show on Blu-ray.

**Blu-ray Type** is similar to DVD Type, in that you choose what kind of Blu-ray video you want to render for the disc. Unlike DVD, however, you don’t have to worry about compatibility. You’re mostly selecting what resolution you want to use. Your options are:

- **Blu-ray 1920x1080 Progressive** (1080p) is the highest current standard for HD content. 1080p looks great, showing off the best your high megapixel images can offer. When you think of ‘HD’ you’re usually thinking of this.

- **Blu-ray 1920x1080 Interlaced** (1080i) is similar to 1080p, but the “interlaced” description means that not every line of video is rendered. Interlaced video leaves a gap every other line to reduce the amount of video data that is sent. This will look slightly inferior to 1080p.

- **Blu-ray 1280x720 Progressive** (720p) is another HD standard, which still looks great and is progressively rendered, meaning that all of the lines are created in full.

- **Blu-ray 720x576 Interlaced** (576i) is a DVD-like resolution that is not considered HD at all. This resolution is the PAL equivalent of DVD.

- **Blu-ray 720x480 Interlaced** (480i) is the same resolution as DVD, but at double the framerate. This results in a DVD-like video, but that has much smoother playback.

**Video Settings** is where can adjust the Framerate options for certain Blu-ray Types, as well as the playback Quality options. By default, these settings are set to match the typical quality you would get when purchasing a Blu-ray movie from the store (Framerate: 24 fps, High Quality (25mbps)).
99% of the time you will not need to change these settings. One instance where you made to do is if you’re seeing jumping or skipping during playback on a Blu-ray player. In those cases, try adjusting the Quality to a lower setting. Keep in mind, that regardless of the setting, your show will still have HD visual quality.

**Blu-ray Output Options** is where you have similar options to DVD creation. You can enable or disable anti-flicker or desaturation. Additionally, you can enable the Loop option, which will cause your show to loop endlessly if you don’t have a menu on the disc. The Video Clip Quality Options are again just like those found for DVD. You can control the overall quality of any videos you included in your show. As is the case with DVD, leaving this at default will give you the best results.

**Use Custom Disc Thumbnail** allows you to configure the thumbnail that appears when you insert the disc into your Blu-ray player. You can enter the name for your disc, and browse your system for an image you want to use as the thumbnail. Note that these custom thumbnails will only appear on Blu-ray players that can do more than just play discs. A PlayStation® 3 is a good example of one such device.
Video CD Options

The options for a Video CD can be slightly arcane thanks to the older nature of the format. It still follows the general standard for creating video on a disc, however.

**Video CD Type** allows you to determine what kind of Video CD you are going to make. You have a selection of options:

- **VCD** creates your standard Video CD, with low resolution video.
- **CVD** is a Video CD standard used in China. This may not work on all CD or DVD players.
- **SVCD** is the Super Video CD, common in America. This will give you slightly higher video resolution.
- **XVCD** is a non-standard Video CD format that may work on PCs, but won’t work on most DVD players.
- **XSVCD** is a Super Video CD version of the non-standard above, which has the same drawbacks.

**TV System** for a video CD is the same as you will find on the other disc formats. NTSC is used in America, PAL in select other countries.

**Audio Type** is just like the audio format option found when creating DVDs. You should not need to change this value unless you have an audio problem with your video CD.

**Video CD Output Options** gives you access to the same anti-flicker and desaturation, and Video Clip Quality options found in both DVD and Blu-ray discs.

In addition to those options, you can also toggle whether your video CD menu will be still, or will use video thumbnails.

**Video / Still Shows** is a set of options unique to the video CD. This is where you determine whether you are using shows that are using video, or are just a sequence of still images.
Unless you have a specific need to change this to stills, it’s always best to leave both the Show Types and Default Show options set to Video Shows.

When set to stills, all motion and effects in your show are removed. Your video CD will play back as a series of completely still images.

**Color Profiles**

For all three disc types, if you use color profiles to correct the colors in your images, you can include these with your shows to help insure that the color balance is correct. You can find more information about adding color profiles to your show in Chapter 24, Color Profiles.
Burning Options

The **Burning** tab is where you configure all of the options for how your show is going to be burned on to the disc you have chosen. These options let you choose which burner you’re going to use, what speed you’re going to use for the burn, and more.

**DVD Burning**

DVD burning is heavily focused on compatibility to help you make a DVD that is going to work without fuss.

**DVD Writer** lets you choose which DVD burner you are going to use to create the disc. Most PCs only have one burner, which will be listed here along with the drive letter. If you have more than one burner, you will see those other options appear in the dropdown list.

You can also select the **ISO Image File** option from this list. An ISO is like a snapshot of a finished DVD. It has all of the information contained in a single .ISO file that is stored on your system. This file can be opened with almost any DVD burning software on the market and burned quickly to disc. An ISO file is a great alternative if you intend to make lots of copies of your disc.

**Speed** is where you choose the burning speed and type of disc you are going to create. There are a few things to note about this.

Burning speed only lists “**Max**” until you insert a blank DVD in the drive. Once a disc has been inserted, ProShow can tell what burning speed options are available.\(^\text{11}\)

**Disc Type** allows you to choose what kind of disc you’re going to make. If you’re burning to a CD, you can choose the “**MiniDVD**” option, which creates DVD video on older CD media. Keep in mind that a “**MiniDVD**” may not work on all DVD players or PCs.

\(^\text{11}\) To ensure the highest disc quality possible, it’s always a good idea to burn on the lowest speed setting.
**DVD Disc Label** is the name that will appear for the disc when inserted into a PC. This name can’t have uncommon characters, spaces, or punctuation.

**Multiple Copies** does just what it appears to. Type in the number of copies of the disc you want to make. Once the first disc has been created, ProShow will prompt you to insert another blank disc to create your extra copies. This will continue until the requested number of copies has been made.

**Include Original Photos** is a simple toggle checkbox that allows you to tell ProShow to burn all of the images that you used to make the show on to the disc. This is a great way to provide someone with all the photos that went into the show.

These files will appear in the root of the disc. If you include multiple shows on the disc the photos will be placed into a separate folder for each show. These folders will appear as 'Show1', 'Show2', etc.

**Include Additional Content** gives you the option to add another folder to your disc. This can be any folder you want. This feature is great if you want to include a folder that contains a portable version of your show designed for devices, promotional information about your studio, brochures, or any other files about you and your show.
All you need to do is check the box click on **Browse** to choose the folder or file you want to include.

**DVD+R/RW Compatibility** is where you enable a feature called **Bitsetting**. **Bitsetting** is a feature that tricks DVD players into thinking that you are using a stamped disc, like those manufactured for movies, rather than a burned disc. This can help ensure that your disc will work in most all players.

It’s important to know that **Bitsetting** only works if you’re using a DVD+R or DVD+RW disc (*not* DVD-R or DVD-RW discs). If you’re using the correct disc and your DVD burner supports the use of the feature, ProShow will automatically use it for you. There is never any need to manually change the setting.

In the **Troubleshooting** pane, you'll find information and general troubleshooting steps to take if you have any difficulty creating a disc.
At the bottom of the pane, you'll also find two options that are best used when speaking to Photodex Support. Because these options are intended to fix problems, rather than configure the disc itself, they are only used when burning isn’t working.\footnote{See Chapter 29 for help with burning failures and information about troubleshooting options.}

**Blu-ray Burning**

Blu-ray burning is a very straight-forward process, with fewer options than are found for DVD burning.

**Blu-ray Writer** is the dropdown list that allows you to select your Blu-ray burner. If you have multiple Blu-ray burners installed on your system, they will all appear in this list, along with their drive letters.

You should also remember that ProShow does not discriminate between DVD and Blu-ray burners. Just because you see a drive appear in the list does not mean that you have a Blu-ray burner installed. Check your PC documentation to make that determination.

Just like DVD creation, you can also make an ISO image file of your Blu-ray show. This image file can be used to burn a Blu-ray show later, or for multiple copies.

**Speed** is where you choose the burning speed for your Blu-ray show. Unlike DVD, you can comfortably use the max burning speed for your disc and drive.

**Disc Label** is the name of the disc that will appear when the disc is inserted into a PC. You can enter whatever name you want, but you cannot use uncommon characters, spaces, or punctuation.

**Multiple Copies** gives you the ability to create additional copies. Type in the number of copies you want, and once the first disc is complete, ProShow will prompt you for another blank disc.
Include Original Files allows you to include the files that were used to make your show, just like you find in DVD burning.

Include Additional Content gives you the ability to add any file or folder you would like to the disc, just as with DVD burning. Enable the option and browse for the content you want to include.

Just as with DVD, the Troubleshooting pane provides information and general troubleshooting steps to take if you have any difficulty creating a disc.

Video CD Burning

Video CD burning is very similar to the Blu-ray burning options, save that you’re burning your show to a standard CD. Otherwise, it’s a very simple process.

Disc Writer allows you to choose which disc burning drive you want to use. Both Blu-ray and DVD burning drives can create regular CDs, so any burner you have installed should work.

In addition to choosing your drive, you can also choose to create a CUE/BIN image file. This is basically an ISO for a CD. It saves the files to your hard drive, and you can burn them to disc later using another burning program.

The remaining options for burning a video CD are identical to those found for both DVD and Blu-ray.
19. Creating Output for Television
20. Creating Video Output

Publishing Your Shows as Videos

ProShow gives you the ability to publish your shows into a variety of video formats. From a video optimized for YouTube, to a mobile version for your smartphone or tablet. You can even publish 1080p HD video files and custom video sizes.

Creating a video of your show offers several advantages over other publishing options:

- High resolution, better looking shows
- No discs to burn, label, package or store.
- Superior compatibility. Playback shows on PC, Mac, portable devices or the web.
- Highly portable. Easy to share online or store on flash drives/phones/tablets.
- Extremely flexible. Customize the resolution to meet your exact needs.

To make creating video as easy as possible, ProShow comes with a large selection of ready-to-go video profiles. Each profile, or preset, is pre-configured to natively match the resolution and specs for your selected output option.

Many of the most common ways you'll want to share videos are included and ready for you to use.

Some of the presets for video publishing include: Facebook, YouTube, Vimeo, iPhone, iPad, Android devices, AVI, MPEG-4, QuickTime, Windows Media Video, Flash, Playstation and Xbox just to name a few.

If your needs aren't met by the preset profiles, you can always create a new video preset that meets your specific needs. It's a quick simple process that is saved from that point forward, letting you easily make output with your custom preset in the future.
When publishing video in ProShow, all of your output options will fall into two categories: Video for Web, Devices and Computers and Custom Video Files.

About 99% of your video publishing needs will be covered by Video for Web, Devices and Computers, so let's start there.

Creating Video for Web, Devices & Computers

Just like the disc options you read about in the previous chapter, you'll find the video publishing options in the Publish Workspace, in both the Toolbar and Publishing Formats pane.

To Access the Create Video Window

1. Finish and save the show you’re working on.
2. Toggle over to the Publish Workspace.
3. In the Publishing Formats pane on the right hand side, select Video for Web, Devices and Computers.
4. Either double-click or press the Create button.

OR

- In the Publish Workspace, click the Video icon in the Toolbar.

Both options will open the Video for Web, Devices and Computers window. From here, chose your desired video output type or device from the Devices, Presets & Services list.
Choosing Devices, Presets & Services

All of the options for creating shows are contained within a single main window. The left side of the window displays a list of video formatting options and device types, such as Game Console, Tablet, Mobile Phone, Video File and Web. These groups can be expanded by clicking on the + icon which appears on the left side of the entry.

The groups expand will expand to show specific devices, or video file types. For example:

- Mobile Phone
  - Apple
    - iPhone 5

As you select an option, you’ll see more details about how the video will be formatted in the information pane.

Once you’ve located the preset you want to use, you’ll see options for the Save Location and Profile toward the bottom of the Create Video window.
The **Save Location** can vary depending on the preset you have selected. In most cases, you'll simply choose a location on your hard drive.

If you're creating output for a device, keep in mind that not all devices allow files to be saved directly to them. If your device does allow direct saving, the option will appear in the **Save Location** dropdown list.

The **Profile** list gives you quality selections based on which preset you’ve chosen. Some presets have more options than others, giving you a range from HD all the way through “normal” quality. Other devices may only have one or two possible profile selections.

When you click on **Create**, ProShow begins rendering a video to the specifications required for your preset selection. Once the video’s done rendering, feel free to share however you see fit. Keep in mind that some devices like iPhones, iPads will require you to copy that file to the device using whatever method is standard for it (iTunes for example).
Creating Custom Presets

ProShow has a substantial list of presets, but there are countless different media devices on the market as well as video file types. If you don't find a preset that works for your show, you can always create your own preset.

Your custom entries can even support multiple profiles to make quick quality selections. For example, you can have a preset called "My Custom Settings" that features profile options for 720p and 1080p video.

To Create a Custom Preset

1. Click on Add (+) icon at the top of the Devices, Presets & Services pane.

2. The Custom Video Preset window will appear. This is where you not only create the entry for the new device, but configure various profiles for it.

3. Start by entering creating a Group for your profile. For example, you may have a group of custom presets for phones, and another group of presets for videos you post online.

4. Next, give your preset a Title.

5. Now you’re going to begin configuring your first profile. The Profile Settings pane is where you name your profile, choose a format and file extension for the video file.
6. Move on now to the **Video Settings** pane to choose specific format requirements for your profile. This includes the compression type, resolution, aspect ratio, framerate and bitrate.

7. Choose the **Audio Settings** which work best for your device or video type.

Click Save to add the new profile to your library of presets. If you’d like to add more profiles to your new custom Group, click the **Add (+)** icon at the top of the **Profiles List**.

In the **Devices, Presets & Services** window, your custom options will always appear in this order: Custom – Group – Title.

Custom will always be the name of the category displayed in the **Devices, Presets & Services** pane.

When creating custom profiles for devices, keep in mind that each device may have specific settings required to make video play back correctly. This information is typically found in the documentation for your device. Have that handy when you’re making a profile so you know which settings to use.
Editing a Custom Preset

You may want to make changes to a custom profile that you’ve added. This could be to create a new profile or update the video settings.

1. Locate the profile that you want to adjust in the Custom category at the bottom of the Devices, Presets & Services list.

2. Select the profile you want to adjust in the list and click on the Edit icon at the top of the pane.

3. The Custom Video Preset window will open again. From here, you can change any of the settings for your custom profiles.

4. Click on Save when you’re done making adjustments to save the changes immediately.

Deleting a Custom Preset

Sometimes you’ll have the need to delete custom profiles you’re no longer using. Remember, once deleted, custom profiles can’t be recovered. You must build the entry from scratch again if you want to re-create it.

1. Select the custom profile you want to remove in your device list.

2. Click on the Remove (-) icon at the top of the Devices, Presets & Services list.

The custom device and all associated profiles will be deleted from your system.

You can also delete profiles using the Custom Video Preset window.
Managing Multiple Profiles

As you’ve seen, each custom preset you add can have multiple profiles available. These profiles are managed with the Profiles list that appears in the Custom Video Preset window.

Every custom preset is going to have one profile by default. You can add more by clicking on the Add (+) icon at the top of the Profiles List.

Selecting that profile will display its settings in the panes on the right. The profile will be updated as you change values. All changes will be saved when you click on the Save button to close the window.

It’s often a good idea to give yourself a couple of profile options. For example, a “Normal Size” option and an “HD” option.

Remember that higher resolution shows will be larger. Make a few options based on resolution and overall quality so you can choose to make a large show or a smaller show based on each show’s publishing needs.
Save to a Mobile Device Using the ProShow Remote App

If you have an iPad, iPhone or iPod, you can use the ProShow Remote App to create, transfer and save a video to a device wirelessly.

1. Finish and save the show you’re working on, then toggle over to the Publish Workspace.

2. In the Publishing Formats pane on the right hand side, select ProShow Remote App.

3. Connect to a device running the app.

4. Select the Video Quality you’d like to use for your show. You can choose from standard web quality, all the way to high quality 1080p.

5. Click the Publish button to begin creating the video.

After it’s created, the video will be sent to your device and will be displayed on the app’s home screen. Simply tap the video to begin playback.

Published videos can be played without the app being connected to ProShow.
To save a video to your device's camera roll, just tap the icon in the video thumbnail.

**Tip #1:** For best results, be sure any devices using the **ProShow Remote App** are connected to a WiFi network. Using a cellular connection is *not* recommended.

**Tip #2:** When creating videos, it's best to disable the lock screen. If the lock screen comes on while your show is being created, it may cause your device to disconnect from ProShow. If this happens, you'll be prompted to reconnect your device, and you may need to restart the video creation process.

For more details about using the **ProShow Remote App**, see chapter 28.
Creating a Custom Video File

When using the Video for Web, Devices and Computers presets, the quality, resolution, TV type, framerate, etc. are already set up for you. All you have to do is make your selection. In the event that you need to control more advanced video settings, use the Custom Video File option.

Using this option, you can tweak every setting to precisely match your video publishing requirements.

To Create a Custom Video File

1. Finish and save the show you’re working on.
2. Toggle over to the Publish Workspace.
3. In the Publishing Formats pane on the right hand side, select Custom Video File.
4. Either double-click or press the Create button.

This will open the Advanced Video Creation window. From here, you can choose from preset formats, or make something completely custom.

Keep in mind, this is an advanced feature. In most cases, you’ll probably never need to use this option.

Understanding Video Files

At the heart of every video file is a codec, which is the compression method that is used to collect all of the video data into a cohesive stream that can be watched.

You can think of a codec almost as a code language. When someone writes in coded shorthand they can create very long messages in very simple characters. When you understand what these characters mean you can read the full message as if it were written to you in natural language.

That’s basically what a codec does. Normal video data, called uncompressed data, is massive. Remember that a video file is basically a
group of images that are played in rapid sequence to give you the illusion of motion. If you don’t compress the video data with a codec, you’re basically looking at a huge stack of uncompressed pictures in one file. Most videos run at around 30 “frames” per second. A “frame”, in this case, is an image. Let’s calculate that for a moment:

$$30 \text{ frames per second} \times 60 \text{ seconds in a minute} = 1,800 \text{ “frames” per minute of video.}$$

If your show is 5 minutes long, you’re looking at 1,800 * 5, which is a whopping 9,000 images just to display that video. Think for a moment about how much space 9,000 images takes on your system. That’s all for one video.

Video data is compressed using a code language called a codec. That means that the information can be shortened to something significantly smaller. The tradeoff for this savings in file size is that you need to have the codec installed to decode the message. If your computer doesn’t know the code language it won’t know how to read the video.

There’s one other wrinkle in the use of video files. Codecs aren’t the only piece of the process for reading a video file. There’s also the container. The container for a video file is the file type. When someone says that they’ve created an AVI file, what they’ve done is created a video file using the AVI container.

Quite a few other video containers can be used. This includes the major video formats that you’re likely familiar with: MPG, MOV, WMV, AVI, and more. Many of these formats, or containers, can use different encoding methods.

The most flexible of these containers is the AVI. AVI files can be created using a massive selection of codecs. They can be created using everything from DivX to Xvid.

Thankfully, most of the containers you can choose use a limited range of codecs that are all supported so long as you can open that file type. Videos of this kind include WMV, MPG, and MOV. So long as you have Windows Media Player, an MPEG decoder (which most PCs do), or QuickTime, you can view those videos.
Video Files and ProShow

We come back around to ProShow after that discussion for one key reason: ProShow will make use of codecs if you adjust the options to do so. ProShow will use its own tools to import video by default. This doesn’t require codecs on your machine. If this isn’t working, however, you can tell ProShow to use the codecs you have installed by adjusting the Preferences. See Chapter 26 for information.

Adjusting the Preferences to use Direct Show changes the way ProShow handles video. This means that if you want to create a MOV you must have the QuickTime codecs installed. The same is true for a WMV. You need Windows Media Player if you want to create a WMV.

So long as you have the codecs for the video that you want to use in a show, or the type of video you want to create, you will be able to do so.

Preset Video Format

When creating a Custom Video File, you’ll notice that ProShow comes with a number of preset Formats to make the creation of most of the common video types very simple. Pick the Type you want to use, choose the Quality level, and you’re ready to create the video.

<table>
<thead>
<tr>
<th>Format</th>
<th>Type</th>
<th>Quality</th>
<th>TV System</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>DVD</td>
<td>High Quality Maximum</td>
<td>NTSC</td>
</tr>
</tbody>
</table>

There are 6 Type presets that you can select, and each one of these has various quality levels available.

- **DVD** creates the standard MPEG2 video, at 720 x 480, that is used when creating a DVD. You can choose basic quality levels such as High Quality Maximum, HQ Safe, and Long Play. These change the quality level of the rendering but leave the resolution and framerate alone.
20. Creating Video Output

- **HD** creates high definition video files in the MPEG2 standard. These are similar to the videos that are created for use with Blu-ray. The **Quality** selection allows you to pick all of the standard HD resolutions from **1080p** all the way down to the non-HD **480p**. For more information on HD resolutions, see **Blu-ray** in Chapter 18.

- **Video CD** creates the same kind of video that is used when you make a video CD. These videos are rendered in MPEG1 format at a resolution of **352 x 240**. The **Quality** options for this setting let you pick what type of VCD video you want. For more information on VCD types, see Chapter 18.

- **AVI** creates uncompressed videos in the AVI format. These are created at a resolution of **720 x 480** and can be either **Interlaced** or **Progressive**. Interlaced videos skip every other line in the video display to save space. Remember that these videos are uncompressed so they can become incredibly large.

- **PC** creates a standard video file using MPEG1 at a resolution of **320 x 240**. If you choose the **High** or **Extra High Quality** options the video will be rendered at **640 x 480** using MPEG2 as the format.

**Note:** all of the video files that are designed to be used with either PAL or NTSC television systems will give you the option to select which you want to use in the **TV System** dropdown list. If that list isn’t available, for example with HD video, it means that type of video doesn’t use a **TV System** standard.

Choosing a **Type** and **Quality** preset is the easiest way to create a **Custom Video File**. These are some of the most common standards that you can find for the creation and playback of video on the PC. If you want to be more specific about what kind of video you create, however, you can choose **Custom** as the **Type**.
Creating a Custom Video File

Selecting Custom as your Type will disable the Quality dropdown list and give you complete control over the Format Settings options.

Let’s cover what each of the Format Settings will let you configure.

Using Format Settings to Create a Custom Video

The first selection you’re going to make when you create a custom video is what Format you want to use. This Format is how ProShow refers to the container that is discussed above. It’s the actual file type that you’re going to create for the video.

Once you select Custom from the dropdown list, the next step is go to the Format Settings pane and choose the exact type of video you want to create.

You have a wide list of format types which includes the following:

- **AVI – Compressed**: an AVI that uses compression so that it isn’t potentially multiple gigabytes in size.

- **AVI – Uncompressed**: the same kind of AVI that is created when you choose the AVI Type option. These files are often very large.

- **Flash Video**: the small videos that are used for Flash players on the web. These videos are often lower in resolution and overall quality than most videos to keep the file size down for streaming.

- **MPEG1**: an older MPEG video compression method that is still quite flexible. MPEG1 can be used with a wide range of resolutions and settings. These are considered very compatible videos.
• **MPEG2**: a more modern update to the MPEG file format which supports a greater range of compression and is used in many modern video compression systems.

• **MPEG4 SP/ASP**: this one version of the most current implementation of MPEG which is designed for both local viewing and streaming video on the web. The SP and ASP notes stand for Simple Profile and Advanced Simple Profile which are components of the MPEG 4 part 2 standards.

• **MPEG4 AVC**: uses the modern H.264 motion compression method which is used in most HD videos today, including Blu-ray. Supports a wide range of resolutions and settings. This is also the most common format in use today for web video.

• **Ogg Theora**: an open source alternative to MPEG4. Ogg Theora is designed to compete with MPEG4 with similar features and options. For most users there will be little difference between the two save that Ogg Theora requires a different set of codecs to view.

• **QuickTime**: the standard video system for Mac computers using Apple’s video technology. MOV files created using this setting should work well on Macs and are widely supported on most PCs, too.

• **Windows Media**: creates a WMV, or Windows Media Video. These videos are well supported in Windows, often playing on a factory installation of Windows with no trouble. Like MPEG and MOV, WMV supports a wide range of compression, resolutions, and dimensions.

You’re ready to select the **Compression** method for your video once you’ve chosen the **Format** you want to use. Each type of **Format** you select has a unique range of **Compression** methods that you can use with it.

There are quite a few options for Compression that exist for each Format type you choose. Thankfully there are many common factors that exist for each of them, so we’ll focus on those common elements.

Let’s start with the **Compression** options for AVI files and move on from there.
Compression Options for AVI

Remember that you have two AVI types you can create. Uncompressed and Compressed. An Uncompressed AVI has no Compression so that feature has no function.

Compressed AVI files, however, can use a very wide range of codecs. When you select AVI – Compressed as your Format you will find a different list of Compression options available to you. This list is entirely based on what codecs you have installed on your PC. For example, if you wanted to encode your AVI with DivX, you must have the DivX encoder installed on your PC. If that is installed it will appear as an option in the Compression dropdown list.

If you’re someone who frequently works with video you’re going to find that AVI – Compressed gives you the most flexibility in what codec you use for the compression. Pick the one that works best for you.

Compression Options for MPEG1 and 2

When you choose any MPEG video type as your Format you will have access to the standard MPEG Video compression method. This uses the MPEG encoder installed on your PC.

Most of the adjustments that you make to MPEG compression are done by clicking on the Settings button to the right of the Compression dropdown list. This window contains the precise adjustments you can use for creating the video.

Settings contains settings for Bitrate, Interlacing, and Group of Pictures (GOPs). The simple explanation is that if you know what these options are you can change them. Most videos of all kinds will work with the default settings used here. They should only be changed by advanced users who are familiar with how these settings impact the video.
The **Audio Settings** pane contains the encoding options that will be used for the audio stream of your video file. The basic rule of thumb is that a higher **Bitrate** and **Frequency** will result in better sounding audio but a larger video. Again, the defaults here should work for most all users.

**Multiplexing** is used during decoding of the MPEG video and is another feature that should not be adjusted unless you know precisely what it does.

Click on **Ok** when you have made the changes you want. Those changes will be applied to the video during rendering.

---

**Compression Options for Flash Video, Ogg Theora, MPEG4, and Windows Media**

When you are creating any of the stream-friendly video formats you will find that the **Compression** options are all the same. You have a series of settings for certain bandwidth connections, starting with 5 megabit and going down to 56k modem.

These **Compression** methods control the overall quality level of the video. The speeds listed are indicating the amount of data that the video must stream to the PC to play correctly. The video will look better when it has more data that it can stream.

If you click on the **Settings** button for each of these entries you will see the data transfer rate in kilobits per second. Higher numbers translate to better looking videos. If you want to specify your own transfer rating for both the video and audio streams you can select Custom as the **Compression** option.
Compression Options for QuickTime Video

QuickTime is a very flexible video format which allows you to use more Compression options than can be easily documented. For example, you can create a QuickTime MOV that uses the same kind of H.264 compression that you find in MPEG4 files.

For more information on the various types of compression and options you have for creating QuickTime videos, please see the documentation for QuickTime.

Resolution and Framerate

Once you have chosen your Format and Compression you have two remaining options to select for your video. The first is the resolution that will be used for the video and the second is the framerate that will be used for playback.

The Resolution you select is entirely up to you. Remember that higher resolution videos will look very good but will be much larger than lower resolution video. If you’re planning to view this video online it’s best to keep the resolution relatively low, typically under 640 x 480. Videos that will be distributed on disc or downloaded can be much larger. Use whatever resolution you feel works best for those, though it’s not recommended that you make your video higher resolution than the images you have used to make the show.

The Framerate is, as discussed previously, the number of images that are displayed in sequence every second to make the video move. Higher framerate makes the video appear to play more smoothly but can dramatically increase the size of the video.

Certain video files also have limitations on how high the framerate can be set. For reference, most TV shows and films use a framerate of 29.97.
20. Creating Video Output

Display Options for Video Files

The delicate part of video file creation is finished. With the **Format Settings** chosen you can move on to the **Display** settings.

The **Aspect Ratio** option you have here is slightly different from the **Aspect Ratio** you have used for the rest of your show. What you’re configuring here is the pixel aspect ratio. The short explanation of this is that pixels will be different shapes and sizes based on the aspect ratio that is selected. This is independent of resolution.

The rule of thumb to follow here is that you want your **Aspect Ratio** to match what you use in your show. If you make a 16:9 show, use 16:9 as the **Aspect Ratio** for the video. The new option here is called **Square Pixels**. **Square Pixels** doesn’t adjust the shape of the pixels to a certain aspect ratio. Instead, it renders the video on a 1:1 basis with the resolution.

As an example, consider this:

The resolution of a normal DVD video is 720 x 480. This is based on the resolution an aspect ratio of 16:9. If you’re going to render a DVD video at a ratio of 4:3, the pixels are adjusted in size so that what is actually a 720 x 480 video doesn’t look distorted when viewed on a 4:3 screen. If you were to use Square Pixels with this video and watch it on a 4:3 screen the image would appear squished and distorted because the Square Pixels keep the video set to the size based solely on resolution – 3:2.
The best time to use **Square Pixels** as your **Aspect Ratio** is when you want your video to match the chosen resolution exactly, regardless of what device you use to display it. The option is most useful if you’re creating a video using a non-standard resolution and intend to display it on a PC, only.

The **Rotation** option simply lets you determine what the default rotation for the video will be. This option is a special function that helps people creating shows for commercial purposes. For example, if you will be using a show as ‘digital signage’ on a flat-panel TV that is turned on its side, you would create the show in the correct orientation, then use this rotation option to ensure that it looks correct when you turn the TV on its end. In most all cases you will leave this as **No Rotation**, otherwise your video could appear upside down or on its side.

**Encoding** is much like the option you find for other output selections. The **Encoding** quality determines how the video will look, by adjusting some details about how the video gets encoded. In most all cases **Normal Quality** will look great.

**Desaturation** and **Anti-Flicker** are the same options found during DVD creation. For more details on these options, see Chapter 19.

**Color Profile** allows you to specify whether you want to use a color profile with the video. For more details on this feature, see Chapter 24.
20. Creating Video Output
21. Creating Output for the Web

Getting Your Shows Online

Sharing shows online is becoming more and more popular every day -and with good reason. When you post your shows online, you make it easier for friends, family or clients to see what you've made. All it takes is an internet connection, and your shows can be viewed from anyplace, at any time. If you're in the business of selling slideshows, it's also a great way to expand your reach and create more exposure for your business.

Thankfully, ProShow features a variety of built in options designed to make publishing shows on the Internet very easy.

When you're ready to publish your show, change over to the **Publish Workspace** in ProShow. This workspace is designed to make accessing all of your output options as easy as possible. From here, it's just a matter of picking your upload destination.

ProShow divides web publishing into two basic categories:

- **Publishing for Social Media.** This includes posting shows on sites like Facebook/YouTube, or using Twitter to tell your friends when you've uploaded a show. This also includes sharing services like SmugMug and Vimeo.

- **Publishing for Web Pages.** This includes options that you would use when integrating shows into your personal web pages.

Keep in mind that no matter which option you choose, you'll be uploading fairly large video files to the internet. This can take time, and you'll definitely want to have a solid internet connection.

Let's start with shows made for social media and sharing sites as these are the options that you'll want to use about 99% of the time.
Sharing Shows on Facebook

As you undoubtedly know, Facebook has become the standard for keeping up with friends, family, business and even customers online. Facebook has close to a billion users who can interact with one another via comments, games, links, and status updates. In addition to this, Facebook users can share video with one another.

That’s where ProShow comes into play. If you’re a Facebook user, you’re not going to find an easier way to share your shows with everyone you know.

To Upload a Show to Facebook

1. Finish and save the show you are working on and toggle to the Publish Workspace

2. In the Publishing Formats pane on the right hand side, select Facebook from the list and either double-click or press the Create button.

3. Enter the details about your show.

4. Click on Upload to Facebook.

OR

1. In the Publish Workspace, click the Facebook icon in the Toolbar.
When you attempt to upload a show to Facebook for the first time you will be taken, via your web browser, to a Facebook Connect page. This page will request that you log in to your Facebook account and allow ProShow to make changes to your Facebook page.

Once you have allowed ProShow to link to your account you can go through the uploading process again.

**Selecting Facebook Video Quality**

Facebook gives you the choice of several video quality options for your show. You can select from **High Definition** or **Standard Definition** in **Best** or **Normal** qualities.

Keep in mind that the higher the quality, the larger your file will be, and the longer it may take to upload to Facebook.

![Facebook Upload](image)

**Entering Facebook Video Information**

Facebook requires that you give your show a **Title** and brief **Description** before you can post it online. Enter that information and click on **Upload to Facebook**.

You also have the ability to save the show to your hard drive if you prefer to upload it to your account using the Facebook web-upload system. Once the upload is complete, you will see options to view the show or announce the show on Twitter.
Announcing Shows on Twitter

ProShow has built-in support for announcing your new shows on Twitter. This option is available any time you upload a show to any social media website.

When an upload is complete, you’ll be presented with a window that contains a button to announce the show on Twitter. Clicking this button will open the Twitter interface, which allows you to tell all your followers about your new show.

Sharing Shows Using YouTube

YouTube is the third most visited site on the internet (following google.com and Facebook), and for many, it’s the go-to destination for media on the web. If you want to get public exposure for your shows, you can’t go wrong with an upload to YouTube.

With YouTube’s addition of HD video support, it’s also become one of best ways to share high-quality, high-definition shows.

There are a few restrictions on shows you upload to YouTube that you should be immediately aware of:

- YouTube only accepts single shows – you can’t add multiple shows
- YouTube does not support the use of menus
- YouTube shows may be limited to less than 15 minutes or 2GB in size – whichever comes first. You can generally increase these limits by verifying your YouTube account.
- You must have a YouTube channel set up before uploading videos.
- YouTube shows must be approved after being uploaded which can take some time
These restrictions don’t diminish the use of YouTube. They simply change how you go about using the service.

To Upload a Show to YouTube

1. Complete and save your show, then switch over to the Publish Workspace.
2. In the Publishing Formats pane on the right hand side, select YouTube from the list and either double-click or press the Create button.
3. Enter the details about your show.
4. Click on Upload to YouTube.

OR

1. In the Publish Workspace, click the YouTube icon in the Toolbar.

You’re going to need a YouTube account to upload your show. These accounts can be created for free on YouTube’s website. YouTube is owned by Google, so if you already have a Google account you can use this to upload your shows.

You’ll begin by entering your Account Information at the top of the screen. This includes your YouTube Username and Password. Next, you’ll need to enter some information about your show.

Information about Your YouTube Video

The Video Information pane is where you will enter a Title and brief Description of the video you are uploading. These fields must be filled out before you can upload.
YouTube Video Options

Once you have entered your video information, select your video quality and YouTube categories. You'll also have the option to tag your video.

Tags are individual keywords that are used to search for your video on YouTube. These can be words that describe what your video is about. Tags and categories can always be changed later on the YouTube website. The Category is just the broad group that your video might fit into. If you’re making something for your family it would go into “Film & Animation”.

YouTube has 3 basic Quality levels: HD, High Quality, and Standard. There are also two options for HD and High Quality – Best and Normal. The best possible quality for YouTube is the High Definition (Best) option. In most cases HD (Best) is the one you will want to select.

You may find that you need to select a lower quality version for a few reasons: slow Internet connection speed, length of show, or show file size. Remember that depending on your account’s size limits, if your show is long, and you select the best quality option, it’s very likely that the show will be too big. Keep your show length in mind when you make your choice.
Next, choose your preferred **Privacy** setting. You can set your shows to be **Public**, **Private** or **Unlisted**.

**Private** videos can only be seen by you and the users you select. These videos will not appear on your channel and will not show up in YouTube search results. Viewers will need to have a YouTube account in order to see the video.

If you choose **Unlisted**, only people who have a direct link to the video will be able to view the show. Unlisted videos do not require users to have a YouTube account, and are also not visible on your channel.

When you're ready to publish your show, click on the **Upload to YouTube** button. This will create the show and upload it for you automatically. After the upload is complete, you’ll have the option to view the show or announce the show on your Twitter account. Keep in mind that shows may not be immediately available on YouTube due to approval and processing times. If you want to save the video to your system or upload it yourself using the YouTube web interface you can click on **Save Video to My Computer**. This will prompt you to save it somewhere on your hard drive.

**Updating YouTube Support**

YouTube is an always-changing web service. This means that the YouTube support in ProShow must be updated from time to time. ProShow will notify you automatically when a YouTube update is available.

You will receive the update automatically when you click on the **Update Available** prompt. The YouTube option will re-open once the update is complete and you are then free to send your show.

**Sharing Shows with SmugMug**

SmugMug is a very popular service used by amateur and pro photographers alike to host and share photos and videos online.

From ProShow, you can directly upload slideshows to your SmugMug gallery with just a few clicks.
To Upload a Show to SmugMug

1. Complete and save your show, then switch over to the Publish Workspace

2. In the Publishing Formats pane, select SmugMug from the list and either double-click or press the Create button.

Before you can begin the upload process, you'll first be asked to login to your SmugMug account. Once you are logged in, close the window and repeat the steps above.

You can also have ProShow keep you logged in for future uploads.

Video Quality with SmugMug

SmugMug allows you to choose from either Standard definition or High Definition in 720p or 1080p. Each gives you the choice of a Normal or Best encoding quality, similar to what you find uploading to Facebook or YouTube. High Definition (Best) is going to look the best but will make the largest video. Keep in mind that the larger your show is, the longer it will take to upload.

Once you have chosen your quality level you need to enter your Video Information.

Video Information for SmugMug

When uploading to SmugMug, you can choose to add your show to an existing album or create a new one. You can also add a caption for your show and set the visibility. Keywords can also be added to help your show be found when during searches. Once these have been entered you can upload the show.
Uploading to SmugMug

Just like with Facebook or YouTube, simply click on **Upload to SmugMug** to create the show and send it to the service. Once the upload is complete, you will see options to view the show or announce the show on Twitter.

If you prefer to upload your show using SmugMug’s web-based upload option, click on **Save Video To My Computer**. It will create the video on your hard drive so that you can upload it later.

Sharing Shows with Vimeo

Vimeo is a video sharing site similar to YouTube that is often the choice for visual artists and creators of short films. Like YouTube, Vimeo allows you to share your shows online with HD quality.

You can't upload a show directly to Vimeo from ProShow, but you can create a show that is optimized to look it’s best in Vimeo.

To Create a Show for Vimeo

1. Complete and save your show, then switch over to the Publish Workspace
2. In the Publishing Formats pane, select Vimeo from the list and either double-click or press the Create button.
3. Enter the details about your show.
4. Click **Upload to Vimeo**

Just like uploading to any of the other services, you must log into your account to upload the show.
Video Quality with Vimeo

Vimeo allow you to choose Standard definition or High Definition in either 720p or 1080p. Each gives you the choice of a Normal or Best encoding quality, similar to what you find uploading to Facebook or YouTube. High Definition (Best) is going to look the best but will make the largest video. This can be taxing to upload if you don’t have a broadband connection to the web.
The ProShow Gallery

The ProShow Gallery offers users a way to share slideshows in their native PX format. In this native format, you are able to view a show online and take advantage of the show controls and interactivity options that are only available in the Executable format.

The ProShow Gallery isn't intended to be replacement for other online sharing services. It's simply another way to share shows online quickly and with ease. For your online video sharing needs, Photodex highly recommend services like YouTube or Vimeo.

To create a show and upload it to the ProShow Gallery, you'll need to create a Photodex.com member account. Anyone can create a free account and upload shows to their personal online Gallery. Once you have an account, you can upload as many shows, of any length that you want to share.

Note: Viewing a show in the ProShow Gallery requires that you and any visitors to your Gallery install the Presenter Plug-in. This plug-in allows your web browser to play slideshows in their native PX format. More details about Presenter can be found a little later in this chapter.

To Publish a Show to the ProShow Gallery

1. Complete and save your show, then switch over to the Publish Workspace

2. In the Publishing Formats pane select ProShow Gallery from the list and either double-click or press the Create button.

The options window that opens up features three tabs that you’re already familiar with: Menu, Shows, and Options. The first two tabs feature the same choices that are found when making DVD, Blu-ray, etc. Let’s focus on the Options tab, which is where you decide how your show will be sent to the ProShow Gallery.
ProShow Gallery Options

The first step is to enter your Account Information for the Photodex website. Enter your Member Name and Password so that the show can be uploaded to your account. If you don’t yet have an account you can click on Sign Up Free to be taken to the website to make a new account.

The Sharing Service dropdown list only one entry – Photodex Web Site. You won’t be changing that one.

Next, make your Album Selection. This is where you’ll upload your show to your personal Gallery. These albums can be configured using the Photodex website. You can also enter a Show Caption which will appear with the show on the site.

The Uploading Options are available to restrict access to your show. If you include mature content or don’t want your show to be seen by others, check either the Mature Content tab or the Privacy tab.

Sharing Shows in your Gallery

Unlike YouTube or Vimeo, shows on the ProShow Gallery are not available to be searched by the public unless someone knows your specific account name. If you want to invite someone to view your show, you can share the link with them or use the Share tools in your Gallery on the Photodex website.

If you mark a show as Private it cannot be viewed by anyone who is not logged into your account, even if you send them a link. Keep that in mind as you decide how you want to upload the show.

Once you have finished choosing your upload options click on Upload. The show will be created and sent to the Photodex website immediately. Once the upload is complete you will be given options to view the show, announce the show on Twitter, and more.
Note: it is important to remember that the Photodex service is completely free and has no restrictions on show length, size, or number. Use it as much as you like.

Note: Before diving into these options, keep in mind that YouTube and Vimeo allow you to embed videos from those sites into your own web pages, blogs etc. Often you'll find that this is the better way to go as it allows you to take advantage of the social aspects of those sites and combine that with the complete creative and functional control of having your own web presence.

Uploading shows to your own web page assumes that you have a basic, but functional, level of understanding when it comes to web development. Knowing how to edit HTML and upload files to your web server are two skills you will need to put shows on your own site.
Publishing to Flash

Flash shows are sort of a hybrid between a normal video and a show shared in your Gallery. These shows are made to be viewed in a web page but are video-based. Unlike the limitations on normal video files, Flash shows support menus and allow you to have multiple shows. While you can use menus with a Flash show, they do not offer any interactivity within the slideshows themselves.

A Flash show is noticeably lower quality than a video shared online or published using the other web page option, ProShow Presenter shows. What Flash shows do have however is high compatibility. Most Internet users have the Flash plug-in already installed for their browser, so watching a show made with Flash is very easy to do.

To Create a Flash Show

1. Complete and save your show, then switch over to the Publish Workspace

2. In the Publishing Formats pane, select Adobe Flash from the list and either double-click or press the Create button.

Configuring the Flash Options

The Menu and Show tabs once again feature the same options you've already learned about when making DVD, Blu-ray, etc.\(^\text{13}\).

The Options tab is where you'll find all of the settings you'll need to configure in order to create your output.

\(^{13}\) For more information about Show Menus, also see Chapter 23.
The Video Options pane contains the Video Format and Video Bitrate that you want to use for the show. You can choose either MPEG4 or FLV. FLV is an older format, supported by Flash 7 and later. MPEG4 is a newer format supported by Flash 9 and later. Adobe (the publisher of Flash) reports that over 99% of all users are using Flash 9 or higher.

Unless you have an extremely specific need, it's highly recommended that you use MPEG4. MPEG4 will provide a better looking show and a better streaming experience for anyone viewing your show.

Once you have chosen your Video Format you can select your Video Bitrate. A higher bitrate, like 5m Broadband, will take longer to load than a video set at a lower speed. Higher bitrates will provide better quality video, but they also require more time to load and playback. In most cases, a medium setting like 768k or 1.5m is a good choice.

The Resolution determines the size of your video. A higher resolution will require a higher bitrate. In most cases, it's recommended to leave this setting as-is unless you need to output to a specific size.

The basic rule here is that a higher Resolution will make your show larger, clearer, and look generally better. A higher Framerate will make the show appear to play more smoothly. Both, however, will dramatically increase the size of the video if increased. This can make the video large enough that visitors with slower connections will have some trouble viewing it.
Finding just the right resolution to use is a matter of personal preference and testing. As a general rule, however, don’t make the resolution of your video larger than the resolution for which you designed your web page.

The **Loop Show** option will cause your show to play continuously if you disable the menus for the show.

The **Video Player Options** allows you to decide if you want to provide playback controls for the viewer. These controls let the viewer play, pause, stop, or adjust the volume of your show.

### Uploading a Flash Show

When you make a **Flash** show, several files are going to be created:

- A video file for each show added.
- A flash file, `<YourShowName>.SWF`
- A web page file. `<YourShowName>.HTML`

These are the files that make your Flash show work on the web.

The SWF file is the container and video player that is used to display your show (the video files). These files work together so they must be in the same place on your web server.

ProShow generates the HTML file for you to make it easier to get your show online. You can upload this page to your website as-is or edit it however you’d like. If you don’t need the HTML page, and are ready to add the show to a page you have already created, feel free to discard it.

When you’re ready to put the **Flash** show on to your web page:

1. Upload the video and SWF files to your web server.
2. Add the code provided by the **View HTML** button to the page you want to use for the show.
3. Save the changes and upload the web page.
4. Refresh the page to view the show.
Web Page Options

If you find that you don’t need the HTML page which is generated, or don’t want to see the show once it’s finished, you can disable these settings.

1. Click on the **Options** tab in the **Create Flash** window.

2. Enable or disable any of the options you want in the **Web Page Options** pane.

*Create HTML* is the option which generates a web page for you automatically. *Open* will cause the show to be viewed as soon as it’s finished. *View HTML* will open the HTML code viewer each time you make a show.

![Web Page Options](image)

Presenter Shows

A **Presenter Show** is a web publishing format based on the Photodex Presenter platform. It’s designed to be added to any web page you might have. Choosing this option allows you to publish a show on your web site using the same PX format that is used when uploading to your ProShow Gallery.

Just as with the ProShow Gallery option, creating a **Presenter Show** allows you to post a show online that uses menus and can also take advantage of the show controls and interactive options.
To Create a Presenter Show

1. Complete and save your show, then switch over to the Publish Workspace.
2. In the Toolbar, click the icon for All Video Formats.
3. In the For the Web options, select ProShow Presenter.

Presenter Shows support the advanced features that are found in most ProShow output formats including Menus, multiple Shows, Options for resolution and appearance, and Color Profiles.

The options for configuring menus can be found in Chapter 22. Web Shows share the same Options as those found in PC-based shows, so you can find those options in the next chapter.

We’ll focus on what you need to do to get your Web Show on to your own website.

Uploading a Presenter Show

You’re going to get two files when you click on Create for a Presenter Show. You’ll get a <YourShowName>.PX file and a <YourShowName>.HTML file. These are the files that make your show work on the web.

ProShow generates the HTML file for you to make it easier to get your show online. If you don’t need the HTML page, and are ready to add the show to a page you have already created, you can discard it.

There is a small snippet of JavaScript that is used to call Presenter on the page and cause the show to play. This snippet can be viewed at any time by clicking on the View HTML button at the bottom of the Create Presenter Show window.
The code looks like this:

<table>
<thead>
<tr>
<th>Line</th>
<th>Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td><code>&lt;script language=&quot;javascript&quot; src=&quot;http://www.photodex.com/presenter.js&quot;&gt;&lt;/script&gt;</code></td>
</tr>
<tr>
<td>2</td>
<td><code>&lt;script&gt;</code></td>
</tr>
<tr>
<td>3</td>
<td>PresenterObject(&quot;ProShow&quot;,&quot;objectname&quot;,&quot;/hosted_shows/my_first_show/myslideshow.px&quot;,640,480,true);</td>
</tr>
<tr>
<td>4</td>
<td><code>&lt;/script&gt;</code></td>
</tr>
</tbody>
</table>

The key elements of this code, by line number, are:

1. **Loads the presenter.js script from Photodex.** This contains the necessary JavaScript code to initialize and prepare the show for playback. This must be pulled from the Photodex server to ensure that it is up to date with the current version of Presenter.

2. **Start a new script block.** The show will actually be played back using a JavaScript function call, so we start a new script block first.

3. **Call the PresenterObject function.** This line actually creates and executes the Presenter plug-in. It has six parameters you can set. All of these are set based on options you choose in the **Presenter Show** output dialog in ProShow, but you can set them manually here in the code.

   a. **“ProShow”** tells Presenter that the show you are playing is a ProShow object. Do not change this.

   b. **“objectname”** is the name of the Presenter object to be created. If you are placing multiple shows on a page, you’ll need to ensure that each show has a unique object name.

   c. **“...myslideshow.px”** is the relative name and path to the slideshow file (*.PX) that was created by the **Web Show** function in ProShow. If your show is in the same folder as this HTML file, you can just use the filename. Otherwise, be sure this is a valid relative path to the PX file.
21. Creating Output for the Web

d. "640" is the width of the show on the web page, in pixels.

e. "480" is the height of the show.

f. "true" turns the playback controls on or off. When the last field is 'true', the user will see playback controls when they move their mouse around the bottom of the show. To disable the controls, set this value to 'false.'

4. Close the script block. The last line of the code simply closes the JavaScript block opened on line 2.

You can edit the code within the Presenter Show HTML widow, and press the Copy button to save it to your clipboard.

The basic process for placing the show on your site is as follows:

1. Upload the PX file to the location you specified in the HTML code on your web server.

2. Add the code snippet to the page where you want to view the show.

3. Save and upload the html page.

4. Refresh the page and you should see the show.
There are a few notes to remember about PX files and their pages.

- PX files work best if they’re in the same folder as the page which calls them.
- PX files cannot be viewed if they are placed behind a secure folder on your web server.
- PX files may require that your web host has added them to the server’s MIME support.

Updating the MIME support is something that you will need to contact your web host to do if they don’t already support it.

**Note:** Keep in mind that any visitors to your site will be required to install the Presenter plug-in to view a Web Show on your site.

**Additional Presenter Show Options**

If you find that you don’t need the HTML page which is generated, or don’t want to see the show once it’s finished, you can disable these settings.

1. Click on the Options tab in the Create Presenter Show window.

2. Enable or disable any of the options you want in the Web Page Options pane.

**Create HTML** is the option which generates a web page for you automatically. **Open** will cause the show to be viewed as soon as it’s finished. **View HTML** will open the HTML code viewer each time you make the show.

**What is Presenter?**

Photodex Presenter is a plug-in that is used to play slide shows in real-time. Rather than rendering a video for viewing, Presenter is able to take collected data about the show and render it as you watch it. It allows you to watch shows created in ProShow in their native format, with the same quality you’d see from a show created on your own computer.
This means you can save enormous amounts of space and bandwidth. Because Presenter uses much less space and bandwidth it is free to use higher resolutions. Most Presenter shows you see on the web are at least 640 x 480, if not larger.

Presenter isn’t just used for web playback. It’s also used to preview a show while you’re making it and to watch an Executable or Autorun CD show. Presenter is used any time you view a show that isn’t in video form.

Presenter is automatically installed for you when you install ProShow. If you share a show using Presenter with someone who does not have ProShow they will receive a prompt to install it when they try to view the show.

The process for installing Presenter is painless. The viewer only needs to allow their browser to install it and the rest is done automatically.

**A Note about Presenter**

The most unique aspect of Presenter is that it renders the show in real-time. What this means is that every moving image and fading transition is being calculated by your PC as it plays.

Video files are rendered in advance which is why they take so long to create. All of those frames must be drawn, put into order, saved, and compressed to make the video file.

Presenter does all of that on the fly. This is why you save so much space and time using it. There can be one drawback to this method, however.

If a PC doesn’t have adequate resources to play the show you may experience dropped frames. This means that certain motions may appear to be slightly choppy or hesitant as the PC ignores certain frames of motion to keep the show playing without bogging down.

You can help alleviate this by avoiding very high resolutions for Presenter shows and making sure that there aren’t multiple system-intensive processes running in the background.
It’s also important to remember that all media playback on the Web uses a plug-in. In many cases that plug-in is Flash, which quite a few users already have installed. That makes it seem as if you can play media without a plug-in from time to time.

It’s important to know that Presenter is a safe and secure way to share your shows on the Web. Photodex is the only place where you can get Presenter and it’s a digitally signed and certified download, meaning it’s coming from a reliable and proven source.

If you do have a recipient of your show who doesn’t want to install the plug-in for one reason or another, remember that it’s the major benefit to having multiple output selections. You can provide them a link to a Flash version of the show.

Finally, consider the benefits of Presenter versus Flash. Presenter is a format designed specifically for slide shows. Flash has all the classic problems of streaming video: long buffer times, low quality for file size, and more. Other kinds of Flash can also have extremely high system requirements to perform well. Use Flash if you must, but remember that Presenter was built from the ground up to make your slide show look great.
21. Creating Output for the Web
22. Creating Output for the PC

Watching Shows on your Computer

One of the best benefits to watching a show on your computer is the sheer quality of it. Unlike TV, computers have been working in high resolution for more than a decade. Monitors and current video cards are some of the best equipment available to view shows and video in the best possible quality.

There’s more benefits available than just the flexible resolutions. Here’s a list of reasons why you might want to create output for your PC:

- The highest possible quality in both resolution and image display
- Incredibly small file sizes for the amount of information packed into a show when using a PC Executable
- Perfect for presentations or meetings
- Flexible customization options to create a show in just the format and size that you need

You can use a quick checklist to determine if PC output is the right choice for you. Do you need a small file that you can easily share electronically without an Internet connection? Do you intend to use the show as part of a presentation with a projector? Do you want to include this show in another show? These are all good reasons to go with PC output.

Options for PC Output

There are three types of shows you can create that fall within the PC output category. Let’s take a look at what they are:

- Executable is the most common show thought of when output for the PC is mentioned. An Executable show is an entire show condensed into one small EXE file. Everything that you need to watch the show is part of the file. It’s completely self-contained
but supports all of the advanced features you expect like Menus and Branding. Executables are the way to go when you want your show to play with absolutely no quality loss due to video encoding.

- **Autorun Disc** is essentially an **Executable** that is burned to disc once it’s made. In all other ways the show that is burned to disc for an **Autorun Disc** is identical to an **Executable**. An **Autorun Disc** is a good choice if you want to give someone a high-quality show on a CD or DVD that will play on a PC. The viewer just puts the disc in their computer, and the show starts automatically.

- **A Video File** gives you the tools to create your own pre-rendered video file in just about any format you can think of. Render your shows to AVI, MPG, WMV, or MOV files in just about any combination of resolutions and encoding types. Video files are a great choice if you intend to incorporate the show into another video production, or if you will be playing the show on a computer that can’t handle the real-time rendering needs of an executable.

In this chapter we’ll be looking at all of your **Executable** and **Autorun Disc** options. For details about creating a **Video File** from your show, please see Chapter 20, Video Output.

**Executables vs. Video Files**

When it comes to creating output for the PC, executables and video files offer two very different choices.

A key difference between the two options is that video files are rendered in advance. That’s why videos take some time to create – your PC is rendering all of the images and compressing them into a video file. Executables are different. These shows render in real-time. That means they’re drawn and moved as you actually watch them.

While both will offer great quality, Executable playback can may be affected by PC performance -You may see different playback results on different computers. Generally speaking, video files will offer the best combination of playback quality and PC compatibility.
Creating an Executable

Getting started with an Executable is much the same as the other output options you can use in ProShow. You’re going to begin by selecting it from the Publishing Formats List. From there you’ll find that it shares many of the same options with almost every other output type.

To Create an Executable

1. Complete and save your show, then switch over to the Publish Workspace

2. In the Publishing Formats pane, select Executable from the list. Notice that the Size Meter above the Slide List will update to show you how large your Executable will be.

3. Either double-click, or press the Create button.

4. Configure your Executable and click on Create at the bottom of the window.

OR

1. In the Publish Workspace Toolbar, click the Executable icon.

In the Create Executable window, you’ll find the same common group of options tabs that you find for almost every other output option in ProShow.

Let’s break these down.

- Menu contains all of the options you’ll use to configure the menus that you use with your show. You can learn more about creating menus in-depth in Chapter 23.
• **Shows** is where you can add additional shows to your Executable, assign an Intro Show, and change show thumbnails. You can find details about working with the **Shows** tab in Chapter 19. The **Shows** tab for Executable and Autorun Disc output works just like the **Shows** tab for TV output, like a DVD.

• **Options** is where you will find the settings you can use to configure and adjust your Executable for settings like resolution, image quality, playback protection and color profiles.

• **Branding** contains settings which can be used to fully customize your show and remove almost all Photodex branding. This is most useful for professional shows that want to maintain a consistent identity.

It’s usually easiest to go through the tabbed options you have from left to right, starting with Menus and ending with Branding. This makes for a natural progression from one section to the next.

**Menus and Multiple Shows**

ProShow supports adding multiple shows to one Executable, and allows you to add a menu that appears when the Executable is started. These features were designed to work exactly like their counterparts found in TV output formats like DVD.

For information on adding or customizing menus, see Chapter 23. For details on adding multiple shows to an executable, see the section on *Choosing What Goes on your Disc* in Chapter 19.

**Adjusting Executable Options**

You’ll find that the **Options** tab for controlling how your show looks are broken into four major panes of options.

• **Playback Startup** covers how the show itself will play. This includes things like what resolution the playback window will use, whether the show will loop, and which monitor it will play on by default.
- **Quality** options are used to determine how your show will look inside the playback window that appears. This is where you set the quality of the images and video that will appear in your shows.

- **On-Screen Controls** enables or disables the on-screen toolbar for pausing, resuming seeking and adjusting the volume of your show as it plays.

- **Protection** is a suite of options that you can enable to limit access to the show. This can include everything from a time limit, to a limited number of views, to a password.

### Playback Startup

This section of your **Options** deals with the window size and playback of the show, rather than the contents of the show.

![Playback Startup](image)

**Window Size** controls the actual dimensions, in pixels, of your show window. This defaults to 800 x 600 which should work on most systems. If you know that the PC you’re going to use has a much higher resolution, feel free to change it. Just remember that you want your window and the show to share the same aspect ratio. If you’re creating a show in 4:3, use a 4:3 resolution such as 800 x 600 or 1024 x 768.

Toggling on **Full Screen** will prompt the show to play in full screen by default.
The option to **Loop Show** does exactly that, going back to the start and playing the show again once it’s over. Remember that you can’t use this option if you have a menu enabled on your show.

Finally, the **Monitor** dropdown list lets you choose which display you want to use for the show. Default means the show will appear on whichever monitor is considered the primary by the PC. ProShow supports the use of up to 10 monitors. The numbers are based on what number Windows assigns to each display.

**Quality**

The options you find here are used to tweak the overall appearance of your show and help ensure that it plays smoothly. These settings have a direct impact on how your show looks and how well it runs.

The **Image Quality** and **Video Quality** sliders control the overall quality level of the rendering of your content during playback. Reducing the Quality may introduce “artifacts” or small inconsistencies in rendering, but will speed up show performance. Increasing the slider will reduce the chance for artifacts but requires more processing power from the system viewing the show.

**Note:** the default values assigned here are considered to be the best blend between overall quality and performance of the show. It’s recommended that you use the defaults unless you have a specific reason to change the values.

**On-Screen Controls**

Just like watching a video on YouTube, Executables feature a control bar that appears at the bottom of the show during playback. This bar lets you skip around in the show, play or pause, change the volume, or go back to the menu.
The **On-Screen Controls** checkbox lets you toggle whether these controls will appear on your show or not. If you’re planning to use the show as a banner or looping element of a presentation, you might not want to give your audience control over the show. Otherwise, it’s a good idea to leave the option enabled.

**Protection**

The Protection pane is where you can find options designed to let you limit access to your show. This can help control who views your show or how many times they get to watch it.

![Protection Pane](image)

Enabling the **Limit By Days** option lets you select a number of days in the life of the Executable. If you set the value to 5, it means that the show can be watched for 5 days, 5 24-hour periods from the time the Executable is first played, before the show cannot be watched.

The **Limit By Runs** option has a similar use except that it counts how many times the show has been run and limits its views to that number. If you set this value to 5, the show can only be watched 5 times before it stops working.

The **Password** option lets you enter a password requirement to watch the show. This can help you limit access to the show to only those who have received the password from you.
The **Info URL** and **Link Text** fields are where you can enter your contact information. Once the Executable expires by date, runs, or if the viewer doesn’t have a password, they will see this information to contact you about how to keep viewing the show.

Now that you know how to configure and adjust your Executable for the best possible results let’s move on to the Branding options.

**Branding**

The options found in the **Branding** tab allow you to create your own custom loading screen and information for the executable. When creating DVD, Blu-ray, or Video CD discs, you can only adjust the branding options if you have enabled an executable on your disc.

**Show Startup Screen**

Checking this option box will show the startup screen. This is the small window that appears while your EXE is loading and prepares to display a show. Depending on the size of your show and the speed of the computer being used, this screen may be visible for only a few moments, or it may be visible for some time.

The startup screen consists of a background image that controls the size and general look of the screen, a progress bar that shows the status as the show loads, and some text to tell the user that the show is being loaded.

Once you have turned on the startup screen, you can click the **Source** button to choose your own image background to use. If the image is too large, ProShow will automatically resize it to fit. Logos or other business branding images work well here. If you are creating an image to use as the startup screen, be sure to leave room for the progress bar.
It is highly recommended that you leave the startup screen turned on. A long delay without a startup screen could cause some viewers of your show to think there is a problem with the Executable or their computer.

Show Progress Bar

This option will enable the loading indicator, showing that the show is currently loading while the startup screen is displayed. Beyond simply enabling the progress bar, you can also change its appearance and position.

Adjusting the text, text color, bar color, and bar type will all update dynamically in the preview window. This will allow you to see how your changes will look in the actual startup screen.

To position the progress bar, click and drag the progress bar in the preview. Click and drag the top or bottom edge of the progress bar area to adjust the size. Changing the size will adjust the thickness of the bar.
**Title Bar**

The title bar is the “chrome” border that appears at the top of every window you use in Windows. You can change the text that is displayed on the title bar of your show using this **Title** field.

**Use Custom Icon**

This option allows you to choose your own custom icon file for the executable. This icon will appear when someone looks at your executable file through Windows.

Custom executable files are .ICO files. See your image editor’s documentation for how you can create .ICO files.

You may select an image file, such as a JPEG, for your icon. To do this, change the type from **Icon Files** to **Image Files** (or **All Files**) in the Windows **File Open** dialog when choosing an icon.

When you select an image other than an .ICO file, ProShow will size the image down to icon size (32 x 32 pixels and smaller) and create a simple icon from the file. While this is a great way to quickly change the icon if you don’t have an icon editor, the quality of this method will usually not match what can be done with an actual .ICO file.

Professionals looking for a truly polished presentation will want to invest the time to create an actual .ICO file.

**Include About Show**

An about show is a very short show that can be added to your executable. When someone right-clicks on your executable in Windows, they can select the “About This Show” option from the menu. You can customize this menu option name.

When this option is chosen, a short, small show appears. The about show is best used to show your studio logo, contact information, or website address.
You can create an about show just as you would any other show. About shows are best when they are small, short, and provide contact information.

**Load and Save Brand Settings**

You don’t have to recreate your brand every time you want to create a new show. Once you have a brand created, click the **Save Brand** button to save it to your hard drive.

When you make another show later, click on the **Load Brand** button, find the brand file you saved, and you can restore your entire brand again. It’s a quick, painless way to save the work you’ve done for later.

**Unique Settings for Executable Output**

The multipurpose nature of the PC means that you have access to features which can’t be used with other types of output. If you’re making a show and Executable or Autorun Disc, you can include all kinds of things like automatic actions performed when slides finish, manual control options to step through the show at your own pace, or interactivity that lets your audience actually participate in the show.

**Action at End of Slide**

This feature is designed to help you make a show that is more interactive than your traditional slide show. You can configure **Actions** by doing the following:

1. Open the **Slide Options** for the slide you want to configure.
2. Click on the **Slide Settings** tab.
3. Locate the **Action at End of Slide** pane.
4. Select an **Action** to perform when the slide ends, as well as a **Destination** if necessary.
There's a large selection of possible actions that can be performed when the slide comes to an end. You can do everything from pause the show to jump to a specific slide in the show.

A common use for **Action at End of Slide** is for pausing. If you're using a slide show to support a presentation you're giving, it might be easier for you to configure certain slides to automatically pause the show once you've reached the end of the slide. This gives you some time to continue speaking before you un-pause the show manually and continue.

Certain actions require a destination, such as the **Open URL** action. You need to enter the full address of the website you want to open in the **Destination** field so that ProShow knows where to go when the action is triggered.

The action would look something like this:

- **Action:** Open URL
- **Destination:** http://www.photodex.com

Other actions share a similar structure. For example, opening a program:

- **Action:** Run Program
- **Destination:** C:\Program Files\Photodex\ProShowProducer\proshow.exe

It's important to note that these features only work when you're creating an Executable or Presenter-based version of the show. DVD, Blu-ray and all other types of video files can't interact in this way. You must be using Presenter-based output to place actions in your show.

You can read more about Presenter and which output types use it in Chapter 21.
Manual Control

Another option for interacting with your show is to enable the **Manual Control** option. This option automatically pauses the slide at the end and waits for your input.

This feature is more specifically designed for giving presentations or creating shows which your user interacts with more than the **Action at End of Slide** option.

You can find the **Manual Control** option in the **Slide Timing** pane under the **Slide Settings** tab for your slide. Simply check the box to enable the option. The slide will now pause once you reach the end. You can continue playing the show by selecting play or use any of the other interactive keys such as skipping slides and more.

You can find a full list of the playback tools you can use with manual control in Chapter 27, Preferences. Also note that when you click **Configure Controls** you are taken to the **Preferences** window where you can see what controls are available and change which keys they are bound to.

There’s also a shortcut to enable **Manual Control** on slides. Each slide thumbnail in the **Slide List** has a small play icon which appears in blue beneath the slide name. If you click on the play icon it turns into a red pause icon. When you see the red pause, you know **Manual Control** is enabled for the slide.
Creating Interactive Shows

You can use a combination of Manual Control, Action at End of Slide, and Caption Interactivity to make a show that your viewer can interact with. It’s just a matter of connecting slides and their actions together.

Here’s a suggestion:

You can create an interactive gallery. Make a slide in your show which displays all of the various images you want them to be able to see. Set this slide to Manual Control so that it pauses when they’ve reached the end of it.

For each image in the gallery, provide a caption which says something like “Learn More Here”. Set an Action for the caption which will use Jump to Slide. Create a new slide that has a close-up of that image and some information about it. Assign the Destination for Jump to Slide to that slide number.

Finally, add an Action at End of Slide which is a Jump to Slide. Have this one jump back to the slide you’re using as the “hub” of the gallery. For each interactive image you want to include, you’ll make another one of the “close up” slides that you just read about. It creates an experience that your viewer can actually interact with rather than just watch.

---

14 Caption Interactivity is detailed in Chapter 10.
Live Shows

The ability to make a Live Show is another feature that is unique Executable output. A Live Show functions the same as a normal show, with one exception...a Live Show can dynamically pull images from a folder on your hard drive as the show plays. Perfect for event photography, or a photo studio. This allows you to change images as the show plays, without the need to stop and rebuild the show.

Live Shows use Live Images

When you make a Live Show, what you're really doing is including Live Images in your show. Live images are assigned on a per layer basis. This means that one layer on your slide can be live while the others are normal pre-selected image or video layers.

Any layer you create on a slide can become a Live Image and live images will work with masks or adjustment layers just like any other image layer will.

To Create a Live Image Layer

1. Create a new slide with any image or video.
2. Double-click on the slide to open the Slide Options window.
3. Select the layer in your slide that you want to become a Live Image, then click the Layer Settings tabs.
4. Check the Live Image box in the Layer Type pane.
Your layer is now live and ready to configure for dynamic images on the fly.

The next step is to control how those **Live Images** are chosen so that ProShow knows exactly which images you want to include in the show.

**Configure Your Live Image Layers**

1. Click on **Configure Folder** next to the **Live Image** checkbox
2. Click **Browse** for both the **Preview** and **Executable** folders and select the folder where the dynamic content will be located.
3. Choose your **Order**, **Rotation**, and **Include** settings in the **Playback Settings** pane.
4. Click **Ok**.

**Understanding Your Live Image Settings**

The **Live Image** settings can be broken down into a few parts to better understand how your chosen settings will impact the way your show plays.

The **Folders to Pull Live Image From** area is where you choose which folder ProShow will use when selecting random images to play during the show. You can specify different folders for both **Preview** and **Executable** playback.

You will see the **Preview** playback images while looking at the show within ProShow. **Executable** playback images will only appear when you create an **Executable** of your show.
**Note:** your Slide List thumbnails during show creation will not immediately update to reflect your live images. Play a preview of your show to see these in action.

Next are your **Playback Settings**. These settings determine how new images added to the Preview and Executable Folders will be added your show.

[Image of Playback Settings]

**Order** allows you to tell ProShow how to select which images it will play during the show.

There are three options to choose from:

- **Play in random order** is the default setting and is the most simple. ProShow will select a random image from the folder every time a live image layer is displayed.

- **Play in order files are added** will cause ProShow to play your images in the order of their creation date, from oldest to newest. This is because your oldest file was created first, while the newest was the last. Once all files have been shown, ProShow will go back to the beginning again.

- **Play newest files first** instructs ProShow to always load new images before anything else. Once all new images have been shown at least once, ProShow will select images at random until a new one has been added to the folder.

**Rotation** tells ProShow to check the EXIF data from your images to determine how to display the image properly. If you're blending normal landscape shots with portrait shots taken from the camera at an angle, the camera will add EXIF data to the picture telling ProShow which direction should be "up". Disable this option if you don't want this behavior.
Include allows you to be a bit more granular in how ProShow selects which images to display. You can specify a time, in seconds, which ProShow will apply to your images.

Once images in your live folders are older than the specified time, ProShow will no longer use those images as part of the live show.

It's important to remember that your live image configuration is applied to the whole show - not per layer. The configuration applies to all live images in your show, no matter how many you have across your slides. This lets you set up the configuration once rather than being forced to make these changes for each live image you include in the show.

Styles and Live Images

Slide Styles work great with Live Images, giving you a great tool to dramatically enhance your live shows without doing a lot of hands-on work with your slides. All you need to do is choose your style, then pick which layers in that slide will be live images. It's often easiest to pick just those images which actually appear in the style.

Be aware that some styles will use duplicates of the same image. If you make all versions into live images, you might get different live images on each of the layers.

Video Clips and Live Images

Because the amount of time it takes to import video can vary so greatly between clips, ProShow won't use video files as part of the Live Image selection as it will cause the Live Show to not play properly. Any videos placed in your live image folders will be ignored during playback of the live show.
Creating an Autorun Disc

As you read in the introduction to this chapter, an Autorun Disc is just an Executable that is burned to a disc and includes one key file – Autorun.inf. This file contains instructions which tell Windows to automatically open and play the show when the disc is inserted.

In all other respects, including the available options, an Autorun Disc is identical to an Executable. You will find one additional options tab, the Burning tab, which shares similar options to what you will find when creating a Video CD. See Chapter 18 for more information on burning to disc.

Creating a Screen Saver

Screen savers are used by Windows to prevent images from being burned into your display. They’re mostly seen when a computer has been idle for a while.

You can create screen saver versions of your show to make that idle computer a bit more interesting. The screen saver version of your show is the show, in its entirety, with or without sound, which begins playing when your system goes idle.

How to Create a Screen Saver

1. Complete and save your show, then switch over to the Publish Workspace

2. In the Publishing Formats pane, select Screen Saver from the list and either double-click or press the Create button.

3. Configure your Screen Saver and click on Create at the bottom of the window.

Your screen saver will be added as a SCR file. This file is recognized in Windows as a screen saver. You can install the screen saver by right-clicking on the file and selecting Install from the menu that appears.
Customizing a Screen Saver

Because a screen saver show is designed to play when your system is idle, you’ll find that it has fewer options than other PC output types. First, there’s no menu system. It does, however, have full support for multiple shows as well as an intro show.

You’ll find complete coverage for Quality options as well as Protection Options. You can find a detailed discussion about both of these earlier in this chapter.

Screen Savers also allow you to select a custom icon, and feature full support for color profiles if you need to use one. You can learn more about color profiles in Chapter 24.

Creating an E-mail Show

ProShow also has the ability to create a show that will be e-mailed to whomever you want to receive the show. In almost all respects the e-mail show is identical to a normal Executable.

You configure settings for your Menu, Shows, Options and Branding. Once you’ve made your selections and click on Create, the executable will be made.

When that’s complete you’ll see the E-mail Show window. This is where you can choose who will receive the e-mail in the To, CC, and BCC fields. You can then type in your From e-mail address, a Subject and a Message.

The show will be attached to the e-mail automatically. Click on Send to begin sending it to all the recipients you chose.

Note: most e-mail servers will not allow EXE attachments these days. This has made it very difficult to send shows via e-mail to most recipients. It’s very likely that most of the shows you send using this method won’t arrive at their destination. If you want to share a show with many people easily, it's always a better options to upload a show to Facebook or YouTube. You can read more about those options in Chapter 21.
Capturing Still Frames

If you’ve ever wanted a jpeg image of a slide you have created, the **Still Frame Capture option** is for you.

This publishing option is designed to allow you to take snapshots of your show that you can save as individual images. How you take the shots, what resolution, and where they’re saved is all configurable by you.

How to Capture Still Frames:

1. In the **Publishing Formats** pane, select **Still Frame Capture** from the list and either double-click or press the **Create** button.

2. Configure your **Capture Frame** settings and click **Ok**.

OR

- In the **Publish Workspace Toolbar**, click the **Capture** icon.

OR

- Right-click on the **Workspace Preview** and choose **Capture Frame** from the menu that appears.

The **Capture Frame** window will appear. This is where you find the options you can use to take still images of your show. Let's take a look at each section:

- The **Frame to Capture** pane allows you to choose how you’re going to capture the images. Choosing **Current** means that whatever you are seeing in the Workspace Preview pane is what will be captured. Clicking on **Time** will take a shot from your show every time that number of seconds passes, starting from the beginning. Choosing **Slide** will take one shot per slide, with the shot being taken at the middle of the slide time.
22. Creating Output for the PC

- **Output Format** is where you choose the file format and resolution for the captured images. You can choose to create either JPG or PNG image, and set any resolution you prefer. Remember that a higher resolution than your slides themselves will make for lower quality images.

- The **Destination** pane is where you choose a save location for your new captured images and name the file. When you’re capturing more than one frame, you can keep your files organized by using the character #. This will add a number to the end of your chosen file name. For example, if you capture 3 frames and set your filename to "ScreenGrab #", the files created will be named "ScreenGrab 1", "ScreenGrab 2" and "ScreenGrab 3".

ProShow will begin making the captures once you click on **Ok**. The captures will be saved to the chosen folder and available immediately. Remember that if you choose to capture only the current frame, you’ll be asked to choose a file name and save location once you click on **Ok**.
Accessing all Publishing Formats

As you've learned in this, and in previous chapters there are several ways to output a show, and several ways to access each publishing option.

When in doubt, keep in mind that all publishing options can be accessed in the Publish Workspace by using:

- The Publishing Formats pane

OR

- The All Formats icon in the Publish Workspace Toolbar

You can also use the Menu Bar and select Publish to access all publishing options.
22. Creating Output for the PC
23. Creating Show Menus

First Impressions

You can create your own full menu system for most of the output selections you make in ProShow. These menus can be simple and effective or fully featured like those you see in movie DVDs.

The process to create them is very similar to making slides and you’ll find much of the same flexibility there. In fact, the process to create a custom menu is so similar to making a slide that all of the tools work in essentially the same way. If you know how to construct and edit a slide you have all the skills you need to create your own menu.

Getting Started

The easiest way to get going with a menu is to make one using any of the pre-made themes that come with ProShow. Let’s start with the configuration of a simple menu and then move on to creating your own custom menu.

There are a variety of different output formats which support menus. These include DVD, Blu-ray, Flash, Executable, Autorun Disc, Presenter Shows and shows uploaded to the ProShow Gallery. When you make a custom menu for any format you choose, you can save that menu, and use it for every other publishing format that supports menus.
Creating a Menu

In its most basic form, a menu consists of the thumbnail(s) for your show, text introducing what your audience is about to watch, and a background behind the thumbnails.

These are the straight-forward options you can configure in the Menus tab. The Theme is going to have the greatest impact on how your menu looks.

Selecting a Theme

You’ll find the Menu Themes List on the right side of the Menu options.

The dropdown list at the top of the selection of themes is where you can filter exactly what themes you see.

You’ll see options like All Themes, Abstract, Floral etc. If you created or installed any other themes, those show up here as well.

The available themes will appear as thumbnails beneath the dropdown list. To select a theme for your menu, just click on the thumbnail. The Preview of your menu will update immediately to reflect the change.
Adjusting the Menu Settings

The **Menu Settings** pane includes two options that have a heavy impact on how your menu looks. The menu **Title** appears at the top of the menu in a large font. Make sure you type in just what you want your overall show to be called.

![Menu Settings](image)

Remember that the **Title** is what appears for the whole menu, not just for an individual show. Make it something that will work for all the shows you include, assuming you have more than one.

The second important option is the **Thumbnails** checkbox. This enables the use of video thumbnails, which are animated thumbnails of your show. This is just like the animated previews that often play when you’re using the chapter selection tool on a film DVD.

If you enable the option to use video thumbnails, you can also choose how long you want the thumbnails to be. By default, they’re 5 seconds long. This causes the thumbnail to display the first 5 seconds of each show that you have as a thumbnail on the menu.

Remember that the time starts from the beginning of the show. If the first part of your show doesn’t have anything that really stands out, you might just want to pass on using video thumbnails.

Also in the **Menu Settings** area you’ll find the option to open or save a **Menu Template**. You’ll use these options to manage the custom menus you create. We’ll cover this in more detail a little later in the chapter.
Selecting a Menu Layout

The way your menu is arranged can have a big impact on how well it’s received. The first thing to consider is the Aspect Ratio of your menu.

It’s usually best to make sure that your menu’s Aspect Ratio matches your show’s ratio. If you’re including a 16:9 show, make sure the menu is set to 16:9.

The Layout refers directly to the number of thumbnails and their arrangement on the page. You can display up to 8 thumbnails as graphics or as a text list on your page. Keep in mind that your thumbnails will come into play when you add more than one show to your menu.

You’ll also find your Customize Menu button here. This is where you go when you’re ready to further customize all of the aspects of how your menu will look. We’ll cover customizing a menu in detail shortly.

Menus and Multiple Shows

You’ve already learned that you can include more than one show in most of ProShow’s output formats. When you include multiple shows, you can opt to include those additional shows as thumbnails on your menu.

That’s where the Layout comes in. You can use the Layout dropdown list to select how many thumbnails you want to display and how you want them to appear on your menu.
The Menu Preview

In addition to being able to see how your menu will look when the show plays, you'll also find some handy tools and information about your menu in the **Menu Preview** area.

At the top of the **Menu Preview**, you'll find a page indicator. This lets you know how many pages your menu uses, and which page you are currently viewing. Use the **Previous/Next** icons to navigate through your menu pages.

If you don't like the way you've set up your menu, use the **Reset** button to undo all customizations you have applied to a menu.

Also in the **Menu Preview**, you'll notice two captions which appear beneath the thumbnail, or thumbnails. Each thumbnail will display the title of the associated show beneath it.

You'll also see the ‘Loop All’ option on the menu. Clicking on this option will play through every show included and loop back to the start once they’re over.

These additional options, as well as the rest of the menu structure, can be changed by creating a custom menu. We’ll get to that in a moment.
Menus as Interactive Pages

Before you begin creating a custom menu, try to think about how menus work on the DVD/Blu-ray movies you purchase. Often you'll have a main page with several options that let you jump to other pages that feature chapters or bonus features.

If you plan to have more than one page in your menus, don’t forget that your viewer will need to be able to navigate back and forth through the pages by selecting images or text within the menu.

Go into a multi-page menu with a plan. Decide which page is going to act as your main menu screen and make sure that every other page gives a link back to it. Be careful about how you link your menu pages together. A dead end page, which means one that you can’t get away from once it’s chosen, is going to frustrate your audience.
Creating a Custom Menu

Custom menus build on what you’ve already created by adding some extra options. Here’s an overview of what you can do with a custom menu:

- Create multiple pages within the menu
- Add layers and captions to menu pages
- Add music to the whole menu, or per page
- Use caption and layer interactivity to allow the menu to be navigated

To Create a Custom Menu

- Click on **Customize Menu** button found in the **Menu Layout** area under the **Menus** tab.

You’ll notice right away that the **Customize Menu** window has similar options when compared to the **Slide Options** window. Use the tabs at the top to navigate through all of the options that are available for arranging the menu.

Let’s go through each of the tabs to see how they can be used to customize your menu:

- **Settings**: From here you’ll set up the basic page options, including: page title, background, simple navigation and your soundtrack.

- **Thumbnails**: The **Thumbnails** tab allows you to control what shows appear on each page of your menu. You can also control the location of the show thumbnail and thumbnail behaviors.

- **Layers**: Working with menu layers is just like working with Layers in **Slide Options**. Here you can add layers to your menu page, configure the location of the layer, perform edits and adjustments to the layer and add any interactivity you want that layer to have.
23. Creating Show Menus

- **Captions**: All of the captions that appear on your menu page can be configured here. In addition to the standard options such as location, font, and color, you can configure interactivity for each caption.

For the most part, making a custom menu is a lot like making a slide. Combine layers, captions, and music together to create a composition that will impress your audience. When approaching a menu page, it’s best to think about it in the same way you think about your slides. You want your menu to be similar to the show you’re making it for, so the same approach you used for the show is the best way to work.

Let’s start by making pages, since those are the canvas you use for the rest of the elements.

**Creating Additional Pages**

When working on a menu in ProShow, you’re always working with a specific page. Your show is probably only going to have one page when you get started.

You can create a new page regardless of the tab you’re in, but it’s usually best to make new pages using the **Settings** tab. That way you can get the basics out of the way first, before customizing.

To the left of the **Menu Preview**, you’ll see the **Pages List**. This is where you add, move, or delete any pages you’re using in your menu.

You can think of the **Pages List** as a bit of a combination of your **Slide List** and a **Layers List**. The pages are like slides because they contain the layers and captions you’re using. At the same time, the pages are like layers because they’re contained within the overall menu.
Since you’re starting with only one new page, go ahead and make another one by clicking on **Add (+) icon** at the top of the list.

The new page will appear next in line with the same background, title, and basic captions, but without thumbnails. You can start customizing the new page right away.

Just like any other list in the program, select the page from the **Pages List** when you want to work with that page. You can also use the **Previous/Next** icons at the bottom of the window to move between pages.

To change the order of your pages, click the up and down arrow icons at the top of the list. To delete a page, click the **Remove (-) icon**.

**Customizing New Pages**

The **Settings** tab has most of the basic options for customizing the pages you create. You’ll see that the **Background Color**, **Background Image**, and **Music Track** are all set here.

Keep in mind that you can set a custom **Background Color**, **Background Image**, or **Music Track** on each page. When making adjustments that will only be applied to single page and not the entire menu, be sure to choose the "For This Page" options.
The best thing about customizing pages is that the tools work just as you’ve learned elsewhere in the program.

As examples, you can adjust the **Scaling** of the **Background Image**, just as you would when making a slide. With your **Music**, if you add a music track to the menu and select **Edit Fades and Timing**, you’ll use the same **Audio Trimmer** you’ve already used when creating the show. **Save from CD** works the same way, too.

### Adding Shows to a Page

You can add show thumbnails to any page you create in your menu. This is all set in the **Thumbnails** tab.

You’ll find two major lists in the Thumbnails options – the **Available Shows** list and the **Show on This Page** list.

The **Available Shows** list is where each show you’ve added to the output appears. You can add or remove shows that can be used in your menu using the **Add (+)** or **Remove (-)** icons at the top of the pane.

You’ll also find tools that allow you to change the **Show Title** or **Show Thumbnail** for any **Available Shows**.

Remember that the thumbnail and title you have in your menu are the same ones you chose for the show when you first created it. They’re one and the same.
The **Show on The Page** list displays those shows that have been added to the current page. If you’re looking at a new page with no thumbnails, this list will be blank.

To add a show to a page, select the show in the **Available Shows** list and click the **Add to This Page** button that appears between the two panes. To remove a show from the page, do the opposite; select the show in the **Show on This Page List**, and click the **Remove from This Page** button.

Once added to a page, in the **Menu Preview**, you'll see the Thumbnail image for the show. Just as you would do in **Slide Options**, you can click and drag the **Show Thumbnail** to move it around and use your mouse wheel to resize it.

You can also adjust the **Show Thumbnail** with more precision using the **Position** and **Zoom** options in the **Thumbnail Position** pane.
You also have tools to change how the thumbnail shows up in the page. The **Thumbnail Highlight** pane lets you configure how the thumbnail is chosen when your audience is interacting with the menu. You can set the color for the selection of the thumbnail, what the color looks like the thumbnail is clicked, and how big the selection box is.

You also have **Thumbnail Effects** that you can enable for people who are watching this menu using PC playback, like an Executable. This includes things like the thumbnail growing in size when selected or causing the outline to pulse. These are just toggled on and off by clicking on the checkbox.

**Adding Layers to a Page**

Keep this in mind: you can customize a menu page just like you would any slide. Add layers (image or video), arrange them within the menu page and adjust their size and appearance.

You can think of the **Layers** tab as being a combination of the **Layer Settings** and **Adjustments** tabs from the **Slide Options** window. You have a little bit of everything here.

**Layers**, just like **Thumbnails**, are added on a per page basis.

On the right side of the preview you'll find a **Layers List**. This list will show you the layers for each of individual the pages in your menu. At the top of the **Layers List** you’ll find tools nearly identical to what you’re already using in your slides. The **Add (+)** button lets you add more layers to the page, the **Remove (-)** icon deletes them. You can change the order of layers using the up and down arrows.

The goal here is to do just what you do when you’re making a slide. Add and adjust layers so that your page looks great. You have almost all of the same freedom here as you do with a normal slide.

Try adding a video layer. You’ll find that it works with the menu. You can even delete the background that’s on the page and add one of your own.
Customizing Layers

You’ll see that you have similar Layer Settings, Adjustments, Editing Tools, Outline and Colorize options that you’re already used to. These tools work the same way here as they do in Slide Options. You can find more information about these features in Chapter 8, where they’re explained in full detail.

Interactive Layers

The major new item you’ll see here is that you can set an Action on Click and a Destination for each layer in the Layer Settings pane.

The actions you can pick are the same as those you use for captions in your menu. You’ll find a description of each of those actions in the next section. Just remember that a layer action is triggered when the layer is selected, rather than a caption.

This is an excellent option to use when making graphics heavy menus. For example, instead of using Menu Captions for navigation, you can create navigation arrows or icons in Photoshop, and add those images as layers on your menu pages. Set the Action on Click for each layer to control how viewers play shows or select different menu pages.
Setting Menu Captions

You’re probably going to want to have some text in your menu. The Captions tab of your Customize Menu options lets you choose just how your text will be set up.

Again, like most of the other options, you’ll see that the Captions tab is very similar to the same options you find when making a slide.

There’s a Captions List in the on the right side of the window. The list lets you create new captions, as well as remove or hide or captions on your menu pages.

The full text of the caption can be customized using the Caption Text pane. The way your caption will look is configured using both the Caption Style and Caption Settings panes.

In these two panes, you’ll set your options for Font, Color, Size, and the rest. In Caption Settings, you also have the option to set a caption so that it will appear on all of the pages in your menu.

Just as with captions on a slide, you can position and resize captions in the Menu Preview window, or by using the options in the panes.
There’s one major difference to focus on when it comes to captions and your menu - the **Caption Interactivity**. The **Action on Click** that you can assign for your captions, and your layers, is quite a bit more restricted than what you’ll find for a show. After all, DVD players can’t typically run programs or open URLs.

---

**Interactivity Makes Menus**

You’ve read that you can make both layers and captions interactive on your pages. That’s a critical part to making a multi-page menu. You’re going to need to give your audience the ability to go back to the starting page or navigate back to chapter select. Trapping your viewer on a page that doesn’t provide a link to go back to the main page would be quite frustrating for them.

Let’s look at each Action you can perform with either a caption or a layer, and whether that Action requires a Destination:

- **Jump to a Menu Page**: lets your viewer click on the layer or caption to go to a specific page in your menu. The pages are numbered from top to bottom. The top most page in your **Pages List** is Page 1, the next one down is Page 2, etc. You’ll need to enter the Destination page number for this to work.
23. Creating Show Menus

- **Play a Show**: causes the caption or layer to start playing a show. You need to choose the show it will play in the Destination field. Remember that you’re limited to choosing the shows you’ve already added to the Shows list.

- **Go to Previous/Next Page**: these two options will go one page back or forward in your menu. That translates to left or right in your Pages list.

- **Loop All Shows**: activating this option will start playing all of the shows that are included from the start, and once they’re over, it’ll start all over again. Doesn’t require a destination.

- **Play All Shows**: similar to Loop All except that it stops once it comes to the end of the last show.

- **Toggle Full Screen**: only relevant on the PC. Tells the show to expand to full screen if it’s running in a window or browser. Since it’s a toggle, activating that action again will move the show back into a window.

- **Activate/Deactivate Full Screen**: rather than toggling full screen on and off, you can choose an action to only make the show appear full screen, or only move the show to a window.

Don’t forget to add interactivity to your menus. When you begin to add multiple pages to your final menu, remember that your audience must have a way to navigate around in them. When you consider how to arrange your interactive elements, just think about how you would want to use the menu. Make your options clear, well defined, and simple.
Saving Custom Menus

Creating a full custom menu system can take time. It's not something that you’re likely to want to do for every single show you create. To save time you can save your custom menu for use over and over again later.

To Save a Custom Menu

1. Finish making your menu system and click on Ok.

2. In the Menu tab of your Create window, click on the disk icon which appears in the Menu Settings pane, next to the label "Menu Template"

3. Choose a name and location to save your custom menu.

4. Click on Save.

Menus are saved as MNU files. These can be shared and distributed if you wish, but the recipient will need the images and other content that you used in the custom menu. They're not included in the MNU file.

To Load a Custom Menu

1. In the Menu Settings pane, next to the label "Menu Template", click the Open button.

2. Browse for the MNU file you want to use for the show.

3. Select the file and click on Open.

The custom menu will be loaded and ready for use with the show. If you’re using a different number of shows or thumbnails you may need to make a few minor tweaks or adjustments so that everything looks correct.
What Gets Saved

Saving your menu file will save all of the major elements of your menu. Your pages, music, captions, and layers will be saved. Your shows, however, won’t be saved. That’s because custom menus are saved so that they can be used with any other kinds of shows in the future.

That means you’ll need to add in and customize where those shows appear on any future uses of the custom menu you’ve created.

Saving Themes and Layouts

You’ve seen how Themes and Layouts are selected when you’re adjusting the standard menu options.

You can use the settings you configure in a custom menu to create your own themes and layouts, which will appear for easy selection in the standard menu options.

The Save Theme and Save Layout button both appear at the bottom of the Customize Menu window, just below the Pages List.

Saving a Menu Theme

Saving a theme saves the layers that aren’t show thumbnails. You can think of it as the basic appearance of the menu background.

When saving a Theme you pick the name for the theme and choose a category for it. If none of the categories fit, you can always type the name of a new one and it will be created for you. Click on Save once you’re done.
Loading a Menu Theme

Themes you’ve created and saved will appear in the Themes List of your standard menu options. The easiest way to find them is to click on the filter dropdown list and choose the category you created or added the theme to.

Saving a Menu Layout

A menu layout is just the position of the thumbnails which are used for your show. Saving a layout that you’re fond of can make it easy to quickly create a new menu.

Saving a Layout is even easier than a Theme. Click on the Save Layout button, give your Layout a name, click Save, and you’re done. That Layout will appear in the Layout dropdown list of your standard menu options.
23. Creating Show Menus
24. Color Profiles

Professional Color Quality

Color profile support gives ProShow the ability to display your show using colors that are calibrated for a specific display. Professional photographers and designers use color profiles to make sure that colors look the same in all situations.

Every monitor and television is different. What looks like pure, rich blue on one screen may look like an odd shade of purple on another. These differences are caused by the settings for the individual screens. Using color profiles can help prevent that.

ProShow supports ICC and ICM color profiles, which are standard color profiles created by a variety of sources. ProShow doesn’t create these profiles, or manage them – it simply has the ability to use them when displaying your show.

If you haven’t yet calibrated your monitor, using ProShow’s color profile support may be of little benefit to you. For the best results, consider using a dedicated monitor calibration tool to create a profile for your screen.

You may also be able to create a profile using software you already have, such as Adobe Photoshop (which usually includes the Adobe Gamma utility). For help with creating and installing color profiles, consult the documentation for your color management software.
How Color Profiles are Used

In ProShow, there are three different color places where color profiles are used:

- **For previews in ProShow.** When enabled, ProShow will use the default color profile on your computer for all previews while you work on your show. This option is set in the Playback section of the Preferences. See Chapter 27 for more information.

- **For video output.** When you use a color profile for video output, ProShow uses that profile to calibrate the colors used in the video. The adjustments to the colors are applied to the video as it is rendered.

- **For PC based playback.** When you choose to apply a color profile to output for PC, such as Executables or Autorun CDs, ProShow will apply the color profile’s color adjustments in real-time as the show plays. This means that your EXE show can display colors calibrated for whatever computer you are running the show on.

Since color profiles are specific to each particular computer, there is no ‘right’ color profile to choose. The right choice is usually to use the default profile, if any – the one that is already being used by your monitor.

If you’re unsure about which color profile settings to apply, it may be best to leave the settings at their defaults. Choosing the wrong color profile could result in your shows playing back with odd or undesired colors.
Using Color Profiles

For output formats that support color profiles, you’ll find a pane at the bottom of the Options tab of the output option you have selected. Regardless of the output format, you’ll see similar options.

Use Color Profile for Video

This option appears for output formats that create video output, like DVD, Blu-ray, and Video CD. Clicking the checkbox for this option will enable the use of a color profile with the video on your disc. Once you have enabled the option, you can choose whether to use an installed, default color profile or a profile from a file. In almost all cases, you’ll be using a profile that is already installed. Choose the profile you have installed from the dropdown list.

If you don’t have the color profile installed, select the Use Custom option, and choose Browse and locate the color profile file you wish to use. You can choose any .ICC or .ICM file.

Use Color Profile Settings for PC Playback

For output formats that include PC playback, such as Executable, PC Autorun, and Presenter Shows, you can specify a color profile to apply to the EXE. For formats that have an option to include an EXE on the disc (such as DVD and Blu-ray), you can specify a color profile for the EXE if you have enabled the Include PC Executable option in the Executable tab.

The color profile settings for PC Playback are identical to the options for video, with one very important difference.
Color profiles for PC playback default to an option called **Use default color profile**. This option will play the show using the correct color profile for whatever screen you are playing the show on. This means that if you create an EXE and move the file to another computer, the EXE will use the correct profile on the new computer.

Unless you have a special need to choose a specific color profile, you will always want to leave the color profile for PC playback on **Use default color profile**.
25. Templates and Projects

Work Smart, Not Hard

Templates and Projects are features designed to save you time, effort, and quite possibly money. These options are available to help you create shows that can be used over and over again or manage large show compilations all at once.

We’ll start by introducing Templates, how they work, and what they can be used for. From there we’ll move on to Projects and how it can benefit you.

Shows are Quick with Templates

A Template is a complete slideshow lacking one major element – images. A Template is made up of blank layers, or template layers, that retain all the settings, adjustments, and configurations made to them in the original show. Only the images associated with the layers are missing.

This means that you have an otherwise complete show which only requires you add images. That’s one of the easiest parts of making a slideshow, so you can save quite a bit of time through the use of Templates.

Consider the use of templates in a business environment. You make money on each show you create. This means, directly, that your time translates into money. The more time you have to create shows means you can increase your income.

Think of templates as part of that process. Let’s say your average show takes you between 2 and 4 hours to complete by hand. This means that if you’re dedicated you can get around 2 shows done per day.

A template is an entire show that just needs images and, if you’re meticulous, some tweaking. You can knock show creation down to 15 minutes if you’re using templates as a normal part of your workflow.
Why not make a handful of templates to serve different show purposes? Make yourself a wedding template, a graduation template, a birthday template, or anything else you might use. You’re going to invest the time up front to make that template strong, but you’ll never have to do it again.

Once the template is made you’re only going to invest a fraction of the time to add some images, make a few adjustments, and move right on to output. If your templates are as strong as your normal shows, you’re not losing anything, but you’re gaining a lot of potential income.

Getting Photodex Templates

One of the best ways to see the Template feature in action is to download a few of the free Photodex Templates. You’ll find these available from the Download Extras section of ProShow. Here’s how you get to them:

1. Click on Tools in the menu bar.
2. Choose Download Extras in the menu that appears.
3. Click on Download Extras again in the sub-menu.
4. Locate the Templates entry at the bottom of the list and select it.
5. Click on Install Selected.
6. The Templates pack will be downloaded and installed for you automatically.

These Templates are simple but effective demonstrations of the feature. We can use them to see exactly how Templates work.
How to Open a Template

1. When you launch ProShow, in the New Slide Show window that appears, click the Template icon.

2. Select a template from the Show Templates list. Either double-click to apply the template or press the Create button.

OR

1. Click on the File entry in the Menu Bar.
2. Click on the New Show from Template option.
3. Select a template from the Show Templates list and press Create.

Now that you have a Template open you can see how it’s a show that lacks images. Anywhere you would normally have an image is occupied by a Template layer. These layers appear in gray with white borders.

Preview the Template. Notice that it plays just like a show. It basically is a show. It’s just waiting for some images.
Adding Images to Templates

There are many ways to add images to your Template. One of the easiest is to just drag & drop like you would with any other image. Rather than dropping the images into the Slide List to make a new slide, just drop those images right on to a Template layer that appears in the thumbnail. The image will get placed right into that layer.

Let’s cover all the ways you can add images to a Template:

- Drag & drop images directly from the File List onto Template Layers in the Slide List

OR

- Right-click on an image in the File List and choose Add Files to Placeholders from the sub-menu.

OR

1. Click on Show in the Menu Bar.
2. Click on the Add Selected Files to Placeholders option.

OR

1. Open the Slide Options for a slide which contains a Template Layer to which you want to add an image.
2. In the Layers List, select any placeholder layer that says "<No Image> Empty"
3. Right-click on the layer and choose Select File from the menu that appears.

Any of these methods will let you add an image to your Template. You can also add a group of images to a Template by selecting multiple images in the File List, right-clicking, and selecting Add Files to Placeholders.

Note: you can also add video files to a Template using these same methods. Remember that video files are able to be used in layers just as images are.
If you try to add more images than the **Template** has layers for, ProShow will tell you that only so many of the total images will fit in the **Template**.

**Creating New Templates**

Making a new **Template** doesn’t require anything beyond one extra step from a normal show. **Templates** are made by converting normal shows into **Templates** once they’re finished.

**To Create a New Template**

1. Open or create a show that you want to use to create a **Template**. Make sure the show has been saved before continuing.

2. In the **Publishing Format** pane, select **Show Template**.

3. A warning will appear which tells you that all content is about to be removed from the show. Click on **Ok** to proceed.

4. Enter a **Name** and **Description** for the new **Template** in the **Save Show Template** window which appears.

5. Click on **Save** when you are done.

The new **Template** will be available for you to use immediately. It will be the same as the show you used to create it, except that it will be missing images.
Soundtrack, Slide Sounds, Captions, and the rest of your show features will all be included in the new Template.

Including Files with Templates

When creating your own Templates, it's very common to make sure that some layers remain in your shows. Typically, this comes in handy when you know that certain backgrounds, borders, or watermarks will work best, or should always be included.

Before creating the Template, you need to uncheck the Replaceable Layer option for each layer that you wish to keep as part of the Template.

To Include Files in a Template

1. Before creating your new template, click on the layer you wish to include and go to the Layer Settings tab.

2. In the Layer Type area, locate the Style / Template setting and uncheck the box for Replaceable Image.

3. The image will now be included as part of the template.

Now that you know how to create a Template, it’s not a bad idea to know how to get rid of them. As you update your Templates while you learn more about ProShow, it’s likely that you won’t need older Templates you’ve created.
Importing and Exporting Templates

Templates are saved as part of the ProShow program data. If you need to backup a Template or use it on another PC, you need to Export it.

If you want to move a Template to another machine, you’re going to need to Import the Template once you get there. Here’s how:

To Export a Template

1. Click on Tools in the Menu Bar
2. Select Manage Show Templates
3. Choose the Template you want to export from the menu and click on Export.
4. You will see a prompt to name the Template file and choose where you want to save it.

Your exported Template will be in the PST file format. This is a full Template that is ready to be backed up or imported to ProShow on another PC.

To Import a Template

1. Click on Tools in the Menu Bar.
2. Select Manage Show Templates
3. Click the + Add button at the bottom of the window and browse for the PST file of the Template you want to import.
4. Click on Open when you locate it.

The new Template will be added to the library on your PC and available for immediate use.
Guidelines for Creating Templates

Templates are typically used for lots of shows once they’re created. This means that they have to be a bit more universal than your typical show. Here are some suggestions for making your own Templates:

- Avoid incredibly flashy effects because not all shows call for these kinds of effects.

- Keep effects and motion focused on the images rather than the overall look of the effect. Not all images will work well with certain dynamic motions and effects.

- Avoid adding music unless you know that the tracks you select will always work with the shows you create for that Template.

- Make your captions generic. Use captions that say things like “Title here” and “Subtitle here”. This will help remind you to change them to a caption that actually works for the show you’re creating.

- Don’t be afraid to update and change your Templates to keep up with how you’re making shows. An out of date Template isn’t helping you save time.
Using Projects

Projects and their associated project files are basically groups of shows. A Project is multiple shows combined together yet still left as individual show files.

It helps to think of a project like a folder that gathers all of your shows together into one larger group.

What Projects are Useful For

Projects are designed to let you work on multiple shows at one time, and to keep a set of shows bundled together. Imagine producing a series of shows for a wedding – you might have an engagement show, a show for the ceremony, and a show for the reception. While each of those are individual shows, they are part of the same project. ProShow’s Projects let you keep all those shows together.

Projects can be opened so that you have multiple shows in your workspaces at one time. You can swap between shows at any time without closing the others, and most importantly, you can copy and paste slides between them.

Projects also combine the shows when you create output. Remember the Shows tab, which lets you select the shows you want to include in your final output? Projects automatically include all of the project shows in that list. It’s made to create larger shows from a group of smaller individual shows.

When you watch a combined project in final output it will play through all the shows in order.

There’s a few compelling reasons to use Projects:

- You can have multiple shows open at once, and copy pieces between them.
- When you create output that supports multiple shows (like DVD or Blu-ray), the output can include all the shows in your project.
Projects help keep you organized when you have multiple shows related to one client or task.

You can divide your show into logical pieces. If you’re covering a wedding that has a section for preparation on the big day, the ceremony, and the reception, you can split those into different shows rather than making one big one.

Use one show in an open project as your ‘scratch paper’ for trying effects you’re not quite ready to add to your show. Test them out in your scratch show, and copy the slides over when you’re done.

If any of these sound useful, it’s time to use a Project.

How to Enable Projects

To begin with a completely new Project:

1. Click on File in the Menu Bar and select New Project. This will enable Projects and create a new blank show for you.

To create a new Project and have ProShow kick-start the process of making a new show:

1. In the Publish Workspace, locate the Project pane on the right side of the workspace.

2. Click the very first button in the toolbar at the top of the pane. This will create a new project and open the New Slide Show window that you see when ProShow first launches. From here, use the Wizard, open a Template, open and existing show, or starting a new show from scratch.
To add a show you have already created into a **Project**:  

1. Click on **Add (+)** button in the **Project** pane toolbar.
2. Browse for the show file and click on **Open**.

You can tell you’re in **Project** mode when the **Information Bar** changes in appearance. You’ll see tabs with the names of your various shows rather than just the name of the current show you’re working on.

Once a project is enabled, you can also add new shows by clicking on the **Add (+)** icon that appears next to the name tabs in the **Information Bar**.

**Managing Projects with the Project Pane**

You can get a full and detailed look at your current project by using the **Project** pane. This pane is located in the **Publish Workspace**. Here you will see which shows are in your project, as well as details about the shows.

You’ll also find some managements tools that allow you to add or remove shows from the project, adjust the order of the shows, save the project, and even configure the project’s menu.
The **Project** pane displays your shows, in order, as the most prominent feature. In addition to this, you have a toolbar along the top which gives you the following options.

From left to right, these buttons allow you to:

- **New Show in Project**: creates a new show within the current project
- **Open Project**: open a saved project for work
- **Save Project**: saves the project.
- **Save Project and Shows**: saves the project and all saves all of the shows within the project.
- **Add Show to Project**: adds an already existing show to the current project
- **Remove Show**: removes the selected show from the project
- **Up / Down**: moves shows up or down in the project order
- **Project Menu**: lets you preview and customize the menu that will be used for the project output

The information displayed for each show in the project includes the name of the show, the number of slides in the show and the total show length.

As with most other features in ProShow, you can also right-click within the **Project** pane. Right-clicking on a show in the **Project** pane gives you access to most of the same features just described, including **Switch Show**, **Rename Show**, **Show Options**, **Adding or Removing** shows.

All of these options are also available by right-clicking on show name tabs that appear in the **Information Bar**.
Understanding Project Files

Project files don’t contain any information about the individual shows that make up the Project. Project files only know which shows are in the Project – nothing more.

Project files are saved as PPR extensions and can be saved wherever you want to place them on the system. They don’t have to be in the same folder as your show files.

There’s one thing to remember, however, and that’s your project menus. The menu you create for your project will be saved as part of the overall project file. Those files that are used in your menu are retained just like a show file. If you move the menu files, the menu will let you know that it’s missing files. You can locate those files just like you would the others in your show.

Saving a project file just updates the Project with the latest list of included shows. That’s it. Project files are there to help you organize multiple shows.

To Save a Project

1. Click on File in the Menu Bar and select Save Project,

2. From the sub-menu, choose Save Project, Save Project As or Save Project and All Shows

3. Choose a location on the system and enter a name for the project file if this is a new Project.

OR

1. In the Project pane, click either the Save Project or Save Project and All Shows icons.
To Open a Project

1. Click on File in the Menu Bar and select Open Project.

2. Browse for the project file and click on Open.

3. The Project and all associated shows will open.

OR

2. In the Project pane, click the Open Existing Project icon.

An added benefit of Projects is that they make it much easier to open a group of shows. Just open the project file and all the shows you’ve included in it will be opened for you.

Making a large show can’t get much easier. Combine Projects and Templates together to find yourself making shows faster than you previously thought possible.
26. Copy, Paste, and Save Time

Nearly Everything Can Be Copied

ProShow has quite a few options you can adjust and control throughout the program. To help cut down on the time it takes to make a show, you’ll find that ProShow allows you to copy nearly everything you work with.

The copying options can be as broad as entire slides and become as granular as individual settings for keyframes. Let’s start with broad copying and work our way down.

Copying Slides

Any slide you create can be copied in its entirety. That includes all layers, settings, captions, and everything else. To copy a slide, you can right-click on a slide in the **Slide List** and select **Copy** from the menu that appears.

Pasting the copy you have made is just as easy. You can right-click in the **Slide List** where you want to paste your copy and select **Paste**.

You can also use the standard keyboard shortcuts of CTRL+ C to copy and CTRL+ V to paste.

Another paste option available from the right-click menu of the **Slide List** is **Paste Into**. Selecting **Paste Into** will paste all of the layers and settings from the slide you copied directly into the slide you have selected. It’s a useful way to merge two slides together.

Yet another way to merge slides together is to select the slides you want to combine, however many that may be, in the **Slide List**. Once you have created the selection, right-click on any of the slides and choose **Combine Slides**. All of the layers, settings, and customization from each slide will be combined into one slide.
You can also combine selected slides by using the **Combine** icon found in the **Design Workspace Toolbar**.

### Copying Slide Styles

If you really love the effect you've applied to a slide, you can quickly copy that Slide Style to other slides in your show. Simply select the source slide and all of the slides you'd like to copy the style to. Right-click on the source slide and select **Copy Effect**, then choose from **Copy Slide Style to All Slides** or **Copy Slide Style to Selected Slides**.

### Copying Layers and Captions

The next steps down from slides and effects are the components that make up slides – layers and captions. These can easily be copied from one slide to another.

#### Copying Layers

The **Copy Layers** window can be opened in a few different ways:

**To Open the Copy Layers Window**

1. In any workspace, click on **Edit** in the **Menu Bar** and select **Copy Layer and Captions**

2. Choose **Copy Layers** from the sub-menu.

**OR**

- In **Slide Options**, click the **Copy** icon at the bottom of the window and choose **Copy Layers**

This window has two panes – the **Layers to Copy** pane and the **Destination Slides** pane. The **Layers to Copy** pane has a collapsed group
for each slide in your show. You can see the layers in each slide by clicking on the ‘+’ icon on the left of the slide’s entry.

An expanded slide will show all of the layers within it. You can select an individual layer within a slide by clicking on the checkbox to the right of that layer. You can also select all layers within a slide by clicking on the checkbox to the right of the slide’s entry.

The buttons at the bottom of the list let you Expand or Collapse the view for of the slides. You can also select All or None of the layers on the slide. At the top of the Layers to Copy pane, you can change what is displayed in the list to filter by Slides or by Layers.

Once you’ve chosen a layer, or layers, to copy, you need to select the slide(s) you want to copy them to. You can select as many destination slides as you need to use. Once you’ve checked each of your destination slides, click on Copy, or Copy & Close.

The layers and all associated settings will be copied to the slides you’ve chosen.
Copying Captions

Copying captions across slides works almost identically to layer copying. First, you need to open the window.

To Open the Copy Captions Window

1. In any workspace, click on Edit in the Menu Bar and select Copy Layer and Captions

2. Choose Copy Captions from the sub-menu.

OR

- In Slide Options, click the Copy icon at the bottom of the window and choose Copy Captions

Notice that it looks just like the Copy Layers window. Choose the captions you want to copy on the left by checking the boxes, and then choose your destination slides on the right by checking the boxes. Click on Copy when you’re done.
Copying Settings

The **Copy Settings** options give you the ability to copy almost any setting you can adjust in the program from one place to another. To use it, you have to start by determining which setting you want to copy. That will help you decide what level you need to use for the copy.

The level of the copy is based on where the setting comes from. You can **Copy Settings** between many areas:

- Between slides, including settings like slide time, fade time, transition time, and more
- Between layers, including settings that can be configured for layers like position, zoom, adjustments, and others
- Between captions, including font, size, position, and more
- Between layer keyframes, with settings like pan, zoom, opacity, and others
- Between caption keyframes, with similar settings to layer keyframes
It’s up to you to decide what you want to copy settings between, based on the settings you intend to copy. Motion applied to a layer, for example, requires that you copy settings between layer keyframes. On the other hand, the font size and color of a caption requires that you copy settings between captions.

**Using the Copy Settings Window**

The *Copy Settings* window is used the same way, regardless of which settings you’ve chosen to copy. It’s very similar to the *Copy Layers* and *Captions* windows.

On the left side of the window you’ll have the **Source**. This is where you can select which slide, layer, caption, or keyframe you want to get the values from. The **Source** list features the same collapsing slide groups, which can expand all the way to the particular setting you’re copying.

The **Settings to Copy** pane appears in the middle. This is where you select the actual settings you want to copy from one place to another. The settings you see here are based on what you’re copying settings between. If you were copying settings between layers, you would see things like **Scaling, Opacity, or Zoom**.

You check the box next to each value you want to copy. Once you’ve made your selections to copy, you need to choose your destination.

Like the **Source**, your **Destination** list displays groups of slides which can be expanded down to the level of the settings you’re copying. You can check the box next to individual areas you want to copy settings to, or even go so far as to check an entire slide – which copies the settings to every layer, caption, or keyframe on the slide.

Once you’re done making your selections, click on **Copy** or **Copy & Close**. The settings will be copied immediately.
To Open the Copy Settings Window

1. In any workspace, click on **Edit** in the **Menu Bar** and select **Copy Settings**

2. Choose your copy options from the sub-menu.

OR

- In **Slide Options**, click the **Copy** icon at the bottom of the window and choose **Copy Settings**, and then the desired settings you wish to copy from the sub-menu.

Copying Everything

What you’ll find as you use ProShow is that not only can you copy nearly every setting using the dedicated copy tools – you can copy nearly every setting directly from the setting with a right-click.

Open the **Slide Options** for any slide and try right-clicking on the **Zoom** value for a layer. You’ll notice that you’re given a group of options:

- ‘**Copy Zoom to other layers**’ opens the **Copy Settings** window for copying between layers.

- ‘**Copy Zoom to all layers on selected slides**’ will copy that **Zoom** value to every layer on those slides you have selected in the **Slide List**.

- ‘**Copy Zoom to all layers on all slides**’ copies the **Zoom** value to every layer on every slide, just as it says – effectively your entire show.

- ‘**Copy Zoom to all layers on this slide**’ copies that **Zoom** value to every other layer on your current slide.

You’ll find that these right-click copy options are available throughout the program for every value that can be copied from one place to another. If you’re in doubt, just try right-clicking on a value. You can even right-click on color selections to copy them throughout your show.
26. Copy, Paste, and Save Time
27. Configuring ProShow: Preferences

Customizing ProShow

Remember the basic hierarchy of options that you can adjust in ProShow:

- **ProShow**
  Customize with Preferences

- **Show**
  Customize with Show Options

- **Slides**
  Customize with Slide Options

The ProShow Preferences are where you set options that will apply to the whole program. That means it will affect how the program operates, what defaults you use, and how all of the shows you make will be created.

There are a wide range of options that you can adjust using the Preferences. These can be grouped into a few major categories:

- Changes that adjust the look and feel of ProShow
- Changes that adjust the way ProShow behaves
- Changes that alter defaults for the way ProShow creates shows
Most users find that they rarely need to change anything in the Preferences. They’ve been set to universal values that should work for most people. If you want a bit more of a custom experience, though, you’re going to find the options to accomplish that in the Preferences.

To Open the ProShow Preferences

1. Click on Edit in the Menu Bar.
2. Select Preferences. It will be at the bottom of the menu that appears.
Adjusting the Look and Feel of ProShow

Let’s start with the options that change how ProShow looks and how it feels to use it.

In the Preferences window you’ll see a list of various options categories on the left side. Changing the look and feel of ProShow involves these categories:

- **Appearance**: this is where you can adjust the overall look of ProShow. You have options to change how the folder list looks, how text on new slides will be displayed and how the Workspaces will look.

- **Colors**: this category essentially gives you the ability to “skin” ProShow. You can change the colors and general look of every aspect of the program? Don’t like the black on gray look of Producer? Change the colors to the traditional look of Gold.

- **Playback**: Here you set options for how ProShow plays back shows on your PC. You can choose what monitor is used for full screen playback, set a color profile for your preview, configure rendering sizes, and control GPU acceleration from this tab.

- **Sound Effects**: this category is where you can enable sound effects that will play when you do certain actions in ProShow. These actions include things like sounds that play when dialog windows open or close or when an action is complete.

- **Thumbnails**: this category is dedicated to changing the appearance of thumbnails in your File List. You can adjust their size, what information is used for each thumbnail, and how selected thumbnails will be displayed.

We’ll go through the options you can adjust for each category and why they may be beneficial to you.
Changing the Appearance Preferences

Most of what you can change in the Appearance category alters the look of the Workspaces. You can change how buttons on the toolbar are displayed, which dialog sizes will be available and set assorted options for your Folder List.

The most notable option found here is the ability to change how text for unnamed slides will appear. An “unnamed” slide is a slide you have created but have not named using the Rename link under the Layer Settings tab of Slide Options. By default, ProShow will use the default ‘Slide #’ value. That means that if your slide is the first in your show it will appear in the slide list as ‘Slide 1’.

Previous versions of ProShow used a different naming scheme for unnamed slides. These slides took the name of the top-most layer on the slide. If that layer was called ‘DSC95272’ because that’s what the image used to create it was called, your slide would have the same name. You can set your slides to display this way by changing the value to ‘Use name of top layer’.

Finally, you can choose to select ‘No text’ which will display no name at all on the slides.

The Main Window pane is used to control how your Toolbar will look in each of the Workspaces. Changing these options can remove some of the graphical flair from the buttons, like the gradient background, textures, and large buttons. Just uncheck a value to disable it. They are all enabled by default.
In the **Dialog Size and Placement** pane, you can tell ProShow to make all dialog sizes available, regardless of screen resolution. Keep in mind that if your monitor isn't capable of display certain resolutions (like 1920x1080), windows may feel broken when opened, and you may not have access to all of the windows’ options.

The **Workspaces** check box is toggled on by default to make sure that you automatically return to the Build Workspace when creating a new show. If this option is unchecked, when you create a new show, ProShow will remain in whatever **Workspace** is currently selected.

The last pane is used to control the look of your **Folder List**. These options control how the **Folder List** looks and what information it contains. By default the **Folder List** has options set to make it look as much like your file browsing experience in Windows Explorer.

You can change the look by enabling or disabling certain parts of the **Folder List** appearance. For example, ‘knobs’ are the + and – icons that indicate whether a folder has been expanded or not. ‘Lines’ can help you figure out which folder is a sub-folder of another by drawing lines between nested folders.

The most significant options here are those which let you show fixed or removable volume labels. If you name the drives you have on your system, those names will appear in the **Folder List** when these two options are enabled. This can be very helpful when locating certain drives on your PC – especially if you don’t know the drive letter.

**Note:** the easiest way to figure out what **Appearance** settings you prefer is just to experiment with them. The changes are made as you enable or disable options, so you can watch the **Workspaces** as you make changes to figure out which settings you like best.
Changing the Colors Preferences

Working with the options in **Colors** is very much about how you want ProShow to look. If you prefer to work with a certain set of colors in your User Interface (UI), you can set those colors here.

These options don’t change the way ProShow works at all. It only changes the color scheme that is used in ProShow.

The **Preview** pane shows you what the current color scheme looks like in ProShow. The **Preview** will update as you make changes in the **Colors** pane to show you what ProShow will look like using those currently selected colors.

Beneath the **Preview** pane is the **Color Configurations** pane. These configurations are basically color templates. They’re quick, pre-made color settings that you can experiment with. Both the ProShow Gold and ProShow Producer color configurations are included for you so that you can choose either the more traditional look of ProShow or the more modern look of Producer should those suit your preference. There’s also some other color configurations there that can be used to demonstrate the flexibility of the color selections.

If you want to load one of the pre-made configurations, just click on the configuration in the list and click on Load. It will appear in the **Preview**. If you are happy with the way it looks, click on **Done** and it will be applied.
Creating your own Colors is just a matter of changing the color associated with each visual element listed in the Colors pane. Clicking on Set, choosing a color, and clicking on Set Color will lock that color in for that part of the UI. Experiment with different color options to see what you like.

When you’re done you can save that color set as a Color Configuration by clicking on Save in the Color Configuration pane. ProShow will ask you to name the file and save it to your system. It can be quickly loaded in the future.

Deleting any configurations you don’t want to use is as easy as selecting the configuration in the list and clicking on Delete.

Adjusting ProShow Playback

Playback in ProShow controls a variety of options that cover the technical side of how previews are displayed while you’re making your show.

The Playback options are in effect whenever you play or look at your show while you’re making it. Let’s cover what each option actually does for you.

GPU Accelerated Rendering: GPU accelerated rendering uses the processor on your graphics card (GPU) to help playback your show. Using GPU acceleration can greatly improve playback performance and preview quality.

Older machines, or PCs that feature graphics cards with less memory or processing power may not be able to take advantage of this option. By default, ProShow will automatically configure GPU acceleration based on your computer’s hardware. If you have trouble previewing your shows, you may need to uncheck the automatic option and try the manual settings.

Direct Draw support is enabled by default in ProShow. Direct Draw is Microsoft’s standard rendering method in Windows. Your desktop and other elements of the programs you use on a daily basis are displayed on the screen using Direct Draw. This method speeds up the process of drawing things on your screen.
What this means, in short, is that working in ProShow will be faster and smoother with **Direct Draw** enabled. If you turn off **Direct Draw** by unchecking the box found at the top of the Playback options you will get slower results. That’s because when **Direct Draw** is disabled ProShow must use older, slower methods of displaying things on the screen. The basic rule is this:

**Direct Draw** is fast, while running without it is slow. Unless you have a deeper technical problem on your PC you should leave **Direct Draw** enabled.

**Video Importing** is where you can configure how ProShow works with the video files you use in your show. This option is enabled by default, which means ProShow will import video files using its own tools, no codecs needed.

If that’s a problem for you, or a particular video isn’t working, try disabling the option to use DirectShow. When this is done, ProShow will use the codecs installed on your PC. This means your codecs must be installed properly.

The **Rendering** options allow you to set the size ProShow will use to render your images for the previews while you are working on a show. You can also set the Target Size for image resizing when creating EXEs or Presenter-based output. Unless you have a very specific need, it's best to leave these at their default settings. These settings have been chosen to achieve a nice mix of quality and speed.
Finally, in the **Miscellaneous Playback Options** pane: **Transition Edges** turns on a thin border to show you when and how a transition effect is playing between your slides. It’s a visual indication of what part of your slides is being changed by the transition rather than by any specific change you have made in the **Slide Options**. This black edge only appears on transitions that have a solid pixel border on them. Effects like the **Radar Wipe** and **Circular Wipe** are good examples of this.

This option is purely about personal preference. If you prefer to see exactly where the edge of your transition is, turn it on. Otherwise there’s no reason to adjust this.

**Color Profiles** allows you to use the default ICC color profile you have installed on your PC for preview playback. If you know what a color profile is and you have one installed you can enable the option. If you’re not familiar with color profiles you should leave this setting alone. Adjusting it can cause the colors in your preview to become distorted.

**Preview Monitor** is only relevant if you have more than one monitor hooked up to your PC. If so, you can use this dropdown list to choose which monitor will be used when you choose **Full Screen Playback** for your preview.

Clicking on the dropdown list will display all the monitors that are detected in Windows, using the same number designation given to the monitors by Windows. Choose the number you want and that monitor will be used for full screen playback every time you preview your show. Remember that this setting only changes the way the show plays in ProShow; it has no effect on any of the publishing options you select.
Working with Sound Effects

If you’re the type to appreciate an audio notification when something has taken place in your programs you’ll find the Sound Effects section useful. This section gives you the ability to choose sound effects that will occur when the program performs a few different tasks.

You can assign a sound effect for three options:

- When a dialog window, like a prompt to enter information, opens
- When a dialog window closes
- When an action that ProShow is performing is complete

ProShow does not come with its own sound effects. You will need to select the sounds you want to use if you enable this feature. You can use WAV files as your sound effects.

To choose a sound effect first check the box next to the action you want to assign an effect to. Click on Browse, locate the sound effect on your hard drive, and click on Open. The sound will now be associated with that action.

This feature is most helpful if you do a lot of unattended rendering with ProShow. That means you start rendering a show before burning it to disc and walk away while ProShow completes that process. If you enable the Action Done sound effect, ProShow will play the sound you choose when the rendering and burning is complete. That makes it easy to turn up your PC speakers, go do something else, and receive an audio notification when ProShow is done.

The Sounds When Minimized section lets you toggle which sound effects are played while you have ProShow minimized to the taskbar. This can also be useful if you want to start burning a show to disc and minimize ProShow while you work on something else. When ProShow is done it’ll play the sound you choose.
Adjusting Thumbnail Settings

Your File List is populated by thumbnails for the images you can use in your shows. These thumbnails aren’t just limited to one size for all PCs, however. You’re able to use the Preferences window to change the size of the thumbnails in your File List to one of 7 available preset sizes or choose your own custom size that best meets your needs.

The Thumbnail Size pane has a column of 7 preset resolutions on the left size, ranging from 48x48 to 130x180. These resolutions are measured in pixels.

The maximum size of any thumbnail is 180x180 pixels. This comes into play when you’re selecting any of the 7 Custom options on the right side of the pane. Choosing one of these will activate the Custom Thumbnail Size pane. You can click and drag the shaded thumbnail box here to set your own custom thumbnail size.

ProShow will remember up to 7 custom sizes – one for each listing in the pane.

The Thumbnail Information pane gives you the ability to choose what data from your images will be displayed beneath the thumbnail in your File List. You can enable quite a bit of information by checking the boxes you do want to see and unchecking those you don’t. By default the only enabled option is Filename.
Changing the Way ProShow Behaves

You’ve got quite a bit of flexibility in how you configure ProShow to behave on your system. This includes changing the default way that ProShow uses the Internet on your PC to what external editing programs ProShow will use when prompted. The options in this category include:

- **External Applications**: this set of options is used to assign what programs you want to use to edit any images, audio, or video files you use in your show. When you prompt ProShow to open a file in an editor it will use the editors you have specified here.

- **Keyboard & Remotes**: this options group can be used to change the hotkeys that are used for playback in ProShow as well as configure how ProShow will work with PC remotes. This is helpful when you’re configuring ProShow to work with presentation remotes.

- **Internet**: the Internet preferences are where you choose a default web browser for ProShow, enter e-mail server information, and more.

- **Miscellaneous**: this category includes various options that all in some way impact how ProShow behaves, such as controlling what ProShow does when you open the program and configuring Autosave options.

- **Prompts**: here you can refine how ProShow will warn you when performing various actions such as copying files or applying Slide Styles.

- **ProShow Remote App**: From here you can enable connection options, view ProShow Remote App configuration settings, and set ProShow to automatically discover devices running the App on start up. When running, the app will allow you import files directly from a device into a show, publish a show directly to device, or control show playback on your PC using the app as a remote. You can learn more about the ProShow Remote App in Chapter 28.
Configuring External Applications

ProShow can make quite a few changes to all of the various kinds of media that you use in your show, but it’s not designed to replace the dedicated editors you may already use for preparing photos, videos and music.

When you need a specialized editor for a file, you can tell ProShow to open that file in the editor of your choice. You make those selections in the **External Applications** section.

ProShow has three default editors you can select: an image editor, a sound editor, and a video editor.

There are a wide range of possible programs you might be using for these tasks so the process for selecting them is the same in all three cases:

**To Choose an External Editor**

1. Choose the editor type you would like to configure from **Photos, Video,** or **Music and Sounds**.

2. Click on the **Browse** button next to that selection.

3. Browse your system for the **EXE** file of that program.
   a. Selecting Photoshop as your default image editor would be in the default installation folder of “C:\Program Files\Adobe\Adobe Photoshop”

4. Click on **Open** to select that file.

Your default editor has now been assigned. When you select **Editor** for any file type, using any method, ProShow will use the selected editor for that file type and open the file.

**Note:** changes that are made in an external editor using this method are permanent. Unlike ProShow, most external editors save those changes to the file itself.
27. Configuring ProShow: Preferences

Setting up Keyboard and Remote Preferences

When playing back a show as an EXE, you can play, pause, skip, etc. using your keyboard. Using the preferences, you can configure which keys perform which action.

Since most presentation remotes work by pretending to press keys, you can configure ProShow to respond to your remote, allowing you to control playback with any presentation remote.

Configuring your keyboard or a remote for use with ProShow is an interactive process. That means that you tell ProShow what button you want to change, it asks you to press the button, and you press the button you want to use for that action.

To access these options select **Keyboard & Remotes** from the list of preferences.

There are two control sets that you can adjust like this: **Navigation and Audio Control**.

If you plan to use a presentation remote with ProShow you will need to set your remote to emulate buttons on the keyboard. Rather than having the button inputs set to something remote specific, like ‘Button 1’, set your remote to use actual keys on the keyboard like Page Up. Consult your remote’s documentation for information on how to set up your remote. When this is done you can bind those buttons to actions in ProShow.
The process is simple. Click **Change** next to the action you want to reassign. When the **Waiting for Keystroke** window appears, press the key you want to use for that action whether it’s on your remote or the keyboard itself. That action will be changed immediately.

**Miscellaneous Options**

You’ll find a wealth of smaller options that can be adjusted here. These are all important even if they’re grouped into a miscellaneous section.

The **Upgrades** pane lets you choose whether you want ProShow to automatically check for program updates and how often it does so. You can enable or disable update checking by checking or unchecking the box. You can also change the number of days ProShow waits to check for updates by entering a number of days in the field that appears.

The **Autosaves & Backups** section is a very important one. This allows you to configure how often ProShow will automatically save the show you’re working on. The default value for **Autosave** is 300 seconds, but you can choose whatever value you want. Keep in mind that saving longer shows can take a few seconds so if you set this time to be too short you might find the pauses to autosave interrupting your work.

The **Backup** field lets you determine how many previous versions of a show ProShow will save for you. By default it saves 10 but you can change this number to fewer if you don’t need that many. The maximum is 10.

**Note:** the **Autosave** feature does not save over your original show file. ProShow keeps a separate autosave file for use with this feature. If you make changes to a show that you don’t like and ProShow uses the autosave feature it won’t overwrite the show you’re working on.
Also note that **Backup** shows are incremented in file number. Your show file will always be the most current, with the previous saved state of that show being called `'<YourShowName>.BAK'`. Older versions will be called `<YourShowName>.B01` through B10.

The **Favorites & Recently Opened** pane lets you determine if ProShow will automatically add entries to your **Favorites** list in the **Build Workspace**.

If you want ProShow to add folders that you frequently use for show creation to your **Favorites** without prompting, enable this option. It is turned on by default. Note that by default the **Favorites** list in the **Build Workspace** isn’t visible. You can turn that on by going to the **Menu Bar** and selecting **Windows > Show > Favorites**.

ProShow has a few options that can be configured when the program starts. This includes whether tips are displayed and which folder to automatically open for you.

The **Startup** pane has the option to disable the ProShow startup screen that appears when you launch the program. If you don’t want to see this, simply uncheck the option.

You can also choose the **Startup Folder** ProShow will display by default when you start the program. Normally ProShow will remember which folder you were working in last time it was open.

If you would rather ProShow open the same folder every time it starts, just choose the **This Folder** option and **Browse** to the location of that folder.
As you’ve learned, all windows in ProShow float and can be moved around your screen or even moved to other monitors. The Transition Picker pane allows you to tell ProShow to remember where you prefer to have the window appear when opened. You can also configure the option to apply Transitions with a single-click.

**Controlling When ProShow Prompts You**

The Prompts section allows you to enable or disable prompts that are displayed when ProShow performs certain actions. These include prompts for things like whether or not you want to save changes you’ve made before you close the Slide Options window or confirm when you’re overwriting an applied Slide Style with another style.

Checking the box next to a prompt enables it while unchecking the option disables it. Almost all prompts are enabled by default and should only be turned off if you’re sure you don’t want to be warned when that action is about to be performed.

**Choosing How ProShow Uses the Internet**

When you prompt ProShow to perform an operation that requires a web browser, e-mail client, or Twitter, ProShow needs to know which tools you want to use and how. That’s where the Internet preferences come into play.

Web Browser allows you to choose the specific browser you want to use with ProShow. By default, ProShow will use whatever browser you have selected as the default for your computer. To change which browser ProShow uses, click on Browse and locate the EXE file for that browser.

The Twitter option lets you toggle whether ProShow will automatically shorten links which are posted to Twitter if you use it to notify followers about new shows. If you would rather use another URL shortening service, just disable the option and use your preference when creating your tweets.
The **Outgoing E-mail Server** pane is where you configure the server which transfers any e-mail you are sending to others. You likely already know your **E-mail Address**, **Account Name**, and **Password**. You might not know the actual web address for your SMTP server, though. If that’s the case, call your ISP or check the documentation available for web mail services like Gmail or Hotmail.

The **Incoming E-mail Server** pane is where you enter the settings you use to receive e-mail messages. This information is only needed if the Outgoing Mail server wants to verify that you’ve also got Incoming access. It’s a security precaution found with some ISPs. This information can often be found by calling your Internet Provider or checking their support documentation online.

**Note:** e-mails sent without servers entered will be sent using Photodex servers.
Changing Show Defaults

The last section of the Preferences window deals exclusively with the defaults that are used in all of the shows you create. These defaults include things like the standard times used for Slide Time and Transition Time as well as the default motion types that are used.

The Time Format for Timelines pane gives you the ability to choose how you want time to be displayed in your every timeline in the program. This includes the Slide List, Timeline, Audio Trimmer, Video Trimmer, and all Keyframe Timelines.

By default ProShow will display time in minutes: seconds format. If you prefer to work only with seconds you can check the option to enable it. This will cause all times to be displayed only in seconds.

The Default Slide Settings pane has various options that control what is used when you create new slides without changing any values.

The Slide Duration is the standard time that will be used for the first new slide you add to a show. The default is 3 seconds. You can change this value to whatever you want. Do you generally make fast-paced shows? Reduce the default time.

15 You can find a detailed discussion on how slide times are determined in Chapter 5.
The **Transition Duration** changes the standard time that is used for transitions on new slides. Again, the default is 3 seconds but you can change it to any value you prefer.

The **Transition Effect** is what ProShow will set as the transition for any new slides you create. If there’s a particular transition that you use very often in your shows you can set that here. By default it uses Crossfade – Linear.

**Random Transition Effects** is just like the **Random Transition Effects** option found in the **Show Options** of Chapter 4. The only difference is that rather than changing the random effects for a single show you’re selecting them for *every* show you create.

**Default Motion Settings** allows you to select which kind of motion you want to use, by default, for all of the slides you create. You can choose between **Pan-Smooth** and **Pan -Linear** in the dropdown list. If you choose **Pan-Smooth** you can also set the amount of smoothing by adjusting the **Curve** value that is used.¹⁶

Finally you have the **Default Image Settings** pane. This pane lets you determine how any new images you add to your slide will be scaled. You can choose any of the normal **Scaling** options, including **Fit to Frame**, **Fill Frame**, **Stretch to Frame**, **Fit to Safe Zone**, and **Fill Safe Zone**. For more details on **Scaling** and how it changes the look of your images, see Chapter 8.

¹⁶ For more details on how Smoothing impacts your motion please see Chapter 15
28. The ProShow Remote App

Going Mobile with ProShow

The ProShow Remote App allows users to seamlessly interact between ProShow desktop software and a mobile device.

So what can you do with the app?

When connected, you can:

- Import content directly from a device
- Save videos to your device wirelessly, without having to plug-in, or use any other software
- Control playback of a show on your PC using your device as a remote

The ProShow Remote App

To use the ProShow Remote App, you'll need two things:

- ProShow version 6 or higher
- Any Apple Device running iOS 6 or higher. We recommend iOS 7 for the best experience

To get the App, go the App Store on your device, or search iTunes for ProShow Remote App. The app is completely free.
Connecting to the App

Once the App is installed, you'll need to establish a connection between your device and ProShow.

1. Make sure your device is connected to a WiFi network. Your PC should also be connected to the same network (either WiFi or LAN).

2. Open the **ProShow Remote App** on your device, then open ProShow on your computer.

3. In ProShow, in the **Menu Bar**, go to **Tools > ProShow Remote App > Connect to Device**.

4. On your device, tap the **Connect** button in the app to view a list of available computers running ProShow on your network. Tap to select the computer that you would like to connect to.

5. In ProShow, in the **Connect to Remote App** window, you'll see a 6 digit access key. Enter this access key into the app, then tap the **Connect** button.

Both ProShow and the app will confirm the connection.
Importing Content from a Device

When ProShow and the app are connected, you can add photos and videos from your device directly into a new show, an existing show, or into the ProShow Wizard.

To Import Files Using the ProShow Remote App

1. Connect ProShow to your device.

2. When working with a new or existing show, click the **Import** Icon in the **Build** or **Design Workspace**. When using the **Wizard**, click the **Import** Icon in Step 1.

3. Choose the **ProShow Remote App** option.

4. Choose a folder on your device. Depending on how much content is the folder, it may take a moment to display thumbnail views for all of the available files.

5. Select the file(s) you wish to import. You can choose files from several different folders at one time. With your content selected, click the **Add to Show** button.

ProShow will then import your content from the device. Any content that you download or import directly into a show will be saved on your computer.

You can access these files just like any other content by using the **Folder List** and **File List**.

Remember, imported content will **always** be listed as **Imported Content** under the **Media Sources** entry in the **Folder List**.

As you import from different devices and folders, ProShow will add new entries to help you keep these downloads organized.
Saving Shows to a Device

Using the ProShow Remote App, you can save shows directly to your device, without having to plug-in the device, or use any other software.

To Save a Show to a Device Using the ProShow Remote App

1. Connect ProShow to your device.


   Or

   From the Menu bar, select Publish > ProShow Remote App

   Or

   In the Publish Workspace, click the All Formats icon in the Toolbar and select ProShow Remote App.

3. Select the Video Quality you’d like to use for you show. You can choose from standard web quality, all the way to high quality 1080p.\(^\text{17}\)

---

\(^{17}\) Video quality options may vary based on your device.
4. Click the **Publish** button to begin creating the video.

After it's created, the video will be sent to your device and will be displayed on the app's home screen. Simply tap the video to begin playback.

Published videos can be played without the app being connected to ProShow.

**Tip:** When creating videos, it's best to disable the lock screen on your device. If the lock screen comes on while your show is being created, it may cause your device to disconnect from ProShow. If this happens, you'll be prompted to reconnect your device, and you may need to restart the video creation process.

**To Save a Video to your Device's Camera Roll**

1. In the **ProShow Remote App**, tap the icon in bottom right corner of the video thumbnail for the show. The App will confirm the save request and verify that video has been saved.
Control Playback your PC Using a Device

Using the ProShow Remote App you can also control the playback of any show currently open in ProShow. When connected, you can play and pause a show, skip between slides and even turn on Full Screen playback.

To Use a Device as a Remote to Playback a Show on your PC

1. Open a show in ProShow and connect to your device

2. On the app home page, in the gray box at the top of the screen, tap to connect to show currently open in ProShow Producer.

3. To begin playback, simply press the play icon in the middle of the screen. To move forward or backward in a show, use the arrow icons, or click on the slide thumbnail.
4. Changing to **Gesture Mode** will allow you to navigate between slides by swiping your device screen.

5. To playback your show in Full Screen on your PC, tap the Full Screen icon at the bottom of the app.

---

**Additional ProShow Remote App Tools**

When your device is connected to a show that's open in ProShow, you'll find some very helpful tools at the bottom of the app screen.

If you haven't already saved a connected show to your device, click the publish icon on the app. This will open up the **Publish to ProShow Remote App** window on your desktop. From here, choose your desired video quality, and save the video to your device.

While previewing a connected show, if you find that you'd like to add more content from your device into your show, click the import icon. This will open the import window in ProShow. Simply, browse and select the new files you'd like to add to your show.

Finally, there's the settings icon. Tap this icon to see more details about your device's current connection to ProShow on your desktop. From here, you can also disconnect your device.
Tips For Using the ProShow Remote App

Here are some handy tips to keep in mind when using the ProShow Remote App.

**Tip #1:** Use WiFi! This tip cannot be stressed enough.

While you can use your device's cellular connection to connect ProShow to a device, 3G/4G/LTE connections are not recommended. Importing content or publishing shows to a device can be very time consuming over a cellular connection.

Additionally, transferring large files like high-resolution images and HD videos can very quickly use up the bandwidth allotted in monthly service plans. Photodex strongly recommends that you use a WiFi connection when connecting ProShow to a device.

**Tip #2:** If you frequently import from or export to a device, you can configure ProShow to automatically discover devices running the app when it starts up. From the **Menu Bar**, go to **Tools > ProShow Remote App > Automatically Enable on Startup**.

You can also configure this option in the ProShow Preferences.
Advanced Connection Settings

If you choose to use a cellular connection, your device and ProShow will most likely not be on the same network. This can add complexity to the connection process and may require you to know the external IP address for the computer running ProShow.

To make this type of connection, in the app, when selecting a computer to connect to, tap the Custom Connection option.

On the next screen, enter the IP address for the computer you wish to connect to, then enter the Access Code, provided by ProShow.

Note: You may be required to configure your internet router to allow this kind of remote connection. This is router specific - not a ProShow setting.

When using a custom IP, ProShow connects to the Remote app using port 9157. Opening this port is not necessary for WiFi based connections.

If you need to configure a router to accept this type of internet connection, please consult your router's documentation.
28. The ProShow Remote App
29. Getting Help with ProShow

Call or E-mail Photodex

If you find that you have a question about how to work with ProShow, or something doesn’t seem to be working properly for you, please give us a call or send an e-mail.

You can reach Photodex support by phone at 1-800-377-4686. If you don’t mind our Texas accents, our reps are available 7 days a week and happy to help.

For online help, including email information and our online knowledge base, visit us online at:

http://www.photodex.com/

To Get Help With ProShow

1. **Click on** Help > Get Help With ProShow **in the Menu Bar.**

This will open a window full of helpful links and contact information. From here you can link directly to the Photodex Knowledge Base, report a problem, email us or check for upgrades.

Reporting a Problem

There may be times when you have a problem that requires a customer service representative to take a look at your show, assuming you don’t mind sending it along. If that’s the case, you’ll be asked to submit a **Problem Report.**

Problem Reports contain the show you have loaded when you send it as well as useful information about the environment of your PC. These elements together can be very helpful when we’re trying to diagnose and resolve a potential problem.
To Send a Problem Report

1. Load the show you’re experiencing trouble with.

2. Click on Help > Report a Problem in the Menu bar.

3. Fill out all of the fields in detail, including a detailed description of the problem.

4. Click on Send to submit your Problem Report.

Uploading a show can take some time, especially if it’s a large show. Let ProShow finish the upload before you move on to anything else.

Checking for Upgrades

Photodex frequently releases updates to ProShow to add new features and expand the program.

ProShow automatically checks for upgrades based on the amount of time you set in the Preferences. You can manually check for updates as well.

To Check for ProShow Upgrades

2. Click on Help > Check for Upgrades in the Menu Bar.

3. If an upgrade is available you will be notified and taken to the product page.

Keep ProShow updated often to make sure you’re using the latest version with the latest and greatest features.
Downloading Extra Content

Photodex makes free content available for ProShow users from time to time. This content may be masks, borders, templates, slide styles and more.

The best part is that these free materials can be downloaded directly into ProShow without ever opening your browser.

To Download More Content

1. Click on **Tools > Download Extras > Download Extras** in the **Menu Bar**

2. Choose the content packages you want to download in the **Download Content** window. You can select as many or as few packages as you want.

3. Click on **Install Selected**.

The packages you’ve selected will be downloaded in the background and integrated into ProShow. The new content will appear in the various selection areas, such as the Themes list when picking a menu theme. Masks, borders, and images can be found in the following folder of the **Folders List**:

**Media Sources > ProShow – Built-In Content**

Check for new downloads throughout the year. You never know when something new will be released.
# Keyboard Shortcuts

## Main Menus

<table>
<thead>
<tr>
<th>Menu</th>
<th>Shortcut</th>
<th>Command Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>File Menu</td>
<td>ALT+F</td>
<td>New Show</td>
</tr>
<tr>
<td>Edit Menu</td>
<td>ALT+E</td>
<td>New Blank Show</td>
</tr>
<tr>
<td></td>
<td></td>
<td>New Show from Wizard</td>
</tr>
<tr>
<td>Show Menu</td>
<td>ALT+S</td>
<td>New Show from Template</td>
</tr>
<tr>
<td>Slide Menu</td>
<td>ALT+L</td>
<td>Open Show</td>
</tr>
<tr>
<td>Audio Menu</td>
<td>ALT+A</td>
<td>Save Show</td>
</tr>
<tr>
<td>Tools Menu</td>
<td>ALT+T</td>
<td>Save Show As</td>
</tr>
<tr>
<td>Show Menu</td>
<td>ALT+S</td>
<td>Save Show As Template</td>
</tr>
<tr>
<td>Window Menu</td>
<td>ALT+W</td>
<td>New Project</td>
</tr>
<tr>
<td>Help Menu</td>
<td>ALT+H</td>
<td>Open Project</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Save Project</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Save All</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Close</td>
</tr>
</tbody>
</table>

## Working With Shows

<table>
<thead>
<tr>
<th>Menu</th>
<th>Shortcut</th>
<th>Command Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>New Show</td>
</tr>
<tr>
<td></td>
<td></td>
<td>CTRL+N</td>
</tr>
<tr>
<td></td>
<td></td>
<td>New Blank Show</td>
</tr>
<tr>
<td></td>
<td></td>
<td>CTRL+B</td>
</tr>
<tr>
<td></td>
<td></td>
<td>New Show from Wizard</td>
</tr>
<tr>
<td></td>
<td></td>
<td>CTRL+ALT+W</td>
</tr>
<tr>
<td></td>
<td></td>
<td>New Show from Template</td>
</tr>
<tr>
<td></td>
<td></td>
<td>CTRL+ALT+N</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Open Show</td>
</tr>
<tr>
<td></td>
<td></td>
<td>CTRL+O</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Save Show</td>
</tr>
<tr>
<td></td>
<td></td>
<td>CTRL+S</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Save Show As</td>
</tr>
<tr>
<td></td>
<td></td>
<td>CTRL+SHIFT+S</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Save Show As Template</td>
</tr>
<tr>
<td></td>
<td></td>
<td>CTRL+SHIFT+ALT+T</td>
</tr>
<tr>
<td></td>
<td></td>
<td>New Project</td>
</tr>
<tr>
<td></td>
<td></td>
<td>ALT+N</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Open Project</td>
</tr>
<tr>
<td></td>
<td></td>
<td>CTRL+SHIFT+O</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Save Project</td>
</tr>
<tr>
<td></td>
<td></td>
<td>CTRL+ALT+S</td>
</tr>
<tr>
<td></td>
<td></td>
<td>CTRL+SHIFT+ALT+S</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Save All</td>
</tr>
<tr>
<td></td>
<td></td>
<td>CTRL+SHIFT+ALT+S</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Close</td>
</tr>
<tr>
<td></td>
<td></td>
<td>CTRL+W</td>
</tr>
</tbody>
</table>

## Adding Slides and Content

<table>
<thead>
<tr>
<th>Action</th>
<th>Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Insert Blank Slide</td>
<td>ALT+B</td>
</tr>
<tr>
<td>Insert Title Slide</td>
<td>CTRL+ALT+B</td>
</tr>
<tr>
<td>Add Selected Files to Show</td>
<td>ALT+I</td>
</tr>
<tr>
<td>Add All Files to Show</td>
<td>CTRL+ALT+I</td>
</tr>
<tr>
<td>Add to Selected Slide</td>
<td>CTRL+SHIFT+I</td>
</tr>
<tr>
<td>Add as One New Slide</td>
<td>CTRL+SHIFT+ALT+I</td>
</tr>
<tr>
<td>Jump to File in File List</td>
<td></td>
</tr>
<tr>
<td>Drag Files into a Slide</td>
<td>CTRL+[drag + drop]</td>
</tr>
</tbody>
</table>

## Editing Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy</td>
<td>CTRL+C</td>
</tr>
<tr>
<td>Cut</td>
<td>CTRL+X</td>
</tr>
<tr>
<td>Paste</td>
<td>CTRL+V</td>
</tr>
<tr>
<td>Paste Into Slide</td>
<td>CTRL+SHIFT+V</td>
</tr>
<tr>
<td>Undo</td>
<td>CTRL+Z</td>
</tr>
<tr>
<td>Redo</td>
<td>CTRL+Y</td>
</tr>
<tr>
<td>Select All</td>
<td>CTRL+A</td>
</tr>
<tr>
<td>Select None</td>
<td>CTRL+ALT+A</td>
</tr>
<tr>
<td>Select Inverse</td>
<td>CTRL+I</td>
</tr>
</tbody>
</table>
### Keyboard Shortcuts

#### Main Workspace
- **Switch Workspaces**: `CTRL+Tab`
- **Build Workspace**: `ALT+F1`
- **Design Workspace**: `ALT+F2`
- **Publish Workspace**: `ALT+F3`
- **Thumbnail File List View**: `ALT+8`
- **Details File List View**: `ALT+9`
- **Toggle Folders**: `CTRL+SHIFT+F1`
- **Toggle Favorites**: `CTRL+SHIFT+F2`
- **Toggle File List**: `CTRL+SHIFT+F3`
- **Toggle Slide List**: `CTRL+SHIFT+F4`
- **Toggle Lightbox**: `CTRL+SHIFT+F5`
- **Toggle Preview**: `CTRL+SHIFT+F6`
- **Toggle Slide Inspector**: `CTRL+SHIFT+F7`
- **Toggle Publish Formats**: `CTRL+SHIFT+F8`
- **Toggle Size Meter**: `CTRL+SHIFT+F9`
- **Toggle Task Monitor**: `CTRL+SHIFT+F10`
- **Toggle Show Info**: `CTRL+SHIFT+F11`
- **Toggle Project**: `CTRL+SHIFT+F12`
- **Exit Program**: `ALT+X`

#### Preview Playback
- **Start / Pause Preview**: `Spacebar`
- **Stop Playback**: `Esc`
- **Full screen**: `ALT+Enter (while playing)`

#### Tools
- **Manage Effects**: `CTRL+E`
- **Collect Show Files**: `CTRL+ALT+C`
- **Remix Slides**: `CTRL+R`
- **Remix All Slides**: `CTRL+ALT+R`

#### Show Options
- **Show Settings**: `CTRL+H`
- **Show Background**: `CTRL+SHIFT+B`
- **Soundtrack**: `CTRL+M`
- **Watermark**: `CTRL+SHIFT+ALT+W`

#### Audio
- **Sync Show To Audio**: `CTRL+T`
- **Quick Sync**: `CTRL+Q`
- **Quick Sync to Track**: `ALT+Q`
- **Quick Sync Selected Slides**: `CTRL+SHIFT+Q`
- **Manage Soundtrack**: `CTRL+M`
<table>
<thead>
<tr>
<th>Action</th>
<th>Key Combination</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open Slide Options</td>
<td>CTRL+L</td>
<td>Set Slide Time</td>
</tr>
<tr>
<td>Nudge a Layer or Caption</td>
<td>CTRL+Arrow</td>
<td>Add Caption</td>
</tr>
<tr>
<td>Nudge More</td>
<td>CTRL+SHIFT+[drag in preview]</td>
<td>Add Gradient</td>
</tr>
<tr>
<td>Constrain Dragging</td>
<td>SHIFT+[drag in preview]</td>
<td>Add Image</td>
</tr>
<tr>
<td>Next Slide</td>
<td>Page Down</td>
<td>Add Solid Color</td>
</tr>
<tr>
<td>Previous Slide</td>
<td>Page Up</td>
<td>Add Keyframe</td>
</tr>
<tr>
<td>Next Layer or Caption</td>
<td>CTRL+Page Down</td>
<td>Add Multiple Keyframes</td>
</tr>
<tr>
<td>Previous Layer or Caption</td>
<td>CTRL+Page Up Down</td>
<td>Add Time to Keyframe</td>
</tr>
<tr>
<td>Next Keyframe</td>
<td>SHIFT+Page Down</td>
<td>Set Keyframe Time</td>
</tr>
<tr>
<td>Previous Keyframe</td>
<td>SHIFT+Page Up Down</td>
<td>Reset Slide</td>
</tr>
<tr>
<td>Zoom Layer or Caption In</td>
<td>CTRL+Plus</td>
<td>Reset All Keyframes</td>
</tr>
<tr>
<td>Zoom Layer or Caption Out</td>
<td>CTRL+Minus</td>
<td>Reset Keyframe Time</td>
</tr>
<tr>
<td>Duplicate Layer or Caption</td>
<td>CTRL+D</td>
<td>Scale Current Layer</td>
</tr>
<tr>
<td>Toggle Layer or Caption</td>
<td>CTRL+H</td>
<td>Vignette</td>
</tr>
<tr>
<td>Toggle All</td>
<td>CTRL+ALT+H</td>
<td>Crop</td>
</tr>
<tr>
<td>Keyframe Editor</td>
<td>CTRL+K</td>
<td>Jump to Slide</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Style in list</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Any Letter or Number</td>
</tr>
<tr>
<td>Slide List &amp; Timeline</td>
<td>Publishing Shows</td>
<td></td>
</tr>
<tr>
<td>----------------------</td>
<td>-------------------</td>
<td></td>
</tr>
<tr>
<td><strong>Toggle Timeline &amp; Slide List</strong></td>
<td>Publish Show</td>
<td>CTRL+P</td>
</tr>
<tr>
<td><strong>Shift Slide(s) Left</strong></td>
<td>Autorun Disc</td>
<td>+A</td>
</tr>
<tr>
<td><strong>Shift Slide(s) Right</strong></td>
<td>Executable</td>
<td>+E</td>
</tr>
<tr>
<td><strong>Combine Slides</strong></td>
<td>Facebook</td>
<td>+F</td>
</tr>
<tr>
<td><strong>Flag Slide(s)</strong></td>
<td>SmugMug</td>
<td>+M</td>
</tr>
<tr>
<td><strong>Goto Slide</strong></td>
<td>ProShow Gallery</td>
<td>+P</td>
</tr>
<tr>
<td><strong>Goto Next Flagged Slide</strong></td>
<td>Vimeo</td>
<td>+V</td>
</tr>
<tr>
<td><strong>Goto Next Slide</strong></td>
<td>YouTube</td>
<td>+Y</td>
</tr>
<tr>
<td><strong>Using File</strong></td>
<td>Capture Frame</td>
<td>CTRL+SHIFT+C</td>
</tr>
<tr>
<td><strong>Clear Flagged Slides</strong></td>
<td>Menu</td>
<td>CTRL+ALT+M</td>
</tr>
<tr>
<td><strong>Flag a Slide During Playback</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Add Range to Selection</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Show Soundtrack Controls</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Delete Slide(s)</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Reset Slide(s)</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Apply Effects to Slide(s)</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Scale Slide Layers</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Randomize Order</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Randomize Motion</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Randomize Transitions</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>CTRL+SHIFTF+R</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>CTRL+SHIFTE</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>CTRL+ALT+[1-5]</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>CTRL+SHIFT+1</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>CTRL+SHIFT+2</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>CTRL+SHIFT+3</strong></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
# Predefined Text Macros

<table>
<thead>
<tr>
<th>Macro</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>\F</td>
<td>Filename (with extension)</td>
<td>Photo001.jpg</td>
</tr>
<tr>
<td>\f</td>
<td>Filename (no extension)</td>
<td>Photo001</td>
</tr>
<tr>
<td>\e</td>
<td>Extension only</td>
<td>jpg</td>
</tr>
<tr>
<td>\R</td>
<td>Image resolution (pixels)</td>
<td>1600x1200 (16.7 M colors)</td>
</tr>
<tr>
<td>\W</td>
<td>Width in pixels</td>
<td>1600</td>
</tr>
<tr>
<td>\H</td>
<td>Height in pixels</td>
<td>1068</td>
</tr>
<tr>
<td>\T</td>
<td>File date</td>
<td>mm-dd-yy</td>
</tr>
<tr>
<td>\C</td>
<td>Current date</td>
<td>mm-dd-yy</td>
</tr>
<tr>
<td>\C</td>
<td>Number of colors</td>
<td>(16.7M colors)</td>
</tr>
<tr>
<td>\c</td>
<td>Numbers of colors (formatted)</td>
<td>16M</td>
</tr>
<tr>
<td>\b</td>
<td>Number of bits per pixel</td>
<td>24</td>
</tr>
<tr>
<td>\P</td>
<td>Total number of slides</td>
<td>[number]</td>
</tr>
<tr>
<td>\p</td>
<td>Current slide number</td>
<td>[number]</td>
</tr>
<tr>
<td>\S</td>
<td>File size in bytes</td>
<td>415135</td>
</tr>
<tr>
<td>\s</td>
<td>File size in Kb (kilobytes)</td>
<td>405K</td>
</tr>
<tr>
<td>\o</td>
<td>Folder name</td>
<td>Pictures</td>
</tr>
<tr>
<td>\d</td>
<td>Full path (no trailing backslash)</td>
<td>C:\Pictures</td>
</tr>
<tr>
<td>\D</td>
<td>Full path (with backslash)</td>
<td>C:\Pictures\</td>
</tr>
<tr>
<td>\</td>
<td>Single backslash (\)</td>
<td>\</td>
</tr>
</tbody>
</table>
Predefined Text Macros
# Supported File Types

## Supported Output Formats

### Video Disc Formats

<table>
<thead>
<tr>
<th>Format</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DVD</td>
<td>DVD video disc</td>
</tr>
<tr>
<td>Blu-ray</td>
<td>Blu-ray video disc</td>
</tr>
<tr>
<td>VCD</td>
<td>VCD video disc</td>
</tr>
<tr>
<td>SVCD</td>
<td>SVCD video disc</td>
</tr>
<tr>
<td>XVCD</td>
<td>XVCD video disc</td>
</tr>
<tr>
<td>XSVCD</td>
<td>XSVCD video disc</td>
</tr>
<tr>
<td>CVD</td>
<td>CVD video disc</td>
</tr>
<tr>
<td>MiniDVD</td>
<td>MiniDVD video Disc</td>
</tr>
</tbody>
</table>

### Disc Media

<table>
<thead>
<tr>
<th>Format</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CD-R</td>
<td>Recordable CD</td>
</tr>
<tr>
<td>CD-RW</td>
<td>Rewritable recordable CD</td>
</tr>
<tr>
<td>DVD+R</td>
<td>Recordable DVD</td>
</tr>
<tr>
<td>DVD+R DL</td>
<td>Recordable DVD Dual Layer</td>
</tr>
<tr>
<td>DVD+RW</td>
<td>Rewritable recordable DVD</td>
</tr>
<tr>
<td>DVD-R</td>
<td>Recordable DVD</td>
</tr>
</tbody>
</table>
### Supported File Types

<table>
<thead>
<tr>
<th>File Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DVD-R DL</td>
<td>Recordable DVD Dual Layer</td>
</tr>
<tr>
<td>DVD-RW</td>
<td>Rewritable recordable DVD</td>
</tr>
<tr>
<td>BD-R</td>
<td>Recordable Blu-ray</td>
</tr>
<tr>
<td>BD-RE</td>
<td>Rewritable Recordable Blu-ray</td>
</tr>
</tbody>
</table>

### File Formats

<table>
<thead>
<tr>
<th>Extension</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>.AVI</td>
<td>Windows video file</td>
</tr>
<tr>
<td>.EXE</td>
<td>Windows executable application</td>
</tr>
<tr>
<td>.SCR</td>
<td>Windows screen saver</td>
</tr>
<tr>
<td>.MPG</td>
<td>MPEG 1 video file</td>
</tr>
<tr>
<td>.MPG</td>
<td>MPEG 2 video file</td>
</tr>
<tr>
<td>.WMV</td>
<td>Windows video file</td>
</tr>
<tr>
<td>.MOV</td>
<td>QuickTime video file</td>
</tr>
<tr>
<td>.FLV</td>
<td>Flash video</td>
</tr>
<tr>
<td>.ISO</td>
<td>CD/DVD image file</td>
</tr>
<tr>
<td>.CUE</td>
<td>Video CD cue/bin image</td>
</tr>
<tr>
<td>.PX</td>
<td>Streaming Web Show</td>
</tr>
<tr>
<td>.3GP</td>
<td>Mobile device video file</td>
</tr>
</tbody>
</table>
# Supported Input Formats

**Video and Animation Formats**

<table>
<thead>
<tr>
<th>Format</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>.AVI</td>
<td>Windows video file</td>
</tr>
<tr>
<td>.M1V</td>
<td>Movie</td>
</tr>
<tr>
<td>.MOV</td>
<td>QuickTime video file</td>
</tr>
<tr>
<td>.QT</td>
<td>QuickTime video file</td>
</tr>
<tr>
<td>.MPE</td>
<td>MPEG video file</td>
</tr>
<tr>
<td>.MPEG</td>
<td>MPEG video file</td>
</tr>
<tr>
<td>.MPG</td>
<td>MPEG video file</td>
</tr>
<tr>
<td>.WMV</td>
<td>Windows video file</td>
</tr>
<tr>
<td>.GIF</td>
<td>Animated Compuserve graphic</td>
</tr>
<tr>
<td>.DIVX</td>
<td>DivX video file</td>
</tr>
<tr>
<td>.DVX</td>
<td>DivX video file</td>
</tr>
<tr>
<td>.XVID</td>
<td>XviD video file</td>
</tr>
<tr>
<td>.ASF</td>
<td>Advanced File Systems format</td>
</tr>
<tr>
<td>.MP4</td>
<td>MPEG 4 video file</td>
</tr>
<tr>
<td>.M2TS</td>
<td>MPEG 2 Transport Stream</td>
</tr>
<tr>
<td>.MTS</td>
<td>MPEG 2 Transport Stream</td>
</tr>
</tbody>
</table>
**Audio Formats**

- .OGG  Ogg Vorbis audio
- .MP3  MPEG 3 music file
- .WAV  Windows sound file
- .WMA  Windows audio file
- .M4A  MPEG4 audio file

**Photo and Image Formats**

- .BMP  Windows Bitmap image
- .DNG  Adobe Digital Negative
- .GIF  Compuserve Graphic
- .ICO  Windows Icon
- .JPEG  JPEG image
- .JPG  JPEG image
- .PNG  Portable Network Graphic
- .PSD  Adobe Photoshop image
- .PSP  Jasc PaintShop Pro image
- .RLE  Windows Bitmap image
- .TIF  Tagged Image File
- .TIFF  Tagged Image File
Other Formats

<table>
<thead>
<tr>
<th>Format</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>.FON</td>
<td>Windows font</td>
</tr>
<tr>
<td>.FNT</td>
<td>Windows font</td>
</tr>
<tr>
<td>.FOT</td>
<td>Windows font</td>
</tr>
<tr>
<td>.OTF</td>
<td>Windows font</td>
</tr>
<tr>
<td>.TTF</td>
<td>Windows font</td>
</tr>
<tr>
<td>.TTR</td>
<td>Windows font</td>
</tr>
</tbody>
</table>

Video Codecs

ProShow uses your system resources to help identify what types of videos you will be able to import and export into the program. The ability to use many types of videos often depends on having specific codecs installed on your PC.

The term "codec" is short for compression/decompression and refers to a specific method used to encode and play back video files.

If a video is encoded using a specific codec on PC #1, in order to view the video properly on PC #2, that same codec must be installed on the second computer.

As codecs are published by third parties, there is no guarantee that they will be compatible with ProShow. Definitely do your research before installing any codecs on your computer. Feel free to contact Photodex Customer Support if you have any video playback or codec questions.
RAW Files

RAW files are a class of file formats created and used by camera manufacturers in order to provide users with an extremely high quality, unaltered digital image.

RAW formats are often not well documented and typically change with the release of each new camera model. In general, camera manufacturers do not document when they change their formats.

ProShow Producer supports a variety of RAW formats, but as the exact specifications for RAW formats are always in flux, not all files will work properly. RAW support for new variants is added when possible, but is subject to the availability of supporting technical documentation from the various camera manufacturers.
Appendix 1

ProShow and Windows

ProShow is optimized to run on PCs using Windows 7 and 8. If you are using an older version of Windows, you should consider upgrading. While ProShow will run on systems using Windows XP or Vista, those operating systems are no longer supported by Microsoft.

Windows 64-bit Editions

ProShow has been tested with 64-bit versions of Windows 7 and 8, and it works normally.

Provided that you have properly working device drivers installed for all your computer's hardware, you should be able to run ProShow under 64-bit versions of Windows without problems. While ProShow itself is not 64-bit, users of 64-bit operating systems may experience slight improvements in performance from faster OS performance.

Installing ProShow

In most cases, you can install ProShow without any additional steps. Download and install ProShow as you normally would. In rare situations, you may need to take a couple extra steps to ensure a good installation. These steps are listed below.

Windows includes UAC (User Account Control). UAC adds additional protection by limiting what software can do on your computer without your permission. Since software needs your permission for some tasks (like installing), it is critical that you install ProShow with the correct permission and steps.
Almost all reports we hear of difficulties with installing, registering, and starting ProShow are easily fixed by installing using the instructions below.

1. Start with a clean installation
2. Use the latest release of ProShow
3. Install ProShow as an administrator
4. Run ProShow the first time as an administrator

**Step 1: Start With a Clean Installation**

If you’ve had ProShow installed on this computer before, uninstall it before you start. This will help ensure that Windows sets the right permissions when you install in the next few steps.

**In Windows 7:**

1. Click on **Start** and go to the **Control Panel** link on the right.
2. Find the **Programs** option, and click on **Uninstall** a program.
3. A list of your computer’s software is displayed. You can scroll down through this list until you locate **Photodex Presenter**. Right-click on **Presenter** and choose **Uninstall/Change**.
4. The **User Account Control** will ask for your permission, click **Continue**. When ProShow asks you whether you’re sure you want to uninstall, click **Yes**.
5. Perform the same Right-click / Uninstall action on the **ProShow** software in this **Programs** list. Once both ProShow and Presenter have been successfully uninstalled, you can close the Control Panel window.
In Windows 8.1:

1. Right-click on Start and select Programs and Features from the right-click menu. (Note: no need to go to control panel, this takes them directly to the uninstall screen)

2. A list of your computer's software is displayed. You can scroll down through this list until you locate Photodex Presenter. Right-click on Presenter and choose Uninstall/Change.

3. The User Account Control may ask for your permission, click Continue. When ProShow asks you whether you're sure you want to uninstall, click Yes.

4. Perform the same Right-click / Uninstall action on the ProShow software in this Programs list. Once both ProShow and Presenter have been successfully uninstalled, you can close the Programs and features window.

Step 2: Use the Latest Release

1. Visit the Photodex website to download the latest version of ProShow.

2. When you click the download-link, you'll be asked what you what to do with the file. Please click the Save button.

3. By default, Windows suggests saving files into the Downloads folder, but it's easier to find the installation file if you save it to the Desktop instead. Choose the Desktop as the target location, and then click the Save button.

4. Once the download has completed, Click the Close button, and close all Internet Explorer windows.
Step 3: Install ProShow as an Administrator

1. Right click on the file you just saved, and choose Run as Administrator.

2. Proceed through the instructions to install ProShow.

Step 4: Run ProShow for the First Time as an Administrator

When ProShow is opened for the first time, it performs a number of steps to initialize itself for your computer. To ensure this all goes smoothly, you should run ProShow as an administrator the first time you open it.

In Windows 7:

1. Right click on the shortcut for ProShow (either on your Desktop or in the Start Menu), and choose Run as Administrator.

In Windows 8:

1. Right click on the shortcut for ProShow (either on your Desktop or on the Start screen), and choose Run as Administrator from the menu bar across the bottom of the screen.

If you are a registered user of ProShow, or if you purchase ProShow at a later time, you'll want to Run as Administrator when you enter your registration keys to ensure that ProShow can properly save your registration information.

2. Right click on the shortcut for ProShow (either on your Desktop or in the Start Menu), and choose Run as Administrator.

3. Click the Activate Registration button on the Evaluation screen when ProShow starts.

4. Enter your registration information which was sent to you when you purchased the software. Click Activate.
Once you've run as an administrator the first time and successfully entered your registration key, you can run ProShow normally by just double-clicking on the icon. You do not need to run as an administrator every time.

**Additional Compatibility Steps If You Encounter Problems**

Installing correctly as described above should ensure that ProShow will run fine on almost all Windows 7 machines. However, if you continue to experience issues, you may be encountering something specific to your computer or operating system configuration. In rare cases like these, there are two additional steps you can take.

**Set ProShow to Always Run as Administrator**

If you want to ensure that ProShow is always run with sufficient administrative rights, there's an option inside the properties of the ProShow desktop icon, allowing you to select this software to always Run as an Administrator.

1. Right-click the ProShow icon, and click on Properties.
2. Choose the Compatibility tab on the top.
3. Check the box next to Run this program as an administrator, then click the Apply button at the bottom.
4. If you do not see this option, that's an indication that your user account is not set up as an administrator. Contact the person responsible for configuring your computer for assistance.

**Disable User Account Control (UAC)**

Windows 7 and 8 both feature User Account Control, also known simply as UAC. UAC is a security measure where Windows will prompt you at various times when settings change on your system. This helps to prevent unauthorized access to your computers settings and files, which is a common way that malicious software misbehaves.
Unfortunately, this feature can block third party software (like ProShow) from placing the necessary files in the right place, or from writing the program’s registry entries properly. In an attempt to prevent viruses and other malicious software from abusing your user account’s administrative privileges, Microsoft requires that you specify whether the software is actually allowed to be Run as an Administrator or not.

Running ProShow as an administrator fixes most registration issues with Windows. But occasionally, User Account Control can conflict with ProShow files during the initial installation process. To make sure that absolutely nothing can interfere with the installation of ProShow, a last-resort is to disable the UAC beforehand.

1. Go to the Control Panel, and click the icon next to User Accounts.

2. Click on Change User Account Control Settings.

3. In the UAC window, you'll see a slider that ranges from Always Notify down to Never Notify. Move the slider down to Never Notify.

4. Click Ok.

5. Your computer may require you to approve the change, and may want to reboot.

After the reboot, try installing ProShow again, using the steps listed above. Once you've gotten ProShow up and running without problem, just revisit the UAC screen and move the slider back to where it was.
End User License Agreement

THIS SOFTWARE LICENSE AGREEMENT IS A LEGAL AGREEMENT ("AGREEMENT") BETWEEN YOU ("CUSTOMER") AND PHOTODEX CORPORATION, A TEXAS CORPORATION ("PHOTODEX").

BY CLICKING ON "I AGREE" AND INSTALLING THE SOFTWARE, CUSTOMER AGREES AND IS SUBJECT TO THE LICENSE TERMS SET FORTH BELOW.

IF CUSTOMER DOES NOT ACCEPT THESE LICENSE TERMS, CUSTOMER MUST NOT INSTALL THE SOFTWARE.

Customer represents and warrants that Customer is authorized to bind himself or herself to the terms of this Agreement and has adequate legal capacity to enter into this Agreement. IF CUSTOMER IS BELOW THE AGE OF 18, CUSTOMER'S PARENT OR LEGAL GUARDIAN MUST REVIEW THIS AGREEMENT AND AGREE TO THIS AGREEMENT. THE SOFTWARE IS NOT INTENDED FOR CHILDREN UNDER 13. Customer affirms that Customer is either older than 13 years of age, or possess legal parental or guardian consent, and is fully able and competent to enter into the terms, conditions, obligations, affirmations, representations, and warranties in this Agreement, and to comply with the terms and conditions of this Agreement.

1. LICENSE GRANT.

In exchange for the fee for the Software paid by Customer to Photodex (the "Software Fee"), Photodex hereby grants to Customer a limited, non-exclusive, non-transferable license ("License") to use the ProShow Producer® software ("Software") in executable code form and any applicable installation manuals and other printed materials provided with the Software ("Documentation"), pursuant to the terms and conditions set forth herein. All rights not expressly granted are reserved by Photodex.

a. Copies. Customer may make one copy of the Software solely for backup purposes. Customer may NOT copy the Documentation.

b. Named User. Customer shall be designated to Photodex in writing during the ordering process to serve as the named user for this License.

c. Installation. Photodex hereby grants to Customer the right to install and use copies of this Software. The Software may be installed on one Computer, including a storage device as specifically set forth in this Section 1(c). Except as provided in Section 1(d), Customer may only install the Software once on a single Computer.
"Computer" shall mean a single microcomputer, computer terminal, network workstation or network file server. Only the Customer may use or otherwise run the Software, and the Software may not be shared, installed or used concurrently on different Computers. The Software is "installed" on a Computer when it is copied to the Computer's persistent storage device (such as a hard disk). The Software is in "use" when it is loaded into the Computer's temporary memory (i.e., RAM). Customer may install the Software on a Computer storage device such as a network server used only to install the Software on Customer's other Computers over an internal network, provided that Customer has a License for each separate Computer on which the Software is installed and used.

d. Portable Computer Use. In addition to the installation of the Software on Customer's primary Computer as set forth in Section 1(c) above, Customer may make one copy of the Software and install it on either a portable Computer or Customer's home Computer, for Customer's exclusive use (the "Portable Copy"). The Portable Copy may not be used concurrently with the copy of the Software on the primary Computer. The Portable Copy may not be installed or used after Customer is no longer the primary user on the primary Computer on which the Software was installed.

e. Software Activation. Customer must activate the License for the Software by entering the registration key as prompted by the Software and as otherwise instructed by Photodex. Customer's failure to follow the activation procedures correctly is a material breach of this Agreement and may cause the Software to lose functionality. Customer shall be required to supply certain information in order to activate Customer's copy of the Software. Customer may be required to re-activate the Software if Customer modifies Customer's Computer hardware, or installs the Portable Copy on another Computer. Software activation requires a connection between Customer's Computer and Photodex's server.

f. Password. Customer may be provided with one or more passwords to register or activate this Software. Passwords are unique to each Customer, and correspond to the Customer's name and contact information. Customer may not disclose or transmit Customer's registration key or password to any other party without prior permission from Photodex. CUSTOMER ALONE IS RESPONSIBLE FOR MAINTAINING THE CONFIDENTIALITY OF THE PASSWORD. Unauthorized disclosure of a password may constitute a federal copyright violation.

g. Evaluation License. If Customer has downloaded a trial version of the Software from the Photodex website, Customer has acquired an evaluation license to the Software (the "Evaluation License"). Under the Evaluation License, Customer is permitted to install the Software once on a single Computer. Under the Evaluation License, Customer is permitted to use the Software for a period of fifteen (15) days for
Customer's personal evaluation purposes only. Customer will be deemed to have an Evaluation License for all Software that has been provided to Customer by Photodex and for which Customer has not paid the Software Fee or has not been provided with a registration key. SOFTWARE PROVIDED UNDER AN EVALUATION LICENSE MAY NOT BE FULLY FUNCTIONAL AND CUSTOMER ASSUMES THE ENTIRE RISK AS TO THE RESULTS AND PERFORMANCE OF THE SOFTWARE. PHOTODEX WILL NOT UPDATE THE SOFTWARE, NOR WILL PHOTODEX SUPPORT THE SOFTWARE. THE SOFTWARE MAY CONTAIN CODE THAT WILL, AFTER A CERTAIN TIME PERIOD, DEACTIVATE THE SOFTWARE AND RENDER THE SOFTWARE UNUSABLE. ALTHOUGH THE SOFTWARE MAY WARN CUSTOMER OF THE TIME-FRAME IN WHICH IT WILL BE DISABLED, CUSTOMER ACKNOWLEDGES AND AGREES THAT THE SOFTWARE MAY BE DEACTIVATED OR RENDERED UNUSABLE WITH OR WITHOUT WARNING. Upon such deactivation, this Evaluation License will be considered terminated. Prior to deactivation of the Software, Customer may contact Photodex to convert the Evaluation License to a License pursuant to this Agreement by paying to Photodex the Software Fee and obtaining from Photodex the applicable registration key. Photodex may, in its sole discretion, terminate the Evaluation License at any time, whereupon this Agreement will be considered terminated.

2. AUTHORIZED USE.

   a. MPEG2 Restriction. ANY USE OF THIS SOFTWARE OTHER THAN CONSUMER PERSONAL USE IN ANY MANNER THAT COMPLIES WITH THE MPEG-2 STANDARD FOR ENCODING VIDEO INFORMATION FOR PACKAGED MEDIA IS EXPRESSLY PROHIBITED WITHOUT A LICENSE UNDER APPLICABLE PATENTS IN THE MPEG-2 PATENT PORTFOLIO, WHICH LICENSE IS AVAILABLE FROM MPEG LA, L.L.C., 250 STEELE STREET, SUITE 300, DENVER, COLORADO 80206.

   b. No Automated Use. Customer is strictly prohibited from automated or semi-automated use of the Software (i) on a remote server via the control of a remote server, (ii) by means of an automated or semi-automated program that simulates the actions of a person controlling the Computer on which the Software is executing, or (iii) by means of any program or process that operates the Software in an automated fashion. CUSTOMER HEREBY AGREES THAT THE DAMAGES TO PHOTODEX OF SUCH USE SHALL BE EQUAL TO THE SOFTWARE FEE FOR THIS LICENSE MULTIPLIED BY THE NUMBER OF UNAUTHORIZED USERS THAT ACCESSED THE SOFTWARE, PLUS ANY LEGAL FEES INCURRED BY PHOTODEX IN CONNECTION WITH THE RECOVERY OF SUCH DAMAGES.

   c. Software Controls. The Software may contain controls intended to prevent the unlicensed or illegal use of the Software. Customer hereby acknowledges such controls and agrees to follow instructions provided by Photodex regarding such
controls. The Software may store on Customer’s Computer information necessary to protect the Software against unlicensed or illegal use. Customer acknowledges and agrees that the Software may transmit information to Photodex for quality assurance purposes.

d. Equipment, Software and Connectivity Requirements. In order to use the Software, Customer is required, at Customer’s expense, to select, obtain, install, use and maintain equipment, software, internet connection and system configuration that meet Photodex’s specifications and instructions.

e. Restrictions. THIS AGREEMENT, THE LICENSE GRANTED HEREUNDER, AND THE SOFTWARE AND DOCUMENTATION MAY NOT BE ASSIGNED, RENTED, LEASED, SOLD, SUBLICENSED OR OTHERWISE TRANSFERRED BY CUSTOMER. Without the prior written consent of Photodex, Customer may not:

i. use, copy, modify, merge, and/or transfer copies of this Software or Documentation, except as provided in this Agreement;

ii. reverse engineer, reverse assemble or reverse compile this Software, data used by this Software, or any component thereof;

iii. sublicense, rent, lease, sell, transfer or assign this Software;

iv. distribute this Software or Documentation in any incomplete or altered form;

v. distribute this Software or Documentation for profit or fee;

vi. create derivative works of the Software or Documentation or any part thereof; or

vii. incorporate any part of this Software or Documentation as part or all of a product to be sold to others.

A VIOLATION OF THIS SECTION 2(E) WILL BE A BREACH OF A MATERIAL PROVISION OF THIS AGREEMENT. UPON VIOLATION, THIS LICENSE WILL AUTOMATICALLY TERMINATE AND PHOTODEX WILL HAVE THE RIGHT TO SEEK LEGAL ACTION AGAINST CUSTOMER.

f. Content. “Content” means any information, text, links, postings, creative material, photographs, image, video or audio files that Customer displays, stores or processes by use of the Software. Customer acknowledges that the Software may be used to display Content which is outside of the control of Photodex. By entering into this Agreement, Customer represents and warrants to Photodex that Customer is the
legal owner of all of the Content that Customer displays, stores or processes with the Software, or that Customer has received written permission or is otherwise authorized by law to display, store or process the Content from the legal owner. Photodex makes no representations or warranties to Customer about the Content and will not be in breach of this Agreement if the Content infringes upon or misappropriates the Intellectual Property rights of any other person or business entity. BY ENTERING INTO THIS AGREEMENT, CUSTOMER IS AGREEING TO INDEMNIFY AND TO HOLD PHOTODEX HARMLESS FROM ANY LOSSES, CLAIMS, LIABILITIES, EXPENSES, DAMAGES AND COSTS, INCLUDING REASONABLE ATTORNEYS' FEES, RESULTING FROM THE CONTENT BEING DISPLAYED, STORED OR PROCESSED BY THE SOFTWARE.

3. UPDATES.

Updates to the Software will be provided to Customer at Photodex's discretion for one (1) year at no charge. To use Software identified as an update, upgrade, or new version ("Update") of the Software licensed hereunder, Customer must have an active, paid-in-full License for the Software identified by Photodex as eligible for the Update. After Customer has been provided with an Update, Customer may continue to use the Software that formed the basis for Customer's Update eligibility; provided, however, that Photodex may terminate the License for such Software, in its sole discretion. The terms and conditions of this Agreement and the License granted hereunder shall apply to the Update. Customer acknowledges and agrees that Photodex's obligation to provide support, if any, shall be for the most recent Update to the Software provided to Customer.

4. CONFIDENTIALITY.

The Software and Documentation contain confidential information and trade secrets of Photodex. Customer will keep confidential and refrain from disclosing any and all technical information, know-how, and inventions disclosed by Photodex in relation to this License, except when, after, and to the extent that the information, know-how, and inventions are generally known to the public.

5. OWNERSHIP.

The Software, Documentation, and all related Intellectual Property (as defined below) are now and will remain the exclusive property of Photodex. All derivative works prepared from the Software, Documentation and all related Intellectual Property are now and will remain the exclusive property of Photodex. Photodex has the right to include trademark, copyright or other proprietary rights notices on the Software and Documentation and Customer may not obscure or remove such marks. "Intellectual Property" means any and all intellectual property associated with the Software and
Documentation and all related designs, formulas, procedures, methods, apparatus, ideas, creations, improvements, works of authorship, materials, processes, inventions, techniques, data, know-how, show-how, algorithms, programs, subroutines, tools, trademarks, patents and patentable materials, copyrights and copyrightable materials, and trade secrets. The Software, Documentation and all related Intellectual Property are protected by the copyright and other intellectual property laws of the United States and international copyright treaties. This License is not a sale of the Software. All materials, including but not limited to, any and all text, graphics, images, software code, screen layout and any other content are the copyrighted materials of Photodex Corporation. All rights reserved.

Customer’s Content, including Content created using the Software, and all Intellectual Property rights associated with the Content are and will remain Customer’s exclusive property.

6. TERM AND TERMINATION.

The term of the License to the Software is as indicated on Customer’s invoice or sales receipt or, if not otherwise specified, perpetual, subject to termination as further provided herein. Photodex may terminate this License if Customer fails to comply with any terms or conditions of this Agreement. In the event of termination, Customer shall destroy all Software and Documentation, and render unusable any backup or archival copy of the Software and Documentation. The provisions in Sections 4, 5, 7, 8, 9 and 11(f) shall survive the termination of this License and this Agreement.

7. NO WARRANTY.

PHOTODEX MAKES NO WARRANTY OF ANY KIND REGARDING THE SOFTWARE OR DOCUMENTATION. PHOTODEX EXPRESSLY DISCLAIMS, TO THE EXTENT PERMITTED BY LAW, ALL IMPLIED WARRANTIES, INCLUDING ANY IMPLIED WARRANTY OF MERCHANTABILITY (INCLUDING, BUT NOT LIMITED TO MERCHANTABILITY OF COMPUTER PROGRAMS), FITNESS FOR PARTICULAR PURPOSE, OR OF NON-INFRINGEMENT, WARRANTIES OF NONINTERFERENCE WITH INFORMATION, AND ACCURACY OF INFORMATIONAL CONTENT. COMPETING CLAIMS MAY EXIST AND PHOTODEX GRANTS ONLY SUCH RIGHTS AS IT ACTUALLY POSSESSES. EXCEPT FOR THE EXPRESS WARRANTIES STATED IN THIS AGREEMENT, IF ANY, THE SOFTWARE IS PROVIDED WITH ALL FAULTS, AND THE ENTIRE RISK AS TO SATISFACTORY QUALITY, PERFORMANCE, AND ACCURACY IS WITH CUSTOMER. THE ONLY REPRESENTATIONS OR WARRANTIES MADE TO CUSTOMER ARE THOSE EXPRESSLY MADE BY PHOTODEX IN THIS AGREEMENT. OCCASIONAL SOFTWARE ERRORS OR OMISSIONS MAY OCCUR. SOME STATES DO NOT ALLOW LIMITATIONS ON IMPLIED WARRANTIES SO THESE LIMITATIONS MAY NOT APPLY TO CUSTOMER. THE WARRANTIES SET FORTH HEREIN
GIVE CUSTOMER SPECIFIC LEGAL RIGHTS AND CUSTOMER MAY HAVE OTHER RIGHTS WHICH VARY FROM STATE TO STATE. PHOTODEX SHALL NOT BE LIABLE FOR ANY DELAY, FAILURE IN PERFORMANCE OR INTERRUPTION OF THE SOFTWARE RESULTING DIRECTLY OR INDIRECTLY FROM ANY CAUSE BEYOND ITS REASONABLE CONTROL.

8. REMEDIES AND LIMITATION OF LIABILITY.

   a. Exclusive Remedy. Photodex's entire liability and Customer's exclusive remedy for any breach of this Agreement or for any other liability relating to the Software shall be, at Photodex's option from time to time exercised subject to applicable law, (i) return of the Software Fee, or (ii) replacement of the Software that is returned to Photodex with a copy of Customer's invoice or sales receipt. Customer will receive the remedy elected by Photodex without charge, except that Customer is responsible for any expenses Customer may incur, including, for example, the cost of shipping the Software to Photodex. This remedy is not available to Customer if failure of the Software has resulted from accident, abuse, misapplication, abnormal use or a virus.

   b. Limitation of Liability. UNDER NO CIRCUMSTANCES AND UNDER NO LEGAL THEORY, INCLUDING TORT, STATUTE, CONTRACT, OR OTHERWISE, SHALL PHOTODEX OR ITS LICENSORS OR THEIR AFFILIATES BE LIABLE TO CUSTOMER OR ANY OTHER PERSON FOR ANY DIRECT, INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES OF ANY CHARACTER, INCLUDING, WITHOUT LIMITATION, DAMAGES FOR LOSS OF PROFITS, DATA, GOODWILL, WORK STOPPAGE, COMPUTER FAILURE OR MALFUNCTION, OR ANY AND ALL OTHER DAMAGES OR LOSSES, EVEN IF PHOTODEX WAS ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. CUSTOMER MAY NOT BRING ANY CLAIM OR ACTION, REGARDLESS OF THE FORM THEREOF, ARISING FROM OR RELATING TO THE SOFTWARE OR THIS AGREEMENT, MORE THAN ONE (1) YEAR AFTER THE DATE OF THE EVENT FROM WHICH THE CLAIM OR ACTION ARISES OR ACCRUES.

9. INDEMNIFICATION.

CUSTOMER WILL INDEMNIFY, DEFEND, AND HOLD HARMLESS PHOTODEX, INCLUDING ITS OFFICERS, DIRECTORS, EMPLOYEES, AFFILIATES, LICENSORS, SUPPLIERS, INFORMATION PROVIDERS, AND AGENTS FROM AND AGAINST ALL LOSSES, CLAIMS, LIABILITIES, EXPENSES, DAMAGES AND COSTS, INCLUDING REASONABLE ATTORNEYS' FEES, RESULTING FROM ANY VIOLATION OF THIS AGREEMENT OR ANY ACTIVITY RELATED TO THE SOFTWARE (INCLUDING NEGLIGENT OR WRONGFUL CONDUCT) BY CUSTOMER OR BY ANY OTHER PERSON ACCESSING THE SOFTWARE AT CUSTOMER'S INSTRUCTION.
10. LEGAL NOTICES AND PRIVACY POLICY.

This Agreement supplements the Legal and Privacy notices on the Photodex website (the "Site"), which may be accessed here: http://www.photodex.com/about/legal. If there is any conflict or contradiction between this Agreement and the Legal and Privacy notices, this Agreement will be controlling. Additionally, the Photodex Privacy notice on the Site describes Photodex's information gathering and dissemination practices, which may be accessed at http://www.photodex.com/about/privacy.

11. MISCELLANEOUS.

   a. No Third Party Beneficiaries. NOTHING EXPRESS OR IMPLIED IN THIS AGREEMENT IS INTENDED TO CONFER, NOR SHALL ANYTHING HEREIN CONFER, UPON ANY PERSON OTHER THAN PHOTODEX AND CUSTOMER AND THE RESPECTIVE SUCCESSORS OR ASSIGNS OF PHOTODEX, ANY RIGHTS, REMEDIES, OBLIGATIONS OR LIABILITIES WHATSOEVER.

   b. Force Majeure. Photodex will not be responsible for any delay or failure to perform the obligations in this Agreement if the delay or failure is caused by fire, flood, explosion, war, embargo, government requirement, civil or military authority, act of God, third party vendors, failure of telecom systems not owned or directly leased by Photodex, or other similar causes beyond Photodex's control.

   c. Entire Agreement. This Agreement is the entire agreement between Customer and Photodex about Customer’s use of the Software. There are no other representations, warranties, terms, agreements or conditions, written or oral, made about Customer’s use of the Software.

   d. Assignment. CUSTOMER AGREES THAT CUSTOMER WILL NOT ASSIGN, SUBLEASE OR TRANSFER THIS AGREEMENT, NOR ANY RIGHTS UNDER IT, IN WHOLE OR IN PART, WITHOUT PHOTODEX’S PRIOR WRITTEN CONSENT. PHOTODEX MAY ASSIGN THIS AGREEMENT AND ANY OBLIGATIONS UNDER THIS AGREEMENT.

   e. Governing Law; Venue; Waiver of Right to Jury Trial. This Agreement, and the relationship between Customer and Photodex, and any litigation between Customer and Photodex, whether grounded in contract, tort, statute, law or equity, shall be governed by, construed in accordance with, and interpreted under the laws of the State of Texas, without giving effect to its choice of laws principles. CUSTOMER AND PHOTODEX AGREE THAT VENUE FOR ANY LITIGATION OR LEGAL PROCEEDINGS UNDER THIS AGREEMENT WILL BE IN TRAVIS COUNTY, TEXAS. CUSTOMER AND PHOTODEX HEREBY AGREE TO WAIVE RIGHT TO A JURY TRIAL FOR ANY CLAIM OR CAUSE OF ACTION BASED UPON OR ARISING OUT OF THIS AGREEMENT. The scope of this waiver is intended to be all encompassing of any and all disputes that may be
filed relating to the relationship between Customer and Photodex relating to this Agreement, including contract claims, tort claims, breaches of duty, common law and statutory claims.

f. Severability. If any part of this Agreement is held to be invalid or unenforceable by a court, arbitrator or a regulatory agency, or as a result of advice of legal counsel for Photodex, the invalidity or unenforceability will not affect or impair the validity and enforceability of the remainder of this Agreement. Customer and Photodex agree that the arbitrator or court making the determination will have the power to alter or amend the provision so that it will be enforceable or, in the case where an arbitrator or court is not involved, Customer and Photodex will, in good faith, renegotiate valid and enforceable substitute provisions, and the provisions will reflect as closely as possible the intent of the original provisions of this Agreement.

g. Compliance with Laws. Customer will comply with all applicable domestic and international laws, statutes, ordinances and regulations regarding Customer’s use of the Software. In particular, Customer (i) represents that he or she is not a party identified on any government export exclusion list, including the U.S. Denied Persons, Entity and Specially Designated Nationals Lists, nor will Customer transfer software, technology, and other technical data via the Software to parties identified on such lists; (ii) agrees not to use the Software for military, nuclear, missile, chemical or biological weaponry end uses in violation of U.S. export laws; and (iii) agrees not to transfer, upload, or post via the Software any software, technology or other technical data in violation of U.S. or other applicable export or import laws.

h. US Government. The Software is commercial computer software developed solely at private expense. The rights of civilian and non-civilian agencies of the U.S. Government to use, disclose and reproduce the Software are governed by the terms of this Agreement. Publisher is Photodex Corporation, 4030 W. Braker Ln. Bldg 2, Suite 100, Austin, Texas 78759, USA.

i. Language. If Customer is located outside the United States, then the following provision applies: Les parties aux présentes confirment leur intention que cette convention ainsi que tous les documents afférents soient redigés dans la langue anglaise. (Translation: "The parties confirm that this Agreement and all related documentation is and will be in the English language.")
12. NOTICES AND CONTACT INFORMATION.

Customer may contact Photodex to provide written notice and with comments, questions or requests by email, fax or mail. Customer acknowledges and agrees that Photodex will provide Customer with written notice under this Agreement via email, unless otherwise provided by fax or mail, in Photodex’s sole discretion.

E-mail: http://www.photodex.com/contact
Fax: (512) 452-6825
U.S. Mail: Photodex Corporation
4030 W. Braker Ln. Bldg 2 Suite 100
Austin, Texas 787589
## Index

### Adjustment Effects, 186, 189
- applied to captions, 234, 235, 236
- Black Point, 189
- Blur, 189
- Brightness, 189
- Colorize, 189
- Contrast, 189
- Hue, 189
- Opacity, 189
- Saturation, 189
- Sharpen, 189
- White Point, 189

### Adjustment Layers
- basics, 421
- Grayscale, 422
- set layer type, 159
- Transparency, 425
- types, 422

### Aspect Ratio
- 16x9 (Widescreen), 79
- 4x3 (TV), 79
- custom, 80

### Audio
- adding music to a show, 262
- automatically fade music at end of show, 264
- DRM, 44
- editing music and sounds, 288
- sound effects. See Slide Sounds
- Soundtrack, 44
- supported files, 261
- sync audio, 269
- Timeline View, 293

### Audio Trimmer, 288, 289
- add a trim marker, 290
- making precise edits, 291
- non-destructive edits, 291
- previewing changes, 291
- set start and end times, 290
- setting fade times, 292
- trim using the mouse, 292
- zoom slider, 289

### Autorun Disc, 605
- menus, 611

### Backup Files, 106, 671
- autosaves, 671
- BAK files, 106
- revert to a backup, 107

### Blu-ray, 516
- burning, 538
- create, 517
- menus, 611
- output options, 532
- use custom disc icon, 532
- video settings, 531

### Blu-ray burning, 538
- Blu-ray writer, 538
- Disc Label, 538
- Include Additional Content, 539
- Include Original Files, 539
- ISO Image File, 538
- Multiple Copies, 538
- Speed, 538
- Troubleshooting, 539

### Blu-ray Type, 531

### Branding
- about show, 596
- custom icon, 596
- load / save, 597
- options, 594
- progress bar, 595
- title bar, 596

### Caption Behaviors, 42, 219
- choose behaviors, 220
- Fly In, 42, 219
- Fly Out, 42, 219
- keyframing, 458
- Normal, 219
- reset behaviors, 222
show behaviors combined, 222
Text Layers, 459
using Keyframe Timeline, 458, 459

Caption Effects
adjustment effects, 234, 235
create, 396
expand effects values, 442
motion effects, 234, 235
practical example using keyframes, 473

Caption Motion Effects, 234, 235, 239, 395
character rotate, 397
Character Rotate, 235
Font (zoom), 235, 397
Position (pan), 235, 397
rotate, 397
Rotate, 235

Caption Styles, 222
applying, 223
creating, 223
deleting, 226
update existing styles, 225
using, 223

Caption Texture
adding a gradient, 240
adding an image, 240
Scaling, 241
Use Texture on Caption, 240

Captions, 40
Add Title Slide, 64
adding, 214
alignment, 217
as text, 213
bold and italics, 216
Caption Behaviors, 219
Caption Format, 41, 215
Caption Placement, 41, 217, 229
Caption Setup, 228
Captions or Text Layers, 260

Case, 215
character rotate, 231
character spacing, 231
convert to Text Layer, 215, 249
copy captions, 652
create a Title Slide, 214
Effects, 234, 236
font, 215
imported from service or app, 113, 142
include with Slide Transition, 228
interactive options, 246
interactivity, 246
line spacing, 231
macros, 242
motion, 395
opacity, 230
Outline, 226
position, 218
rotate, 230
Selected Caption Text, 41, 215
Shadow, 226
Show Caption, 227, 228
Size, 215
skew, 230
texturing, 239
visibility, 227

Captions List, 40, 214, 227
add caption, 227
Captions List Menu, 227
remove caption, 227

Collect Show Files, 109

Color Profiles
choosing, 633
disc output, 534
uses, 631

Copy
captions, 652
copy settings, 653
layers, 154, 650
Paste Into, 649
Slide Styles, 650
slides, 649
using right-click, 655

**Copy Settings, 155, 389, 653**
- between captions, 653
- between keyframes, 653
- between layers, 653
- between slides, 653
- keyframe settings, 446
- open copy settings, 655
- using, 654

**Custom Video Files**
- compression options, 556
- create, 551, 555
- display options, 560
- preset video formats, 553, 555
- resolution and framerate, 559
- understanding video files, 551

**Disc Output**
- adding shows, 522
- Anti-Flicker, 529
- audio type, 528
- Blu-ray options, 531
- Blu-ray output options, 532
- burning, 520, 535
- collecting, 520
- Color Profiles, 534
- creating, 517
- creating menus. See Menus
- desaturation, 530
- DVD options, 527
- Executable. See Executable intro show. See Intro Show
- remove shows, 523
- rendering, 519
- Size Meter, 523
- troubleshooting, 537, 539
- TV System, 528
- VCD output options, 533
- Video CD options, 533
- Video Clip Quality, 530
- what goes on a disc, 520, 522

**Download Only, 141**

**DVD, 515**
- burning, 535
- create, 517
- Create DVD, 48
- DVD options, 527
- menus, 611

**DVD burning, 535**
- Bisetting, 537
- Disc Label, 536
- Disc Type, 535
- DVD writer, 535
- Include Additional Content, 536
- Include Original Photos, 536
- ISO Image File, 535
- Multiple Copies, 536
- Speed, 535
- Troubleshooting, 537

**DVD Type, 527**

**Editing Options**
- Adjustments, 172
- Editing Tools, 172
- non-destructive editing, 171

**Effects, 127, 186**
- Adjustments, 129, 186
- applying effects, 130, 190
- caption effects, 234
- caption motion, 395
- categorize, 327, 352
- Favorites, 329, 353
- manage, 323, 347
- manage effects, 136
- Motion, 128, 186, 365, 366
- Slide Styles, 130, 309
- The Effects (FX) Window, 136
- Transitions, 128, 339

**Effects (FX) Window**
- applying effects, 131, 132
- create effects, 136
- manage effects, 136
- open FX window, 64, 136

**Executable**
- actions at end of slide, 597
- Autorun Disc, 605
- branding, 594
- create, 589
creating interactive shows, 600
Email a show, 606
manual playback control, 599
menus, 590, 611
on screen controls, 592
options, 590
playback, 591
protection, 593
quality, 592
Screen Saver, 605
Facebook, 564
import files from Facebook, 113, 140
upload a show, 564
video information, 565
video quality, 565
File List, 30, 60
Adding Files to a Show, 62
Adding Files to Placeholders, 62
sort, 61
thumbnail size, 61
Find Missing Files, 107
Flash
create, 576
menus, 611
options, 576
uploading a show to your website, 578
web page options, 579
Folder List, 29, 59
Favorites, 59, 71
Imported Content, 60
Media Sources, 60
Import Content from Service or App, 140
Add to Show, 141
All or None, 141
Download Captions, 141
download location, 143
using the ProShow Remote App, 142
using the Wizard, 113
Imported Content
Folder List, 60
Information Bar, 55
using projects, 645
Intro Show, 524
use custom show, 525
Keyframe Editor, 444, 478
Keyframe Previews
active preview, 432
navigation preview, 432
preview canvas size, 434
previewing effects, 460
previews, 432
scubbing through preview, 460
Three Previews mode, 433
Two Previews mode, 433
Keyframe Selector Ribbon, 440
Keyframe Timeline, 435
default keyframes, 438
keyframe numbering, 439
Pause Motion, 471
Pause Motion Until Here, 469
set keyframe time, 451
Show Keyframes as Show Time, 436, 479
Time Format, 436
Keyframe Toolbar
Keyframe Toolbar, 443
keyframe types. See Keyframe Types
Keyframe Types
matched keyframe, 439
normal keyframe, 439
selected keyframe, 439
Temporary keyframes, 439, 463
Keyframing
accessing Effects, 430
add / remove time, 452
auto and manual settings, 461
Caption Behaviors, 458
caption visibility, 455
Convert to Static Keyframe, 463
copy effects between keyframes, 446
create multiple, 448
create new keyframes, 447
delete, 449
Effects values, 442
expand Effects values, 442
layer transition. See Layer Transitions
layer visibility, 454
move to another keyframe, 450
select, 450
Keyframing Basics
creating adjustments, 429
creating motion, 429
explanation, 427
how keyframes are used, 429
understanding, 428
Keyframing Example
using adjustments, 472
using captions, 473
using motion, 465
using Soundtrack, 480
Keyframing Soundtrack
Soundtrack control slider, 479
volume control points, 307, 485
Keyframing Tools
Keyframe Effects values, 431
Keyframe indicators, 431, 441
Keyframe Selector Ribbon, 431
Keyframe Timeline, 431
Keyframe Toolbar, 431, 434
previews, 431
Layer
add new layer to existing slide, 143
adding, 139
adding multiple layers at once, 144
adjusting using the preview, 166
basics, 137, 139, 252
copy layers, 650
default image settings, 676
editing and adjustments, 170
Gradient layer settings, 201
Gradient layers, 196
Import Content from Service or App, 52, 64, 140
imported content download location, 143, 679
interchangeable layers, 138
Layer Setup, 160
Layer Type, 159
layers stack, 137
Live Image, 604, See Live Show
making changes to a layer, 157
Notes, 158
position, 163
rename, 153, 158
reset a layer, 155
right-click to add layers, 145
scaling, 160
Solid Color Layers, 194
Text Layers, 149, 150, 249
transparency, 193
using a Gradient with Adjustment Layers, 422
using a Gradient with masking, 410
visibility, 153
zoom, 165
Layer Adjustments, 172
Black Point, 172
Blur, 172
Brightness, 172
Contrast, 172
Opacity, 172
Saturation, 172
Sharpen, 172
White Point, 172
Layer Editing Tools
Index

Chroma Key, 180
Colorize, 184
Crop, 178
Flip, 173
Outline, 185
Red-Eye, 176
Rotate, 173
Shadow, 185
Vignette, 174, 403

Layer Scaling, 160
Fill Frame, 161
Fit and Fill to Safe Zone, 162
Fit To Frame, 161
Stretch to Frame, 162

Layer Transitions, 456
set timing, 457
setting up, 457
Text Layers, 459

Layers List, 147
add Adjustment layer, 152
add from Media Source, 152
add Gradient, 151
Add Image or Video, 151
add layer, 151
add Masking layer, 152
add Placeholder, 151
add Solid Color, 151
add text layer, 250
add Text Layer, 151
adding layers, 146, 149
adding text layers, 150
Duplicate layer, 152
Layers List Menu, 153
reading masking and
adjustment layers, 148
reading text layers, 149
reading the layers list, 147
remove a layer, 152
replace a layer, 150
toggle layer, 147
tools, 151

Lightbox, 70
Live Show, 601
Configure Folder, 602
Live Image, 601
Playback Settings, 603
set layer type, 159

Masking Layers
access masking options, 401
create, 401, 407
create Grayscale mask, 410
create text layer mask, 417
create Transparency mask, 414, 417
Grayscale mask, 409
inverted masks, 413
masking basics, 399
masks in the layers list, 405
moving layers in and out of masks, 406
practical uses, 419
set layer type, 159
Transparency mask, 404, 412
types of masks, 408
using motion, 416
using text layers, 417
using video, 416
visibility, 405

Media Sources
Imported Content, 143, 679
managing, 53, 60

Menu Bar, 52
Audio tools, 53
Edit options, 52
File open and save, 52
Help, 53
Publish, 53
Show Options, 53
Slide Options, 53
Tools, 53
Window settings, 53

Menu Options
Branding, 518
 Burning, 518
Executable, 518
Menu, 518
Options, 518
Shows, 518
Menus
adding layers to page, 622
adding menu pages, 618
adding shows to page, 620
available shows, 620
configuring captions, 624
creating, 612
creating a custom menu, 617
customizing layers, 623
customizing menu pages, 619
getting started, 611
interactive layers, 623
interactive options, 625
loading custom menus, 627
menu preview, 615
menu settings, 613
MNU menu files, 627
navigating between menu pages, 619
remove menu pages, 619
remove shows from a page, 621
reset a menu, 615
saving custom menus, 627
saving themes and layouts, 628
selecting layouts, 614
selecting themes, 612
show thumbnail effects, 621
using multiple shows, 614

Modifier Actions, 494
Add to Modifier, 494
Divide Modifier, 494
Multiply Modifier, 494
Subtract from Modifier, 494

Modifier Amounts, 495
Amount from Function, 496
Constant, 495
Variable, 496

Modifier Functions
Block Wave, 497
Cosine Wave, 497
Linear Ramp, 498
Quadratic Curve, 499
Random Wave, 498
Sawtooth Wave, 498
Sine Wave, 497
Triangle Wave, 498

Modifier Waveform
Interactive Fade Lines, 513
Preview, 500, 503
Value Bar, 502

Modifiers, 487
adding, 489
advanced options, 510
amounts for actions, 495
copying modifiers, 510
creating actions, 493
description, 487edit, 490
eexample, 505, 507
Keyframe Timeline, 501
modifier window, 490
options, 491
remove, 489
types, 488
types of actions, 494
what can be modified, 489

Motion
basic information, 365
controlling Soundtrack, 398
copy motion, 389
create motion, 374, 385
default motion settings, 676
effects, 366
expand effects values, 442
identify a keyframe, 371
Keyframing, 398
matching, 391
motion options, 374
motion speed, 392
randomize, 394
remove, 393
show motion path, 384, 433
time and motion, 366
timeline, 369
using modifiers, 398

Motion Effects, 186
caption motion, 234
Curve, 187, 383
Horizontal Tilt, 188, 382
Pan, 187, 379
Rotate, 188, 382
Rotate Center, 383
Rotation Center, 188
Soundtrack, 189
Vertical Tilt, 187, 381
Zoom, 187, 380
Zoom unlock X and Y, 187

**Motion Previews, 368**
active preview, 370
changing preview modes, 372
creating motion using the
previews, 377
preview motion effects, 378	hree previews mode, 372
two previews mode, 373

**Motion Speed, 392**
Accelerate, 393
Decelerate, 393
Linear, 392
Smooth, 393

**PC Playback, 587**
Autorun Disc, 588
Executable, 587
options, 587
Video, 588

**Photodex Presenter**
what it is, 583

**Preferences, 62, 107, 657**
appearance, 660
Autosaves, 671
color profiles, 665
default slide settings, 675
Direct Draw, 663
eXternal applications, 669
Favorites folder, 672
GPU Accelerated rendering,
663
internet options, 673
keyboard and remotes, 670
miscellaneous options, 671
open preferences, 658
playback, 663
preview monitor, 665
prompts, 673
ProShow Remote App, 668
rendering, 664
show defaults, 675
sound effects, 666
start up options, 672
thumbnail settings, 667
time format for timelines, 675
upgrades, 671
video importing, 664

**Presenter Show, 579**
create, 580
upload a show to your
website, 580
web page options, 583

**Preview Options**
Composition Lines, 90
Define Grid, 91
show Grid lines, 91

**Projects, 635**
enable projects, 644
opening, 648
PPR project files, 647
project files, 647
saving, 647
tabs in information bar, 645
the Project Pane, 69
uses, 643
using Project Pane, 645

**ProShow Gallery, 573**
menus, 611
options, 574
publishing a show, 573
sharing your shows, 574
uploading, 574

**ProShow Remote App, 53, 677**
additional tools, 683
advanced connection settings,
connecting to the app, 678
control playback on desktop, 682
import files into a show, 142, 679
import files using the Wizard, 114
imported content download location, 143, 679
Preferences, 668
requirements, 677
save video to device camera roll, 681
saving shows to a device, 549, 680
tips for using the app, 684

ProShow Web
import from ProShow Web, 52

PSH Show File, 105

Publishing Formats
Adobe Flash, 576
all publishing formats, 609
Autorun Disc, 605
Blu-ray, 516
custom video files, 551
eDVD, 515
Email, 606
Executable, 589
Facebook, 564
for PC playback, 587
for TV, 515
for Web, Devices and Computers, 542, 563
Presenter Show, 579
ProShow Gallery, 573
Screen Saver, 605
SmugMug, 569
Still Frame Capture, 607
Templates, 635
Video CD, 516
video output, 541
Vimeo, 571
YouTube, 566

Publishing Shows

Publishing Formats, 69

ProShow Web
import from ProShow Web, 52

PSH Show File, 105

Publishing Formats
Adobe Flash, 576
all publishing formats, 609
Autorun Disc, 605
Blu-ray, 516
custom video files, 551
eDVD, 515
Email, 606
Executable, 589
Facebook, 564
for PC playback, 587
for TV, 515
for Web, Devices and Computers, 542, 563
Presenter Show, 579
ProShow Gallery, 573
Screen Saver, 605
SmugMug, 569
Still Frame Capture, 607
Templates, 635
Video CD, 516
video output, 541
Vimeo, 571
YouTube, 566

Publishing Shows

PXC Cached Show File, 106
Redo, 46
Remix, 395

Saving Shows
Save Toolbar Icon, 47

Screen Saver, 605

Show Background, 87
adjusting and editing, 88
Background Source, 87

Show Options, 75
open Show Options, 76
Show Background, 77
Show Settings, 77
Soundtrack, 77
Watermark, 77

Show Settings, 77
Aspect Ratio, 79
safe zone, 82
Set Random Transitions, 84
Show Information, 85
show Notes, 78
Show Thumbnail, 81
show Title, 78

Size Meter, 68

Slide, 93
Add Blank Slide, 64
Background, 93, 156
captions, 93, 94
change slide timing, 98
change times using the Timeline View, 299
combine slides, 649
copy slides, 649
default duration, 675
Edit Slide, 64
flag a slide, 103
layers, 93, 94
lock a slide time, 99
Remix slides using the Wizard, 121
rename a slide, 102
reset a slide, 65
shift order, 95  
slide notes, 103  
slide sound, 93  
Slide Time, 32  
Styles, 94  
total slide time, 96, 97

**Slide Inspector, 66**

**Slide List, 31, 55**  
drag and drop, 31  
playback indicator, 34

**Slide Options, 39, 99**  
Adjustments, 157  
Background + Sound, 100  
Captions, 100  
Effects, 157  
Layers, 100  
Layers Settings, 157, 158, 255  
Play icon, 43  
preview controls, 221  
Slide Settings, 100  
Slide Styles, 100  
Toolbar, 101

**Slide Sounds**  
adding, 266  
adding a voice over, 285  
Continue playback, 283  
controlling sounds with the  
Timeline View, 300  
default volume and fade  
settings, 279  
Edit Fades and Timing, 284  
offset time, 283  
remove a slide sound, 284  
Sound Timing, 283  
sync sound and slide times,  
283  
volume options, 282

**Slide Styles, 37, 130, 309**  
access slide styles, 309  
adding, 324  
applying Slide Styles, 132, 133  
applying to multiple slides,  
316  
aspect ratio, 314, 336  
backing up, 332  
categorize, 327  
copy styles between slides,  
650  
create, 319, 325  
edit, 326  
export, 330  
Favorites, 316, 329  
FX window information, 132  
hide, 327  
import, 325  
include content when  
creating, 322  
making changes to styles, 317  
managing, 323  
preview, 312  
PXS Styles files, 333  
reading style entries, 315  
remove, 326  
replace or update, 331  
replaceable layer, 159  
Selected Slide Style, 313  
settings not saved, 335  
structure, 333  
styles list, 313  
Styles List, 311  
Styles List filters, 314  
Text Layers, 259  
undo a style, 323

**Smug Mug, 569**  
upload a show, 570, 571  
video quality, 570

**Social Media**  
import files from Social Media  
Services, 113, 140  
sharing shows online, 563  
uploading a show to  
Facebook, 564  
uploading a show to YouTube,  
566  
using Twitter to announce a  
show upload, 566

**Soundtrack, 89, 263**  
add or remove soundtrack, 89
adding multiple tracks, 263
Audio Trimmer, 288
automatically fade Soundtrack at End of Show, 264
controlling volume with keyframes, 280
crossfade tracks, 301
duplicate soundtrack, 89
Edit Fades and Timing, 280, 288
master show volume, 277
offset times, 281
Quick Sync - Entire Show, 270
Quick Sync – Entire Show, 45
Quick Sync – Selected Slides, 271
Quick Sync – Selected Slides to Track, 272
record slide timing, 276
Save Music from CD, 267
Soundtrack Bar, 263
Soundtrack During Slide Sounds, 279
soundtrack volume, 278
Sync Slides to Audio, 273
syncing audio to a beat, 275
syncing options, 274
syncing the soundtrack to a show, 269
video clips with audio, 286
Soundtrack Bar, 44, 56, 263
Still Frame Capture, 607
options, 607
Support
check for upgrades, 688
contacting Photodex, 687
sending problem report, 687
Task Monitor, 63
Templates, 635
adding images, 638
creating new, 639
downloading, 636
importing / exporting, 641
including files, 640
manage templates, 53
opening, 637
replacable layer, 159
uses, 635
Text Layers, 149, 249
add from Layers List, 250
adding, 150, 151, 249
Adjustments, 256
convert caption to text layer, 215, 249
Effects and Text Effects, 256
example using Text Layers, 257
keyframing, 459
Layer Settings, 252, 255
masking with text layers, 417
reading text layers, 149
Slide Styles, 259
Text Settings, 252, 255
tips for zooming effects, 259
Timeline View, 56, 293
add a fade in or fade out, 297
additional Volume Control Points, 307
adjusting the soundtrack, 296
changing slide and transition times, 299
controlling Slide Sounds, 300
create an offset, 298
crossfade tracks, 301
Duplicate a track, 300
expand the timeline view, 295
see the timeline, 293
set beginning or ending point, 298
Split a track, 300
Volume Control Points, 303
Volume Control Points Made Using Keyframes, 485
zoom sliders, 294
Toolbar, 54, 63
Add Blank Slide, 64
add or edit Watermark, 67
Add Title Slide, 64
capture still frame, 67
collect show files, 67
Combine slides, 65
create a video, 68
create Blu-ray, 68
create DVD, 67
create Executable, 68
Edit Slide, 64
New slide show, 64
open All Formats window, 67
open Effect (FX) window, 64
Open existing show, 64
open Menu Theme and Layout, 67
open Show Options, 65
open Show Options Music tab, 65
open the Wizard, 64
Remix, 64
Reset a slide, 65
Save current show, 64
Sync Music, 65
upload show to Facebook, 68
upload show to YouTube, 68

**Transitions, 36, 128, 339**
adding, 348
applying, 131, 339
backing up, 363
categorize, 352
change times using the Timeline View, 299
Choose Transition window, 341
choosing transitions, 341
create, 349, 355
default duration, 676
default transition effect, 676edit, 351
export, 354
Favorites, 353
managing, 347
PXT Transitions Files, 363
Random Transition Effects, 676
random transitions, 344
remove, 350
Set RandomTransitions, 84
sort transitions, 348
structure, 363
Transition Effect, 36
Transition Icon, 36
Transition In, 96
Transition Out, 96
Transition Time, 32, 36, 95
Transitions List, 343
using modifiers, 362

**Twitter**
announcing a show upload, 566

**Undo, 46**

**Video CD, 516, 533**
Audio Type, 533
burning, 539
menus, 611
Output Options, 533
TV System, 533
Video/Still Shows, 533

**Video CD burning, 539**
CUE/BIN image file, 539
Disc Writer, 539

**Video CD Type, 533**

**Video Layers**
adding video, 204
importing, 205
looping, 206
Prevent default soundtrack fade, 287
Preview, 207
Sync Time, 207
Trim Video, 207
using the same video more than once, 212
Video Clip Settings, 205
video Speed, 206
volume, 286
Volume, 207, 286

**Video Output, 541**
choosing a preset, 543
creating custom presets, 545
custom video files, 551
delete a custom preset, 547
editing a custom preset, 547
for Social Media, 563
for Web, Devices and Computers, 542, 563
managing custom presets, 548
publishing options, 542
save to a device using ProShow Remote App, 549

**Video Trimmer, 207**
non-destructive editing, 212
open the Video Trimmer, 208
precise edits, 212
preview windows, 209
reset trim, 209
set start and end times, 211
setting a trim marker, 211
Video Timeline, 208
zoom slider, 210

**Vimeo, 571**
create a show for Vimeo, 571
video quality, 572

**Volume Control Points, 303**
adding, 303
removing, 304
set volume as left or right neighbor, 306
set volume level, 304
tips for using Volume Control Points, 305
Volume Control Points Made Using Keyframes, 305, 485

**Watermark, 85**
adding, 86
adjusting and editing, 87

**Web Page Output, 563, 575**
Adobe Flash, 576
Presenter Show, 579
web page options, 579, 583

**Web Show**
menus, 611

**Wizard, 111**
add music, 116
add photos, videos, 112
add text slide, 114
Audio Crossfade Overlap, 119
Caption, 115
create new Wizard themes, 124
edit Wizard themes, 122
Energy Level, 117
Import Content from Service or App, 113, 114
Remix slides, 121
remove Wizard theme, 125
try again, 120

**Workspace Preview, 33, 57**
Full Screen Playback, 57
preview playback controls, 33, 57
slide information, 58

**Workspaces, 28**
Build Workspace, 28, 51, 59
customizing workspaces, 71
Design Workspace, 28, 51, 65
loading custom layouts, 74
Publish Workspace, 28, 48, 51, 67
saving custom layouts, 73
Workspace Selector, 52, 54

**YouTube, 566**
channel, 566
privacy, 569
updating support, 569
upload a show, 567
video information, 567
video quality, 568
video size limits, 566